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1: Introduction

ABOUT THIS GUIDE

Welcome to PAC Manager, the configuration and inspection tool for working with the SNAP PAC system. This
guide shows you how to configure and work with the following Opto 22 devices using the PAC Manager
software tool

«  SNAP PAC S-series controllers
«  SNAP PAC R-series controllers
«  SoftPAC controllers
«  SNAP PACEB brains
«  SNAP PAC SB brains

NOTES:

If you are using groov EPIC or groov RIO, do not use PAC Manager. Instead, use groov Manage or PAC
Control. For details, see the following:
« groov EPIC User’s Guide (form 2267)
« groov RIO User’s Guide (form 2324)
e PAC Control User’s Guide (form 1700)
Allen-Bradley: If you are using SNAP PAC EB brains or SNAP PAC controllers with Allen-Bradley Logix
PLC systems, do not use PAC Manager. Instead, use the EtherNet/IP Configurator. For details, see the
EtherNet/IP for SNAP PAC Protocol Guide (form 1770). Both the software and the quide are
available on our website, www.opto22.com.

PAC Manager is available for download from our website, www.opto22.com.

Contents

This guide assumes that you have some familiarity with TCP/IP, UDP/IP, and Ethernet networking. If you are not
familiar with these subjects, we strongly suggest you consult commercially available resources to learn about
them before attempting to use these systems.

This user’s guide includes the following sections:

Chapter 1: Introduction—Information about the guide and how to reach Opto 22 Product Support. Also
includes product comparison charts.

Chapter 2: Configuring Devices—How to assign an IP address to your hardware, how to configure I/0 units
and I/0 points, how to use I/0 point features such as counters, watchdogs, and analog scaling; and how to
send configuration data to I/O units.

Chapter 3: Configuring Optional Functions—Information on configuring security, communication
protocols like SNMP and PPP, streaming, the Scratch Pad area, and other optional functions.

PAC Manager User's Guide 1
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https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide

FOR DEVELOPERS: SNAP PAC REST API

Chapter 4: Setting Up Events and Reactions—If you are not using PAC Control, information on configuring
local reactions to local events.

Chapter 5: Reading and Writing to Specific Devices—How to read data directly from a specific controller
or I/0 unit or write directly to a controller, brain, or /O points.

Chapter 6: Maintaining Devices—Changing IP addresses, upgrading firmware, and working with files on
the device.

Chapter 7: Troubleshooting—Tips for resolving difficulties you may encounter while working in PAC
Manager.

Appendix A: Menus—Describes the PAC Manager menu commands.
Appendix B: Dialog Boxes—Describes the features of PAC Manager dialog boxes.

Related Documentation

You may also need some of the following documentation, depending on the system you are using and how
you expect to communicate with it:

To use this See this O s

form #
. SNAP PAC R-Series Controller User’s Guide 1595
SNAP PAC R-series controllers OptoMMP Protocol Guide 1465
. SNAP PAC S-Series Controller User’s Guide 1592
SNAP PAC S-series controllers OptoMMP Protocol Guide 1465
SOftPAC controllers SoftPAC Software-based Controller for PC-based Control 2020

Data Sheet

. SNAP PAC Brain User’s Guide 1690
SRS SIS OptoMMP Protocol Guide 1465
PAC Control User’s Guide 1700
PAC Control strategies PAC Control Command Reference 1701
PAC Control Commands Quick Reference Card 1703
Serial communication modules SNAP Serial Communication Module User’s Guide 1191
High-density digital modules ~ SNAP High-Density Digital Module User’s Guide 1547

All forms are available for download from our website, www.opto22.com. The easiest way to find one is to
search on the form number.

FOR DEVELOPERS: SNAP PAC REST API

If you're a developer who'd like to use PAC Control strategy tags in communications with other devices, the
Opto 22 SNAP PACREST APl is a secure and powerful way to do just that. The API is available in SNAP PAC
R-series and S-series controllers with PAC firmware R9.5a and higher. To configure HTTPS access to your PAC's
RESTful server and learn how to call the API, visit developeropto22.com.

PRODUCT SUPPORT

If you have problems installing or using PAC Manager and cannot find the help you need in this guide or on
our website, contact Opto 22 Product Support.

Phone: 800-TEK-OPTO
(800-835-6786 toll-free in the U.S. and Canada)
951-695-3080
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CHAPTER 1: INTRODUCTION

Monday through Friday,
7 am.to 5 p.m. Pacific Time

Email: support@opto22.com

Opto 22 website: www.opto22.com

When calling for technical support, you can help us help you faster if you provide the following information to
the Product Support engineer:

A screen capture of the Help > About dialog box showing software product and version (available by
clicking Help > About in the application’s menu bar).

Opto 22 hardware part numbers or models that you're working with.
Firmware version:

- Forgroov EPIC processors and groov RIO modules: available in groov Manage by clicking Info and
Help > About.

—  For SNAP controllers and brains: available in PAC Manager by clicking Tools > Inspect.

Specific error messages you received.

Version of your computer’s operating system.

For PAC Control, PAC Display, OptoOPCServer, or PAC Manager, you may be requested to provide
additional information, such as log or dump files. You can find these files in a support files sub-folder:
a. Onyour Windows Desktop, double-click the PAC Project 10.5 folder.

b. Double-click Support Files.

c. Double-click on the appropriate shortcut to open the sub-folder containing the requested files.
Note: PAC Control, PAC Display, OptoOPCServer, and PAC Manager create appropriate sub-folders when they

create diagnostic log or dump files. If they have not created these files, the sub-folder may not exist; in this case,
the shortcut will not work.

OPTO 22 PROCESSOR COMPARISON CHART

This table compares SNAP PAC controllers and brains using PAC firmware R10.0 and PAC Project R10.0 software (or higher). Shaded part
numbers are obsolete as of 2024; please contact Pre-Sales Engineering for more information.

Runs PAC Control strategies

D D
A A 0 0

(Obsolete)

SNAP PAC Brains

Standalone Rack-mounted Ethernet ‘ Serial

SNAP-PAC-SB2
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-3 u o e AN «
- - N mMm mMm M@
X ol B A T R
2 2 2 23 32 2
T | ¢ i ke ¢ T ¢ 41 44 1
a 0 0 0 0 o o a a o oo o
- < < < < < < ] 9 <
O P4 4 b4 Z2Z ZZ Z
(7] (%) (7] nmw nuun u

| 0 o o e o o

Maximum PAC Control charts running at once (plus

host task)

‘64
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w
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OPTO 22 PROCESSOR COMPARISON CHART

AP PA

SNAP PAC Brains

© (Obsolete)
W [Standalone| __Rack-mounted  [ICORTRSIER
ATUR N = =G
= "l‘ ? - F' N (‘Il - N
BEA : F oF LD ELS &
T | ¢ i e ¢ ¢ ¢ 41 47T 2 2
BESEEREREN X I I S I < <
; 5 5 5 66 66 5 o
Two independent Ethernet network
interfacesp (two IP addresses) ’ ® ® ® e o ®
Two switched Ethernet network
Communication |interfaces (one IP address) for o o
multi-drop configuration
Total number of RS-232 serial ports b 2 4¢ 1 1 1 1 0 0 0 0
Total number of RS-485 serial ports & 1 4¢ 0 0 0 0 0 0 1 1
TCP/IP, UDP/IP o o o o ® O o o o
EtherNet/IP” (Allen-Bradley”
RSLogix” systt(ems and othe):'s) ® o ® e o ® ® ®
Modbus'/TCP (slave)d e o o e 6 o6 o o
OPC driver support ® o o o e o o e o o o
RESTful API o o o e © o
Protocols HTTP/HTTPS [ ) o [ ) e O ([ ]
(C)opitoMMP memory-mapped proto- Py P P P P Py °® e o o
SNMP (network management) o o [ ) ® O () o ()
FTP server, file system o o o ® O () () o
FTP client e o o [ J e o o
SMTP (email client with authentica-
tion ar(wd attachments) ® ® ® ® e o ®
SNAP-PAC nodes for Node-RED; RESTful API () o [ ) ® O ()
Direct access to hard drive & network drives (Dropbox®,
etc.) ®
Realtime clock 3 () () () e O () () e o o
Backup battery (recharges when brain has power)" e O o e o o ( e o o
Physical RAM (MB) a 32 16 (256 for GEN2) 16 16
RAM available for Strategy (MB) 64 16 4 (64 for GEN2) - -
Battery-backed RAM (MB) 8 8 2 _ -
Flash memory (MB) ! 16 8 (16 for GEN2) 8 8
Removable data storage (microSD card slot) a |32 GBmaxX 32 GB maxX
32-bit processor a e o (] e o o e O o o
Floating-point unit (FPU) a o () () e © ()
| 50to5.2 | 5.0to5.2
Power requirements a 13V\7—21\1I.33CW SIS Vbe Vbe
max @1.2-15A @ 750 @ 750
mA-1.0A | mA-1.0A
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CHAPTER 1: INTRODUCTION

SNAP PAC Brains
SNAP PAC Controllers (Obsolete)

Standalone Rack-mounted Ethernet ‘ Serial

N
=
—~ | W
19 =
FEATURE R = & o
S | & - NN = o
—= o~ - - - - N mmnm mm M m
BEERERE = = x ub Lo o
2 1¢]¢ | FIREEEIRIEE
AESERES & £ § 33 333 &
(AN S o o o oo aQ Qo Qo
< < < < < < < 9 << < <
AN Z Z Z ZZ Z2Z ZzZ =z
(%) (2] (2] [%2) [%2) (2] [%2) nuu Oun ou (2]
Operating Temperature in degrees C a -20 to 60 -20to 60 -20to 60 -20 to 60
Storage Temperature in degrees C -40to 85 -40 to 85 -40to 85 -40 to 85
Humidity (non-condensing) a 0-95% 0-95% 0-95% 0-95%
SNAP PAC EB brains e o o [ ] e o o
o SNAP PAC SB brains [ ) ()
ﬁoon;z?:;n € SNAP PAC R-series controllers e o6 o o e o o
groov EPIC processors e o o o e o o
groov RIO modules e o o [ e o o
Combination controller and 1/0 processor o e o o
Mounts on SNAP PAC I/O mounting rack n/a n/a o o () () e o o
Mounts on SNAP B-series I/0 mounting rack n/a n/a ()
Maximum number of modules allowed on largest rack: o o o o p
Any mix of 16 digital, 16 analog, and 8 serial n/a n/a 1 o o ® o e & o
Input latching o e O o e O o o
On/off status [ e o o e O o o
Watchdog timer (] e o o e O o o
High-speed counting (up to
20 kHz) o e O o o
o _ |Quadrature counting" o ® O o o
Digital I/O point
faatures On-pulse & off-pulse measurement?| n/a n/a o e O o o
Frequency & Period measurement [ ) e O o o
TPO (time-proportional output) o ® o o () e o o
Digital totalizing? o e O o e e o o
Pulse generation (continuous
square wave, N pulses, on-pulse, o ® O e O o
off-pulse)
Thermocouple linearization (32-bit
floating point for linearized values) L o o i o o o o
Minimum/maximum values o o O ©o ® o o o
Offset and gain o ® o o e O o o
_ [Scaling [ e o o e e o o
;—\ne:log /O point |1p( (Time-proportional output)® | n/a n/a [ ] e 6 6 o o o o
eatures
Output clamping o e o o e o o o
Filter weight ([ e o o e e o o
Watchdog timer [ e o o e o o o
Analog totalizing' o e o o e o o o
Ramping' o e O o o e o o
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PID logic (maximum 96 PID loops per controller or
brain)

SNAP PAC Brains
(Obsolete)

AD DA 0O 0O

Standalone Rack-mounted Ethernet ‘ Serial

Data logging

Digital events, alarm events, serial events

Event messaging

UDP streaming of I/O data to host

I/0 point data mirroring and memory map copying

n/a
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As provided by the Microsoft Windows computer the software runs on.
SoftPAC cannot communicate through serial ports on the PC.

Serial ports are software configurable for RS-232 or RS-485.

PAC firmware >=R9.4b, 8 max connections. Lower firmware, 2 max con-
nections.

Available with OptoOPCServer and PAC Control, through a SNAP PAC
controller.

SoftPAC includes Status Read, Status Write, and Scratch Pad memory
map areas.

Models manufactured before August 2007 and S1s with serial numbers
625653 and lower have user-replaceable backup batteries. See original
user's guide.

Flash memory function implemented via a file; size is limited only by
disk space.

For SNAP-PAC-R1 (GEN2): Requires firmware R10.5g or higher and
loader R6.0d. It does not support lower versions.

For SNAP-PAC-51, SNAP-PAC-S2, SNAP-PAC-RT (pre-GEN2),
SNAP-PAC-R1-FM, SNAP-PAC-R1-B, and SNAP-PAC-R2: Requires PAC
firmware 9.4a and loader 6.1a or higher. S-series with microSD & manu-
facture date older than 06/14 supports max. 2 GB microSD.

PAC Manager User’s Guide
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Units with serial numbers lower than 500,000 have an 8-24 VDC
input voltage rating. Verify voltage on the unit’s faceplate before apply-
ing power.

For compatibility with legacy Opto 22 hardware, see Legacy and Cur-
rent SNAP Product Comparison and Compatibility Charts

(form 1693).

For SNAP-PAC-R1s with serial numbers lower than 600,000, and all
SNAP-PAC-R1-Bs: 4-point digital modules are limited to eight per
rack and they must be in slots 0-7.

Not supported: serial, motion control, Profibus, & Wiegand modules.
Four-channel modules only; not high-density modules.

Requires a SNAP-IDC5Q quadrature input module.

Requires a SNAP analog TPO module (SNAP-AOD-29).

Requires a SNAP PAC controller and PAC Control commands.

Does not support serial events.
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2: Configuring Devices

INTRODUCTION

Follow the steps in this chapter to assign IP addresses to Opto 22 devices on an Ethernet network. (Addressing
information for SNAP PAC SB serial brains is set on the brain itself. For details, see the SNAP PAC Brains User's
Guide, form 1690.) This chapter also includes steps for configuring I/O unit points and features. I/O points must
be configured before you can read or write to them.

This chapter assumes that you have already installed the hardware and software according to steps in the
device's user's guide. (See “Related Documentation”on page 3.)

If you are using a wireless or modem connection, or if you are using event messages, email, streaming, the
Scratch Pad area for peer-to-peer communication, or SNMP for communicating with enterprise management
systems, also see Chapter 3, which shows you how to set up these optional functions. All this information goes
in the configuration file that PAC Manager uploads to I/0 units.

WHEN TO USE PAC MANAGER AND PAC CONTROL

If you will be running a PAC Control strategy on a SNAP PAC System to control I/0 units, you may be
wondering when to use PAC Manager versus when to use PAC Control. These two tools serve different
purposes, but some of their functionality overlaps.

NOTE: PAC Manager cannot be used to configure groov I/O units or mistic I/O units.

«  Forgroov I/O units, use groov Manage.
«  Formistic /O units, use PAC Control

|
PACManager Tasks PAC Control Tasks
I-\I;s;%r:j?:i change —y Configure I/0 = Configure control =) Programand
Load firmware El 1/0 Unit engine (so PC running debug control
oA ; PAC Control can logic
Configure communications  [#- & UI0_Station_1 communicate with the 9
and events Em Points controller)
‘ T
1

SNAP 1/0 can be configured in PAC Manager and imported into PAC Control.
SNAP and mistic 1/0 can also be configured in PAC Control.

PAC Manager User's Guide 7
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ASSIGNING AN [P ADDRESS

Choosing a Configuration Tool for SNAP 1/0

About ETand E2 brain boards: You can configure E1s and E2s like any other I/O unitif you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E2s),
see 1/0 Configuration for E1 and E2 Brain Boards (form 1576).

For most 1/0 units, if you are already in PAC Control, configuration is easier there and you can use the loopback
IP address for SNAP PAC R-series 1/0 units controlling themselves. However, some functions for 1/0 units
cannot be configured in PAC Control.

If you use PAC Manager, you can save your configuration to a file, load it to multiple I/O units at once, and use
it for referencing points in OPC. However, you cannot use the loopback address in PAC Manager.

Choose your configuration tool based on what you need to do:

Use PAC Manager for SNAP I/0
configuration if

Use PAC Control for I/0 configuration if

+ You have only one I/O unit or I/O unit + You have multiple I/O units whose configurations
configurations are different. are exactly the same or similar.

+ The strategy will run on SNAP PAC R-series I/O + You are using a modem connection (PPP) or
units that are controlling themselves using the SNMP.
loopback IP address, 127.0.0.1 + You are using event messages or email.

« You are using an Ethernet network for « You are configuring events and reactions on the
communications (or using a SNAP PAC controller | 1/0 unit in addition to strategy logic.
with an SB brain). - You are not using PAC Control.

« The strategy handles all logic; you are not also
configuring events and reactions on I/0 units.

Whichever tool you use for configuring 1/0, be aware of the impact if you later change configuration. For
example, if you configure I/0 in PAC Manager, and then download the configuration file to I/O units, and then
later add a point in PAC Control, remember that your configuration file won't contain the new point.

ASSIGNING AN IP ADDRESS

NOTE: Ifyou are using redundant controllers with the SNAP PAC Redundancy Option Kit and PAC Project Professional
R9.1, do not use PAC Manager to assign IP addresses. Instead, use the PAC Redundancy Manager.

About IP Addresses

Each Ethernet-based device (controller or brain) ships from the factory with a unique hardware Media Access
Control (MAC) address and with a default IP address of 0.0.0.0, which is invalid. Each device must have a valid
IP address and subnet mask so that it can communicate on the network.

Assigning IP Addresses to SNAP PAC

Checking Network Setup and PC

Before using a PC or laptop computer to assign IP addresses, check the following:

« Wil your controller or brain run on a network that has a DHCP server? Dynamic Host Configuration
Protocol (DHCP) servers can automatically respond to BootP requests and assign a “dynamic”
(changeable) IP address to the requesting device, but SNAP PAC controllers and brains must have static IP
addresses. If your network has a DHCP server, Opto 22 recommends you connect the device directly to

8 PAC Manager User’s Guide
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For multiple devices,
see page 14.

CHAPTER 2: CONFIGURING DEVICES

your computer with a network cable (even if the device is a Wired+Wireless model), and then assign the
IP address. After the device has a static IP address, you can connect it to the network.

« Ifthe computer has an active wireless network connection, disable the wireless connection and connect
to your Opto 22 device via a wired connection. If you are connecting to a wireless Opto 22 device, you
will configure the wireless connection later.

«  Ifthe computer has multiple network interface controller (NIC) cards, disable all of them except for the
one that will be connecting to your Opto 22 device. You can re-enable them after you complete these
steps.

« If you need to modify the computer’s network interface settings, you must be logged in with
administrative rights.

«  Ifyouare using Windows Defender Firewall, verify that PAC Manager is checked for all network types,
including Domain.

« If needed, temporarily disable firewalls on the computer running PAC Manager. Firewalls, such as the
ones that come with some anti-virus software programs and the built-in firewall in Windows, can prevent
PAC Manager from receiving BootP broadcasts. (Firewalls in a router should not be a problem.)

If disabling firewalls is not an option, configure a firewall exception for PAC Manager.

- To configure a firewall exception in your system'’s anti-virus software, see the manufacturer’s
instructions.

- Toconfigure afirewall exception in Windows, open Control Panel > System and Security > Windows
Firewall > Allow an app or feature through Windows Firewall and add PAC Manager to the list of
allowed programs.

You can reenable the firewall (or remove the firewall exception) after you have assigned the IP addresses.

o Checkyour PC's Network Profile. If it is set to Public, change it to Private. For Windows 10, choose
Settings > Network & Internet > Ethernet and click the name of your Ethernet connection. Set the “Make
this PC discoverable” option to On.

Assigning IP Addresses

SNAP PAC controller, must be assigned a unique, static IP address. If the network you're using has a
Dynamic Host Configuration Protocol (DHCP) server, either assign a static IP address before connecting the
device to the network (preferred), or disable the server. (These servers may respond to BootP requests and
assign a dynamic address.)

Wired+Wireless models: These devices have a wireless LAN interface as well as wired interfaces, but they
send a BootP request only on the wired interface. First, follow the steps below to connect to them over a wired
network and assign their primary IP address. Later, you can configure the wireless interface.

If you are adding an I/0 segment to an existing Ethernet network, your network administrator must provide
static IP addresses and subnet masks for the I/0 units. If you are creating an independent, dedicated Ethernet
network just for I/0, you can choose your own addresses.

1. Make sure that the Opto 22 hardware is installed according to directions in its user’s guide, and that the

PAC Manager software is installed on the computer.

2. Make sure you know the IP address, subnet mask, and MAC address for each device that will receive an IP
address.

- The MAC address is on a label on the side of the controller or brain.

—  SNAP PAC S-series and R-series controllers each have two separate Ethernet network interfaces;
wired+wireless models have an additional wireless interface. Each interface has its own MAC
address and must be on a separate logical network. The interface’s logical network is determined by
its IP address and subnet mask. For details, see the Simplified IP Addressing Technical Note (form
1362) or get help from your system administrator.

PAC Manager User’s Guide 9
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ASSIGNING AN [P ADDRESS

Only Ethernet 1 sends a BootP request. Once you have assigned this primary IP address, you can
assign Ethernet 2 (the secondary address) and the wireless address, if applicable. To assign an
address to Ethernet 2, see page 17; for wireless configuration, see page 22.

SNAP PAC brains are different from controllers. Since the brain’s two Ethernet network interfaces act
as an Ethernet switch and share the same IP address, it doesn’t matter which interface is attached to
the network. The BootP broadcast comes through both. On a wired+wireless EB brain, the wireless
interface has a separate IP address. After you assign the primary IP address for the wired network,
see page 22 for wireless configuration.

3. Turn on the Opto 22 device(s).
4. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.
The PAC Manager main window opens.

ﬂ PAC Manager

File Tools View Help

<4—F—Menu bar

Ready

Dls|d| 4|wal n 6l o

<«—1—Toolbar

A

5. In PAC Manager's menu bar, click Tools > Assign [P Address.

The Assign IP Address dialog box opens. Any Opto 22 Ethernet-based devices without IP addresses that
are on the computer’s network segment appear in the list of units requesting IP addresses.

8 Assign IP Address

Units Requesting IP Addresses

*
Status | MAC Address | IP Address | Subnet Mask | Hostname | Gateway Addr... | Assign |
Discovered  00-CC-CC-00LC-CC
Discovered  00-CC-3D-00-9E-CC Set Static IP |
Assign All |
£ >
Listening for DHCP Discovers and BootP Requests Set All Static IPs |
MAC To IP Address Mappings - (MacToIP.map) Test
MAC Address | IP Address | Subnet Mask | Hostname | Gateway Addr... | DNS Addre Add...
Modify... |
Delete |
Save List... |
< > Load List... |
Close | Help |

If no MAC address appears, check the following:

10
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- Isitcorrectly connected to the computer using a crossover cable or correctly connected to an
Ethernet switch using a straight-through cable? in

- Isthe computer's network card configured with the same subnet mask as the device? See the
computer’s user’s guide for networking information.

- Does the device already have an IP address? If you want to change the IP address, see page 199.

- Isthe device booting to the loader rather than the firmware? If so, see the device’s user's guide for
more information on STAT LED blink codes.

- Have you addressed all the items in “Checking Network Setup and PC"on page 87

Double-click the MAC address of the device in the list that matches the device you are assigning the IP
address to.

CAUTION: PAC Manager lists ALL Opto 22 devices sending BootP broadcasts. Assign IP addresses only to the
devices that are yours.

The Mapping dialog box opens.

=5 Add MAC To IP Mapping X
MAC Address: |DO-CCCCO0CGLC )
IP Address: | o .o .0 .0
Subnet Mask: | o .o .0 .0
Gateway Address: | o .0 .0 .0
DNS Address: | o .o .0 .0
Host Mame: |

OK | Cancel |

Enter the IP Address and the Subnet Mask for the device. If the device will be communicating with a
device on another subnet, enter the Gateway (router) address. If it will communicate only on the local
subnet, leave the gateway address all zeros (0.0.0.0).

Leave the DNS address at 0.0.0.0 and the Host Name field blank.

WARNING! Each device on your network, including computers, routers, controllers, brains, and so on, must
have a unique IP address. Failure to assign unique IP addresses may cause catastrophic network or hardware
failures. If you don't know which IP addresses are safe to use, check with your system administrator.

When the IP address, subnet mask, and other fields are correct, click OK.

The new IP address information appears in the upper list in the dialog box, and the device's status
changes to Mapped. The address information also appears in the lower list to show that this device has
been mapped to this address.

PAC Manager User's Guide 1"
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Status changes to Mapped

8 Asdign [P Address

Units Requesting IP Addresses

| MaC Address | 1P Address

[Ha pped i

oovered  00-CC-3D-00-9E-CC

<

MAC To IP Address Mappings - (MacToIP.map)

An IP Address has been Mapped to this Unit, but not yet Azsigned

Assign
Set Skatic IP

Assign All

Set All Skatic IPs

L

Test

MAC add ress data MAC Address | IP Address | Subnet Mask | Hostname | Gateway Addr... | DNS Addre
appears in lower pane 00CCLC-01LeCe 10.199.99.119 255.285.199.0 0.0.00 0.0.00
£
Close | Help |

>

Add...

Modify...

Delete

Save List...

Load List...

JLLL

9. With the device still highlighted, click Assign.

The address is saved to flash memory, and the status changes to IP Address Assigned.

Status changes to IP Address Assigned.

8 Absign [P Address

Units Requesting IP Addresses

| Hostname

| Gateway Addr

et Mask
B5.199.0

Unit has been permanently assigned an P Address

MAC To IP Address Mappings - (MacToIP.map)

Assign
Set Skatic IP

Assign All

Set All Skatic IPs

L

Test

MAC Address | IP Address | Subnet Mask | Hostname

| Gateway Addr... | DNS Addre

O0CCLC-01CCCe 10.193.93.113 255.255133.0

Close | Help |

0000

0000

>

Add.
Modify...

Delete

Save List...

JLLL

Load List...

- Once a device's status becomes Assigned or Static, you can no longer change its IP address
information from this dialog box. To change the address, use Tools > Change IP Settings. (For details,

see page 199.)

- Ifthe device's status changes from Mapped to IP Address Assigned, and then back to Mapped, and
the STAT LED on the device continues to flash (instead of steadily glowing green) this means the IP
address was not successfully assigned. This often happens when you try to assign the IP address by
using a wireless connection, rather than a wired connection. Connect to the device with a cable and
try again, and verify that you've performed all of the checks listed in “Assigning IP Addresses to SNAP

PAC"on page 8.
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CHAPTER 2: CONFIGURING DEVICES

To verify that the IP address has been assigned successfully, highlight the device in the upper listand click
Test.

A command prompt window opens and the IP address is automatically tested using the PING command.
You should see a reply similar to the following:

BN C:\Windows\system32\cmd.exe EI@

Pinging 18.192.54.118 with 32 hytes of data:

Reply from 18.192.54.118: bytes=32 time=1ims TTL=255
Reply from 18.192.54.118: bytes=32 time{ims TTL=255
Reply from 18.192.54.118: bytes=32 time{ims TTL=255
Reply from 18.192.54.118: bytes=32 time{ims TTL=255

Ping statistics for 18.192.54.118:

Packets: Sent = 4, Received = 4, Lost = @ (Bx loss>.
Approximate round trip times in milli-seconds:

Minimum = Bms. Maximum = ims. Average = Bms

Press any key to continuwe . . . _

If you don't see a reply, make sure the subnet mask you've assigned matches the subnet mask on your
computer.

For future reference, write the IP address next to the MAC address on the white sticker provided on the
device.

Repeat steps 6 through 11 for any other devices in the list that you are responsible for.

To save the list of IP address and MAC address mappings (the lower list in the dialog box) for future
reference, click the Save List button. Navigate to the folder where you want to save the file, enter a
filename, and then click Save.

The address information is saved. You can load this information into PAC Manager later if you need to see
it.

What's Next?

For a SNAP PAC R-series controller, continue to page 17 to assign an IP address to Ethernet 2.

- For a Wired+Wireless model, configure the wireless LAN interface (page 22). Then continue with
“Creating an I/0 Unit Configuration File” on page 26.

For a Wired+Wireless EB brain, configure the wireless LAN interface on page 22. Then continue with
“Creating an I/0 Unit Configuration File” on page 26.

For a SNAP PAC EB brain, continue with “Creating an 1/0 Unit Configuration File” on page 26.
For a SNAP PAC S-series controller, choose from the following:

- Toset up security on the wired network, see page 78.

- Toassign an IP address to Ethernet 2 on a wired network, see page 17.

- (Wired+Wireless models only) To configure the wireless LAN interface, see page 22.

To create PAC Control strategies to run on the controller, see the PAC Control User's Guide (form 1700).
Information on peer-to-peer communication using the Scratch Pad area of the controller can be found in
the PAC Control User’s Guide; see the “peer-to-peer communication”in the index. See also the PAC Control
Command Reference (form 1701).

To work with the controller’s file system, microSD card, and FTP, see page 217.
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ASSIGNING AN [P ADDRESS

Assigning IP Addresses to Multiple Devices

NOTE: In order to assign IP addresses, you must be logged in with administrative rights.

If you are an OEM, integrator, or customer who has a large number of Opto 22 devices to work with at once,
you may find it easier to first create a file of MAC-to-IP address mappings, and then assign IP addresses from
the file.

Creating the Map File

1.

Upper section is used for live
assignment to devices.

Lower section shows contents
of a file containing lists of
addresses. These addresses
may or may not be actual
assignments.

Make sure you have the MAC addresses for all Opto 22 devices in front of you. Also make sure you know
what IP addresses and subnet masks you are going to use for them.

The MAC address for each device appears on a white sticker or space on the device itself. To determine
the IP addresses and subnet masks to use, work with the network administrator for the Ethernet network
on which the devices will be used.

NOTE: On a SNAP PAC controller, you can assign only the primary IP address using these steps. To assign the
secondary IP address (Ethernet 2), follow steps on page 17.

Before installing the Opto 22 devices, open PAC Manager by clicking on the Windows search button and
typing in PAC Manager.

From the Tools menu, click Assign IP Address.

The Assign IP Address dialog box opens.

| Assign IP Address

Units Requesting IP Addresses
Statuz MALC Address IP Address Subnet Mask Hosthame Gateway Addre:

q [ [T

Listening for DHCP Discovers and BootP Requests

MALC To IP Address Mappings - [MacT ol P.map)
MALC Address IP Address Subnet Mask Hostname Gateway Address | DNS Address

-
o
o

FEEEE FEELY |

Load List...

-~

Cloze | Help |

The upper section of this dialog box lists all Opto 22 devices on the same network that send a BootP or
DHCP broadcast while the dialog box is open. When you are ready to assign IP addresses, this is where
you do so. For now, ignore anything that appears here.

The lower section shows the contents of a mapping file you create, either while assigning actual
addresses or in advance of assigning them. This file can be saved, changed, and reloaded at a later time
for reference or to quickly assign addresses using the upper section—but the actual addresses on
devices cannot be assigned or changed here. The important thing to remember about this lower section
is that the list does not necessarily reflect actual addresses on devices. The IP addresses in the list may not
have been assigned yet, or a device’s address might have been changed at some point and the list not
updated.

In the lower section of the dialog box, click Add.
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Host Hame:
ak | Cancel |

CHAPTER 2: CONFIGURING DEVICES

For the first Opto 22 device, type the correct MAC address (the first six digits are entered for you; they are
the same for all Opto 22 devices). Enter the IP address and subnet mask. Enter the Gateway address if
needed. Leave the DNS address at 0.0.0.0 and the Host Name field blank.

Double-check all numbers. When all are correct, click OK.
The device's address information is listed in the lower section of the dialog box.

| Assign IP Address

Units Requesting IP Addresses

4 I

Statuz MALC Address IP Address Subnet Mask Hosthame Gateway Addre:

Listening for DHCP Discovers and BootP Requests

MALC To IP Address Mappings - [MacT ol P.map)

diliy

MAC Address IP Address Subnet Mask Hostname
00-40-30-01-85-9C  10.192.54.110 285.285.192.0

Cloze | Help |

Gateway Address | DNS Address

-
o
o

i

0000

Load List...

Click Add again and add additional addresses until all of them are listed in the lower section.
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16

| Assign IP Address

Units Requesting IP Addresses
Statuz MALC Address IP Address Subnet Mask Hosthame Gateway Addre:

4 I 2

diliy

Listening for DHCP Discovers and BootP Requests

MALC To IP Address Mappings - [MacT ol P.map)

MALC Address IP Address Subnet Mask Hostname Gateway Address | DNS Address Add...
00-a0-3d-00-d4-eb  10.192.54.37 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-9d-d3  10.192.56.230 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-d5-ed  10.192.55.110 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c1-48  10.192.54.115 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c1-40  10.192.54.70 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c7-22  10.192.54.156 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-9d-c5  10.192.56.229 285.285.192.0 0.0.00 0.0.00

'l 1 3 Load List...

Cloze | Help |

Double-check the addresses. If one is incorrect, click it to highlight it, click Modify, and make the
necessary changes.

To save the mapping file, click Save List. In the Save dialog box, navigate to the folder where you want to
place the file, enter a filename, and click Save.

The .map file is saved as a simple text file. This allows it to be modified in text editors such as Notepad.

10. Continue with the next section to assign the addresses.

Assigning Addresses from the Map File

NOTE: BootP broadcasts cannot get through a firewall in the computer where PAC Manager is running. Make sure
any firewall in the computer is disabled before you try to assign IP addresses. Firewalls in a router should not be a
problem.

1.

o vk W

IMPORTANT: Disable all DHCP servers on the Ethernet network you are using to assign IP addresses.

If a DHCP server is enabled on the network, it may assign IP addresses before PAC Manager has a chance
to do so. If that happens, turn off power to the devices, disable all DHCP servers, and turn the devices
back on. They should broadcast again.

Make sure that each Opto 22 device is installed according to directions in its user's guide. Make sure the
computer you use is on the same network segment as the devices.

Turn on all the Opto 22 devices.

If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.

In the PAC Manager menu bar, click Tools > Assign IP Address.

If the .map file you want does not appear in the lower section of the Assign IP Address dialog box, click
Load List, locate the file, and open it.

The Opto 22 devices begin to appear in the upper section of the dialog box. IP address information from
the map file is copied to the corresponding MAC address in the upper section, and the status of each
device changes to Mapped.
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Status changes to Mapped. IP address information is filled in.
5| Agsign IP Address
Unit} Requesting IP Addresses
Stdtus MALC Address IP Address Subnet Mask Hostname Gateway Address | DME
Mapped 00-a0-3d-00-d4-eb | 10.192.54.37 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-9d-d3 | 10.192.56.230 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-d5-ed | 10.192.55.110 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-c1-48 [ 10.192.54.115 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-c1-40 | 10.192.54.70 285.285.192.0 0.0.00 0.l
Mapped 00-a0-3d-00-c7-22 | 10.192.54.156 285.285.192.0 0.0.00 0.l
tapped 00-a0-3d-00-9d-c5 ( 10.192.56.223 255.285.192.0 0.0.0.0 0.0l

IT F

Listening for DHCP Discovers and BootP Requests

MALC To IP Address Mappings - [MacT ol P.map)

FEEEE FEELE

MALC Address IP Address Subnet Mask Hostname Gateway Address | DNS Address Add
00-a0-3d-00-d4-eb  10.192.54.37 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-9d-d3  10.192.56.230 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-d5-ed  10.192.55.110 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c1-48  10.192.54.115 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c1-40  10.192.54.70 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-c7-22  10.192.54.156 285.285.192.0 0.0.00 0.0.00

00-a0-3d-00-9d-c5  10.192.56.229 285.285.192.0 0.0.00 0.0.00

« [ I ] Load List...

Cloze | Help |

7. Checkthe address information. If anything is incorrect, double-click the device in the lower list and
change it. Click Save List to save the change to thefile.

The change is automatically made to the upper section.
8. When all addresses are correct, click Assign All.
The address is saved to flash memory, and the status changes to Static IP.

The devices now have their IP addresses. If you need to change an address, use Tools > Change IP Settings
(see page 199).To assign an IP address to Ethernet 2 on a SNAP PAC controller, see the steps in the next
section.

Assigning an IP Address to Ethernet 2 (SNAP PAC Controller Only)

NOTE: This section does not apply to SNAP PAC brains; the two Ethernet network interfaces on a SNAP PAC brain have
the same IP address.

For Wired+Wireless models, see page 22 to configure the wireless LAN interface.

SNAP PAC R-series and S-series controllers have two independent Ethernet network interfaces, labeled on the
top of the controller as Ethernet 1 and Ethernet 2. The controller sends its initial BootP request from Ethernet 1,
and the IP address you assign to the controller is for this primary interface. To communicate through Ethernet
2, you must assign it a separate IP address following the steps below.

IMPORTANT: The two Ethernet interfaces will work only if they are on separate IP subnets, so the control engine can
clearly determine where to direct communication. (The subnet masks can be the same or different, but when you
perform alogical AND on the IP address and subnet mask for each interface, the two results must be different.) For

example:
Ethernet 1 Ethernet 2
IP Address: 192.168.0.12 10.0.0.5
Subnet Mask: 255.255.255.0 255.255.255.0
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NOTE: If you need to configure or modify settings for the network interface cards on your computer, you must be
logged in with administrative rights.

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.
2. Inthe PAC Manager main window, click the Inspect button Ql

The Inspect window opens.

- Ifyou haven't used the Inspect window before, the window will not show any data.

¥ Inspect Opto 22 Device - X

Device MName: I ;I Options ¥ (=1L Error reading area: Timeout

[~ Status Read

Status Read I

Status Write | ﬂl

Wireless LAN ¥

Point Config |
Digital Bank |
Digital Point |
Analog Bank |
Analog Point |
High Density |
System b |
SeratchPad |

Datalog

PID »

Events > |
Communications ¥ |
Other 3 |

Help | [™ AutoRefresh |1snnn msec

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.

8 Inspect Opto 22 Device — *
Device Name: I 10.199.99.99 LI Options ¥ | Status: | Status Read area last read at 07/05/16 10:34:58
~Status Read
Status Read |
Status Write ADDRESS DESCRIFTION VALUE ~ Refresh I
= 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
e | OxFFFF F030 0008 Buay Flag 0
Paint Config | 0xFFFF F030 0018 Loader Version R5.1lc
Diital Bank 0xFFFF FO30 0000 Memory Map Version 1
gita! Ban | 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Point | 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016
Analog Bank | 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point | 0xFFFF FO30 0020 Unit Type 0x0000007A
High Density | 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
g 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
5 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
HEEn | 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
Scratch Pad ,l 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log 3 |
ETHERENET 1 Interface

PID * 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-85-9C
, L OXFFFF FO30 0034 IP Address 10.192.55.67
em PN M| s 0GR ERR R 200038t S AnE LMt e oAt P, D55 AASFABY 0, Ay o anmen pasal

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.
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Secondary IP address
information

CHAPTER 2: CONFIGURING DEVICES

- Ifyou have configured six or more devices, the Inspect window provides two additional features:
Next and Back navigation buttons (to navigate back and forth through the alphabetized list of
devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons

and Most Recently Used list
are displayed when you have
six or more devices configured.

S

Status Rga

Status Wiits

Wireless LAN

| Inspect Opto 22 Device

Cookie Controller
Cookie Controller
EngineRm

Coil Portable
SoftPAC

Boiler
Chamber 1
Chamber 2

Paint Config oyl portable

(CRIFTION

rerup Clea
¥y Flag 1

der Versij

T Cookie Controller ory Map Ve
HD@E' B EngineRm mware Verd
Digital Point S2fPAC mware Ver,

| ‘fJxFFFF FO30 00BO Firmware Verg

. Mo, Jlr=r = e, v . anin?

In the Device Name field, type the name for the SNAP PAC controller (or choose it from the drop-down
list). If the controller has not been defined in PAC Manager, the Add New Device dialog box appears.
Choose Direct Connection to Ethernet Device and enter the IP address of the primary Ethernet interface
(Ethernet 1). Leave the Ethernet port at 2001 unless you have changed it on the controller.

Click Status Read.

Status information for the controller is shown in the window. Scroll down till you see ETHERNET 2
Interface. If the IP address for Ethernet 2 has not been assigned yet, the IP address information will show

all zeros.

| Inspect Opto 22 Device

Device Name: | jlSERRFR:y) +| Options ¥

Status Read
Status Read

Status:

Status Read area last read at 07/05/16 09:55:07

} OXFFEF FO30 0018
Status Wit 0xFFFF FO30 0000
Wireless LAN ¥

0xFFFF F030 0230
0xFFFF F030 001C
0xFFFF F030 00RO
Paint Config 0xFFFF F030 00BO
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

System »

OxFFFF F030 0020
0xFFFF F030 0080
0xFFFF F030 0024
0xFFFF F030 0025
0xFFFF F030 0026
0xFFFF F030 024C
0xFFFF FO30 0028

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Ivpe

Unit Description

1/0 Unit Hardware Revision (Month)
1/0 Unit Hardware Revision (Day)
1/0 Unit Hardware Revision (Year)
1/0 Coprocessor Firmware Version
Installed Ram

ETHERNET 1 Interface

R5.1c

1

Flash Memory
L9.5a
05/03/2016
15:29:32

0x0000007R

4
21

2008
0.0z
33554432

5.

0xFFFF F030 002E MAC Address 00-R0-3D-01-85-8C
Saatchpad b 0xFFFF F030 0034 IF Address 10.192.55.67
0xFFFF F030 0038 Subnet Mask 255.255.192.0
Datalog * 0xFFFE FO30 003C Gateway 10.192.51.51
0xFFFE F030 0040 DS 10,192 60,31
PID b ETHERNET 2 Interface
== b | 0xFFFF FFEF FO60 MAC Address 00-R0-3D-01-85-8D
0xFFFF FFEF FOS0 IF Address 0.0.0.0
Communications 0xFFFF FFFF FOSE Subnet Mask 0.0.0.0
_ 0xFFFF FFEF FO68 Gateway 0.0.0.0
Other >| 0xFFFF FFEF FO70 DNS 0.0.0.0

SNAP-FAC-R1 |}

~ Refresh

[~ AutoRefresh | 15000  msec

Click Status Write. Scroll down to see all the IP address fields for Ethernet 2.
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*

| Inspect Opto 22 Device —

Device Name: | 10.192.55.67 j Options » Status: | Status Write area last read at 07,/05/16 09:58:59

Status Write
Status Read
Status Write Address | Description | Value | A Refresh
OxFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147433643.000
- OxFFFF FO38 0054  Scanner Flags 0x 00000000 Apply
Wireless LAN ¥

OxFFFF F038 0154 Host Name
0xFFFF FO33 0194 Domain Name

Point Config 0xFFFF F408 0004  Strategy Download Method Mormal Jia|

| OxFFFF F700 2000 Turn-Around Delav for Port 0 {msec) 0
Digital Bank ETHERNET 2 Interface
——— OxFFFF FFFFFO50 1P Address 0.0.0.0
Ethernet 2 IP &l— OxFFFF FFFFFO58  Subnet Mask 0.0.0.0
ddress field e — OxFFFF FFFFFOG8  Gateway 0.0.0.0 L
aadress tielas g OxFFFF FFFFFO70 DNNS 0.0.0.0

v
Analog Point

High Density Operation
OptoMMP Device A Send Command
Restart command TystEm +t Restart Device from powerup )
Store configuration to flasi
Erase configuration from flash
L3
Eaakdied Reset to defaults and Restart Device
» microSD
ey Store configuration and IP settings to micraSD

BID , Erase configuration and IP settings from micraSC
Erase firmware from microSD

M Erase strategy from microsD
Other
Switch to loader mode
»
M Clear Digital Events - Expanded configuration
M Clear Digital Events - Old configuration w

Close Help [~ AutoRefresh | 15000  msec

6. Click the Value field for IP Address under Ethernet 2 Interface and type in the IP address. Enter the
Ethernet 2 Subnet Mask the same way. If necessary, change the Gateway. Leave the DNS as is.

7. When all the secondary IP address fields are correct, click Apply.

The information is sent to the SNAP PAC, but it cannot communicate on the Ethernet 2 interface until it is
restarted.

8. Inthe Operation Commands section, highlight Restart Device from powerup. Then click Send Command.
The SNAP PAC s restarted.

9. Checkto make sure the controller is back on line by clicking Status Read again. Click OK at the message.
Scroll down a little to see all the IP address information for Ethernet 2.
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IP address for primary
interface (Ethernet 1)

Ethernet 1 IP address

@ Inspect Opto 22 Device

CHAPTER 2: CONFIGURING DEVICES

Device Name: | 10,152,55.67

Status Read
Status Read |

Status:

j Options »

Status Read area last read at 07/05/16 10:07:17

information

Ethernet 2 IP address
information

IP address for secondary
interface (Ethernet 2)

Ethernet 1 IP address
information

Status Write OxFFFF FO30 0000 Memory Map Version 1 ~ Refresh
OXFFFF FO30 0230 Current Boot Device Flash Memory
) OxFFFF F030 001C Firmware Version R9.5a
SEEELN D OkFFFF FO30 00A0  Firmware Version Date 05/03/2016
OxFFFF F030 00BO Firmware Version Time 15:29:32
Point Config
T O0xFFFF FO30 0020 Unit Type 0x00000074
OxFFFF FO30 0080 Unit Description SNAP-PAC-R1
Digital Point OxFFFF F030 0024 I/0 Unit Hardware BRevision (Month) 4
OxFFFF FO30 0025 I/0 Unit Hardware Revision (Day) 21
Analog Bank OxFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
OXFFFF FO30 024C I/0 Coprocessor Firmware Version RD.Da
Analog Paint OXFFFF FO30 0028 Installed Rem 33554432
m ETHERNET 1 Interface
O0xFFFF FO30 002E MAC Rddress 00-A0-3D-01-85-9C
deEr b 0xFFFF_FO30 0034 P Address 10.192.55.67
sqatchPad » 0xFFFF FO30 0038 Subnet Mask 255.255.192.0
_ 1 OxFFFF FO30 003C Gateway 10.192.51.51
Datalog * OxFFFF FO30 0040 OIS 10.192.60,31
(ETHERNET 2 Interface
PID b OxFFFF FFFF FO60 MAC Rddress 00-20-3D-01-85-9D
== o= AXFFFFFFFFFOST IF Address 10.10.10.7
OxFFFF FFFF FOS8 Subnet Mask 255.255.255.0
e e 0 OxFFFF FFFF FO68 Gateway 0.0.0.0
0xFFFF FFFF F070 DNS 0.0.0.0
Other 3 w

Close Help

™ AutoRefresh | 15000  msec

10. To verify that the secondary IP address (Ethernet 2) is also communicating, make sure Ethernet 2 is
attached to the correct network. On a computer on the same subnet as Ethernet 2, open the PAC
Manager Inspect window. Enter the Ethernet 2 IP address (or a different name) in the Device Name field

and click Status Read.

The controller now shows the same information, but through the secondary interface:

@ Inspect Opto 22 Device

Device Name: | 10.10.10.7

Status Read
Status Read |

Status:

j Options »

Status Read area lastread at 07/05/16 10:07:17

Ethernet 2 IP address
information

Status Virite 0xFFFF FO30 0000 Memory Map Version 1 ~ Refresh |
0xFFFF F030 0230 Current Boot Device Flash Memory
) 0xFFFF FO30 001C Firmware Version B9.5a
LEESU D OXFFFF FO30 00A0 Firmware Version Date 05/03/2016
0xFFFF F030 00BO Firmware Version Time 15:29:32
Point Config
T 0xFFFF F030 0020 Unit Type 0x0000007R
0xFFFF F030 0080 Unit Description SNAP-FAC-R1
Digital Point 0xFFFF FO030 0024 I/0 Unit Hardware Revision (Month) 4
0xFFFF F030 0025 I/0 Unit Hardware Revision (Daw) 21
Analog Bank OxFFFF F0O30 0026 I/0 Unit Hardware Revision (Year) 2008
0xFFFF F030 024C I/0 Coprocessor Firmware Version A0.0a
Analog Point 0xFFFF FO30 0028  Installed Ram 33554432
m ETHERNET 1 Interface
0xFFFF F030 002E MAC Rddress 00-A0-3D-01-85-9C
SR 0xFFFF FO30 0034 IP Address 10.192.55.67
Soratchpad » OxFFEF F030 0038 Subnet Mask 255.255.192.0
0xFFFF F030 003C Gateway 10.192.51.51
Datalog * 0xFFFF FO30 0040 DNS 10.192.60.31
(ETHERNET 2 Interface
PID b 0xFFFF FFEF F060 MAC Rddress 00-20-3D-01-85-3D
T OxFFEE FFEF FOS0 IP Address 10.10.10.7
0xFFFF FFFF F058 Subnet Mask 255.255.255.0
Communications ¥ 0xFFFF FFFF FO068 Gateway 0.0.0.0
0xFFFF FFFF F070 DNS 0.0.0.0
Other 3 Y]
loce | =Y | [~ AutoRefresh | 15000  msec
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Configuring Wireless LAN Communication (Wired+Wireless Models Only)

This section applies only to SNAP PAC controllers and EB brains with wireless LAN interfaces (models ending in
-W). These devices send their initial BootP request from Ethernet 1,and the IP address you assign to them is for
this primary interface. To communicate through the wireless LAN interface, you must assign it a separate IP
address and configure communication following the steps below.

IMPORTANT: The wireless LAN interface will work only if it is on a separate IP subnet, so the device can clearly
determine where to direct communication. (The subnet masks can be the same or different, but when you perform a
logical AND on the IP address and subnet mask for each interface, the two results must be different.) For example, on
a SNAP-PAC-S1-W you might use the following addresses and subnet masks:

Ethernet 1 Ethernet 2 Wireless LAN
IP Address: 11.192.55.162 10.10.10.7 146.87.12.250
Subnet Mask: 255.255.255.0 255.255.255.0 255.255.255.0

NOTE: If you need to configure or modify the settings for the network interface cards on your computer, you must be
logged in with administrative rights.

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.
2. Inthe PAC Manager main window, click the Inspect button @
The Inspect window opens.
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If you haven't used the Inspect window before, the window will not show any data.

¥ Inspect Opto 22 Device

Device Name: |

| _options ¢

[S=YTE Error reading area: Timeout

[~ Status Read
Status Read I

Status Write |
Wireless LAN ¥

Point Config |
Digital Bank |
Digital Point |
Analog Bank |
Analog Point |
High Density |
System b |
SeratchPad |

Datalog

PID »

Events > |
Communications ¥ |
Other »l

- |

I Auto Refresh |1snnn msec

If you have used the Inspect window before, the last device you inspected is shown in the Device

Name field, and current Status Read information appears in the window.

8 Inspect Opto 22 Device

Device Name: | 10.199.99.99

LI Options >|

Status: | Status Read area last read at 07/05/16 10:34:58

~Status Read
Status Read |

ADDRESS

Status Write

DESCRIFTION

VALUE

0xFFFF F030 0004
0xFFFF F030 0008

Wireless LAN  » |

Point Config |
Digital Bank |
Digital Point |
Analog Bank |
Analog Point |
High Density |

System 3 |
Data Log 3 |

FID 3

0xFFFF F030 0018
0xFFFF F030 0000
0xFFFF F030 0230
0xFFFF F030 001C
0xFFFF F030 00RO
0xFFFF F030 00BO

0xFFFF F030 0020
0xFFFF F030 0080
0xFFFF F030 0024
0xFFFF F030 0025
0xFFFF F030 002&
0xFFFF F030 024C
0xFFFF F030 0028

0xFFFF F030 002ZE
0xFFFF F030 0034

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress

PUC Receiwed (0}
a

R5.1c

1

Flash Memory
19.5a
05/03/2016
15229232

0x0000007A
SHAP-FRC-R1
4

21

2008

R0.0a
33554432

00-A0-3D-01-85-3C
10.192.55.67

~ Refresh I

P .E“e\”—“""\__,"l__ L OXFERP R0 20m0035 m FtanetMaming Ao ot trin it D55 ASESARR G, Ay A snmrn et

If you have configured other devices, they are listed in alphabetical order in the drop-down list.

If you have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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3.

of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

=] Inspect Opto 22 Device

(s3] - W BCookie Controller
Cookie Controller
EngineRm

SASIGE Coil Portable 4
Status Wit R
Wireless LAN terup Clea

ireless

—— I Chamber 1 v Flag 1

. Chamber 2 J

Point Config g partable der Versid

o Cookie Controller ory Map Vi

HD@E' B EngineRm mware Verd

Di SoftPAC Imware Ver

igital Point 1
0xFFFF F030 00BO Firmware Verg

In the Device Name field, type the device’s name or IP address (or choose it from the drop-down list).

4. (lickWireless LAN and choose Wireless LAN Configure from the popup menu.

[ @ =)

Status: WiFi Configuration area last read at 01/06/12 11:47:32

| Inspect Opto 22 Device

Dievice Name: [10.152.50.20

j Options ¥

‘Wireless LAM Configuration

Status Read
Status Wi ‘ Address | Descnpon : | Walue | Rsfresh
WLAN Configurafior |
i OFFFF FS000000  'WLAN Enable Disabled =l Apply
Wireless LAN ¥ O4FFFFFR00 0004 WLAN Logging Logging Disatled =

[0xFFFF FB00 0008 R Inactivity Reazsociation Timeout [sec]

Metwork Block Configuration

300
Paint Canfig Wiew Status

Digital Bank OsFFFFF700 4004 IP Address 0oan

— OsFFFF FP004008  Subnet Mask 0000

Digital Point 04FFFF F700400C  Primary Gateway 0000

O+FFFF F7004010  Secondary Gateway 0000

Analag Bank 0FFFFFT004014  Primary DNS 0000

2 0xFFFF F700 4018 Secondary DMS oooo

AR DFFFFFPO0401C  Metwork Hame (351D)

0=FFFF F700 40428 Encryption Type Mone =l

High Denszity

i

5. Inthe WLAN Enable line, click the arrow next to Disabled and choose Enable.

6. Leave WLAN Logging disabled and Rx Inactivity Timeout at the default of 300.

7. Under Network Block Configuration, enter the IP address and subnet mask for the wireless network.
Remember that it must be on a separate network segment from the wired interfaces on the device.

8. Ifnecessary, enter the Primary and Secondary Gateway addresses. Leave the Primary and Secondary DNS
fields blank.

9. Typeinthe name of the wireless network (SSID).

10. For Encryption Type, click the arrow next to None.
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13.

14.
15.

16.
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-_T]InspectOptoEE Device | = ‘ = | £2 |

Device Mame: |1 0.19250.20 j Options ¥ Status: |WiFi Configuration area last read at 01/06/12 11:47:32

Wireless L&N Confiquration
Status Read

N Address | Description | Walue | Befresh
m wLAM Configuration
) 0%FFFF FRO00000  WLAN Enable Disabled -l Apply
Wireless LAN ¥ D4FFFFFE000004  WLAN Logging Logging Disabled =1
0xFFFF F200 0003 R Inactivity Reassociation Timeout [sec) 300
Paint Config “iew Status
Metwork Block Configuration
Digital Bank 0xFFFF F700 4004 IP Address 172.205.0
0xFFFF F700 4008 Subnet Mask 255.255.192.0

Digital Point OFFFF F700 4000 Primary Gateway 0000
nalog Bank OxFFFF F700 4010 Secondary Gateway ooono

WY 0« FFFF700 4014 Primary DNS 00.0.0

. 0FFFF F700 4018 Secondary DMS 0.00.0
m D4FFFFFFODA0C  Metwork Hame [5510) WEactony
High Dersity 0FFFF F700 4043 Encryption Type Mone -
Mone
SEm O WEP (4]
WEP [128-hit]
Scratch Pad KIP)
i 3 P e
ata Log ‘ - y

From the drop-down list, choose the security used on the wireless network.

Additional fields appear.

Choose the Network Key Input Type, either Hexadecimal or ASCII (WEP is normally Hex; WPA and WPA2
are normally ASCII).

Enter the Network Key (the password for the network).

This field will show the password when you enter it; however, if you inspect the device later, the field will
show only asterisks.

When all fields are complete, click Apply.

At the message asking whether you want to restart the device, click Yes.

The configuration information is sent to the device and stored to flash memory, and the device is
restarted. The WLAN LED turns orange to indicate that the interface is searching for or authenticating the
wireless network. Once the network is found, the LED turns solid green.

To see connection status and signal strength, click the View Status button. (You can also see this screen
by clicking Wireless LAN > Wireless LAN Status.)
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B Inspect Opto 22 Device EI E @

Options ¥ | Status: IWireIess LAM Status area last read at 09/01/11 15:18:07

Device Mame:  |[IEEE

—wirgless LAM Statu:
Status Read |

e | Connection Status: Connected
wieless LN v | Signal Quality: Good (30 dB)

Puint Config |
—Dgatet | | [ D
Diigital Paint
»=10 »=20 »=30 »=40

Analog Bank |
- Address | Description | Walue |:
et et | WIRELESS ETHERNET INTERFACE
High Densit | O+FFFF F7004004  IP Address 10,192.55.35
O+FFFF F700 4008  Subnet Mask 265, 255.192.0
O«FFFF 7003002 MAC Address 00-40-17-1E-83-47
Swpstem 3 |
WIRELESS LAN
Seetehirz] 0 OFFFFF7003008  State Eamizsied)

»=50

m

Data Log b | 0«FFFF F700 3040 Signal To Moise Ratio [dB)] a0
0«FFFF F700 3014 Metwark Mame [S51D) 22-wifi
FID 3 0=FFFF F700 4054 Enciyption Type WwRAZ [AES)
0«FFFF F700 300E BSSID 00-14-01-C5-8C-28

Ewents 3 | O<FFFF F700 3034 Channel / Frequency 11 4 2462
O<FFFF F700 3033 Receive Rate (kbps] 48000
Communications b |

(<FFFF F700 3044 Signal Level [dBm) 5
Other — + | 0+FFFF F700 3048 Noise Level idBm 57 -

Help | ™ Auto Refresh I15DUD msec

CONNECTING WITH A SNAP PAC SB BRAIN

Most devices you communicate with using PAC Manager are Ethernet-based. That is, they have at least one
Ethernet network interface and can be reached directly over an Ethernet network that includes the computer
where PAC Manager is installed.

SNAP PAC SB brains are an exception: they have no Ethernet interface and instead communicate over a serial

network. PAC Manager can communicate with SB brains in two ways, however.

»  Through a SNAP PAC controller, via an Ethernet connection to the controller and then a serial connection
from the controller to the brain. This method is easy and does not require the brain to be located near the
computer.

«  Directly from the computer to the brain, using the computer’s serial port via a serial cable and an RS-485
adapter, such as an Opto 22 PCI-AC48 adapter card. This method is useful for configuring points and
features before brains are deployed to the field, or if you are not using a SNAP PAC controller.

For connections, see wiring instructions in the SNAP PAC Brains User's Guide (form 1690).

CREATING AN I/0 UNIT CONFIGURATION FILE

About E1and E2 brain boards: You can configure E1s and E2s like any other I/O unitifyou have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E2s),
see 1/O Configuration for E1 and E2 Brain Boards (form 1576).

Before you create a control strategy using PAC Control, or before you read or write to 1/0 units, you need to
configure the I/0 points and features the strategy or other application will use. You can use PAC Manager to
copy a configuration or to configure all points, save the configuration to a file, and then upload the
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configuration to one I/0 unit or to several at once. You do not need to be attached to the I/0 unit while you
are creating the configuration file and configuring its points.

NOTE: If you are using OPC to communicate with the I/0 unit, you can use the configuration file (tag file) that PAC
Manager produces as an easy way to reference points for OPC. For details, see the OptoOPCServer User's Guide
(form 1439, available with the purchase of PAC Project Professional or OptoOPCServer).

You can start configuration in one of three ways:

If this is a new configuration, you can create a new configuration file (page 27).

If an existing 1/0 unit has the exact configuration you want, you can copy it directly to another I/0 unit
(page 28).

If you have a PAC Control strategy with similar /0 units configured, you can save them as a configuration
file (page 30) and modify the configuration. Note that this method transfers I/O unit and point
information only; any event messages, email or SNMP settings, and so on are not included when a
configuration file is exported from or imported to PAC Control. Also, 4-channel digital module and point
information is generic; you will need to reenter specific digital configurations.

Creating a New Configuration File

Configuration tree

If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.

In the PAC Manager main window, click the New button _|j| or click File > New.

In the Create New Tag Database dialog box, navigate to the location where you want the file to be. Type a
filename. Click Open.

A new configuration tree appears. (If you are familiar with PAC Control, you'll notice that this window
looks like part of a Strategy Tree.)

=5 PAC gel _Process
File Edit Tools View Help

C:\Program Files (x86)\Opto22\PAC Project 9.0\SNAP PAC Learning Center\Mair MNUM v

You can expand and collapse the folders to see or hide the I/O units and points in them. Closing the
configuration tree is the same as closing the configuration file.

To save the configuration file, click the Save button El (or in the menu bar, click File > Save).
Once the file is saved, continue with “Adding an I/0 Unit"on page 31.
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Copying an 1/0 Unit Configuration

If you have an I/0 unit or a previously saved I/0 unitimage file with exactly the configuration you want to use,
you can copy the configuration information to another I/O unit or to an I/0 unit image file. This works with all
SNAP PAC Ethernet and serial brains.

1. Inthe PAC Manager menu bar, click Tools > Import/Copy I/0 Unit.

| /O Unit Import/Copy @
Source  ————Image Source
{* Existing IO Unit Flash Memory Read
10 Unit Mame: | 10.192.54.110 j Options ¥

" Previously Saved Ij0 Unit Image File

| =

Destination ~——— Imaage Destination

+ Send Image To /O Unit Flash Memory
IfO Unit Name: | j Options »

" Save To IjO Unit Image File

| L

2. For the source, choose one of the following:

—  Existing I/0 Unit Flash Memory: Choose an existing I/0 unit. If you want to add or modify an I/O unit,
click Options. For help, see “Add/Modify New Device” on page 243.

- Previously Saved /0 Unit Image File: Enter the name of the I/0 image file you want to use, or click the
browse button to find the file.

3.  When the source is correct, click Read.
A success message appears when the data has been read. Click OK.
4. For the destination, choose one of the following:

Send Image To I/0 Unit Flash Memory. Choose an existing /0O unit. If you want to add or modify an I/0 unit,
click Options. For help, see “Add/Modify New Device” on page 243.

Make sure you have entered the correct IP address. The configuration will overwrite anything currently in the I/0O
unit's flash memory.

Save To I/0 Unit Image File. Enter the name of the I/0 image file you want to write to, or click the browse
button to find the file.

Create New /0 Unit: Select this option to copy all the point information from a brain to create a new I/O
unit in PAC Manager. You will be prompted to enter an I/O unit name. For more information, see
“Creating a New 1/0 Unit from an Existing One”on page 28.

5. When the destination is correct, click Send, Save, or Create depending on the destination type.
A success message appears when the operation has completed.

Creating a New 1/0 Unit from an Existing One

The Create New I/0 Unit option on the I/0 Unit Import/Copy dialog box allows you to create a new 1/0 unit by
importing point information from the flash memory of an existing /0 unit directly into the tree structure of a
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configuration file (also known as a tag database). You can then configure, add, or delete points in the new 1/0
unit just as you would with an 1/0 unit created from scratch.

1. Make sure to save the existing 1/0 unit's configuration information to flash memory. See “Saving
Configuration to a Device's Flash Memory”on page 190.

2. Open an existing configuration file on the File menu, or create a new one. For information, see “Creating
a New Configuration File” on page 27.

3. Inthe PAC Manager menu bar, click Tools > Import/Copy I/O Unit.
. Forthe Image Source, choose Existing I/0 Unit Flash Memory.
5. Enter the IP address of the existing I/0 unit, and click Read.
A success message appears when the data has been read. Click OK.
6. Forthe destination, choose Create New I/0 Unit, and click Create.

Image Destination

" send Image To IO Unit Flash Memory M Click Create

0.0 .0.0 Port: | 2001 Timeout: | 10000

" save To IO Unit Image File

| L

7. Inthe Add I/0 Unit dialog box that appears, enter a name for the new /0 unit, and click OK.
The new I/0 unit is added to the open tag database and a success message appears. Click OK.

8. C(lose the I/0 Unit Import/Copy dialog box.

9. Expand the new I/O unit to see the imported points.

Main_Process*® EI@
B[ Main_Process Tag database (configuration file)
£ Cookies New 1/0 unit
-3 Points Imported points

----- OM_, aoOvenTemperatureControl
----- D% aolConveyorspeedControl
----- I% ailvenTemperature

..... A

----- I% ailloughVesselPressure

..... L4 diChipLevelSwitch

----- I“'%“_' dilnspectionPassFailSwitch

..... HY diEStop

----- B"’—_“,' doDoughPressureControlValve
----- B"’—_“J doDoughDispenseValve

----- I doChipDispenseValve

----- 1 doRejectValve

10. Before you can save the new I/0 unit, the digital points must be assigned specific modules as follows:
a. Right-click a digital point and select Configure from the popup menu.
b. Double-click a generic digital module.
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Generic digital
module
C.
d.
e.

[05] Not Used

< |
Close I Help |

| Configure /O Points EI
IO Unit: ICookies Type: |SMAP-PACR1 (analog/digital)
Modules and Points Type Features / Subty... « Add... |
= ﬂ [00] Generic Digital Input Madify... |
LU 0 diDoughLevelSwitch None
L 1§ diChipLevelSwitch None Delete |
LU 2 dilnspectionPassFailSwitch None
L 3 diEStop None Mave Ta... |
Bl [01] Generic Digital Output Digital Output
ﬁ [02] SNAP-ACV-27 Analog Qutput Expand Al |
- [03] SNAP-AICTD Analog Input
- [04] SNAP-AIV Analog Input Collapse All |

o

Calibrate. ..

In the Edit Module dialog box, select a digital module to match the existing 1/0 unit, and then click

OK.

3| Edit Module

Type:

Digital Output
Analog Input
Analog Output

Module:

SMAP-IDCS: 10 - 32 VDC/VAC
SMAP-IDCSFAST: 2.5 - 16 VDC
SMAP-IDCS-FAST-A: 18 - 32VDC
SMAP-IDCSD: 2.5 - 28 VDC

SNAP-IDCSMA: 10 - 32 VDC/VAC Man/auto Switch
SMAP-IDC5-5W: Dry Contact Switch
SMAP-IDCSQ): 4 - 24VDC

SNAP-IDCSG: 35 - 75 VAC/VDC

SMAP-IDC5HT: 15-32VDC

SNAP-IDC5-5W-NC: Dry Contact Switch
SMAP-IDCSFM: 10 - 32VDC

SMAP-IDCSDFM: 2.5 - 28 VDC

SMAP-IDC-32: 10 - 32VDC

SMAP-IDC-32M: -10 - 32VDC

SMAP-IDC-32D: 2.5 - 12VDC

SMAP-IDC-32DM: -2.5 - -12VDC

SMAP-IDC-16: 10 - 32VDC

SNAP-IDC-HT-16: 15 - 28 VDC/VAC

Generic Digital Input

SNAP-TACS: 90 - 140 VDC/VAC

SNAP-TACSA: 180 - 230 VDC/VAC

SNAP-TACSMA: 90 - 140 VDC/VAC Man/auto Switch
SNAP-TACSFM: 90 - 140 VDC/VAC

oK I Cancel |

»

m

Select a digital module

Repeat steps b and ¢ for each generic module on the new /0 unit.

11. Save the new I/O unit.

Close the Configure I/0 Points dialog box.

Creating a Configuration File from Another Strategy

If you use PAC Control and have a strategy with SNAP PAC 1/0 units already configured, you may want to
export that file and use it as a starting point, rather than creating a configuration file from scratch. The
exported file will contain all the I/O units in the strategy. However, note the following:

« 1/Ounit and point data is transferred; optional functions such as event messages are not.

«  Four-channel digital modules and points do not retain specific configurations but revert to generic ones.
Specific data will have to be reentered.
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You cannot save changes you make in PAC Manager back to the strategy file. Instead, you save them to a
configuration file, which can then be imported into PAC Control.

Follow these steps to create a configuration file from an existing strategy:

1.
2.
3.

Configuration tree

In PAC Control, open the strategy that contains the I/O units whose configurations you want to export.
In the configuration tree, right-click the I/O Units folder and choose Export from the pop-up menu.

In the Export I/O Units to an Opto Tag Database dialog box, navigate to the location where you want to
save the configuration file. Enter a name for the file, and click Save.

If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.
In the PAC Manager main window, click the Open button El or click File > Open.
In the Open Tag Database dialog box, locate the file you just saved and open it.

=5 PAC gel _Process
File Edit Tools View Help

EEEEEO)
O

7.

8.

C:\Program Files (x86)\Opto22\PAC Project 9.0\SNAP PAC Learning Center\Mair MNUM v

Expand the I/0 Units folder in the configuration tree to see the units and points that are already
configured.

Continue with the next section to add or change I/0 units.

ADDING AN I/O UNIT

About ETand E2 brain boards: You can configure E1s and E2s like any other /O unitif you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E2s),
see /0 Configuration for E1 and E2 Brain Boards (form 1576).

An 1/0 unit consists of a SNAP 1/0 mounting rack, plus the /0 processor (brain or on-the-rack controller) and
I/0 modules mounted on it. Racks used with SNAP PAC I/O units can hold up to 16 modules.

You must add an I/0 unit before you can configure its modules and points.

1.

Make sure the configuration file is open. On the configuration tree, double-click the I/O Units folder to
open the Configure I/0 Units dialog box:
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2,

| Configure I/Q Units

Add...

Faodify... |
Delete |

Import/Copy... |

1/0 Paints.. |
PBID Loops... |
fodules 3 |
Ewvents 2 |
Scratch Pad  » |
Commurications ¥ |
Others 2 |

Mame | Tupe | Port | Addressz | Wwiatchdog | Degcription |

Cloze I

Help |

To configure a new I/0 unit, click Add or double-click anywhere in the box below any listed units.
The Add I/0 Unit dialog box appears.

Add I/O Unit

Mame: ||

w >

Dezcription: I

Type: ISNAP—PAC—RZL

Temp:

f+ Fahrenheit

€ Celziug

Part:

Address:

|2DD'I

joooo

Address List area

@ mm OO

Secondary: I

Address List

Add...

Modify...

it

Delete

‘Watchdog: & Mo  Yes

3.

Help

o]

Cahicel |

For a SNAP PAC SB brain, skip to step 5. For an Ethernet-based unit, complete the fields as follows:
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A—Name. Enter a name for the I/0 unit. The name must start with a letter and may contain letters,
numbers, and underscores. Spaces are converted to underscores.

B—Description. (Optional) Enter a description of the unit.
C—Type. Select the type of 1/0 unit from the drop-down list.
D—Temp. Choose whether temperatures will be handled in Fahrenheit or Celsius.

E—Port. Specify the communication port to use (2001, unless you have changed it for security
purposes according to instructions starting on page 78).

F—Address. Enter the IP address for the I/0 unit.

G—Secondary. Ifit's a SNAP PAC R-series /O unit with a secondary IP address, enter the secondary IP
address.

H—Watchdog. Select whether you want a Watchdog on the unit. The default is No (disabled). If you
select Yes, a new field appears; enter the Watchdog timeout value in seconds. The default timeout is 0.5
seconds. For information on watchdogs, see page 73.

The Address List area shows IP addresses of the I/0 units that should receive this configuration. If this is
the only I/0O unit to receive the configuration, don't add any addresses here. However, if you have 1/0
units that are exactly alike, list all of them here. That way you can download the configuration file to all
the 1/0 units at once.

a. Toaddan P address, click Add.

In the dialog box, you can add a single IP address or a range of addresses.

| Add IP Address =]

* Add one IP Address / Host Mame

* |Paddess: | I . 0 . 0.0

r [
" 4dd arange of IP 4ddresses

ok | Cancel | Help

b. Enterthe IP address(es) and click OK.
The addresses appear in the Address List area.
c. Skiptostep 6.
For a SNAP PAC SB brain, complete the dialog box as follows:

PAC Manager User's Guide 33



ADDING AN I/0 UNIT

Add 1/0 Unit =]
A —— Hame: || J_
B——— Description: |
C— In= |SHAP-PAC-SB1 -
F
D—— Temm f* Fahlrenheit " Celzius G
E ——— Conrection: " Seral Direct ' Ethemet Passthrough . L
Connectior: & Serial Diregy” £ Ethemet Passthrough
Controller
Computer
Address: |0.0.0.0 Port: |2001

Serial Port: -
Serial Port: | Serial 2 -

Baud Rate: |115200 -
Baud Rate: | 230400 -

Device .
Device

Senal Address: |0 ¥ 24%fine Serial Addrmse: ,07

H——— atchdog: & Mo (7 Yes

QK. | Cancel Help

A—Name. Enter a name for the I/0 unit. The name must start with a letter and may contain letters,
numbers, and underscores. Spaces are converted to underscores.

B—Description. (Optional) Enter a description of the unit.
C—Type. Select the type of 1/0 unit from the drop-down list.
D—Temp. Choose whether temperatures will be handled in Fahrenheit or Celsius.

E—Connection. Choose whether you are connecting to the SB brain through a SNAP PAC controller or
directly from the computer (for more information, see “Connecting with a SNAP PAC SB Brain”on
page 26).

F—Ethernet Passthrough.
—  Enter the controller's IP address. Leave the port at 2001 unless you have changed it.

—  Enter the controller’s serial port where the brain is connected. On a SNAP-PAC-S1, it's Serial 2.
On a SNAP-PAC-S2, it could be any port.

—  The baud rate on the controller must match the rate set on the brain.
—  Enter the serial address of the brain.

G—Serial Direct.

—  Enter the serial port on the computer where the brain is connected. The baud rate on the
controller must match the rate set on the brain.

—  Enter the serial address of the brain.

H—Watchdog. Select whether you want a Watchdog on the unit. The default is No (disabled). If you
select Yes, a new field appears; enter the Watchdog timeout value in seconds. The default timeout is 0.5
seconds. For information on watchdogs, see page 73.
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6. When information in the Add I/0 Unit dialog box is complete, click OK.
The new I/0 unit appears in the Configure I/0 Units dialog box.

| Configure I/Q Units @

| Add...

Maodify... |
Delete |

Import/Copy... |

1/0 Paints. . |

PID Loops... |

Modules 3 |

Ewvents » |

Scratch Pad  » |

Communicatians # |

Cloze | Help | Others 3 |

| Tupe | Port | Addressz | Wwiatchdog | Degcription

SHAPPAC...  Ethemnet 1015254, Enabled

7. Continue with the next section, “Configuring I/O Modules and Points.”

CONFIGURING I/0 MODULES AND POINTS

About ETand E2 brain boards: You can configure E1s and E2s like any other I/O unitifyou have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or £25),
see 1/0 Configuration for E1 and E2 Brain Boards (form 1576).

Once you have added an I/0 unit, you can configure its modules and points. See the following pages for
configuration steps. For motion control modules (such as SNAP-SCM-MCH16), see the SNAP PAC Motion
Control User's Guide (form 1673).

Configuring SNAP Digital Points

About E1and E2 brain boards: You can configure E1s and E2s like any other I/O unitifyou have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E2s),
see 1/O Configuration for E1 and E2 Brain Boards (form 1576).

Use the following steps to configure digital points on all digital modules supported by the brain or
on-the-rack controller.

1. In the Configure I/0 Units dialog box, make sure the I/O unit for the point you are adding is highlighted.
Click the 1/0 Points button.

The Configure I/0 Points dialog box appears. The dialog box shown here is for a SNAP 1/0 unit.
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CONFIGURING 1/0 MODULES AND POINTS

| Configure /O Points EI-
140 Unit: Type: ISN.&F‘-F’.&C-H'I [analog/digital]
Modules and Points Type | Features / Subty. .. « Add... |
D0] Not Used Modify
01] Net Used
[02] Mot Used Delete
[03] Mot Used
4] Not Used Mawe To...

05] Not Used IS
[06] Mot Used
[07] Mot Used
[08] Mot Used Collapse &l

09] Not Used -
| | »

Close I Help | Calibrate. ..

Expand All

| ORRELE

2. Double-click the number that represents the digital module’s position on the rack. (For help, see the
diagrams starting on page 155.)

3. Fora SNAP I/O unit, choose the module type and then the exact module part number from the list.

= Add Module

Type:

Digital Input
Drigital Dutput
Analog Ihput
Analog Dutput

rdodule:

SHAP-IDCE: 10 - C
SNAP-IDCEFAST: 25-16VDC i
SMAP-IDCEFAST-A: 18 - 32VDC

SMNAP-IDCED: 25- 28VDC

SMAP-IDCEMA: 10 - 32 WDEAAL Mandbuto Switch
SHAP-IDCE-5W Dy Contact Switch

SHAP-IDCEQ: 4 - 24DC

SMAP-IDCEG: 35 - 7RVACADC

SMAP-IDCEHT: 15 - 32WDC

SHAP-IDCE-SW-MC: Dy Contact Switch
SMAP-IDCEFM: 10 - 32VDC

SMNAP-IDCEDFM: 25 - 28WDC

SMAP-IDC-32: 10 - 32vDC

SMAP-IDC-32M: -10 - 32VDC

SMAP-IDC-32D: 25-12%DC

SMAP-IDC-32DN: -25-12VDC

SMAP-IDC-16: 10 - 32vDC

SMAP-IDC-HT-16: 15 - 28 WDCAMAC —
EMU-ID-8: Input

EMU-D-4: Input

Generic Digital Input

SHAP-IACE: 90 - 140 VDCAAL

SMAP-IACRA: 180 - 280 WDLCAALC -

ak. I Cahicel

m

4. C(lickOK.
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5. Backin the Configure I/0 Points dialog box, click the plus sign next to the new module to expand it.
Notice that the module icon is color-coded to reflect the type of module being configured: white for
digital DC input, red for digital DC output, yellow for digital AC input, and black for digital AC output.

-'-_';] Configure /0 Points EI
140 Unit: IF'leprncess Tupe: |SMAP-PAC-R1 [analog/digital]
Module icon ~

™ Modules and Points Type Features / Subty... = dd
Expand or collapse points on [Elw] (001 SHAP-IDCS: 10 - 32 VDC/VAC Digital Input Madify
the module by clicking the + L Not Used —
or - sign in the box. L 1 Not Used Delete

L T 2 Not Used

Points — | L 3 Not Used Move Ta...

01] Mot Used
[02] Not Used
[03] Not Used
04] Mot Used Collapze Al

05] Mot Used -
1| | »

Cloze I Help | LCalibrate. ..

Expand Al

| R

6. Double-click the point you want to configure.

Add Digital Point
Mame: I A
Deszcription: I B
Tope: It = ] C
Module:  |SNAPIDCS: 10- 32 VDCAME ~|
Features: I Hone ;i D
Watchdog: & Mo 7 Ves E

ok I Cancel Help

7. Complete the fields as follows:

A—Name. Enter a name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. Spaces are converted to underscores.

B—Description. (Optional) Enter a description of the point.
C—Type, Module. For a SNAP I/0 unit, the type and module are already filled in for you.

D—Features. To use a feature of the module, choose it from the drop-down list. (See “Using /0O Point
Features”on page 70 for explanations of point features. Note that some features, such as pulsing and
totalizing, can be configured in PAC Manager but require PAC Control to use them.)
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E—Watchdog. (Output modules only) To configure a status the point should be set to if the
Watchdog timer on this I/0 unit expires, click Yes and choose On or Off from the drop-down list.

8. When you have completed the fields, click OK.

The new point appears in the list.

01] Not Used
[02] Not Used
[03] Not Used
04] Not Used
05] Not Used

Cloze |

Help

| Configure /O Points EI
140 Unit; |Freprocess Type: |SNAP-PAC-RT [analog/digital]

Modules and Points | Type | Features / Subty... « fdd.. |
=[] [00] SNAP-IDC5: 10 - 32 VDC/VAC Digital Input Modiy

a1 0 Pump_i_Status ___ [Couter —

L1 1 Not Used Delete

L1 2 Not Used

1M 3 Not Used Move To..

Expand Al

Collapze All
ﬂJ

LCalibrate. ..

b

9. To configure more digital points, repeat the steps. To configure analog points, see page 40.

Configuring Digital Points for a G4EB2

Use the following steps to configure digital points on all G4 or Quad Pak digital modules supported by the
GAEB2 brain. The G4EB2 replaces a 32-channel brain in a mistic or Pamux system with an

Ethernet-based 32-channel digital brain that uses OptoMMP protocol. The G4EB2 brain is functionally similar
to a SNAP-PAC-EB2 brain without analog 1/0 functionality. Input and output modules can be placed in any

order.

1. Inthe Configure I/0 Units dialog box, highlight the digital /0 unit the points are on, and click I/0 Points.
The Configure I/0 Points dialog box appears.

E=N ECR =5

(G4 zimple digil

| Cenfigure /0 Paints
(NG 4 Digital Urit Type: |G4EB2
Channel | Mame | Type | Features | Enable | Ref Co... | Descrip... |
oo Mot Uszed
o Mot Uzed
0z Mot Used
03 Mot Uzed
04 Mot Uged
05 Mot Uged
0g Mot Used
o7 Mot Uged
0z Mot Uzed
03 Mot Used
Cloge I Help |

m

Points that have not been configured yet show as Not Used.
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For G4 modules, there is one channel per module.
For Quad Pak modules, there are four channels

He 3

per module which must be grouped together as % g5 ¥ FEREETE VAR
shown. L FECEFRIRAVERD BRI BRRDENND
i ' i.d
Module Position Channels Used g T %
First 0-3 3 3
R
Second 4-7 b
Third 8-11
Fourth 12-15
First module (channels 0-3)
Fifth 16-19
Sixth 20-23
Seventh 24-27
Eighth 28-31

Double-click the channel number for the point you want to add.
The Add Digital Point dialog box appears.

Add Digital Point (2]
Mame: | — A
Description; | — B
Tvpe: Input il | C
Modue:  |G4IDCR 10-32vDCA232WAD —=l 1 1 D
Eeatures: |None —:l—— E
Watchdog, & Mo F
Ok | Cancel | Help
|

Complete the fields as follows:

A—Name. Enter a name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. Spaces are converted to underscores.

B—Description. (Optional) Enter a description of the point.
C—Type. Select the type, either Input or Output.
D—Module. Select a module from the drop-down list.

E—Features. To use a feature of the module, choose it from the drop-down list. (See “Using I/0 Point
Features”on page 70 for explanations of point features. Note that some features, such as pulsing and
totalizing, can be configured in PAC Manager but require PAC Control to use them.)

F—Watchdog. (Output modules only) To configure a status the point should be set to if the Watchdog
timer on this I/0 unit expires, click Yes and choose On or Off from the drop-down list.

When you have completed the fields, click OK.
The new point is added.
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5. To configure more digital points, repeat the steps.

Configuring Analog Points

About E1and E2 brain boards: You can configure E1s and E2s like any other I/0 unitif you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing E1s or E25),
see /0 Configuration for ET and E2 Brain Boards (form 1576).

To configure points on analog modules supported by the brain or on-the-rack controller:

1. Inthe Configure I/0 Points dialog box, double-click the number that represents the analog module’s
position on the rack. (For help, see the diagrams starting on page 155)

2. Fora SNAP I/O unit, choose the module type and then the exact module part number from the list.

= Add Module =]

Tupe:

Drigital [nput
Digital Output

Analog Output

TModule:

SHAP-AIARMS: 0-104 AC/DC

SMAP-AIARMS-i 0- 104 AC/DC v
SMAP-AICTD: ICTD Temp. Probe
SMAP-AICTD-4: ICTD Temp. Probe
SMAP-AICTD-E ICTD Temp. Probe
SMAP-AILE: -2 - +2 i A Fast
SHNAP-AILC-Z: -4 - +4 mv M Fast
SHAP-AIMA: -20 - +20 md,
SHAP-AIMA-: -20 - +20 ma
SHAP-AIMAGSHC: -20 - +20 ma
SHNAP-AIMA-4: -20 - +20 ma,
SHAP-AIMA-S: -20 - +20 ma, | 4
SHAP-AIMA-32 -20 - +20 ma,

SHAP-AIMAZE -1 - +1 ma,

SHAP-aIMY-4: 150 - +150 m\

SHAP-AIMYZ-4: -B0 - +50 ml'

SHAP-aIPM: O - 250WACADC

SMAP-AIPM-3: 0 - 300 VACADC

SHAP-AIPM-3 [ONd]: 0 - 260VACADC

SHAP-AIPM-3v: 0 - 300 WACADC

SHAP-AIPM-3 [O1d]: 0- 250 VaCADC

EMU-AIPM-3; 0 - 400 WACADC

SHAP-AIRATE: Rate [Frequency] -

ak. | Cahicel

m

3. (lick OK.

4. Inthe Configure I/0 Points dialog box, click the plus sign next to the new module to expand it. Notice
that the module icon is color-coded to reflect the type of module being configured: blue for analog
input, green for analog output.
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| Configure /O Points EI
140 Urit: |Preprocess Type: |SMAP-PACFRI [analog/digitsi)
Madules and Points Type | Features / Subty. .. « fdd... |
= |j [DO] SMAP-IDCS: 10 - 32 VDC/AVAC Digital Input Madiy... |
IL,E' 0 Pump_1_5Status Courter
‘ =1 1 Not Used Delete |
Module icon 8 2 Not Used
Iﬂd— 3 Mot Used Move To... |
Expand or collapse points on SN J [01] SHAP-AIVA |Angloginput | ]
h =
the modgle by clicking the + =4 0 Mot Used Expand Al |
or - sign in the box. / 24 1 Not Used
) // 2] Not Used Collapse &l |
Points [03] Nt Used -
1| | 3
Close I Help | Lalibrate. .. |

5. Double-click the point you want to configure.

Add Analeg Point
Mame: I A
Diescriptian: I B
Tupe: Input =] - C
Module:  [SNAP-AIVE -10- +10VDC =l
| writs: VT sesng

|
Default ] E
D Zero Scale; |-1D

|
Custom. .. | F
|| EullScale: I'ID -

Watchdog: & No 7 Yes G

QK I Cancel | Help

6. Complete the fields as follows:

A—Name. Enter a name for the point. The name must start with a letter and may contain letters,
numbers, and underscores. (Spaces are converted to underscores.)

B—Description. (Optional) Enter a description of the point.

C—Type, Module. For a SNAP 1/0 unit, the type and module are inserted for you, but you may be able
to choose a different range or module from the drop-down list.

D—Units, Scale. Units and scaling for this module. See “Using Custom Scaling” on page 42.
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E—Scaling Default. To return the units, zero-scale value, and full-scale value to the defaults for the

module, click Default.

F—Scaling Custom. To assign custom units and values to the module, click Custom. For example, you
could scale the voltage range of a-10 to +10 VDC module to be interpreted as engineering units of liters
per second instead of volts. See “Using Custom Scaling” on page 42.

G—Watchdog. (Outputs only.) To configure a value this point should be set to if the Watchdog timer
on this I/0 unit expires, click Yes and enter the value.

7.  When you have completed the fields, click OK.

The new point is added. This image shows a SNAP I/0 unit.
| Configure I/O Points EI@
140 Unit; |Freprocess Type: |SNAP-PAC-RT [analog/digital]
Modules and Points | Type | Features / Subty... « fdd.. |
B [3 [00] SNAP-DCS: 10 - 32 VDCAVAC Digital Input '
Maodify...
IL,E' 0 Pump_1_5Status Counter —l
1 Mot Used Delete |
2 Mot Used
3 Mot Used Maove To... |
B ‘ [01] SMNAP-AIVS Analog Input
et 0 Fowmeter A | ]| 10--10v0C
I+~ = Expand Al
1 Mot Used —l
[02] Mot Used Collapze Al |
[03] Not Used -
| | 3

Cloze I

Help |

LCalibrate. ..

Point types and features are shown in the Features/Subtype column.

8. Toadd more analog points, repeat the steps. To add digital points, see page 35.

Using Custom Scaling

Analog modules can be set to show something other than the actual inputs or outputs. For example, you
could scale the readings of a -10 to +10 VDC input point to measure its input as zero liters per second when
the real-world reading is zero VDC, and 1000 liters per second when the real-world reading is five VDC.

Thermocouple values are not linear and cannot be scaled.

NOTE: Custom scaling has no effect on the resolution or accuracy of the module.

1. Inthe Add Analog Point dialog box, click the Custom button in the Scaling area to open the Scale Analog

Readings dialog box.

42 PAC Manager User’s Guide



CHAPTER 2: CONFIGURING DEVICES

: This example shows units scaled to liters per
Seale Analog Readings @ second. At an actual input of 0 VDC, the point
N will show 0 liters per second. At an actual input
A —— Scaled Units: [Lites per second of 5 VDG, the point will show 1000 liters per
Lower Yalue second.
B——— sctua [0 [voC
C—1— Secaled: |D |Liters PEr SECO
Upper Yalue
D—— #ctual |5 [vDC
E——— Scaled: |1 ujuli] |Liters pEr gEcn
QK | Cancel | Help |

Custom scaled values are floating point values:

- Foranalog input points with PAC firmware R8.0a and higher, you can use inverted scaling. Inverted
scaling means the lower value is greater than the upper value; inverted scaling can accommodate a
sensor, for example, that is wired to the SNAP module in a way that produces a negative current or
voltage.

- Foranalog output points you cannot use inverted scaling. The upper value must be greater than the
lower value.

Complete the fields as follows:
A—Scaled Units. Enter new engineering units for the module. The example uses liters per second.

B—Actual Lower Value. Enter the actual real-world lower value that the scaled lower value
corresponds to. Note that inputs typically have under-range capability, which means you can specify a
lower actual value that is less than the zero-scale value. Outputs do not have under-range capability.

C—Scaled Lower Value. Enter the new scaled lower value. This value can be any floating point value.

D—Actual Upper Value. Enter the actual real-world upper value that the scaled upper value
corresponds to. For inputs, you can specify an upper actual value greater than the full-scale value.

E—Scaled Upper Value. Enter the new scaled upper value. For outputs, this value can be any floating
point value greater than the scaled lower value. For inputs, it can be greater than or less than the scaled
lower value. This example uses 1000, which scales the output to 1000 liters per second when its actual
reading is 5 VDC.

Click OK.
The new custom-scaled units appear in the Add Analog Point dialog box.
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Notice the new units of liters per second and the
new minimum-scale (“Zero Scale”) and

Add Analog Point S| naximum-scale (“Full Scale”) values of -2000 and
+2000. The example connects a sensor with a
Name: FlowmeteA range of 0-1000 liters per second, but an output of
- - only 0-5 volts, to a SNAP-AIV module with an
Description: | output of-10to +10volts. The figures shown reflect
the total possible range of the module, not the
_ Sensor.
Tvpe: Input
Module:  |SNAP-AR-E 10 - +10WDC | Custom Module’s
scale scale
Urnits: Liters per second Sealing (Liters/sec) (VDQ)
Default .
Zera Scale: |-2000 Q Possible low
> value for -2000 -10
FullScale:  |2000 module
Watchdog: & Mo 1000 >
Upper & lower 0 = 0
values entered
oK Cancel Help in dialog box 1000 = 5
A Possible high
value for 2000 10
module

Calibrating Offset and Gain

This section describes how you can manually set offset and gain or have them automatically calculated and
set for you.

NOTE: You must use the manual method (page 46) if:

«  Youdon't have access to a calibrator, or

«  The point uses inverted scaling and your device has PAC firmware R9.5b or lower. (In inverted scaling, the
lower scaled value is greater than the upper scaled value.)

Starting with the introduction of SNAP-B3000-ENET, all SNAP PAC brains (including SBs), SNAP Ethernet I/O units,
and E2 brain boards can automatically calculate offset and gain for analog input points. If a -50 mV to +50 mV
input receives signals that are slightly off (for example, not exactly -50 mV at the lowest point), the offset and gain
can be calculated so that values appear accurately when read.

Offset and gain values affect engineering units (EU). For a temperature input, engineering units are in degrees
Cor F, depending on how the I/0 unit is configured.

IMPORTANT: To calibrate the point, the I/O unit must be turned on and attached to the network, and you must
have access to the I/O unitin order to use the calibrator. For points on a SNAP PAC SB-series brain, connect directly via
serial or through the controller via Ethernet. (See page 26 for details.)

Save the configuration to flash so that it is not lost when power is turned off. Since each calibration is for a specific
point on a specific I/0O unit, the result cannot be saved to the configuration file and cannot be sent to any other I/0
unit.

First, calculate offset, and then calculate gain. The offset must be calculated at the signal corresponding to
zero engineering units (EU), and the gain must be calculated at the signal corresponding to the point’s
maximum input range value (or, for inverted scaling, the point's minimum input range value—in inverted
scaling, the lower scaled value is greater than the upper scaled value).

1. Inthe Configure I/0 Points dialog box, highlight the analog input point you want to calibrate.

PAC Manager User’s Guide



2.

CHAPTER 2: CONFIGURING DEVICES

| Configure I/O Points

[o]l e ]

10 Urit: |F'reprocess

Type: [SNAP-PAC-RI

[analog/digital]

1 Mot Used
[02] Not Used
[03] Not Used
[04] Mot Used
[05] Not Used
[06] Mot Used
[07] Not Used
< |

Clase |

Help |

Madules and Points | Type | Features / Subty. .. « |

+ ﬂ [DO] SMAP-IDCE: 10 - 32 VDC/VAC Digital Input Modify

- gl (011 SNAP-AIVH Analog Input —
e 0 Fowmeter A | [10-+10VDC | Delete

Mowe To...

Expand All
Collapze Al

-

V[
LCalibrate. ..

Click the Calibrate button in the lower-right corner of the dialog box.

=] Calibrate Analog Input - Flowmeter_& (Modulel, Point0)  [223]
Automatically Calculate et Offsat
o 1 Use a calibrator to input the signal
corresponding to zero Engineering Units Cloze

" Gain - Use a calibrator ta input the signal
cormezponding to the paint's masimurm
nominal value

MOTE: Yiou must set the Offzet first. Mare >

I

To have the offset and gain calculated for you:

1.

On the analog input point, use a calibrator to input the signal that corresponds to zero Engineering Units

(EV).

Example 1:SNAP-AIV (-10 to +10VDC) configured with default scaling

zero EU =0VDC

Example 2: SNAP-AIV (-10 to +10 VDC) configured with custom scaling

Actual Scaled

Units VDC PSI
Lower -10 0*
Upper +10 100

*Zero EU is 0 PSI, which corresponds to a -10 VDC field signal

Click Offset, and then click the Set Offset button.

Use the calibrator to input the signal corresponding to the maximum input range value—or for inverted
scaling, to the minimum input range value—for the configured point type.
(In inverted scaling, the lower scaled value is greater than the upper scaled value.)

For the exact values, refer to the configured Point Type or see the module's data sheet.

Example:SNAP-AIV module; Point Type of -10 to +10 VCD:
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Maximum Input Range Value = +10 VDC
For inverted scaling, Minimum Input Range Value =-10 VDC

4. (lick Gain, and then click the Set Gain button.

To manually set offset and gain:
a. (lick the More button.

=] Calibrate Analog Input - Flowmeter_& (Modulel, Point0)  [223]

Set Offzet

o
Cloze
~
MOTE: Yiou must set the Offzet first. <4 Less
Manually Set

Offzet. |0 Gain: |0

b. Enter the Offset value. Click the Set Offset button.
c. Enterthe Gain value. Click the Set Gain button.

When you have finished calibrating the point, close the dialog box to return to configuring 1/0 points.

NOTE: To store offset and gain values permanently, you must save the change to flash when you send the
configuration data to the I/O unit (see page 68).

Configuring RS-232 and RS-485/422 Serial Communication Modules

NOTE: For information on connecting a Windows serial application to a remote serial device through a SNAP
Ethernet-based system, see the SNAP Serial Communication Module User's Guide (form 1191).

(Not applicable to SBbrains) RS-232 and RS-485/422 serial communication modules do not require
configuration unless you need to change communication parameters such as port numbers or baud rates.
Because these serial modules require no configuration, they do not appear in the Configure I/0 Points dialog
box in PAC Manager; you have to remember which positions on the I/0 unit are filled with serial modules. For
more information on these modules, see the SNAP Serial Communication Module User's Guide (form 1191).

Default port numbers are shown on page 156. Default communication parameters are:
« 1 start bit (not configurable)

« 9600 baud
»  Noparity
»  8databits
« 1stopbit

»  No handshaking

«  Send a test message when the module is turned on.
«  SNAP-SCM-232: No flow control

o SNAP-SCM-485-422: 2-wire mode
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Port numbers and all parameters except the last two (flow control and 2- or 4-wire mode) can be changed in
the I/0 unit's configuration file using the following steps. For flow control and 2- or 4-wire mode, see the steps

on page 48.
1. With the configuration file op
pop-up menu, choose Config

en, right-click the name of the 1/0 unit the serial module is on. From the
ure.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

==l

. Ethermet

Address ‘Wwatchdog De Add...

10.192.54.110 Enabled
Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules j—— Modules
I button
Scratch Pad  »

<

Cloze | Help |

1 ¢
Communications »
Others 3

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Serial Modules from

the pop-up menu.

X5

FPort | Baud Rate | Party [1ata Bits | Stop Bitz | EQM Chars Test Message |A

| Ceonfigure Serial Modules
Status | Module | Part | IF
Dizabled O A
Dizabled 0 B
Dizabled 1 A
Dizabled 1 B
Dizabled 2 )
Dizabled 2 B
Dizabled 3 )
Dizabled 3 B
Dizabled 4 &
Dizabled 4 B
Dizabled & A
Dizabled L} B
Dizabled B A
Dizabled B B
Dizabled 7 )
Dizabled 7 B
aK | Cancel

m

Help

3. Clickthe status cell for the module number and port number whose parameters you want to change.
From the pop-up menu, choose Enabled.

The Status changes to Enabled.

4. Tochange a communication
Choose from the drop-down

parameter, click the cell you want to change within the highlighted line.
list, if there is one, or type the new value in the cell.

NOTE: The start bit is not configurable. To set flow control and 2- or 4-wire mode, see the steps on page 48.
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NOTE: EOM (end-of-message) characters apply only when using the serial module port with serial events (see
page 139). The device can check any one of up to four characters as the EOM indicator, and you enter them in
the field in hex. Example: 0xODOA000O looks for a 13 (hex 0D) or 10 (hex 0A).

5.  When you have finished changing parameters for serial modules, click OK to close the dialog box and
return to configuring I/0 units.

IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the I/0 unit
when you send the configuration data to the I/0 unit (see page 68).

Configuring Flow Control and 2- or 4-Wire Mode

IMPORTANT: You can configure flow control on a SNAP-SCM-232 and 2- or 4-wire mode on a SNAP-SCM-485-422
using PAC Manager. However, these configurations cannot be saved to the configuration file. The I/O unit that

contains the serial module must be on the same network as your computer, and the configuration is sent directly to
the l/O unit.

1. Inthe PAC Manager main window, click the Inspect button @
The Inspect window opens. o
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If you haven't used the Inspect window before, the window will not show any data.

¥ Inspect Opto 22 Device - X

| _options ¢

Device Name: I =\ W Error reading area: Timeout

[~ Status Read
Status Read I

Status Write |
Wireless LAN ¥

Point Config |
Digital Bank |
Digital Point |
Analog Bank |
Analog Point |
High Density |
System b |
SeratchPad |

Datalog

PID »

Events > |
Communications ¥ |
Other 3 |

- |

I Auto Refresh |1snnn msec

If you have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.

= Inspect Opto 22 Device - *
Device Name: I 10,192,50.21 LI Options # | Status: | Status Read area last read at 07/05/16 12:03:48
~Status Read
Status Read |
Status Write k&DDRESS DESCRIFTION VALUE ~ Refresh I
= 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
e | OxFFFF F030 0008 Buay Flag 0
Paint Config | 0xFFFF F030 0018 Loader Version Ré.la
Diital Bank 0xFFFF FO30 0000 Memory Map Version 1
gita! Ban | 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Point | 0xFFFF F030 001C Firmware Version R9.5a
0xFFFF FO30 00R0 Firmware Version Date 07/05/2016
Analog Bank | 0xFFFF F030 00BO Firmware Version Time 07:58:52
Analog Point | 0xFFFF FO30 0020 Unit Type 0x0000007C
High Density | 0xFFFF FO30 0080 Unit Description SNAP-FAC-51
g 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 11
5 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 22
HEEn | 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2005
Scratch Pad ,l 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3 |
ETHERENET 1 Interface
PID L 0xFFFF FO30 002E MAC Address 00-A0-3D-00-D3-08
Events N 0xFFFF FO30 0034 IF Address 10.192.50.21
ven | 0xFFFF F030 0038 Subnet Mask 255.255.192.0
Communications ,l OxFFFF FO30 003C Gateway 10.192.51.50
0xFFFF FO30 0040 DNS 10.192.60.91
Other >| ETHEENET 2 Interface v
Close I Help | [ Auto Refresh |1sooo msec

If you have configured other devices, they are listed in alphabetical order in the drop-down list.

If you have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

| Inspect Opto 22 Device

Device Name

Cookie Controller

Cookie Controller

1_ [EngineRm

Status R4 ol partable 4

0

Status Wiits R
A b erup Clea

ireless i

—— I Chamber 1 v Flag 1
. Chamber 2 J
Point Config g partable der Versid
o Cookie Controller ory Map Vi
ngltal B EngineRm mware Verd
Digital Point S2fPAC mware Ver,

g
] 0xFFFF F030 00BO Firmware Verg
e o -

In the Device Name field, type the name of the I/0 unit (any unique name, usually the name configured
in PAC Control) or choose it from the drop-down list. (You can also enter the IP address.) Then click
Refresh.

If the I/0 unit has not been defined in PAC Manager, the Add New Device dialog box appears. Choose
Direct Connection to Ethernet Device and enter the IP address of the device. Leave the Ethernet port at
2007 unless you have changed it on the device.

Click the Communications button and choose Serial Modules from the pop-up menui.
Information from the I/O unit is displayed in the window.

=] Inspect Opto 22 Device (=& =]

Device Name: |1D.192.54.11D j Options ¥ Status: |Senal Module area last read at 1712 1217:28

Status FRead

Statug write |

Serial Modules

Sernial Module Number: |0 w | Module 0is NOT a Senial Module

Cloze Help

5 Address | Diescription | Walue | Befresh |
ircles I MODULE INFORMATION
0FFFF FOCO 0000 Module Type Digfnone [0=00]
Puirt Config OxFFFF FO34 7FO0 Module Subtype a0
_ 0xFFFF FO34 7F02 Hardware Revision Date A
Digital Bank 0=FFFF FO34 7F0E Loader Wersion A
. R 0xFFFF FO34 7F0&  Fimware Yersion MAA
Digital Point PORT &
Analog Bank 0xFFFF FO34 8000 IP Port Mumber 22500
OxFFFF FO35 8004  Baud Rate 9600
. OxFFFF FO34 8008 Parity Mone
m OWFFFF FO34 8009 Data Bits 8
High Density O=FFFF FO34 8004 Stop Bits 1
OxFFFF FO34 800C Powerup Test Meszage? ‘fes
S 0xFFFF FO34 8200 EOM Character List O 00040000
bRED D FORT 8
0xFFFF FO34 8010 IP Port Mumber 2250
m OxFFFF FO34 8014 Baud Rate 9600
Datalog  » OxFFFF FO34 8018 Parity Mone
0xFFFF FO34 8019 DataBits ]
FID 3 OxFFFF FO34 8014 Stop Bits 1
OxFFFF FO34 801C Power-up Test Message? ‘fes
Events L4 0=FFFF FO34 8210 EOM Character List [ OD0A0000
Communications
Other 3

[T Auto Refresh [15000  msec

4. C(lick the Serial Module Number drop-down list and choose the module’s position number on the rack to
see the module’s communication parameters.

PAC Manager User’s Guide




5.

6.

CHAPTER 2: CONFIGURING DEVICES

To change a parameter, click its value in the Value column and choose from the drop-down list or enter a
new value.

NOTE: This is the only way to change hardware flow control for a SNAP-SCM-232 or 2- or 4-wire mode for a
SNAP-SCM-485-422. You can also change other parameters in this dialog box if necessary. However,
parameters changed in this dialog box are NOT saved to the configuration file.

This example shows how to change Hardware Flow Control on a SNAP-SCM-232:

] Inspect Opto 22 Device |i| = |£

Drevice Name: |1U.182.54.11D j Options Status: |Serial Module area last read at 01/17/121217:28

Serial Modules
Status Read

Serial Module Number: |0 | Module Diz NOT a Serial Module
Statuz \Write |

Address |Descnpliun Walue | Befresh |
Bzl O MODULE INFORMATION

0«FFFF FOCO 0300 tadule Tppe 0w FO
Foint Config 0«FFFF FO3& FF30 todule Subtype 1

0xFFFF FO34 7F32 Hardware Revision D ate 2003-06-06

Digital Bank. OxFFFF FO34 7F36  Loader Version R1.0e
. K 0:FFFF FO3& 7F34 Firrweare Version Fl1e
Digital Point PORT &

o B [4FFFF FOZ4 8060 IP Port Number 22508
m OxFFFFFO34 8064 Baud Rate 3600
O:FFFF FOIA 8068 Parity Mone
_ndogPont | || BT A g Dot e 8
M OsFFFF FO34 8064 Stop Bits 1
0:FFFF FO34 S06E Hardwsare Flow Control? |N0 ﬂ

st 5 0«FFFF FO34 S0EC Power-up Test Message?
gEn 0sFFFF FO34 5260 EOM Character List P
PORTE
SeratchPad ¥ | | | oFerrF0s88070 I Port Number 22507

M 0xFFFF FO3& 8074 Baud Rate 9600
O+FFFF FO34 8078 Pariy Mone

FID 3 O:FFFF FO32 8073 Data Bits g
0xFFFF FO34 8074  Stop Bits 1
Events } 0xFFFF FO34 B07E Hardware Flow Contral? Mo
. 0«FFFF FO3& 807C Power-up Test Message? res
Communications ¥ 0xFFFF FO34 8270 EOM Character List Ox 0D 040000

Other 3
Close Help [T AutoRefresh 15000 msec

When you have finished changing parameters for this module, click Apply.
The configuration changes are sent to the I/O unit.

Configuring Wiegand Modules

(Not applicable to SB brains) Wiegand modules are a type of serial module. Before configuring a Wiegand
module, see the (form 1191) for more information about these modules.

1.

With the configuration file open, right-click the name of the /0 unit the Wiegand module is on. From the
pop-up menu, choose Configure. The Configure I/0 Units dialog box opens.
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2,

3.

=»| Configure I/O Units

==l

4

Cloze | Help

Address

I

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules I,—
Events 3
Scratch Pad  »
: Communications »
Others 3

—— Modules
button

Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Wiegand Modules

from the pop-up menu.

| Configure Wiegand Modules @
WWiegand Maodule
Mumber: |0 | [ Used
Address | D escription | Walue
MODULE INFORMATION
O«FFFF FOCO 0000 Module Type Diig/more [0x00]
(«FFFF FOZA 23501 todule Subtype i]
0=FFFF FO3& 8502 Hardware Revision Date REC
0=FFFF FO3& 8506 Loader WVersion REC
0=FFFF FO3& 8504 Firrmwware Version REC
PORT &
0=FFFF FO3& 8600 IP Port Number 22500
0=FFFF FO3& 8604 Format ] |
0=<FFFF FO3& 8608 Data Length kr)
0=FFFF FO3& 8E0C Site Position g
0=FFFF FO3& 8610 Site Length g
(«FFFF FOZA 3614 Badge Pozition 13
0=<FFFF FO3& 8618 Badge Length 15
0=FFFF FO3& 8E1C Parity Check Mo
OxFFFF FOZA 3620 Ewen Parity Poszition i]
0=FFFF FO3& 8624 0dd Parity Pogition ]
PORT B
0=FFFF FO3& 8640 IP Port Number 22501
0=FFFF FO3& BE44 Format ] |
0=FFFF FO3& BE48 Data Length kr)
0=FFFF FO3& BE4C Site Position g
0=FFFF FO3& 8650 Site Length g
(«FFFF FOZA 3654 Badge Pozition 13
0=FFFF FO3& BE5E Badge Length 15
0=FFFF FO3& 8ERC Parity Check Mo
(«FFFF FOZA 3660 Ewen Parity Poszition i]
0=FFFF FO3& BEE4 0dd Parity Pogition ]
0K, | Cancel Help

In the Number field, choose the Wiegand module’s position from the drop-down list. Click to put a check

mark in the Used box.
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If you need to change port numbers, enter the new numbers for each port in the TCP port Number fields.

5. Clickthe Format/Value cell, and from the drop-down list, choose a standard data format (shown by its
total data length) or choose C for custom.

NOTE: O s the 37-bit Opto 22 format used in a sample PAC Control strategy available for use with Wiegand
modules. For details, see the SNAP Serial Communication Module User's Guide (form 1191).

6. Change the following fields if necessary to match your Wiegand hardware device:
Data Length—total length of data in the transmission
Site Position—first bit of the site code
Site Length—Ilength of the site code, in bits
Badge Position—first bit of the badge code (should be the next bit after the site code)
Badge Length—Ilength of the badge code, in bits
7. When data for both ports is correct, repeat from step 3 for additional Wiegand modules.

8. When all Wiegand modules are configured, click OK to close the dialog box and return to configuring I/0
units.

IMPORTANT: If you changed a TCP port number, you must save the change to flash and restart the I/O unit when you
send the configuration data to the /O unit (see page 68).

9. When you are ready to send all configuration data to the I/0 unit, see “Sending Configuration Data to the
I/O Unit"on page 68.

Configuring Profibus Modules

1. With the configuration file open, right-click the name of the I/O unit the Profibus module is on. From the
pop-up menu, choose Configure.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units @

Mame Type Port Address ‘Wwatchdog De Add...

SMAP-PAC...  Ethemet 10.192.54.110 Enabled
Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules :,—— Modules
Events 3 button
Scratch Pad  »
4 | 1 3
Communications »
Cloze | Help | Others 3

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Profibus Modules
from the pop-up menu.
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«=+| Configure Profibus Modules @

Prafibus odule
Mumber: |0 | [ Used

Address | Description | W alue
FMODULE INFORMATION
0«FFFF FOCO 0000 todule Type Digdnome [0=00]
0«FFFF FO3& 7FO0 todule Subtype 0
(«FFFF FO34 FFOZ2 Hardware Revizion D ate KB
(«FFFF FO3A 7RO Loader Wersion KB
(4FFFF FO3A FFO4, Firrare Verzion KB
PORT &
(=FFFF FO3& 8000 IP Part Mumber 22500
(=FFFF FO3& 8004 Baud Rate 15200 =1
0«FFFF FO3& 8008 Parity Even
(=FFFF FO3& 8009 Data Bits a8
(=FFFF FO3& 8004, Stop Bits 1
(«FFFF FO3A 2008 Hardware Flow Contral? &[]
0«FFFF FO3& 800C Power-up Test Meszage? Yes |
(=FFFF FO3& 8200 EOM Character List (0= 0D OA0000

Cancel Help

3. Inthe Number field, choose the Profibus module’s position from the drop-down list. Click to put a check
mark in the Used box.

If you need to change port numbers, enter the new numbers for each port in the TCP port Number field.

5. Change the Baud Rate and EOM Character List fields if necessary to match your Profibus devices. Choose
whether to have the module automatically send a Test Message when turned on (the default is Yes).

6. When data is correct, repeat from step 3 for additional Profibus modules.

7.  When all Profibus modules are configured, click OK to close the dialog box and return to configuring 1/0O
units.

IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the I/0 unit
when you send the configuration data to the I/0 unit (see “Sending Configuration Data to the /0 Unit” on page 68).

Configuring SSI (Serial Synchronous Interface) Modules

Serial synchronous interface (SSI) modules (part number SNAP-SCM-SSI) are a special type of serial module.
Unlike other serial modules, these can be used with SNAP PAC serial brains.

Before configuring an SSI module, see the SNAP SSI (Serial Synchronous Interface) Module User's Guide (form
1931) for information you will need to configure it.

1. With the configuration file open, right-click the name of the I/O unit the SSI module is on. From the
pop-up menu, choose Configure.

The Configure I/0 Units dialog box opens.
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=»| Configure I/O Units @

Port Address ‘Wwatchdog
Ethernet 10.192.54.110 Enabled

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules >_-,—— Modules
Events 3 button
Scratch Pad  »
: Communications »
Others 3

4 I

Cloze | Help |

2. Make sure the correct I/O unit is highlighted. Click the Modules button and choose SSI Modules from the
pop-up mendu.

| Configure 551 Modules @

551 Module

Mumber: |0 | [ Used

Address | D escription | Walue
PORT O
O«FFFF FOZA 1000 [1ata Frame Length i]
0xFFFF FO3& 1004 Clock Divider ]
(«FFFF FOZA 1003 Data Delay, Clock Cycles i]
(wFFFF FOZA 100C ozt Significant Diata Bit Offget i]
0=FFFF FO3& 1010 Data Bits in the Data Frame 0 »» 24 Max <<
0=FFFF FO3& 1074 Error Bit Qffzet in the Data Frame ]
O«FFFF FOZA 1013 Error Bit Lewel High EBit Indicates Eror = |
(wFFFF FOZA 1010 [1ata Encoding Binary =1
OxFFFF FOZA 1020 Enable Scanning Dizabled =1
PORT 1
OxFFFF FOZA 1040 [1ata Frame Length i]
0=FFFF FO3& 1044 Clock Divider ]
(«FFFF FOZA 1043 Data Delay, Clock Cycles i]
(wFFFF FOZA 1040 ozt Significant Diata Bit Offget i]
0=FFFF FO3& 1080 Data Bits in the Data Frame 0 »» 24 Max <<
0=FFFF FO3& 1054 Error Bit Qffzet in the Data Frame ]
(xFFFF FOZA 1053 Error Bit Lewel High EBit Indicates Eror = |
(wFFFF FOZA 1080 [1ata Encoding Binary =1
O«FFFF FOZA 1080 Enable Scanning Dizabled =1

Cancel

3. Inthe Number field, choose the SSI module’s position from the drop-down list. Click to put a check mark
in the Used box.
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4. Configure all parameters for each port used. See the SNAP SS/ (Serial Synchronous Interface) Module User's
Guide (form 1931) to obtain the data for these fields. For each port, choose Enabled in the Enable
Scanning field.

5. Repeat for additional SSI modules.
6. When all SSI modules are configured, click OK to close the dialog box and return to configuring I/0 units.

7. When you are ready to send all configuration data to the I/O unit, see “Sending Configuration Data to the
I/0 Unit"on page 68.

Configuring CAN Modules

The SNAP-SCM-CAN2B provides an interface to a Controller Area Network (CAN) that allows your SNAP PAC
system to receive data from CAN devices. Before configuring a CAN module, see the SNAP SS/ (Serial
Synchronous Interface) Module User’s Guide (form 1931) for more information about these modules.

Configuration for the SNAP-SCM-CAN2B module is normally done in a PAC Control strategy using the example
subroutine from the CAN RX/TX Integration Kit for PAC Project, part number PAC-INT-CAN-RXTX, a free
download available on our website, www.opto22.com. As described below, you can also use PAC Manager to
change the IP Port Number, Baud Rate, Data Masks, or Filters for the SNAP-SCM-CAN2B serial module.
However, the settings in your strategy will override the settings in PAC Manager for each module.

1. With the configuration file open, double-click the I/O Units folder.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units @

De

Port Address ‘Wwatchdog
SMAP-PAC...  Ethemet 10.192.54.110 Enabled

Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules :,—— Modules
Events 3 button
Scratch Pad  »
: Communications »
’W‘ Help | Others 3

4 | i

2. Highlight the I/0 unit the CAN module is on. Click the Modules button and choose CAN Modules from
the pop-up menu.
Information from the I/0 unit is displayed in the window.
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«#| Configure CAM Modules @
CAN Madule
CAN module
number ——— Mumber: | ~| I Used
Address | Description Value |
PORT INFORMATION
0xFFFF FO34 9000 Port Number 22500
0xFFFF FO34 9004  Baud Rate 250000 =]
OxFFFF FO34 9008 Dats Mask 0 (0x 00000000
OxFFFF FO34 900C  Filter 0 0x G0000000
OxFFFFFO34 9010  Filter 1 0x 00000000
OxFFFF FO34 9014 Data Mask 1 0x 00000000
OxFFFF FO3A 9018 Filter 2 Ox 00000000
OxFFFF FO3A 901C  Filter 3 0x 00000000
OxFFFF FO3A 9020  Filter 4 0x 00000000
OxFFFF FO34 9024 Filter 5 Ox B0000000

CHAPTER 2: CONFIGURING DEVICES

3. (lickthe CAN Module number dropdown list and choose the module’s position number on the rack to

see the module’s communication parameters.

4. Tochange a parameter, click its value in the Value column.
To change the Baud Rate on a SNAP-SCM-CAN2, choose from the drop-down list

OxFFFF FO34 9004 Baud Rate
(OxFFFF FO34 9003 Data Mask 0
OxFFFF FO34 900C  Filter 0
OxFFFF FO34 9010 Filter 1
OxFFFF FO34 9014 Data Mask 1
(OxFFFF FO34 9013 Filter 2
OxFFFF FO34 901C  Filter 3
OxFFFF FO34 9020 Filter 4
OxFFFF FO34 9024 Filter 5

1000000 k
500000

To change the Filter or Data Mask values, see the next section below.
5. When you have finished changing parameters for this module, click OK.
Repeat the previous step for additional CAN modules.

7.  When all CAN modules are configured, click OK to close the dialog box and return to configuring I/0

units.

8. When you're finished configuring I/0 units, close the dialog box. Choose File > Save to save the

configuration file.

SNAP-SCM-CAN2B Filters and Data Masks

The filters and data masks for each CAN2B module are normally configured in a PAC Control strategy using the
sample subroutines provided in the CAN RX/TX Integration Kit for PAC Project, part number
PAC-INT-CAN-RXTX. You can also use PAC Manager to configure these settings. However, the filter and data
mask settings in your PAC Control strategy will override the settings in PAC Manager for each module.

In PAC Manager the Data Masks and Filters are all set to 0 by default, which means that all CAN packets will be
received. If you want the SNAP-SCM-CAN2B module to provide filtering, then configure the Data Masks and

Filters.

Always start with the highest priority mask and filter, Data Mask 0 and Filter 0. Mask 0 uses Filter 0 and Filter 1,

in that order. Then Data Mask 1 uses Filters 2-5, in that order.
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Bits:

Bit values:

Mask in hex:

Address D escription Walue
PORT INFORMATION

OxFFFF FO34 9000 Port Mumber 22500

O+FFFF FO34 9004 Baud Rate 250000 [E2
O+FFFF FO34 9008 DataMask 0 [ 00000000

OxFFFF FO34 900C  Filter 0 0 00000000

O+FFFF FO34 9010 Filter 1 0 00000000

O+FFFF FO34 9014 Data Mask 1 [ 00000000

O+FFFF FO34 9018 Filter 2 (x 00000000

O+FFFF FO34 901C  Filter 3 0 00000000

O+FFFF FO34 9020 Filter 4 0 00000000

O+FFFF FO34 9024 Filter 5 [ 00000000

-l A Iy R, o s il et

Masks and filters each consist of 32 bits; in PAC Manager these are entered in hex. The mask determines how
broadly or narrowly the filter will be applied, that is, which bits of the CAN ID to pay attention to when
deciding to accept or reject a CAN packet. The following table shows how the mask and filter work together.

Mask Bit Filter Bit  CAN ID Bit Accezfc/ Reje
0 X* X* Accept
1 0 0 Accept
1 0 1 Reject
1 1 0 Reject
1 1 1 Accept

* X =Don't Care

The configuration examples below show how to build the masks and filters.

These examples assume you are using module firmware 2.0b or higher.
Example 1

Suppose many CAN frames are placed on the bus at regular intervals (in no particular order). Some are
standard CAN frames; others are extended CAN frames. You are interested in only one frame, an extended CAN
frame with an Arbitration ID of: 0x14613A2C

This is the only frame you want to capture. How do you configure the Mask and Filter fields to capture it?

Parameter Value Description

A mask with all bits set means the module should consider each bit of the

Mask 0 Ox1FFFFFFF arbitration ID for acceptance. This makes the filter more stringent.

Since this is an extended CAN frame, you want the filter to apply to extended
CAN frames received. So bitwise OR the Arbitration ID with the Extended ID

DAY 0x54613A2C Enable (EXIDE) flag. This flag tells the brain that the filter should apply to
extended CAN frames. The value of this flag is 0x40000000.

Filter 1 0x0 Not used, since you are interested in only one CAN frame.

Mask 1 0x0 Not used

Filters2-5  0x0 Not used

Here are representations of the 32-bit mask and the 32-bit filter for this example:

Mask 0

3031221212 (2(2 (2 ]2 (2|2 (1 |1 (1T {1 (1T |1 (1|1 |1 ]1
1109187 1|6|5(41(3(2|1|0(9 (8|7 |6(51]4 (3|2 (1|0

O1O0(O | 1T {1 (T[T ({1 | [T ||| [T T [T {1111 |{T{T1]T1|1|1(1

1 F F F F F F F
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Bits:

Bit values:

Filter in hex:

CHAPTER 2: CONFIGURING DEVICES

Filter 0

For data in an extended frame, set the EXIDE flag, which is bit 30. The Arbitration ID of 0x14613A2C
becomes 0x54613A2C when bit 30 is set:

ArbitrationID

Not used
IDE fla
Not used

- W
o w
O N
o N
NN
N
v N
AN
w N
NN
- N
o N
O —
00 —
N =
o\ —
S,
D =
w —
N —
o =

o
—_
o
—_
o
—_
o
o
o
—
—_
o
o
o
o
—_
o
o
—
—_
—
o
—

o
o
o
—_

o
—

—
o
o

Example 2

Building on Example 1, suppose now you decide that in addition to the extended CAN frame with Arbitration
ID 0x14613A2C you alsowant to capture a standard CAN frame with Arbitration ID 0x1EC.

For this second frame you have two options:
»  You could put the standard frame at Filter 1 so that both frames are using Mask 0.
«  You could use a different mask, Mask 1, and use Filter 2.

In either case you need to map the 11-bit (standard) Arbitration ID to the 32-bit value the module is
expecting. The module expects the 11-bit standard ID to be in bits 28—18 of the 32-bit filter. So, in terms of
math: mask the desired 11-bit Arbitration ID with 0x7FF and then left-shift by 18 bits: ( (11-bit
Arbitration ID) & Ox7FF)<<18

Using Mask 0. Mask O is already considering each bit in the Arbitration ID, and since we only want to look at
these two CAN frames, we could use Filter 1.

Parameter Value Description

A mask with all bits set means the module should consider each bit of the

Mask 0 OxTFFFFFFF arbitration ID for acceptance. This makes the filter more stringent.

Since this is an extended CAN frame, you want the filter to apply to extended

AL Rl CAN frames received. So bitwise OR the Arbitration ID with the EXIDE flag.

Value of standard Arbitration ID filter after mapping it to its 32-bit value. Do

not set the EXIDE flag. In this case the lower 18 bits (the extended arbitration
bits) are excluded from the acceptance check, even though the mask would

indicate otherwise, since this is a standard CAN frame filter.

Mask 1 0x0 Not used
Filters 2-5 0x0 Not used

Filter 1 0x07B00000

Using Mask 1. If Mask O were less stringent (fewer set bits) so it would not cause acceptance of just the
0x1EC Arbitration ID, then you could use the Mask 1 and Filter 2.

Parameter Value Description

A Mask with much less stringent acceptance criteria. The set mask bits are

Mask 0 OxXTC63FFFF used in the comparison with the filter, while the cleared bits are “Don't Care.”
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Parameter Value
Filter 0 0x54613A2C
Filter 1 0x0
Mask 1 0x1FFC0000
Filter 2 0x07B00000

Filter3-5 0x0

Description

Since this is an extended CAN frame, we want the filter to apply to extended
CAN frames received. So bitwise OR the Arbitration value with the EXIDE
flag. (Depending on the Arbitration IDs of other CAN frames on the bus,
other extended CAN frames will also be accepted, for example 0x15613A2C,
0x16613A2C, 0x17613A2C, 0x14713A2C, and so on.)

Not used

A mask stringent on the standard arbitration bits but allowing all the
extended arbitration bits.

Value of standard Arbitration ID filter after mapping it to its 32-bit value. Do
not set the EXIDE flag. This filter captures only the 0x1EC standard CAN
frame.

Not used

Configuring HART Modules

HART® SNAP I/O are a special type of serial module that provides communication with other Highway

Addressable Remote Transducer (HART) current loop devices. For more information, see the HART SNAP 1/0

Modules Data Sheet (form 2080).

1. With the configuration file open, right-click the name of the I/O unit the HART module is on. From the
pop-up menu, choose Configure.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

==l

Mame

Address ‘Wwatchdog De

10.192.54.110 Enabled

Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules j—— Modules
I button
Scratch Pad  »

<

Cloze | Help

I

2
Communications »
Others 3

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose HART Modules from

the pop-up menu.
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| Inspect HART Module =3
HART Module
Mumber: |0 x| I Used
Address | Description Value
PORT A
OxFFFF FO34 9400 Port Number 22500
OxFFFF FO3A 9404 Primary Master 0
OxFFFF FO3A 9408 Retry Limit 2
OxFFFF FO3A 940C  Burst Message 0
OxFFFF FO3A 9410 Promiscuous Mode g
OxFFFF FO3A 9414 Preambles Count 5
PORTB
OxFFFFFO3A 9430 Part Number 22301
OxFFFF FO3A 9434 Primary Master g
OxFFFF FO3A 9438 Retry Limit 2
OxFFFF FO3A 943C  Burst Message 0
OxFFFF FO3A 9440 Promiscuous Mode o
OxFFFF FO34 9444 Preambles Count 5
’Tl Cancel |

In the Number field, choose the HART module’s position from the drop-down list. Click to put a check
mark in the Used box.

Configure all parameters for each port used.

Port Number: If you need to change port numbers, enter a new number for each port in the Port
Number field.

Primary Master: 0 = Secondary Master, 1 = Primary Master

A master is a device that is in control of the HART Bus. Either master (Primary or Secondary) can
initiate a transaction with a slave field device attached to the bus.

If you want a permanent master connected to the HART bus, use Primary Master = 1. This allows you
to temporarily attach another master device to configure a device or troubleshoot the HART bus.
Retry Limit: 0, 1,2, 3,4, or5

If the module does not receive a valid message from the slave device it is talking to, it will
automatically send up to the configured number of retries until it gets a valid response. If it does get
a valid response after the maximum number of retries, it will report back that an error occurred.
Burst Message: 0 = Don't report burst messages, 1 = Report burst messages

A burst message occurs in a special mode where one slave device on the HART Bus is periodically
sending data without a request generated by a master device. Burst messages can be retrieved
using the Receive HART Burst Response command in your PAC Control strategy. For more
information, see the Analog group of commands in the PAC Control Command Reference (form
1701).

Promiscuous Mode: 0 = Don't report other master requests/responses, 1 = Report other master
requests/responses.

When enabled (1), the module reports transactions initiated by the other master on the bus,
including requests generated by the other master and responses to those requests by the addressed
slave. You can retrieve Promiscuous Mode messages using the Receive HART Burst Response
command in your PAC Control strategy. For more information, see the Analog group of commands
in the PAC Control Command Reference (form 1701).

Preambles Count: 5 to 20
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Preamble characters are sent with every message to indicate that data is about to be transmitted.
The default of 5 should work in most situations. However, you might need to increase the number if
the slave device requires more preamble characters, which is generally true of older HART devices

and can be determined using HART command 0.
5. Repeat the previous step for additional HART modules.

6. When all HART modules are configured, click OK to close the dialog box and return to configuring 1/0

units.

7. When you are ready to send all configuration data to the I/O unit, see “Sending Configuration Data to the

I/0 Unit"on page 68.

Moving a Configured I/0 Point

You can move a configured I/O point to an empty position on the same 1/0 unit or on a different /O unit.

1. In the Configure I/0 Unit dialog box, highlight the unit the point is on and click I/0 Points.

The Configure I/0 Points dialog box opens.

2. If necessary, expand the modules by clicking Expand All.

3. Highlight the point you want to move and click Move To.

-_';] Movwve Point To

10 Urikg: Pointz:

0K | Cancel Help

(007 [00] :
[00][01]:
[00] [02]:
[00][03]:
[0 [00]:
[][01]:
[027[00]:
[02][01]:
[02][02]:
[027[03]:
[03][00]:
[03][01]:

[ Iata LI

Pump_1_5tatuz
Mot Uszed
Mot Uszed
Mot Uszed
Flowmeter_a,
Mot Uzed
Mot Uszed
Mot Uszed
Mot Uszed
Mot Uszed
Mot Uszed
Mot Uszed

Ri_til._ 1

|.m

4. Inthe Points area of the Move Point To dialog box, highlight the location you are moving the point to.

Then click OK.

You return to the Configure I/0 Points dialog box, and the point has been moved.

COPYING AND PASTING I/0 UNITS
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You can copy configured I/0 units and paste them into the same configuration file or into another

configuration file.

1. Inthe configuration tree, right-click the name of the I/0 unit. On the submenu, click Copy.

2. Choose one of the following:
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—  To paste the I/0 unit into the same

configuration file, right-click the 1/0 vainpr‘_’cm' Lo = sl
Units folder and click Paste on the B0 MainProcess
submenu. The I/0 unit is pasted. As - VO Units
|
shown in the graphic at right, the = E”
names of the pasted I/0 unit and Original unit T8 pump.1_Status
points are the same as the originals, and points L ZA Flowmeter A
except with an underscore and a _____ ) PIDs
number added. ----- ﬁ Memory Map Values
- Topaste the /O unit into a different R Preprocess 1

configuration file, close the first file, A -3 Points

o . Pasted unit I8 pymp 1 Status 1
and then open the file into which you and points P Flowrmeter A 1
want to paste the /O unit. Right-click || | ¢ - L‘I‘DS e
thel/O Unitsfolderin the configuraton || | . ] Memory Map Values

tree. On the submenu, click Paste. The
I/0 unit is pasted. To see it in the
configuration tree, you can click the plus sign to expand the folder.

3. Tochange the name or configuration of the pasted I/0 unit, double-click it. Make the changes in the Edit
I/0 Unit dialog box and then click OK.

4. To change the name or configuration of a point on the pasted unit, double-click the point's name. Make
changes in the dialog box and then click OK.

CONFIGURING PID LOOPS

Whatis a PID?

PID loops (or simply PIDs) are used to drive an input (process variable) toward a particular value (the setpoint)
and keep the input very close to that value by controlling an output. For example, consider temperature
control, where the input is a measurement of ambient temperature, the setpoint is the desired temperature,
and the output is a heater. A PID will use a mathematical formula (algorithm) that controls the output to
maintain a desired temperature, efficiently adjust to changes in setpoint, and compensate for changes in load,
such as the influx of cold air. In this example, a temperature sensor (analog input), a thermostat (analog input),
and a heater control (analog output) are components of one system, controlled by a PID loop.

This guide assumes that you are already familiar with using PIDs. PID calculations are complex and the physical
qualities of systems suitable for PID control differ greatly. This guide includes only basic information for
configuring PIDs on SNAP PAC I/0 units.

SNAP PAC R-series I/0 units support 96 PID loops per I/0 unit; SNAP PAC EB and SB 1/0 units support 32 PID
loops per I/0 unit. These PIDs can control isolated systems or be part of cascaded systems where one loop
controls the setpoints or input variables of others.

NOTE: On SNAP PAC R-series, PID loops run on the I/O side, independent of any PAC Control strategy. Once it starts
running, a PID continues running until the I/O unit loses power or the PID is set to Manual. If you subsequently
download a different strategy to the control engine, you'll receive an error message (-700) reminding you that a PID
loop is still running and that it may conflict with the new strategy. To turn off the PID loop, use Inspect mode in PAC
Manager to change the PID’s algorithm to None.

Each PID must be configured with essential parameters and then individually tuned for efficiency. You can
configure PIDs through either PAC Manager or PAC Control. For tuning PIDs, it's easier to use the graphic
tuning tools in PAC Control. (For details, see the PAC Control User’s Guide, form 1700.)
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CONFIGURING PID LOOPS

If you are not using PAC Control, it is possible to configure and tune PIDs through the I/0 unit’s memory map.
The memory map is in the OptoMMP Protocol Guide (form 1465).

For additional help with PIDs, see the OptoTutorial: SNAP PAC PID (form 1641).

Algorithm Choices

When you configure a PID loop, choose one of these algorithms':

«  Velocity (Type Q)

« ISA

o Parallel

« Interacting

Velocity (Type C) is typically used to perform velocity control. The ISA, Parallel, and Interacting algorithms are
derived from the article “A Comparison of PID Control Algorithms” by John P. Gerry in Control Engineering

(March 1987). These three equations are the same except for the tuning coefficients; converting from one
equation to another is merely a matter of converting the tuning coefficients.

Key to Terms Used in Equations

Derivative tuning parameter. In

Process variable; the input to the units of seconds. Increasing

PV TuneD

PID magnitude increases influence on
output.
SP Setpoint Output Output from the PID
InL . TheE PV -SP) f h
R Range of the input Err 1 N .rror( SP) from the
InHi - previous scan
OutLo Integrator. Anti-windup is applied
! Range of the output Integral | afterthe outputis determined to
OutHi s
be within bounds.
, Proportional tuning parameter. PV from the previous scan and the
G . . PV1, PV2
atn Unitless. May be negative. scan before that.
Integral tuning parameter. In
units of seconds. Increasing , Actual scan time (time since
Tunel . . . ScanTime .
magnitude increases influence previous scan)

on output.

Equations Common to All Algorithms

Err = PV - SP

Span = (OutHi - OutLo) / (InHi - InLo)
Output = Output + FeedForward * TuneFF

Equations Common to ISA, Parallel, and Interacting
Integral = Integral + Err
TermP = Err

The following obsolete algorithms support PID loops configured before PAC Project R9.5. For details, see the Opto 22
KnowledgeBase article KB82058
+ Velocity (Type B) Obsolete
ISA (Obsolete)
Parallel (Obsolete)
Interacting (Obsolete)
Do not use these obsolete algorithms with groov RIO. For other devices, you can continue to use them, but Opto 22
recommends you use the new algorithms when configuring new PID loops.
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TermI = Tunel * ScanTime * Integral
TermD = (TuneD / ScanTime) * ( PV - PV1 )
Velocity (Type C) Algorithm

ATermp = ( PV - PVl )

In this part of the formula, you adjust Tunel.
ATermI = Tunel * ScanTime * Err

In this part of the formula, you adjust TuneD.
ATermD = TuneD / ScanTime * ( PV - 2 * PVl + PV2 )

In this part of the formula, you adjust Gain.
Aoutput = Span * Gain * ( ATermP + ATermI + ATermD )

ISA (or “Ideal”) Algorithm
Output = Span * Gain * ( TermP + TermI + TermD )

Parallel (or “Independent”) Algorithm
Output = Span * ( Gain * TermP + TermI + TermD )

Interacting (or “Classic”) Algorithm
Output = Span * Gain * ( TermP + TermI ) * ( 1 + TermD )

NOTE: In SNAP PAC PIDs, the derivative is applied only to the process variable (the input) and not to the setpoint. This
means you can change the setpoint without causing spikes in the derivative term. These PIDs also prevent integral
windup by back calculating the integral without the derivative term. The feed forward term (“bias”) is added before
output clamping and has a tuning factor.

Steps for Configuring PIDs

1. With the configuration file open, right-click the name of the I/O unit the PID will be on. From the pop-up
menu, choose Configure.

The Configure I/0 Units dialog box opens.

=»| Configure I/O Units @

Address ‘Wwatchdog
Ethernet 10.192.54.110 Enabled

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
PID Loops... j—— PID LOOpS
Modules 3 button
Events 3
Scratch Pad  »
4| 1 L2
Communications »
Cloze | Help | Others 3

2. Make sure the correct I/0 unit is highlighted. Click the PID Loops button.
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| Configure PID Loops EI@
10 Unit: j Type: |SHAP-PACH1 [analon
# Mame | Input Setp... | Output | Mode | Enable| Ref... | Descr Add..
oo Mat ...

m Mat ...

0z Mat ...

JIK] Mat ...

04 Mat ...

1L Mat ...

113 Mat ...

in Mat ... -

4 T 3

Cloze | Help

3. Double-click the lowest unused PID number.
Add PID Loop =]
A ———+ Hame: ||
B ——+— Descriptian: |
C || Input: ||,.-'E| Paint j |Flnwmeler_.& j [ Square Root || D
E—— Low Range: |0 High Range: |10
F — 1 Setpoint: |I.n"D Fairt j |Flnwmeter_.-’-‘« j
G || Output: |I.r'D Paint j | j
H—+— Lower Clamp: |0 dpper Clamp: |0
I Ll tin Change: |0 tax Change: |0
COutput optionz for when the input iz out of range
3J [ Switch to manual mode when input goes out of range
[ Force output when input is out of range [auto mode only)
0 0
N
K—— Algorthm: |Welocity - Type C + | Gain: |'| Feed Fwd Initial: |0 o
L ——— Mode |Aut0 j Turel: |D | Feed Fiwd Gain: |0 i
M— ScanBate: |1 zec. | TuneDl: |0 | P
QK. | Cancel | Help |

4. Complete the fields as follows:
A—Name. Type a unique, descriptive name for the PID.
B—Description. (Optional) Enter a description of the PID.

C—Input. Select the type of input: 1/0 Point, Host, or PID Output.
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- Ifthe PID’s process variable comes from an 1/0 point on the same unit, select 1/0 Point. Choose the
point from the drop-down list or type a point name to configure a new point.

- Ifthe PID’s process variable comes from a PAC Control strategy, select Host. Enter an initial value for
the input.

- Ifthe PID’s process variable is the output of another PID on this 1/0 unit (a cascading control loop),
select PID OQutput. Choose the PID from the drop-down list.

D—Square Root. (Optional) If you chose I/0 Point or PID for step C, check this box if the error should be
calculated based on the square root of the process variable (applies to flow control systems where volumetric
flow is proportional to the square root of a signal from a flow transducer).

E—Low/High Range. Set the valid range of the process variable by entering the low range and the high
range. (See J for optional responses to out-of-range input.)

F—Setpoint. Choose the source for the setpoint: /O Point, Host, or PID Output.

- To control the setpoint using a device such as a potentiometer, select /O Point; choose an I/0 point
from the drop-down list or type a new point name.

- To control the setpoint using PAC Control or PAC Display, select Host and enter an initial value.

— Ifanother PID loop will control the setpoint, select PID Output and choose the PID from the
drop-down list.

G—Output. Choose the destination for the PID output: 1/0 Point or Host. (To use the output for controlling
the setpoint or input of another PID, choose Host.)

H—Lower/Upper Clamp. Enter upper and lower clamp values to prevent the output from exceeding a
desirable range. These values should equal the range of the output point, if used. Or choose values to make
sure that the output device doesn't shut off (for example, keeping a circulation pump running regardless of
the PID output) or that the output never reaches a destructively high setting (for example, keeping a motor
below maximum).

I—Min/Max Range. (Optional) Enter minimum and maximum change values. The output won't respond
until the minimum change is reached (for example, you may not want a heater to turn on to correct a 1
degree error). Maximum change prevents too drastic a change in output (for example, you could limit the
increase in a pump's output to prevent pipe breakage). The default for both minimum and maximum is zero,
which disables the feature.

J—Output Options. Choose how the PID should respond if the input goes out of range. If no boxes are
checked, the PID will freeze output at the current value. To have PAC Control logic or an operator respond,
check Switch to manual mode. To force the output to a specific value, check Force output and type the output
values. NOTE: If both boxes are checked (forced output and manual mode), the output will be forced and the PID put
into manual mode; but if the PID is already in manual mode, the output will not be forced.

K—Algorithm. Choose algorithm: Velocity-Type C, ISA, Parallel, or Interacting. See page 64 for more
information.

L—Mode. Choose Mode. Auto activates the PID. Manual requires that PAC Control logic or an operator
control the PID output.

M—Scan Rate. Enter a scan rate to determine how often the input is scanned and the controller output is
calculated. Minimum value is 0.001 (1 millisecond). Scan time should be greater than system lag (the time it
takes for the controller output to have a measurable effect on the system). Also consider other PIDs and tasks
on the I/0 unit competing for processing power.
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N—Gain. Enter a positive or negative value for Gain. Heating systems usually require a negative value and
cooling systems a positive value. NOTE: Gain is usually refined during the tuning process.

O—Fd Fwd Initial and Fd Fwd Gain. (Optional) Enter Feed Forward Initial and Feed Forward Gain values
if you need to offset the controller output in your application. These values are constants that are multiplied
and added to the controller output; often they are not used in PIDs.

P—Tune I, Tune D. (Optional) Enter Integral and Derivative settings if you know the desirable settings.
However, Integral and Derivative are not essential to basic configuration and are better determined in the

tuning process.
5. Click OK.

The new PID appears in the list.

| Configure PID Loops EI@
10 Unit: |F'repru:|c:ess j Type: |SNAF’-F’AE-F|1 [analon

# Mame | Input Setp... | Output | Mode | Enable| Ref... | Descr

Juli] Ower.. Owe.. Host Fuel.. Auto.. Era. 0O

m Mat ...

0z Mat ...

JIK] Mat ...

04 Mat ...

1L Mat ...

113 Mat ...

in Mat ... -

4 T 3

Cloze Help

6. When you have finished configuring PIDs, click Close.
PIDs appear in the configuration tree under the I/0 unit.

MainProcess™

[o]lE =]

-3 MainProcess

25 VO Units

A0

=I5 Points

Preprocess

. I8 pump 1 Status
2 Flowmeter A
2 Oven A Temp
L2 Fuel Pump

=I5 PIDs
=]

PIC

[

Oven_A_Control

— PID loops

----- == Memory Map Values

SENDING CONFIGURATION DATATO THE I/0 UNIT

After you have configured I/0 units and set up optional functions such as security, email, and SNMP from
Chapter 3, you must load the configuration file onto the I/0 unit.

You can load the configuration file into RAM only, or you can save it to flash memory at the same time. If you
don't save to flash, the configuration is lost if the I/O unit is turned off. When you save to flash, the new
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configuration overwrites any configuration already in the flash memory. Note that for some functions, you
must save to flash and restart the 1/0 unit for the configuration to take effect.

1. With the configuration file open, click Tools > Send Configuration to I/0 Unit.
The Send Configuration dialog box appears.

5| Send Configuration to Opto 22 Device IEI
M ame | D escription | Fart | Address List | Send |
3 10.15254.110
Clear Flash
Cloze
Help
W Save to Flash Timeout [msec):
[~ Restart Device 10000

The list on the left shows all the I/0 units in this configuration file. (In the case of an SB I/0 unit, there is
only one.) When you click a unit, the Address List shows the serial address or IP addresses for all I/O units
associated with the highlighted unit. This is the address list you set up in the Add I/0 Unit dialog box,
shown on page 32.

2. Highlight the I/0 unit configuration(s) you want to send.
3. Highlight the IP addresses to receive the I/O unit configuration.
If you don't highlight any addresses, the configuration will be sent to the entire list.

NOTE: If you highlighted more than one unit configuration, each unit configuration will automatically be sent
to all the IP addresses associated with it.

4. If necessary, change the Timeout field.
The timeout field shows how long, in milliseconds, PAC Manager will try to communicate with the 1/0
unit before returning a timeout error.

5. Tosave the configuration file to flash memory as well as to RAM, check Save to Flash. (If you don't save to
flash, the configuration is lost if the I/0 unit is turned off) To also restart the unit, check Restart Device.

IMPORTANT: For the following configurations, you must save to flash and restart the unit in order for
configuration to take effect:

Changes in TCP port for serial modules SNMP configuration
Email configuration PPP configuration
Data logging interval

6. Click Send.

The configuration data is sent to the I/0 units whose IP addresses you chose.
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Using PAC Manager to Clear Flash Memory

You can also use PAC Manager to clear configuration data from flash memory in one or more /0 units. (This
action does not affect brain or controller firmware, strategy files, or files from the 1/0 unit’s file system that may

be stored to flash.)

1. With the configuration file open, click Tools > Send Configuration to I/0 Unit.

2. Inthe Send Configuration dialog box, highlight the I/0 unit configuration and addresses for the I/0 units
you want to clear.

3. ClickClear Flash.
Configuration data in flash memory is cleared.

USING I/0 POINT FEATURES

The I/0 point features available on I/0 units depend on the combined capabilities of the I/0 processor (brain
or on-the-rack controller), the module, and in some cases, the protocol used. See page 73 to determine which
features are available for the processor you are using. Note that some features (such as pulsing and totalizing)
can be configured in PAC Manager but are currently available for use only through PAC Control. For details, see
the PAC Control User's Guide (form 1700).

The following table defines the features. Some have referenced pages for more information.

Feature

States

Latches

Counters

Quadrature
counters

Frequency
measurement

Period
measurement

Time-
proportional
output (TPO)
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Description

(digital input and output)—A digital point is either on or off. You can read

the current state of a digital input or write an on/off state to a digital output.

(digital input)—When the value of a digital input point changes from off to
on, an on-latch is automatically set. While the value of the point may return
to off, the on-latch remains set, as a record of the change, until you clear it.
Similarly, an off-latch is set when the value of a digital point changes from
on to off, and it remains set until cleared.

(digital input)—A counter keeps track of the number of times a digital input
changes from off to on. The count accumulates until it reaches the
maximum count available in the I/O unit or until you reset the counter to
zero. For example, to count the number of widgets produced per shift, you
would clear the counter at the start of each shift and read it at the end of
each shift.

For points on a 4-channel module, the speed of the counter depends upon
the brain or controller’s capabilities and the speed of the module used. For
points on a high-density module, counting is done in the module.

(digital input)—A quadrature counter requires a SNAP quadrature input
module, which is attached to the encoder device. The module sends a pulse
to the I/0 unit upon each change in quadrature state, and the I/O unit
counts the pulses and keeps track of the direction and rotation.

(digital input)—Frequency is the speed with which a digital point changes
state and is usually measured in counts per second. For example, reading
the frequency can help you determine the speed of rotating machinery.

(digital input)—Period refers to the elapsed time for a complete on-off-on
transition on a digital point. Measurement starts on the first transition
(either off-to-on or on-to-off) and stops on the next transition of the same
type.

(digital output)—Time-proportional output varies the duty cycle and the

percentage of on time within that cycle. TPO is often combined with a PID
loop and used to control the output, for example in a heater or oven.

See

page 72

page 72

page 72

page 73
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Feature Description See
Pulse (digital input)—A pulse is a brief on (or off) state, usually repeated at a
duration specific interval. The brain can measure the first pulse, that is, the amount of N/A

measurement time the input stays on (or stays off).

Pulse and (digital output)—A pulse turns a digital output on (or off) briefly, either
square wave once or for a specified number of times at a specified interval. A digital *®
generation  square wave is a specific pattern of on and off states, repeated continuously.

(digital and analog input)—For a digital input, a totalizer accumulates the
total amount of time that a digital input is on (or off). The on-time totalizer
shows how long the point has been on; the off-time totalizer shows how
long the point has been off. Totalizers are often used to determine
maintenance or use schedules.

For an analog input, a totalizer accumulates readings by sampling the
input point at set intervals and storing the total value, for example to
determine total flow based on a varying flow rate signal.

Totalization

(digital and analog points)—A watchdog monitors communication on the
OptoMMP port (port 2001, unless you have changed it). If nothing accesses
the port for the length of time set in the watchdog, the I/0 unit
automatically sets designated digital and analog I/O points to the values
you have determined.

A watchdog helps make sure that a communication failure doesn't result in
disaster. If communication fails between the host and the I/O unit
controlling a process, the watchdog makes sure the process is automatically
brought to a safe state. For example, a valve could automatically close to
avoid completely emptying a tank.

IMPORTANT: A strategy running on a SNAP PAC R-series controller accesses
the points on its own rack directly, not through the OptoMMP port.
Consequently, reads and writes to the local I/0 are not seen by the
watchdog.

Watchdog page 73

(analog input and output)—Analog input and output points can be scaled
Scaling as needed. For example, you can scale a -5V to +5 V input point to reflect page 73
0% to 100%

(analog input)—Minimum and maximum values are sometimes called
peaks and valleys. You can read these values at any time, for example, to

Minimum and L . .
record minimum and maximum temperatures. You can also reset min/max

m::;::;m values. For example, if you want to record the maximum temperature at page 74
point 2 in each 24-hour period, you must reset the values after they are read
each day.
(analog input)—The I/0 unit automatically converts the thermocouple
Thermocouple junction's millivolt values into temperature values, so you don’t have to.
linearization = Choose the appropriate module and make sure you configure the point as -
the correct thermocouple type (E, K, etc.) for your purpose.
(analog input)—Offset and gain calculations are used to calibrate analog
Offsetand  points. If a-50 mV to +50 mV input receives signals that are slightly off (for
gain example, not exactly -50 mV at the lowest point), the offset and gain can be page 74
calculated so that values will appear accurately when read.
(analog output)—Clamping limits values that can be sent to analog output
points so they do not go above or below a specific value. For example, if you
. are using a 0-10 VDC output module, but the device attached to one of its
Clamping page 75

points can handle a maximum of only 5 VDC, you can set an upper clamp of
5VDC for that point. The values for upper and lower clamp are set in
engineering units.
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Feature Description See

(analog output)—Some devices attached to analog outputs should not be
abruptly stepped up or down, because a sudden change might damage the N

Ramping equipment or cause other problems. Instead, you can gradually ramp the
device up or down to the desired value.
(analog points)—Proportional integral derivative (PID) loops are used to
PID loop drive an input toward a particular value (the setpoint) and keep the input age 63
control very close to that value by controlling an output. PID loops are often used in pag
temperature control.
Average filter (analog inputs)—A filter weight smooths analog input signals that are page 75

weight erratic or change suddenly.

* Requires PAC Control and a SNAP PAC controller for use. For details, see the PAC Control User’s Guide
(form 1700).

Some I/O point features are discussed in the following sections.

States (Digital Points)

You can read the ON or OFF state of a digital input point or write to a digital output point to turn it on or off.
This feature is automatic and needs no configuration.

Latches (Digital Points)

Latching is available on both 4-channel and high-density digital points. It is automatic and needs no
configuration. Using memory map values, you can read the on-latch or off-latch state of a digital point, and
you can clear latches.

Counters (Digital Points)

Any SNAP digital input can be used as a counter. Note the differences in counting between 4-channel and

high-density digital modules:

SNAP high-density digital
counters

SNAP-PAC-R1 (-B, -FM', -W')
SNAP-PAC-R2” (-FM', -W")

SNAP 4-channel digital counters

SNAP-PAC-R1 (-B, -FM', -W')

Processor R SNAP-PAC-EB1! (-FM', -W")
compatibility SNA:;\IPAAS__FE:(!_S(;%H_W ) SNAP-PAC-EB2' (-FM', -W")
SNAP-PAC-SB1'
SNAP-PAC-5B2'2 1!
Counting is done on... ...the brain ...the module
High speed (depends on speed of
Counting speed module; modules available upto 20  Low speed (up to 50 Hz)
KHz)
» Each point to be used as a counter  « Configure points only if using PAC
must be configured. Control.
« Counters start as soon as + Counters are always counting.
Configuration and Use  configured. . Counters can be Read or Read &
» Counters can be Started, Stopped, Cleared.
Read, and Read & Cleared. - Counters cannot be Started or
Stopped.
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G4EB2—Any digital input can be used as a counter. Counters must be configured. They start as soon as they
are configured and can be Started, Stopped, Read, and Read & Cleared.

Use PAC Control digital point commands to work with counters.

Quadrature Counters (Digital Inputs)

/0 units with the following I/O processors support quadrature counters for quadrature encoder devices:
«  SNAP-PAC-RT

«  SNAP-PAC-R1-B

o  SNAP-PAC-EB1 (obsolete)

o SNAP-PAC-SB1 (obsolete)

(obsolete)(obsolete) (obsolete)A quadrature counter requires a SNAP quadrature input module (SNAP-IDC5Q),
which is attached to the encoder device. The module sends a pulse to the processor upon each change in
quadrature state, and the processor counts the pulses and keeps track of the direction and rotation. For each
axis, the counter counts up if Phase A leads Phase B; it counts down if Phase A lags behind Phase B. Each axis
can have counts from 0 to 2,147,483,647.

If your encoder device has an index feature, you can use two separate digital input points as indexes, one for
each axis. The index automatically resets the count, and it shows what the count was when the index was
triggered. Counts are sometimes lost, due to noise or encoder problems, for example; with the index, you can
see whether the count varies too much.

Watchdog (Digital and Analog Points)

To configure a watchdog, set the watchdog when configuring the //0 unit. Then when you configure a digital
or analog output point, you can choose the status or value the point should be set to if the watchdog timer
expires.

About ETand E2 brain boards: You can configure E1s and E2s like any other /O unitif you have E1/E2 firmware R1.2a
(and higher) and PAC Project 9.5000 (and higher). Also, if a SNAP PAC controller communicates with the E1 or E2, the
controller must have PAC firmware R9.5a (or higher) to use this simplified configuration method. If you are not using
these firmware and software versions (or if you prefer to use the previous method to reconfigure existing ETs or E2s),
see |/0 Configuration for E1 and E2 Brain Boards (form 1576).

Scaling (Analog Points)

You can scale analog input or output points to match your needs. For example, you can scale a
-5V to +5 Vinput point to reflect 0% to 100%. Point types may be unipolar or bipolar.

Examples of Unipolar Points Examples of Bipolar Points
4-20 mA analog output -25mV to +25 mV analog input
0-10 A RMS analog input -10to +10VDC analog output

Unipolar and bipolar points are scaled in the same way, with the lowest reading reflecting the low scale and
the highest reading reflecting the high scale. Here are two examples:

Unipolar Input Point Bipolar Input Point
Low scale High scale | Low scale High scale
Actual reading 0mA 20 mA -5V ov +5V
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74

Scaled for percentage 0% 100% 0% 50% 100%
Scaled for counts* 0 +25,000 -25,000 0 +25,000
*Counts for input points always range -25,000 to +25,000.
Unipolar Output Point Bipolar Output Point
Low scale  Highscale |Low scale High scale
Actual reading 4 mA 20 mA -10VDC 0VvDC +10VDC
Scaled for percentage 0% 100% 0% 50% 100%
Scaled for counts* 0 4,095 0 2,047.5 4,095

*Counts for output points always range 0-4,095.

NOTE: With PAC firmware version 8.1 and higher, you can also use inverted scaling. For example:

OmA 20mA
742 fom -27fpm

Minimum and Maximum Values (Analog Points)

Starting with the introduction of SNAP-B3000-ENET, all SNAP PAC brains (including SBs), SNAP Ethernet I/0
units, and E2 brain boards automatically keep track of minimum and maximum values on analog points. You
can read and clear these values using PAC Manager's Inspect mode.

Offset and Gain (Analog Points)

Starting with the introduction of SNAP-B3000-ENET, all SNAP PAC brains (including SBs), SNAP Ethernet I/0 units,
and E2 brain boards can automatically calculate offset and gain for analog input points. If a-50 mV to +50 mV
input receives signals that are slightly off (for example, not exactly -50 mV at the lowest point), the offset and gain
can be calculated so that values appear accurately when read.

Offset and gain values affect engineering units (EU). For a temperature input, engineering units are in degrees
CorF, depending on how the I/0 unit is configured.

IMPORTANT: To calibrate the point, the I/O unit must be turned on and attached to the network, and you must
have access to the l/O unit in order to use the calibrator. For points on a SNAP PAC SB-series brain, connect directly via
serial or through the controller via Ethernet. (See page 26 for details.)

Save the configuration to flash so that it is not lost when power is turned off. Since each calibration is for a specific
point on a specific I/0 unit, the result cannot be saved to the configuration file and cannot be sent to any other I/0
unit.

First, calculate offset, and then calculate gain. The offset must be calculated at the signal corresponding to
zero engineering units (EU), and the gain must be calculated at the signal corresponding to the point’s
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maximum input range value (or, for inverted scaling, the point’s minimum input range value—in inverted
scaling, the lower scaled value is greater than the upper scaled value).

For details, see “Calibrating Offset and Gain Using the Default Method” on page 175.
If you don't have access to a calibrator, or if the point uses inverted scaling and your device has PAC firmware
R9.5b or lower, see “Calculating Offset and Gain Using the Two-Point Method” on page 177.

If you are using Modbus/TCP, you will need to calculate the offset and gain yourself. Then you can write offset
and gain values to the I/O unit. For details, see page 44Calibrating Offset and Gain.

Clamping (Analog Points)

SNAP 1/0 units with analog capability and SNAP PAC SB brains can clamp values sent to analog output points
so they do not go above or below a specific limit. For example, if you are using a 0-10 VDC output module,
but the device attached to one of its points can handle a maximum of only 5 VDC, you can set an upper clamp
of 5VDC for that point. The values for upper and lower clamp are set in engineering units. (See “Configuring
I/0 Modules, Points, and Features”on page 157.)

Average Filter Weight (Analog Points)

SNAP PAC I/0 units and SNAP PAC SB brains can use a filter weight to smooth analog input signals that are
erratic or change suddenly. The formula used for filtering is Y = (X - Y )/W + Y, where Y is the filtered value, X is
the new unfiltered value, and W is the filter weight.

This graph shows the effect of filter weights (W) 2, 5, and 10 on a step input signal:

Y =(X-Y)W+Y
Filter Response for Different values of 'W'

4 As this graph shows, the
larger the filter weight (W)
you use, the smoother the
analog signal.

Afilter weight of zero turns off the calculation. Values less than or equal to 0.5 are changed to zero, since those
values would cause an unstable signal.

Filtering is applied to values that are in engineering units, including minimum and maximum values. Filtering
does not apply to values that are in counts. Set filter weight when configuring the analog point. Use the PAC
Manager Inspect window to set filter weight (see “Configuring I/O Modules, Points, and Features”on
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page 157). If you are using PAC Control, you can also set filter weight in your control strategy using the
command Set Analog Filter Weight.
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Functions

INTRODUCTION

Chapter 2 showed you how to configure I/0 unit points and features. This chapter includes instructions for
setting up the following optional functions:

Setting up network security (wired network) page 78
Logging data page 87
Sending event messages via email, SNMP, a stream packet, or a serial module page 92
Using SNMP for communicating with enterprise management systems page 96
Configuring DNS Servers page 99
Sending email page 100
Using the Scratch Pad area for peer-to-peer data sharing page 102
Streaming data page 104
Mirroring I/0 point data page 107
Copying memory map data page 109
Configuring Modbus options page 112
Setting system date and time page 115
Communicating serially with devices attached directly to a controller page 117
Using PPP for communicating via modem with the device page 122

In most cases, you use the same configuration file in PAC Manager to set up optional functions as you did to
configure /0 units, so the complete configuration information can be uploaded to I/O units all at once.

PAC Manager User's Guide 77



SETTING UP NETWORK SECURITY (WIRED NETWORK)

SETTING UP NETWORK SECURITY (WIRED NETWORK)

78

For network security on a wireless LAN, see “Configuring Wireless LAN Communication (Wired+Wireless
Models Only)” on page 22.

You can use PAC Manager to set up security on a wired network for an Opto 22 SNAP PAC Ethernet-based
device. You can limit access to specific computers or other devices on the network. You can also limit access to
specific protocols used with the Opto 22 device, such as SNMP (below). You can require a password for using
FTP (see page 79). In addition, you can protect a PAC Control strategy so that it runs without possibility of
interference from a host (page 80).

Limiting Access to Specific Computers

You can limit access to the controller or I/0 unit based on the IP address of the computer or other host device
attempting to communicate with it. You specify the IP addresses that may access the controller or 1/0 unit.
Anyone on a computer or other host device with an acceptable IP address has access.

Work with your network administrator to make sure you are specifying the correct IP addresses. See
“Configuring Ethernet Security on an I/0 Unit” on page 82 or “Configuring Ethernet Security on a Standalone
Controller”on page 85 for instructions.

Limiting Access to Specific Protocols

You can also limit access to specific protocols the controller or I/0 unit uses. These protocols can travel
simultaneously over the Ethernet/TCP/IP link and set up sessions, or ports, on the device:

«  File transfer protocol (FTP), used for exchanging files between the device and a computer (applies to
SNAP PAC R-series, S-series, and SoftPAC only)

«  Modbus/TCP protocol, used by Modbus/TCP software and hardware

«  OptoMMP, the IEEE 1394-based memory map protocol, used by most other tools for interfacing with the
SNAP device

«  Simple network management protocol (SNMP), used to communicate with SNMP-based enterprise
management software

For security purposes, you can hide or disable one or more of the protocols by changing the port number
from its default. The following table shows these default ports.

NOTE: If you change any port number, you must restart the device before the changes will take effect.

Protocols for Default Ports:

Protocol Used by Dgf:rlélt
FTP PCs for file exchange 21
SNMP enterprise management system 161
Modbus/TCP Modbus/TCP software and hardware 502
OptoMMP PAC Manager and most other tools 2001

Preventing Access. For example, suppose you want to prevent any device from accessing a controller using
FTP. To do so, you would change the port number for the FTP protocol from the default of 21 to zero. Since
zero is an invalid port, no device could access the controller using FTP,

Limiting Access. If you wanted to limit FTP access, you could change the port number from 21 to a
non-reserved number between 1 and 65,535 (see list of reserved port numbers, below). If you change the
number, anyone (or any application) that needs to access the controller using FTP can do so by adding the
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changed port number to the controller’s IP address. For example, if the controller's IP address is 10.22.56.3 and
the port number is changed to 85, you would enter the following to access the controller:
10.22.56.3:85

Reserved Port Numbers

If you change port numbers, do not use any number in the following list. These numbers are reserved for
Opto 22 firmware:

Port Used by Port Used by

20 FTP 2222 EtherNet/IP (UDP for I/0)

21 FTP 22000 Reserved

25 SMTP 22001 PAC Control/ioControl Host

67 BootP Server 22002 PAC Control Background Downloading
68 BootP Client 22003 Reserved

161 SNMP 22004 PAC Control User Chart

162 SNMP Traps 22005 PAC Control User Chart

502 Modbus/TCP 22500-22531 | Serial Communication Modules

2001 OptoMMP Host 23567 PAC Controller Redundancy

2002 OptoControl Peer 44818 EtherNet/IP (TCP & UDP Explicit messages)
2003 OptoControl Peer 50000-50999 | PAC controller internal use

For more information, see “Configuring Ethernet Security on an I/0 Unit"on page 82 or “Configuring Ethernet
Security on a Standalone Controller”on page 85.

Configuring the PAC as an HTTP/HTTPS Server

In addition to working as a client (for example, to send email) SNAP PAC R-series or S-series controllers with
PAC firmware R9.5a or higher include a built-in HTTP/HTTPS server and a REST API. The PAC listens for HTTP
and HTTPS requests, and then sends I/O point or strategy variable data to the client that requested it. The
complete SNAP PAC REST API and instructions to get started are on developer.opto22.com.

To prevent unauthorized access, the HTTP/HTTPS server feature in PAC R-series or S-series controllers is
disabled by default. To configure the server in your controller, you enable either HTTPS or HTTP protocol on
the controller and configure a listening port for TCP communication.

IMPORTANT: Opto 22 strongly recommends using HTTPS for secure, encrypted access to your controller.
Use HTTP for testing purposes only.

1. In PAC Manager, click Tools > Inspect, or click the Inspect button BJ

2. Inthe Inspect Opto 22 Device window, enter the IP address for the R- or S-series controller you want to
configure, or select it from the list.

3. C(lickthe Communications button, and then choose Network Security from the pop-up menu.
4. Inthe WEB SERVER section:
a. Change the default value of TCP Listen Port (address OxFFFF FO3A 0014).
Typically, port 443 is used for HTTPS, and port 80 is used for HTTP,
b. Verify the value of HTTPS (address OxFFFF FO3A 0070).
—  For HTTPS, the value should be Enabled.
—  For HTTP change the value to Disabled.
c. Click Apply to save the changes.
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=] Inspect Opto 22 Device

Device Name: ]Opho 22 Controller _L] Options » i Status: ]Network Security area last readl?

~Metwork Security - l
Status Read g
T Address ] Description ] Value
OxFFFF FO3A 0004  OptoMMP 2001
) OxFFFF FO3A 0008 Modbus 02
T A J OxFFFF FO3A000C  SNMP 161
0xFFFF FO3A 0010 FTP 21

Point Config PR ROSA0eT e R T TTeT= r=—-ir )

— VVEB SERVER
Digital Bank | 0xFFFF FO3A 0014 TCP Listen Port 443

o (OxFFFF FO3A 007C  HTTPS Enabled
Digital Point M e

M-D

5. Toimmediately enable the HTTP/HTTPS server feature, reboot the controller so that the changes take
effect.

= Inspect Opto 22 Device

Device Name: iOpho 22 Controller _L] Options * i Status: | Restart Device from DO‘!I
—Status Write 1
Status Read
Status Write Address ] Description 1
OxFFFF FO38 0004  Always BootP /DHCP On Powerup i
8 OxFFFF FO38 0008 Degrees FjC 1
mEEry D J OxFFFF F038 0010 Comm Watchdog Time (msec), 0 = Disable !
OxFFFF F038 0014 TCP Minimum Retransmission Timeout {msec)
Point Config 0xFFFF F038 0018 TCP Initial Retransmission Timeout {msec)
0xFFFF FO33 001C  TCP Retransmission Attempts
Digital Bank OxFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable |
= 3 OxFFFF F038 0294 Digital Feature Scan Interval (msec) l
Digital Paint ] 0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) Send Command
Analog Bank OxFFFF F038 0298 Out Of Range Value (16-Bit)
J 0xFFFF F038 02B0  Out Of Range Value (32-Bit)

Analog Point ‘ 0xFFFF FO38 0054  Scanner Flaos
High Density ErEaT
}— Do ry ~ Send Command |
Restart Device from powerup
3
% \ Store configuration to flash ’
SeelEiil D Reset to defaults and Restart Device

Data Log >l | miUPSD

&anfigurati d IP ings to mi

Once you've configured the PAC as a server, the next step is to use a browser (for example, Google Chrome™ or
Microsoft Internet Explorer®) to access the PAC and set up the administrator password and APl accounts. After
that, authorized users can use the SNAP PAC REST API to access data in the controller. For details, see
developer.opto22.com.

Requiring a Password for FTP

You can configure security so that anyone who wants to access the device using FTP is required to enter a
username and password. If you are using the Opto iPAC app for iPhone, iPod Touch, or iPad, we strongly
recommend you require a password.

See “Configuring Ethernet Security on an I/0 Unit”on page 82 or “Configuring Ethernet Security on a
Standalone Controller”on page 85 for instructions.
Protecting a PAC Control Strategy from Interference

You can set up a standalone or on-the-rack controller to run a stable strategy without the possibility of
interference from a host. This means that no one can alter or stop the strategy using PAC Control or PAC
Terminal; but it also means that PAC Display cannot communicate with the control engine.
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To protect a PAC Control strategy from interference, finalize the strategy, download it, save it to flash memory,
and then set the autorun flag. (For the steps, see the PAC Control User’s Guide, form 1700.)

Then, follow the steps in the next section to change the Control Engine port number from the default of
22001 to zero, and save that setting to flash as well. The strategy will automatically run when power is turned
on, but a host cannot communicate with it.

If you need to change the Control Engine port number back to 22001, you can do so in PAC Manager, because
PAC Manager uses the OptoMMP protocol to communicate with the controller.

Turning Off EtherNet/IP

If you are not using the EtherNet/IP protocol on a SNAP PAC device, you can turn the protocol off. Note that
you must restart the device after this change.

Since this procedure sends the configuration directly to the device, the device must be on the same network
as your computer.

1. Inthe PAC Manager main window, click the Inspect button @ }

Device Name: | 10.199.99.99 j Options » Status: | Status Read area last read at 07/05/16 10:34:58
Status Read
Status Read |
T —— LDDRESS DESCRIPTION VALUE - lm
. 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed FOC Receiwved (0}
| [iEEEL OxFFFF FO30 0008 Busy Flag 0
| Point Config 0xFFFF FO30 0018 Loader Version BS.1lc |
e —— 0xFFFF FO30 0000 Memory Map Version 1 |
gital Ban 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Paint 0xFFFF FO30 001C Firmware Version 19.5a
0xFFFF FO30 00RO Firmware Version Date 05/03/2016

Analog Bank 0xFFFF FO30 00BO Firmware Version Time 1529232
Analog Point 0xFFFF FO30 0020 Unit Type 0x00000074

High Density 0xFFFF FO30 0080 Unit Description SNAP-EAC-R1
| 0xFFEF FO30 0024 I/0 Unit Hardware Revision (Month) 4
| 0xFFEF FO30 0025 I/0 Unit Hardware Revision (Day) 21
System b 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
| ScratchPad 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version a0.0&
0xFFFF F030 0028 Installed Ram 33554432

Data Log 3
ETHERNET 1 Interface

FID * 0xFFFF FO30 002E MAC Lddress 00-A0-30-01-85-5C
R I_ OxFFFF FO30 0034 IP Address 10.192.55.67
om PSP s g FERP R0 200 (35, B M e A oA ottin s, I8 SASFARR G A e A sumnn e

2. Inthe Device Name field, type the name or IP address of the controller (or choose it from the drop-down
list).

3. ClickCommunications and choose Network Security from the submenu. Scroll down till you see
ETHERNET/IP
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| Inspect Opto 22 Device — X

Device Name: | 10,192.55.67 j Options » Status: | MNetwork Security area last read at 07/05/16 10:42:09

Metwork Security
Status Read

Status Write Address | Description | Value | A Refresh |
0xFFFF FO3D 0000 FTP Username
e OxFFFFFO3D 0040 FTP Password Apply
BROADCAST FILTER
OxFFFF FO3A 0070 Stop incoming broadcasts No a|
Point Config IP FILTERS
OxFFFF FO3A 0020 Filter 0 - Address 0.0.0.0
Digital Bank OxFFFFFO3A 0024 Filter 0 - Mask 0.0.0.0
o . 0xFFFF FO3A 0028 Filter 1 - Address 0.0.0.0
Digital Point OXFFFFFO3A002C  Filter 1-Mask 0.0.0.0
Analog Bank 0xFFFF FO3A 0030 Filter 2 - Address 0.0.0.0
0xFFFF FO3A 0034 Filter 2 - Mask 0.0.0.0
Analog Point 0xFFFF FO3A 0038 Filter 3 - Address 0.0.0.0
OxFFFF FO3A 003C Filter 3 - Mask 0.0.0.0
High Density OwFFFFFO3A 0040 Filter 4 - Address 0.0.0.0
OxFFFF FO3A 0044 Filter 4 - Mask 0.0.0.0
System R OxFFFF FO3A 0043 Filter 5 - Address 0.0.0.0
OxFFFF FO3A 004C Filter 5 - Mask 0.0.0.0
ScatchPad  » OxFFFF FO3A 0050 Filter & - Address 0.0.0.0
0xFFFF FO3A 0054 Filter & - Mask 0.0.0.0
Datalog * OxFFFFFO3A 0058 Filter 7 - Address 0.0.0.0
0xFFFF FO3A 005C Filter 7 - Mask 0.0.0.0 k
PID 3 0xFFFF FO3A 0060 Filter & - Address 0.0.0.0
0xFFFF FO3A 0064 Filter 8 - Mask 0.0.0.0
Events 4 OxFFFF FO3A 0063 Filter 9 - Address 0.0.0.0
| OxFFFF FO3A 006C  Filter 9 - Mask 0,0,0.0
Communications » ETHERNET/TP
e , OxFFFF FO3A 0078 EtherMet/IP Protocol Enabled a|
Close | Help | [~ Auto Refresh | 15000  msec

4. Inthe Value column, click the down arrow and choose Disabled.
To enable EtherNet/IP again, choose Enabled.

5. Click Apply to send the configuration change to the device.

6. Click Status Write. In the Operations Commands section, highlight Store configuration to flash. Click Send
Command.

7. Inthe same section, highlight Restart Device from powerup. Click Send Command.
The change is stored to flash memory and the device restarts.

Configuring Ethernet Security on an 1/0 Unit

Use these steps for an Ethernet-based I/0 unit on a wired network. For security on a wireless LAN, see page 22.
For a SNAP PAC S-series standalone controller, use the steps on page 85.

1. In PAC Manager, click the Open button g (or in the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
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ﬂ PAC Manager - Main_Process
File Edit Tools View Help

| Dies|d| *|%alal B

B Main_Process
=Bl /0 Units
20 Line_1

e
Preprocess

Ready [ N4

In the configuration tree, right-click the name of the I/O unit on which you want to set up security and
choose Configure from the pop-up menu.

= Configure /0 Units *

Name | Type | Part | Address | watchdog | Description Add... |
Line_1
Preproces

SNAP-PAC... Ethernet 10.192.55... Disabled
SNAP-PAC... Ethernet 10.192.55... Disabled Modify. .. |

Communications Communications
button

Coss | Hep |

4. (lick the Communications button and choose Network Security from the pop-up menu.
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E Configure Network Security 4
[~ Used

Address | Description | Value A
PORTS

0xFFFF FO3A 0004 OptoMMP 2001

0xFFFF FO3A 0008 Modbus 502

0xFFFF FO3A 000C SNMP 161

0xFFFF FO3A 0010 FTP 21

0xFFFF FO3A 0074 Control Engine 22001
WEB SERVER

0xFFFF FO3A 0014 TCP Listen Port a

OxFFFF FO3A 007C  HTTPS Enabled |
FTP LOGIM

0xFFFF FO3D 0000 FTP Username
0xFFFF FO3D 0040 FTP Password

BROADCAST FILTER

0xFFFF FO3A 0070  Stop incoming broadcasts Mo =l
IP FILTERS

OxFFFFFO3A 0020  Filter O - Address 0.0.0.0

OxFFFF FO3A 0024 Filter 0 - Mask 0.0.0.0

OxFFFFFO3A 0028 Filter 1- Address 0.0.0.0

OxFFFF FO3A 0020 Filter 1 - Mask 0.0.0.0

OxFFFFFO3A 0030 Filter 2 - Address 0.0.0.0

OxFFFF FO3A 0034 Filter 2 - Mask 0.0.0.0

OxFFFFFO3A 0038 Filter 3 - Address 0.0.0.0

OxFFFF FO3A 003C  Filter 3 - Mask 0.0.0.0

OxFFFF FO3A 0040 Filter 4 - Address 0.0.0.0

OxFFFF FO3A 0044 Filter 4 - Mask 0.0.0.0

OxFFFFFO3A 0048  Filter 5 - Address 0.0.0.0

OxFFFF FO3A 004C  Filter 5 - Mask 0.0.0.0

OxFFFF FO3A 0050 Filter & - Address 0.0.0.0

OxFFFF FO3A 0054 Filter & - Mask 0.0.0.0 v

OK | Cancel

5. Ifthereis no check mark in the Used box, click the box to place a check mark there.
To limit access to a specific protocol, change the Port number in the Value column.

CAUTION: Ifyou change the Control Engine port to zero, a strategy that is already in the control engine will
still run, but PAC Display, PAC Control, and other hosts will not be able to communicate with it. See “Protecting
a PAC Control Strategy from Interference” on page 0.

7. Touse the built-in HTTP/HTTPS server on a SNAP PAC R-series or S-series controller, see “Configuring the
PACas an HTTP/HTTPS Server”on page 79.

8. Tosetupan FTP login, enter the Username and Password to be required from anyone who uses FTP to
access the device.

9. To limit access to specific computers, set up to ten filter addresses and filter masks.
The filter address is the IP address that is allowed to access the I/0 unit; the filter mask indicates a range of
allowed addresses. If only one IP address may access the 1/0 unit, enter 255.255.255.255 for the filter
mask. If a range of IP addresses may access the I/O unit, enter a mask that reflects the subnet range.
For example, if only IP address 1.2.3.4 may access the I/O unit, enter 1.2.3.4. as the filter address and
255.255.255.255 as the filter mask. If any IP address that starts with 1.2.3 may access the I/O unit, enter
1.2.34 (or 1.2.3.1, or any address in the range) as the filter address and 255.255.255.0 as the filter mask.

NOTE: For troubleshooting purposes, you can use the Broadcast Filter value to temporarily turn off incoming
broadcasts to the I/0 unit. Normally you would NOT want to do this; a BootP response, for example, is an
incoming broadcast.

10. When you have finished configuring security, click OK.
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11. Configure other optional functions, or return to the PAC Manager main window and click the Save button
|=l| to save the configuration file.

IMPORTANT: If you changed a port number, you must restart the device when you send the configuration to the
/0 unit. Otherwise the port change will not take effect.

When you are ready to upload the configuration file to the /O unit, see “Sending Configuration Data to the I/O

Unit"on page 68.

Configuring Ethernet Security on a Standalone Controller

These steps are for a wired network. For security on a wireless LAN, see page 22.

Since this procedure sends the configuration directly to the controller, the controller must be on the same

network as your computer.

NOTE: If you change a port number, you must restart the device in order for the port change to take effect.

1. In the PAC Manager main window, click the Inspect button [E, |

The Inspect window opens.

- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.
- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device

Name field, and current Status Read information appears in the window.

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

Device Name: | 10,199.99.99 j Options # Status: | Status Read area last read at 07/05/16 10:34:58
Status Read
Status Read
Status Write ADDRESS DESCRIFTION VALUE ~ Refresh |
= 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
| | EEsL OxFFFF F030 0008 Buay Flag 0
| Paint Config 0xFFFF F030 0018 Loader Version R5.1lc |
Diital Bank 0xFFFF FO30 0000 Memory Map Version 1 |
gita! Ban 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016
Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A
High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
| g 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
5 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
HEEn 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
| ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3
ETHERENET 1 Interface
PID L 0xFFFF FO30 002E MAC Address 00-R0-3D-01-85-9C
N L 0xFFFF FO30 0034 IF Address 10.192.55.67
em PN M| s 0GR ERR R 200038t S AnE LMt e oAt P, D55 AASFABY 0, Ay o anmen pattion

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

Wpto 22 Device

Cookie Controller

|_ |[EngineRm i
| Cail Portable
: SoftPAC [CRIPTION
Wireless LAN | Boter [Eeanitees
—— I Chamber 1 v Flag 1
. Chamber 2
Point Config g partable der Versij
o Cookie Controller ory Map Vi
HD@E' B EngineRm mware Verd
Digital Point S2fPAC mware Ver,
=7 i
‘fJxFFFF FO30 00BO Firmware Verg
s aloneR o l...‘_.‘ s e e

——

2. Inthe Device Name field, type the name or IP address of the controller (or choose it from the drop-down

list).

3. ClickCommunications and choose Network Security from the submenu.

| Inspect Opto 22 Device

Device Name: | 10,192,55.67

Metwork Security
Status Read

j Options »

- X

Status: | Metwork Security area last read at 07/05/16 11:11:21

Status Write Address | Description | Value | A
g PORTS
OxFFFF FO3A 0004  OptoMMP 2001
WCEESL D OXFFFFFO3A 0008 Modbus 502
OxFFFFFO3A 000C  SNMP 161
Paint Config OxFFFFFO3A 0010  FTP 21
OxFFFFFO3A 0074  Control Engine 22001
Digital Bank FTP LOGIM
— OxFFFF FO3D 0000 FTP Username
Digital Point OxFFFFFO3D 0040 FTP Password
Analog Bark BROADCAST FILTER
OxFFFF FO3A 0070 Stop incoming broadcasts No ea|
Analog Point P F_ILTERS
g OxFFFFFO3A 0020 Filter 0 - Address 0.0.0.0
High Density OxFFFFFO3A 0024 Filter 0 - Mask 0.0.0.0
OxFFFFFO3A 0028 Filter 1 - Address 0.0.0.0
EY— OxFFFFFO3A 002C  Filter 1-Mask 0.0.0.0
OxFFFFFO3A 0030 Filter 2 - Address 0.0.0.0
SqatchPad  * OxFFFFFO3A 0034 Filter 2 - Mask 0.0.0.0
OXFFFFFO3A 0038 Filter 3 - Address 0.0.0.0
Datalog * OxFFFFFO3A 003C  Filter 3 - Mask 0.0.0.0
OxFFFF FO3A 0040 Filter 4 - Address 0.0.0.0
PID » OFFFF FO3A 0044 Filter 4 - Mask 0.0.0.0
OxFFFFFO3A 0048 Filter 5 - Addrese 0.0.0.0
Events  » OxFFFF FO3A 004C  Filter § - Mask 0.0.0.0
OxFFFFFO3A 0050 Filter 6 - Address 0.0.0.0
Communications OxFFFF FO3A 0054 Filter 6 - Mask 0.0.0.0
OxFFFFFO3A 0058 Filter 7 - Address 0.0.0.0
Other  + OxFFFF FO3A 00SC  Filter 7 - Mask 0.0.0.0 v

Close |

Help |

Refresh |
Apply

™ Auto Refresh | 15000  msec

4. Tolimit access to a specific protocol, change the Port number in the Value column.

CAUTION: Ifyou change the Control Engine port to zero, a strategy that is already in the control engine will still
run, but PAC Display, PAC Control, and other hosts will not be able to communicate with it. See “Protecting a PAC

Control Strategy from Interference” on page 80.

5. Tosetupan FTP login, enter the Username and Password to be required from anyone who uses FTP to

access the device.
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6. To limit access to specific computers, set up to ten filter addresses and filter masks.

The filter address is the IP address that is allowed to access the controller; the filter mask indicates a range
of allowed addresses. If only one IP address may access the controller, enter 255.255.255.255 for the filter
mask. If a range of IP addresses may access the controller, enter a mask that reflects the subnet range.

For example, if only IP address 1.2.3.4 may access the controller, enter 1.2.3.4. as the filter address and
255.255.255.255 as the filter mask. If any IP address that starts with 1.2.3 may access the controller, enter
1.2.34 (or 1.2.3.1, or any address in the range) as the filter address and 255.255.255.0 as the filter mask.

NOTE: For troubleshooting purposes, you can use the Broadcast Filter value to temporarily turn off incoming
broadcasts to the controller. Normally you would NOT want to do this; a BootP response, for example, is an
incoming broadcast.

7. When all the values are correct, click Apply to send the configuration to the controller. If you changed a
port number, also restart the controller:

a. (lick the Status Write button in the upper left.
b. In the Operation Command list, highlight Restart Device from powerup.
c. (lick Send Command.

The device is restarted and a Success message appears.

LOGGING DATA FROM MEMORY MAP ADDRESSES

You can use a SNAP PAC R-series, EB, or SBI/O unit to log data from up to 64 memory map addresses. The data
from all addresses goes into the same data log file, which you can view from PAC Manager. For Ethernet-based
/0 units, data from this composite file can also be emailed to someone at a time interval you set. For a
complete list of memory map addresses, see the OptoMMP Protocol Guide (form 1465).

NOTE: Ifyou are using SNAP PAC-R with PAC Control, you may prefer to log data in a different way. For more
information about the controller’s file system, see page 217 and the PAC Control User’s Guide (form 1700).

Note that SNAP PAC brains cannot save logged data if power to the unit is cycled.

Configuring Data Logging

1. In PAC Manager, click the Open button g (or in the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
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LOGGING DATA FROM MEMORY MAP ADDRESSES

=8| PAC Manager - Main_Process - O *
File Edit Tools View Help

| Dies|d| *|%alal B

B Main_Process
=Bl /0 Units
20 Line_1

e
Preprocess

Ready [ N4

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up data logging
and choose Configure from the pop-up menu.

= Configure /0 Units *
Name | Type | Part | Address | watchdog | Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

Events » |
ScratchPad  » |

Communications » Others

__ oters—f— button

Coss | Hep |

4. (lick the Others button and choose Data Logging from the pop-up menu.
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#=#| Configure Data Logging X

Log Point
Mumber: |0 | [ Used

Since emails
Address | Description | Value | include values
AL from all memory
OxFFFF F300 0700 E-mail Enabled for all data logging Mo =] ) mapaddressesset
0xFFFF F300 0704 Number of Datalog entries per E-mail 0 up for data
TRIGGER logging, entriesin
OxFFFF F300 0000 Trigger ON 0x 00000000 00000000 this section apply
OxFFFF F300 0008  Trigger OFF 0x 00000000 00000000 ;
LOGGING toglldataloggmg
OxFFFFF300 0010 Address of value to log 0x FOADDDO0 points.
0xFFFF F300 0014 Data Format Float (0x66) =1
OxFFFF FOAQ 0000 Current Value M/A
0xFFFF F300 0018 Logging interval in miliseconds (0 = log once) 5000

OK | Cancel L\\S

Choose the lowest empty Log Point number from the drop-down list and click to put a check mark in the
Used box.

NOTE: To reduce scanning time, the I/0 unit stops scanning log points when it reaches an unused data logging
number. Make sure you use these numbers in order, starting with the lowest.

(Not applicable to SB brains) To have the data log emailed, click the Value column cell and enable email.
Also enter the number of data entries in the log you want each email message to contain.

A maximum of 140 log entries can go in each email. Remember that email applies to all points that are
logged, since all the data goes into one file.

In the Value column, click the cell and then enter the Scratch Pad On mask and Off mask to trigger this
data log point. Also enter the memory map address of the data you want to log and choose the format of
data in that address. Finally, enter how often data should be logged for this address, in milliseconds (to
log data just once, enter 0).

When all values are correct, click OK. Repeat from step 5 for additional log points.

Remember to also configure email to indicate where the data log should be sent. See page 100.
Configure other optional functions, or return to the PAC Manager main window and click the Save button
ﬂ to save the configuration file.

IMPORTANT: If you have changed the data logging interval, you must save the configuration file to flash
memory and restart the I/0 unit for the configuration to take effect.

When you are ready to upload the configuration file to the I/O unit, see page 68.

Reading the Data Log

The data log is a single file that records data from all the memory map addresses you have configured to log
data from (see steps starting on page 87). The data from up to 64 memory map addresses can be logged, and
all logged data is recorded in one file. The log file holds up to 300 lines of data; when it is filled, new entries
replace the oldest ones.

This composite log file can be viewed through PAC Manager. (On Ethernet-based I/0 units, it can also be
emailed to someone at regular intervals you set.) Each line in the log file consists of the date and time stamp,
the memory map address the data is coming from, the type of data, and the data itself.

1.

To view logged data, click the Inspect button Q in the PAC Manager main window.
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2. Inthe Device Name field, enter the name of the I/O unit or choose it from the drop-down list.
Click Data Log and choose Data Logging Samples from the pop-up menui.

23 Inspect 10 Unit E”§|E|

Device Name: |SB biain j Options ¥ Status:lData Logging Sample area last read at 10/03/07 16:48:16
Data Logging Samples
Statuz Read
Shatus Wiite # Address  YYYY-MM-DD HH:MM:3%5.hh  Src 4ddr  Type Data -~ Refresh |
- - 0 F3020000 2006-10-09 14:31:35.04  FOADO300  Float 28.412872
Point Config 1 F3020014 2006-10-09 14:31:39.04  FOAOO300  Float 28.379028
Digitsl Bank 2 F3020028 2006-10-09 14:31:40.04 FOA0O300  Float 28.345215
3 F302003C 2006-10-09 14:31:41.04 FOAOO300  Float 28.277527
Digital Paint 4 F3020050 2006-10-09 14:31:42.04  FOADO300  Float 28.277527
5 F3020064 2006-10-09 14:31:43.05 FOA00300  Float 28.226746
Analog Bank 6 F3020075 2006-10-09 14:31:44.05 FOA00300  Float 28.209839
p— 7 F302008C 2006-10-09 14:31:45.05 FOADO300  Float 28.192932
g P & F3020040 2006-10-09 14:31:46.05  FOADOZ00  Float 28. 159038
[T — 9 F30200B4 2006-10-09 14:31:47.05 FOA00300  Float 28.108307
GEEm D 10 F3020008 2006-10-09 14:31:45.05  FOA0D300  Float 28.125244
11 F30200DC 2006-10-09 14:31:49.05 FOA0D300  Float 28.074493
Scratch Pad  » 1z F30200F0 2006-10-09 14:31:50.05 FOA0D300  Float 25.057556
13 F3020104 2006-10-09 14:31:51.05 FOA0D300  Float 28.057556
Datalog  » 14 F3020118 2006-10-09 14:31:52.05 FOA0D300  Float 28.023712
=D N 15 F302012C 2006-10-09 14:31:53.05 FOA00300  Float 28.006805
16 F3020140 2006-10-09 14:31:54.05 FOA00300 Float 27.854523
Everts b 17 F3020154 2006-10-09 14:31:55.05 FOAOO300  Float 27.922211
18 F3020168 2006-10-09 14:31:56.05 FOA0D300  Float 28.074493
Communications » 19 F302017C 2006-10-09 14:31:57.05 FOA0D300 Float 28.142151
Other L 20 F3020190 2006-10-09 14:31:58.05 FOA0D300  Float 28.209839
z1 F3020144 2006-10-09 14:31:59.05 FOA00300  Float 28.277527
b d
Close Help

The log includes the following information:

Column Notes

Address of the data item within the data log itself. Data is logged in memory

Address map addresses F3020000-F302175C. Each data item takes 20 bytes.
YYYY-MM-DD Date the data was logged

HH:MM:SS.hh Time the data was logged

Src Addr Memory map address the data came from

Type Format of the data

Data Data from the memory map address. NOTE: -nan means “not a number” and

indicates that data is not in the form of an IEEE float.

Clearing All Data from the Log

1. Inthe PAC Manager main window, click the Inspect button Q
The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.
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- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

8 Inspect Opto 22 Device

Device Name: | 10.199.59.99

Status Read
Status Read

Status:

j Options »

Status Read area last read at 07/05/16 10:34:58

Status Write NS

DESCRIFTION

VALUE

~ Refresh |

0xFFFF F030
0xFFFF F030

| WirelessLAN ¢

: Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
| High Density
System 3
| ScratchPad  »
Data Log 3

FID 3

0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030

0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030

0xFFFF F030
0xFFFF F030

,-__,,,E“e\n-‘r"\__:..l_ A LOZFERFEQ 20038, # S noLMongie, e mmton pob e, 908 AGFAO0 QL A A st sl

0004
0008

0018
00oo
0230
001c
00RO
00BO

00z0
0080
0024
0025
00z2é
024C
002g

00ZE
0034

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress

PUC Receiwed (0}
a

R5.1c |
1

Flash Memory
29.5a
05/03/2016
15229232

0x0000007A
SHAP-FRC-R1
4

21

2008

R0.0a
33554432

00-A0-3D-01-85-3C
10.192.55.67

If you have configured six or more devices, the Inspect window provides two additional time-saving

features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons

and Most Recently Used list
are displayed when you have
six or more devices configured.

Wpto 22 Device

1_ [EngineRm
| Cail Portable
: SoftPAC

Boiler
Chamber 1
. Chamber 2
Point Config g partable

Wireless LAN

Digital Ban? EngineRm
o SoftPAC

Cookie Controller

Cookie Controller

(CRIFTION

rerup Clea
¥y Flag 1

der Versij
ory Map Vi
mware Verg
mware Ver:

igital Point = 1
0xFFFF F030 00BO Firmware Verg

In the Device Name field, type the name (or IP address) of the 1/0 unit or choose it from the drop-down

list. Click Status Write.
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| Inspect Opto 22 Device

Device Name: | 10,192,55.67

Sl
Status Read
Status Write

Wireless LAN ¥

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

j Options » Status: | Status Write area last read at 07/05/16 11:15:33
tatus Write
Address | Description | Value ~ Refresh |
OxFFFF FO38 0004 Always BootP /DHCP On Powerup Mo JEa |
OxFFFF FO38 0008 Degrees F/C DegreesF id | Apply
0xFFFF FO38 0010 Comm Watchdog Time {msec), 0 = Disable 1]
0xFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250
OxFFFF FO38 0018  TCP Initial Retransmission Timeout (msec) 3000
0xFFFF FO38 001C TCP Retransmission Attempts 5
OxFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1
OxFFFF FO38 0050 Max Analog and High Density Digital Scan Interval {msec) 1000
OxFFFF FO38 0298 Out Of Range Value (16-Bit) -32768.000
OxFFFF FO38 02B0  Out Of Range Value (32-Bit) -2147483545.000
0xFFFF FO38 0054  Scanner Flaos 0x 00000000 v

Operation

System  *
ScratchPad  »
Datalog *
PID 3
Events 3
Clear Data Logging Samples — Commnications »| | |

Store configuration and IP settings to micraSD A Send Command
Erase configuration and IP settings from microSC
Erase firmware from microSD
Erase strategy from microSD
Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration
Clear Alarm Events configuration
Clear PPP configuration
Clear E-mail configuration |}
Clear PID Loops configuration
p Clear Data Logging samples

command Other ¥

Send powerup dear [v]

Close | Help |

™ Auto Refresh | 15000  msec

3. Inthe Operation Commands list, scroll down and click to highlight Clear Data Logging Samples. Click

Send Command.

The data log is cleared and a Success message appears.

CONFIGURING EVENT MESSAGES

(Not available on SNAP PAC SB brains.) You may need to send a message—uvia email, data streaming, SNMP, or
a serial module—from an 1/0 unit or a controller when a specific event occurs. For example, you could send a
message if a digital point is on, if an analog point reaches a certain value, if a specific string is received through
aserial module, or if a variable contains a specific value. You can send one type of message or more.

NOTE: You must be using a PAC Control strategy or PAC Manager R9.0a or higher to configure event messages in this
way. In the PAC Control strategy, your flowchart monitors the event and triggers the message using the command
Set I/0 Unit Event Message State. Messages must be configured before they can be used in PAC Control.

Ifyou are NOT using a PAC Control strategy or are using a PAC Manager version less than R9.0, you cannot configure
event messages in a configuration file. You must configure them using Inspect mode. See page 141.

Follow these steps to configure up to 128 event messages for use with a PAC Control strategy.
1. In PAC Manager, click the Open button g (or in the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
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=8| PAC Manager - Main_Process - O *
File Edit Tools View Help

| Dies|d| *|%alal B

B Main_Process
=Bl /0 Units
20 Line_1

e
Preprocess

Ready [ N4

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up event
messages and choose Configure from the pop-up menu.
For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an I/0 unit
of the type Generic OptoMMP Device with the loopback address (127.0.0.1).

= Configure /0 Units *
Name | Type | Part | Address | watchdog | Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

Coss | Hep |

4. (lick the Events button and choose Event Messages from the pop-up menu.
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= Configure Event Messages *

£ | Message Mame | Message Text | ~ Modify... |

a
1
2
3
q
5
[
7
3
9
10
11 A
Close I Help
5. Highlight an empty message number in the list and click Modify.
=] Add Event Message #0 by
A Message MName: ||
B Message Text:
C ————— scratch Pad Trigger ON Mask: Ox I 00000000 00000000
Scratch Pad Trigger OFF Mask: 0x I 00000000 00000000
D ———— [ Streaming —SNMP Trap

IDisabIed vI Period (sec): I 0 IDisabIed ;I—— H

E —— [E-mail Period (sec): IU
IDisabIed vI Period (sec): I 0
Trap Type: I a

F ———— [~ Serial Module

Priarity: IH' h vI
IDisabIed vI Serial Ports Mask: Ox I ty g

G ———— MemMap Copy Destination

IDisabled vI MemMap Address: Ox I Period (msec): I a
IF Address: I . . . Part: 2001

0K I Cancel | Help |

6. Complete the fields as follows:
A—Message Name. Enter a name for the message.

B—Message Text. For an email or serial message, and optionally for an SNMP message, enter the
message text. Message text is not sent in the streaming packet.
C—Message text is limited to 127 characters. You can place data from the I/O unit's memory map into

the message by using a plugin (see page 95). If you are sending a serial message, make sure the text is
formatted so the serial device that receives it will understand it.
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D—Scratch Pad. To trigger bits in the Scratch Pad, enter the On and Off masks to set.

E—Streaming. To send a stream of data as the message, choose Enabled from the drop-down list.
Enter how often in seconds to send the stream (0 sends it only once).

F—E-mail. To send an email message, choose Enabled from the drop-down list. Enter how often in
seconds to send the email (0 sends it only once).

G—Serial Module. To send a message through a serial module to a serial device, choose Enabled from
the drop-down list. Enter a mask representing the modules and ports to receive the message.

H—Mem Map Copy Configuration. To copy memory map data, see page 109.

|—=SNMP Trap. To send an SNMP trap as the message, choose Enabled from the drop-down list. Enter
how often to send the trap (0 sends it only once). Also enter the trap type (determined by your SNMP
management software). If you are using SNMP with outgoing PPP and want the trap stored in the I/O
unit until the next communication, set Priority to Low. If you want the 1/0 unit to immediately dial out
and send the trap, set Priority to High.

NOTE: SNMP messages must be acknowledged. If the Period is set to more than zero, the alarm will continue to
be sent until the trap is acknowledged and the Scratch Pad trigger is reset to zero.

In PAC Control, you can use the command Set I/O Unit Event Message State to build the acknowledgment into
the flowchart logic.

In PAC Manager, you can acknowledge the trap and reset the Scratch Pad by using Inspect > Events > Event
Messages (change State to Acknowledged and reset Scratch Pad bits).

7. When all fields are correct, click OK.
8. When you have configured all event messages, click Close.
9. Foreach type of message you configure, make sure you also set up basic configuration:

Serial: page 46
SNMP: page 96
Email: page 100
Streaming: page 104

10. Configure other optional functions, or return to the PAC Manager main window and click the Save button
Il | to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/0O
Unit"on page 68.

USING PLUGINS

Several plugins are available for use in event messages and memory map copying. The following table guides
you in using them.

To do this Use this plugin In these places See

Include the pattern string from a

. . $! str Serial messages page 92
serial communication module. - -

Show which serial port sent the

. .
R HirE $! port_ Serial messages page 92
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To do this Use this plugin In these places See

Include data from a memory map
address.

X = type of data (S=string Event messages

representation of the data, S1X YYYYYYYY Memory ma page 92
D=integer, F=float, P=IP address, = ~ coovin ymap page 109
B=4 binary bytes) pying

YYYYYYYY = memory map address

(see examples below)

Number emails with a sequence ID  $! seqid Email messages page 92
Turn digital points on or off using a §#x00000000 Memory map page 109

bit mask copying

NOTE: Foremail messages, message text including plugins must be 127 bytes (characters) or less. The message length
after all plugins have been expanded into their data values must be 255 bytes or less.

Examples

Including Data from Memory Map Addresses

For the complete list of memory map addresses, see the appendix in the OptoMMP Protocol Guide
(form 1465).

Here are a couple of examples:

To include the on/off state of a switch on module 0, point 3, you would put this in the message:
$!D F08000CO

To include the temperature of an ICTD input on module 4, point 0, you would use:

$!F FOA00400

Sending Binary Data in Event Messages

To send binary data in the text of an event message, begin with s#x and end with _.You can include any
number of ASCII hex digits up to the 127-byte limit for the message field. You can also include multiple &itx
plugins. This plugin is resolved after all other plugins have been resolved, and only just before sending the
contents of the message field out of the specified serial ports. Examples:

To include an embedded null (one binary character):
&#x00_

To include a number of binary characters:

&#x0a0dCF0034

CONFIGURING SNMP

(Not available on SB brains) The Simple Network Management Protocol (SNMP) is used to communicate
with an SNMP-based enterprise management system, such as Computer Associates' Unicenter®,
Hewlett-Packard's OpenView®, or IBM's Tivoli®, over Ethernet. These enterprise management systems can
manage analog, digital, or serial devices through a SNAP PAC controller or I/O unit just as they manage
computer equipment on the Ethernet network.
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SNMP Traps

You can set up the controller or I/0 unit to send messages to the management system in the form of SNMP
traps. The device can send three kinds of traps:

«  Authentication trap—sent when a host requests data that is outside its access permissions
»  Cold start trap—sent whenever the I/O unit is tured on
«  Exception trap—sent in reaction to an event; an exception trap is a type of event message.

Authentication and cold start traps can be enabled using the steps in this section. To configure exception
traps, see “Configuring Event Messages”on page 92.

SNMP Access Privileges

Community groups control access to SNMP information from the controller or 1/0 unit. When you set up a
community group, you determine its privileges to read, write to, and receive traps from the system.

In order to receive traps, a host must be a registered management host and be part of a community group that
has access privileges for traps. Once a registered management host becomes part of a community group, that
group is no longer available to non-registered hosts. It includes only the hosts registered to it.

To set up community groups, follow the steps in this section. You can define up to eight community groups.

Configuring the SNMP Agent

1. In PAC Manager, click the Open button El (orin the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it.

=8| PAC Manager - Main_Process - O *
File Edit Tools View Help

| Dies|d| *|%alal B

e
Preprocess

Ready [ N4

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up SNMP and
choose Configure from the pop-up menu.

For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an I/O unit
of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
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= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |
PID Loops... |
Modules 4 |
Events 4 |
ScratchPad  # |
Communications H—— Communications
Tem T | button

Close I Help |

4. Make sure the correct I/0O unit is highlighted in the list. Click the Communications button and choose
SNMP from the pop-up menu.

=8| Configure SNMP Agent >
—System Traps
A—. SysMame: I Version: |v1Tra|:| vl — F
B SysLomﬁon:l Destination I 162 — G
[ Authentication Trap H
C ——— SysContact: I [ Cold Start Trap
D — Community Groups
# | String | Read | write | Trap | A
a
1
2
3 W

E — Management Hosts
£ | Community String | Host IP Address | ~

LRSI S e =}

oK I Cancel | Help

5. Complete the fields as follows:

A—SysName. Enter the name assigned to the I/0 unit as a managed node within the SNMP
management system.

B—SysLocation. Enter the physical location of the I/0 unit.

C—SysContact. Enter the ID of the contact person for the /0 unit.
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D—Community Groups. To set up the Community Groups you need, highlight a line in the list. Click
the String cell within the line and type the name of the group. Then click in the Read, Write, and Trap cells
and choose Yes or No from the drop-down list to indicate whether that group has privileges to read,
write, and receive traps.

E—Management Hosts. To set up Management Hosts, highlight a line in the list. Start with hosts on
the local network first, because the system sends messages to hosts in numeric order. Click the
Community String cell and enter the name of the community group the host belongs to. Click the Host IP
Address cell and enter its IP address, including the dots (for example, 10.192.55.60).

F—Version. From the drop-down list, choose the version of SNMP you are using.

G—Destination Port. 162 is the default port for SNMP traps. If you know that your application will use
a different port, enter the number of that port here.

H—Authentication/Cold Start Trap. To enable authentication or cold start traps, click the box to
checkit.

6. When all fields are correct, click OK.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the I/O unit, save it
to flash memory, and restart the /0 unit.

7. Configure other optional functions, or return to the PAC Manager main window and click the Save button
Il | to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit"on page 68.

CONFIGURING DNS SERVERS

If you want to use host names in PAC Control comm handles or in SMTP messaging configuration, use the
DNS Resolver to designate one or two DNS servers to resolve host names into IP addresses. The servers are
queried one at a time in the order listed.

1. InInspect mode, click the Communications button and choose DNS Resolver from the pop-up menu.

| Inspect Opto 22 Device EI:_EF'

Device Name: | 10,192.54.110 j Options * Status: |SSI Module area last read at 06/14/12 13:40:24

DMS Resolver
Status Read

o Address | Description | Walue | | Refresh |
Status Write DSFFFFFBT00T00  Reties 1
O+FFFF FE100104  Timeout 2 Apply
Wireless LAN  »

DMS Address Servers In Use
OxFFFF FE10 0300 DNS Address Server #0 0.0.0.0

Point Config OxFFFF FE10 0304 DNS Address Server #1 0000
Digital Bank e
) . TR F st P enanipisen Q"“ W AT m il

0.0.0.0 indicates that the DNS
server is not being used.

2. Toadda DNS server address or to change the Retries or Timeout, click the appropriate value in the Value
column. When you have finished changing values, click Apply.

3. When you have finished changing values, click Apply.

The values are sent to the controller and stored to flash memory. Then you are prompted to restart the
controller.
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4. Restart the controller to use the new configuration.

CONFIGURING EMAIL

(Not available on SB brains) You can send an email message or page someone in response to an event. Follow
the steps in this section to set up email parameters. See “Configuring Event Messages”on page 92 to set up
the message itself.

1. In PAC Manager, click the Open button El (or in the menu bar, click File > Open).

2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

=8| PAC Manager - Main_Process - O *
File Edit Tools View Help
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3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up email and
choose Configure from the pop-up menu.
For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an I/O unit
of the type Generic OptoMMP Device with the loopback address (127.0.0.1).
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= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |
PID Loops... |
Modules 4 |
Events 4 |
ScratchPad  # |
Communications H—— Communications
Tem T | button

Close I Help |

Make sure the correct I/0 unit is highlighted in the list. Click the Communications button and choose
E-mail from the pop-up menu.

=] Configure E-mail >
—SMTP Server
A ——— [P Address: I | . . Port: | 25
B— Timeout {miliseconds): I 30000

r—E-mail Header

From: I
D — | To: I
E—— Subject: I

0K I Cancel Help

Complete the fields as follows:

A—IP Address. Enter the IP address and port number of the Simple Mail Transfer Protocol (SMTP)
server the 1/0 unit will use to send email. You should be able to get this information from your network
administrator.

B—Timeout. Enter the length of time in milliseconds the I/0 unit should wait for a response from the
email server. The default is 30,000.

C—From. Enter avalid email address that will identify the /0 unit to the person who receives the email.
D—To. Enter the email address of the person who will receive the email.

E—Subject. Enter a phrase that will indicate the purpose of the email to the person receiving it. Note
that this subject line applies to all email messages sent by this /O unit. Plugins can be used in this field.
For example, if a similar email will be sent at intervals (such as an email of the data log), you can use the
seqid plugin to put a sequence number at the end of each subject line. This plugin is in this format:
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$! seqgid
So, forexample, if you enter Process Data Log $! seqgid_ inthe subject field, the first
email message will have a subject line of Process Data Log 0, the next message will have a
subjectline of Process Data Log 1,andsoon. Forinformation on other plugins, see “Using
Plugins”on page 95.

6. When all fields are correct, click OK.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the I/O unit, save it
to flash memory, and restart the I/O unit.

7. Configure other optional functions, or return to the PAC Manager main window and click the Save button
El to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit"on page 68.

SETTING UP INITIAL VALUES IN THE SCRATCH PAD AREA
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Before you use this section, read “Event/Reaction Concepts”on page 127.

To set initial Scratch Pad values and save them as part of the configuration file, follow these steps. (To see
Scratch Pad values or change them in real time, see “Reading and Writing to the Scratch Pad Area”on
page 184.)

1. In PAC Manager, click the Open button El (or in the menu bar, click File > Open).

2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to openit.

=8| PAC Manager - Main_Process - O *
File Edit Tools View Help
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3. Ifyouareusinga SNAP PAC S-series or SoftPAC controller, configure an I/0 unit to represent the controller
for Scratch Pad purposes. Configure this 1/0 unit as a Generic OptoMMP Device, using the loopback
address (127.0.0.1). (Do not add any points or configure other features.)

4. Inthe configuration tree, right-click the name of the I/0 unit on which you want to configure the Scratch
Pad and choose Configure from the pop-up menu.
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= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |
PID Loops... |
Modules 3 |
Events 3 |
ISy —— ~craich Pad
o | button
Communications »
Others 3 |

Close I Help |

5. Make sure the correct I/0O unit is highlighted in the list. Click the Scratch Pad button and choose Bits,
Integers, Floats, or Strings from the pop-up menu.

Scratch Pad Bits

=8| Configure Scratch Pad Bits by
[~ Used

Address | Description | Value |
DIRECT ACCESS

OxFFFF FODSE 0000 Scratch Pad Bits Ox 00000000 00000000
MOMO ACCESS

0xFFFF FOD3 0400 OM Mask Ox 00000000 00000000

0OxFFFF FOD3 0408 OFF Mask Ox 00000000 00000000

oK I Cancel |

1. Clickto put a check mark in the Used box.

2. Clickthe cell in the Value column to set initial values for either the bits in the Direct Access area or the
MOMO masks in the MOMO Access area.

3. (lickOK.

Scratch Pad Integers, Floats, or Strings

The Configure Scratch Pad Floats dialog box is shown as an example. The dialog boxes for strings, 32-bit
integers, and 64-bit integers are similar.
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x

#=#| Configure Scratch Pad Fleoats

Used | Address | Value | ~ Select Al

D u] 0xFFFF FODE 2000 u] | I
D 1 0xFFFF FOD& 2004 Unselect Al
Clear al

(I DxFFFF FODS 2008
sz DxFFFF FODE 200C
O DxFFFF FODS 2010
s DxFFFF FODA 2014
Os DxFFFF FODS 2013
Oz DxFFFF FODS 201C
s DxFFFF FODS 2020
O« DxFFFF FODA 2024
[1 10  oxFFFF FODS 2028
[111  OxFFFF FODS 202C
[11z  0xFFFF FODS 2030
[113  OxFFFFFODS 2034
[114  0xFFFFFODS 2033
[115  OxFFFF FODS 203C
[115  0xFFFF FODS 2040

oK | Cancel

[ [y o R - R o [ [ o R o B o [ [ o R e B (N R e R |

1. Foreach integer you want to use, click to put a check mark in its box in the Used column. Click the cell in
the Value column and enter the initial value.

2. Repeat for each integer. When all integers have been set, click OK.

CONFIGURING STREAMING

104

(Not available on SB brains) Most Ethernet communication involves the two-step process of request and
response. A faster way of getting information from the 1/0 unit, however, is by streaming data. Streaming does
not use TCP/IP; it uses the User Datagram Protocol (UDP/IP) instead.

NOTE: Because Modbus/TCP runs on TCR not UDP, streaming data via Modbus/TCP is not possible. However, you can
stream to a non-Modbus host at the same time you are using the Modbus/TCP protocol for another purpose.

Streaming is a fast way to get continuous data from the I/O unit and is ideal for data acquisition applications.
When it streams, the system sends data at regular intervals to specified IP addresses. You set up the interval,
the IP addresses to receive the data, and (optionally) the port number. The system sends the data at the
specified interval. The communication is one-way; the system does not wait for a response.

CAUTION: If you stream to multiple IP addresses, and one or more of the streaming targets is either offline or not
running the application that receives the stream, delays may occur. If a target is offline, the I/O system will stop
streaming while it tries to resolve the IP address. If the application is not running on the computer that receives the
stream, the computer will send the I/0 system an error message; if the stream occurs frequently, the additional error
messages can slow down the network.

Streaming involves two steps: setting up parameters on the I/0 unit for streaming, and receiving data in your
application. Follow the steps in this section to set up the parameters. For information on receiving data in your
application, see the OptoMMP Protocol Guide (form 1465).

1. In PAC Manager, click the Open button g (or in the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
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In the configuration tree, right-click the name of the I/O unit on which you want to set up streaming and
choose Configure from the pop-up menu.

= Configure /0 Units *

Mame | Type | Port | Address | Watchdog Description Add... |
Line_1 SMAP-PAC... Ethernet 10.192.55... Disabled
Preproces SNAP-PAC... Ethernet 10.192.55... Disabled Modify. .. |

Events 3 |

(o= 7

MI_ Communications
s » | button

Coss | Hep |

Make sure the correct I/0 unit is highlighted in the list. Click the Communications button and choose
Streaming from the pop-up menu.
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#=#| Configure Streaming X
A Enable Streaming: _ - Target Device Information
B Port: 5001 I E
Enable If0 Mirroring:  |Ma -
Stream Target #1: . . . —F
Source Memory Map Information Stream Target #2: , , ]
C Interval {miliseconds): | 1000 Stream Target #3: . . .
Stream Target #4: . . .
D — |  use Default Streaming Area

Stream Target #5: l—
Ii Stream Target #6: l—
Iﬂi Stream Target #7: l—
Stream Target #3: l—

" Specify Streaming Area

0K | Cancel | Help |

5. Complete the fields as follows:
A—Enable Streaming. To enable streaming, choose Yes from the drop-down list.

B—Enable I/0 Mirroring. /0 mirroring is a separate function. It's generally not a good idea to use
both streaming and mirroring on the same 1/0 unit. See “Mirroring /0 Point Data”on page 107 for more
information.

C—Interval. Enter how often in milliseconds you want the I/0 unit to send the streamed data. If you
are configuring streaming to use only as an event message, set the streaming interval to 0. Zero means
that the stream will be sent only once.

D—Use Default Streaming Area. To stream all addresses in the Streaming section of the I/0 unit's
memory map, click Use Default Streaming Area. For more information, see the memory map appendix in
the OptoMMP Protocol Guide (form 1465). (Note that the Streaming section does not include data from
high-density digital modules.)

To stream only part of the Streaming section, or to stream a different part of the memory map, click
Specify Streaming Area. Enter the starting address in the Memory Map Address field (the address must be
entered in hex), and enter the size in bytes of the data to stream in the Size Of Data field.

E—Port. Enter the port on the computers or devices that receive the streamed data. Your application
must refer to this port number. Use the default of 5001 unless you know it is already being used for
another purpose.

F—Stream Target. Enter the IP addresses of up to eight devices to receive the streamed data.

6. When all fields are correct, click OK.

7. Configure other optional functions, or return to the PAC Manager main window and click the Save button
ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit"on page 68.
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MIRRORING I/0 POINT DATA

(Not available on SB brains) Mirroring 1/0 point data is a way to automatically change all the points on one I/O
unit to match all the points on another I/0 unit. A simple example of mirroring is controlling whether lights in
one facility are on or off by having them mirror the on or off status of switches in another facility.

Mirroring reads the current analog bank values (in Engineering Units) and the current digital bank status
(4-channel digital modules only, not high-density digital modules) of the points on a system and writes the
data to the same point numbers on a second system. The reading and writing occurs as often as you specify.
In our lighting system example, the status of switches in Facility A could be read every minute and
automatically written to the lights in Facility B. When someone turns on the switches in Facility A, the lights in
Facility B would automatically be tured on within a minute.

It's generally not a good idea to use both mirroring and streaming on the same 1/0 unit. If you do use both,
streaming target #1 will receive both mirroring and streaming packets; the streaming packets are ignored, but
they unnecessarily add to network traffic.

NOTE: Due to the size limit of the mirroring packet, mirroring for digital points occurs on the first 32 points of the I/0O
unitonly (points on the modules in positions 0—7). Mirroring cannot be used with high-density digital modules.

Follow these steps to set up I/0 point data mirroring:
1. In PAC Manager, click the Open button El (orin the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
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3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set up mirroring and
choose Configure from the pop-up menu.
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= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |
PID Loops... |
Modules 3 |
Events 3 |
ScratchPad  » |

Communications Communications

Others 3 | button

Close I Help |

4. Make sure the correct I/0O unit is highlighted in the list. Click the Communications button and choose
Streaming from the pop-up menu.

=8| Configure Streaming >

Enable Streaming: Im 'I —Target Device Information
B Port: I 5001 +—D
Enable If0 Mirroring:  |Mo -
Stream Target #1: I . . . —— E
—Source Memory Map Information ———— Stream Target #2: I } . )
C——— | Interval (miliseconds): I 1000 Stream Target #3: I . . .
Stream Target #4: I . . .
Stream Target #5: I . . .
"~ Specify Streaming Area
Stream Target #6: I . . .
MemiMap Address; Dxl
IU— Stream Target #7: I . . .
Stream Target #8: I . . .

¢ Usge Default Streaming Area

Size of Data;

0K I Cancel | Help |

5. Complete the fields as follows:
A—Enable Streaming. Streaming is a separate function. It's generally not a good idea to use both
streaming and mirroring on the same /0 unit. See “Configuring Streaming”on page 104 for more
information.
B—Enable I/0 Mirroring. To enable mirroring, choose Yes from the drop-down list.

C—Interval. Enter how often in milliseconds the data should be mirrored.

D—Port. Enter the port number. This is the primary port number used to communicate with the 1/0
unit. The default shown is 5001; enter 2001 instead. (Exception: if you changed the MMP port for security
reasons, use the number you changed it to.)
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E—Stream Target. Enter the IP address of the I/0 unit to receive the mirrored data.

CAUTION: Since all digital and analog points are mirrored, make sure that the points on the second /O unit are
configured to accept the values that will be written to them.

6. When all fields are correct, click OK.

7. Configure other optional functions, or return to the PAC Manager main window and click the Save button
Il | to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/0O

Unit"on page 68.

COPYING MEMORY MAP DATA

(Not available on SB brains) You can use memory map copying to do the following:
»  Copydata on the same /O unit

«  Copy data to a memory map location on another unit

Copying Binary or Memory Map Data on the Same I/0 Unit

You can copy data on the same I/0 unit, for example to write the value of an analog point to another analog

point.

1. Follow the steps in “Configuring Event Messages” on page 92 until you reach the Add Event Message #

dialog box.

=8| Add Event Message #0

Message Name: I |

Message Text:

Scratch Pad Trigger ON Mask: 0x I 00000000 00000000

Scratd'1PadTriggerDFFMask:Ux| 00000000 00000000

—Sireaming

IDisabIed vl

—SNMP Trap

Period (sec): I 0

r— E-mail

IDisabIed vl

Period (sec): I 0

— Serial Module

IDisabIed vl

Serial Ports Mask: 0x I

[pisabled =l
Period (sec): ID—
Trap Type: ID—
Priority: Im

C — MemMap Copy Destination

IDisabIed vl MemMap Address: Ox I Period (msec): ID
I - - - Port: I 2001

IF Address:

[ o 1]

Cancel | Help |

2. Complete the fields as follows:
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A—Message Name. Enter a descriptive name for the message.

B—Message Text. In the Message Text section, enter a plugin containing a memory map address to
write from (the source address), in the following format:

$1B_FOB00000_

$!indicates the start of the / Data \

. Address  _indicates the end of the plugin
plugin format

or a four-byte constant, in this format:
&#x00000001
Constants must be written in exactly four bytes (8 characters).

While the data format indicator in the plugin can be other types (D=integer, F=float, B is typically used
for memory map copying. The other types copy a string representation of the data, since plugins are
primarily used for generating messages and emails.

C—MemMap Copy Destination. In the MemMap Copy Destination area, choose Enabled from the
drop-down list. Enter the Memory Map Address you are copying to (the destination address) as an
eight-digit hex number (the last eight digits of the address, for example, F0B00040). In the Period field,
enter how often to send the data, in milliseconds.

Since the points you are copying to are on the same I/O unit, type 0.0.0.0 forthe IP Address, and
ignore the TCP port field.

When all fields are correct, click OK.

Configure other optional functions, or return to the PAC Manager main window and click the Save button
ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/0
Unit"on page 68.

Copying Binary or Memory Map Data to a Different 1/0 Unit

You can also copy data to an address on a different system. Configure the event message in the source system
(the one you are copying from), but make sure that any points you are affecting on the destination system are
configured to accept the data.

Follow the steps in “Configuring Event Messages”on page 92 until you reach the Add Event Message #
dialog box.
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=5 Add Event Message #0 X

Message Mame: ||

Message Text:

Scratch Pad Trigger ON Mask: 0x | 00000000 00000000

Scratch Pad Trigger OFF Mask: 0x | 00000000 00000000

Streaming SMNMP Trap

Disabled  ~ Period (sec): | 0 |Disabled |

E-mail Period (sec): |0
Disabled - Period (sec): | 0
Trap Type: a

Serial Module

Priority: High
Disabled - Serial Ports Mask: 0x 2

MemMap Copy Destination

Disabled »| MemMap Address: 0x Period (msec): |0
IP Address: . . . Port: 2001

0K | Cancel | Help |

Complete the fields as follows.
A—Message Name. Enter a descriptive name for the message.

B—Message Text. In the Message Text section, enter a plugin containing a memory map address to
write from (the source address), in the following format:

$1B_FOB00000_

$!indicates the start of the / Data

. Address  _indicates the end of the plugin
plugin format

or a four-byte constant, in this format:
&#x00000001
Constants must be written in exactly four bytes (8 characters).
While the data format indicator in the plugin can be other types (D=integer, F=float, B is typically used

for memory map copying. The other types copy a string representation of the data, since plugins are
primarily used for generating messages and emails.

C—MemMap Copy Destination. In the MemMap Copy Destination area, choose Enabled from the
drop-down list. Enter the Memory Map Address you are copying to (the destination address) as an
eight-digit hex number (the last eight digits of the address, for example, F0B00040). In the Period field,
enter how often to send the data, in milliseconds.
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Also enter the IP Address and TCP port for the I/0 unit whose point you are copying to (the destination
system). TCP port is usually 2001.

3. When all fields are correct, click OK.
4. Configure other optional functions, or return to the PAC Manager main window and click the Save button
El to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit"on page 68.

CONFIGURING MODBUS OPTIONS

(Not available on SB brains) If you are using Modbus/TCP to communicate with a SNAP PAC device, see the
Modbus/TCP Protocol Guide (form 1678).

Using PAC Manager, you can change the Modbus float format. In addition, if you need to read or write data in
areas of the device's memory map that are not included in the Modbus memory map (shown in the protocol
guide), you can use PAC Manager to determine the Modbus Unit ID and Register Address that are equivalent
to the memory map address you want to use.

Changing Modbus Float Format

1. In PAC Manager, click the Open button El (or in the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
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3. Inthe configuration tree, right-click the name of the I/0 unit on which you want to change Modbus float
format and choose Configure from the pop-up menu.

For a SNAP PAC S-series or SoftPAC controller, if it does not already appear in the list, add it as an I/0 unit
of the type Generic OptoMMP Device with the loopback address (127.0.0.1). (Do not add any points.)
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= Configure /0 Units *
Mame | Type | Port | Address | Watchdog | Description Add... |
Line_1 SMAP-PAC... Ethernet 10,192,55... Disabled
Preprocess  SNAP-PAC... 10.192,55... Disabled Modify... |

Delete |
Import/Copy... |

10 Points... |
PID Loops... |
Modules 3 |
Events L4 |
ScratchPad  » |
communications »f——— Communications
Tem T | button

Close I Help |

4. (lick the Communications button and choose Modbus from the pop-up menu.

=] Configure Modbus by
[~ Used
Address | Description | Value |
MODBUS
0xFFFF FO39 0000 Modbus 32-bit Float Format Big Endian |

OK I Cancel | Advanced |

5. Clickto place a check mark in the Used box. In the Value column, click the value shown for float format.
Choose the format you want from the drop-down list.

NOTE: Word swapped is still Big Endian, but places the most significant bit in the most significant register.

6. When the value you want is shown, click OK.
7. Configure other optional functions, or return to the PAC Manager main window and click the Save button
ﬂ to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit"on page 68.

Determining Modbus Unit ID and Register Address

If you need to read or write data to the device’s memory map in areas not included in the Modbus memory
map, you can use PAC Manager to convert memory map addresses to Modbus Unit ID and Register Addresses,
or vice versa. For more information, see the Modbus/TCP Protocol Guide (form 1678).
1. Determine the device’s memory map address (or the Modbus Unit ID and Register Address) you want to
convert.
To find out the memory map address, you can use the memory map appendix in the OptoMMP Protocol
Guide (form 1465), or you can copy and paste the address from the Inspect dialog box in PAC Manager.
2. Inthe PAC Manager main window, with a configuration file open, right-click an /0 unit and choose
Configure from the pop-up menu.
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3. Inthe Configure I/0 Units dialog box, click the Communications button and choose Modbus from the

pop-up mendu.
=] Configure Modbus by
[ Used
Address Description | Value |
MODBUS
0xFFFF FO39 0000 Modbus 32-bit Float Format Big Endian |

OK | Cancel | Advanced

4. (lickthe Advanced button to see the rest of the dialog box.

= Configure Modbus .4
™ Used
Address Description Value ]
MODEBUS
OxFFFF FO39 0000 Modbus 32-bit Float Format Big Endian =

[~ Address Conversion

Opto 22 Memory Map Address (Valid range FO00 0000 to F1EB FFFE)
To convert to Modbus address

Forexample: FoD&8 1000

g'||1|1|'|§l]|0|l}|0 1|‘F|0|1 ‘F|0|0|0§ 0|0|0|1 0|0|0|0-0|0|0|0 0|0|0|§

8 bits. 16 bits
011011000 000100000000000¢0
Convert to decimal I:? Convert to decimal
108
Add2 +2
Medbus: UnitlD 110 Register Address 2048

For applications that use Register Number
instead of Register Address, convert

the address to a Register Number: Add1  +1

Medbus: UnitlD 110 Register Number 2049
Note:Modbus Register Numbers start at 1, but the c ponding Register Add
startat 0. For ple, Register Number 2049 is at Register Address 2048.

Modbus Unit ID:
MemMap Address: Uxi 4|
Register

x| _on |

5. To convert an I/O unit memory map address to a Modbus Unit ID and Register Address, type the last
eight digits of the 1/0 unit's memory map address in the MemMap Address field.

Make sure there are no spaces in the address (for example, type F0300020).
6. Click the right-arrow button | »

The equivalent Modbus address appears. Note that the Modbus numbers are decimal.
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= Configure Modbus .4
™ Used
Address Description Value J
MODEBUS
OxFFFF FO39 0000 Modbus 32-bit Float Format Big Endian =

[~ Address Conversion

Opto 22 Memory Map Address (Valid range FO00 0000 to F1EB FFFE)
To convert to Modbus address

Forexample: FoD&8 1000

!'||1|1|'|§l]|0|l}|0 1|‘F|0|1 ?|0|0|01; 0|0|0|1 0]0|0|0-0|0|0[0 c|o|n|ﬂ
8 bits 16 bits
011011000 000100000000000

Convert to decimal Convert to decimal
108
Add2 +2
Medbus: UnitlD 110 Register Address 2048

For applications that use Register Number
instead of Register Address, convert
the address to a Register Number: Add1  +1 Memory map

address (in hex)

Medbus: UnitlD 110 Register Number 2049

N Modbus Bes

q start at 1, but the ¢
start at 0. For example, Register Number 2049 is at Regi:

Modbus UnitID: | 5 .
| Equivalent Modbus

Geml\"lap Address: Uxi FOO753E4

Egister [455%4 | address (decimal)
oK | Cancel ] Basic

7. To convert from Modbus to a memory map address, type the Unit ID and Register Address and click the
left-arrow button.

The equivalent memory map address appears.

SETTING UP SYSTEM DATE AND TIME

SNAP PAC devices have a built-in clock. The clock is set at the factory before the device is shipped to you. If
necessary, you can set the date and time on an 1/0 unit by following these steps. (For a SNAP PAC S-series
controller, see “Reading System Date and Time”on page 184.)

NOTE: If you are using PAC Control and want to synchronize the I/0 unit’s time with your computer’s time, don’t use
these steps, instead, follow the instructions in the PAC Control User’s Guide (form 1700).

1. In PAC Manager, click the Open button g (or in the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
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SETTING UP SYSTEM DATE AND TIME

=8| PAC Manager - Main_Process - O *
File Edit Tools View Help

| Dies|d| *|%alal B

B Main_Process
=Bl /0 Units
20 Line_1

e
Preprocess

Ready [ N4

3. Inthe configuration tree, right-click the name of the I/O unit on which you want to set the time and date
and choose Configure from the pop-up menu.

= Configure /0 Units *
Name | Type | Part | Address | watchdog | Description Add... |
Line_1 SNAP-PAC... Ethernet 10.192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192.55... Disabled Modify... |

Communications >| Others

_ omes rf— button

Coss | Hep |

4. C(lick the Others button and choose Date and Time from the pop-up menu.
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#=#| Configure Date And Time bt
[~ Used

Address Description | Value
TIME

0xFFFF FO35 0000 Hours 03

0xFFFF FO35 0000 Minutes o

0xFFFF FO35 0000 Seconds o

0xFFFF FO35 0000 Hundredths of a Second i}
DATE

0xFFFF FO35 0000 Maonth 01

0xFFFF FO35 0000 Day 01

0xFFFF FO35 0000 Year 2003

oK | Cancel

5. Clickto put a check mark in the Used box. Enter the correct time and date values in the Value column.
Click OK.

6. Configure other optional functions, or return to the PAC Manager main window and click the Save button
Il | to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit"on page 68.

CONFIGURING DIRECT COMMUNICATION TO SERIAL DEVICES

Applies to SNAP PAC controllers only.

Serial connectors are located on the top of SNAP PAC controllers. For the type, number, and function of serial
ports on each device, see the device's user guide. Depending on the device, these ports may be used for
several purposes:

«  Maintenance, such as loading new firmware (see page 201).
«  Point-to-Point Protocol (PPP) communication via modem (see page 122).
«  Connection to serial I/O units (PAC-S only).

«  Sending or receiving data directly from a serial device, such as an RFID or barcode reader, a weigh scale,
or any intelligent device with a serial port. For this use, communication occurs through PAC Control
communication handles. (For more information, see “Communication Commands”in Chapter 10 of the
PAC Control User's Guide (form 1700).

NOTE: This section shows you how to configure the controller to talk serially with devices directly connected to it.
Serial devices attached to an I/0 unit through serial communication modules on the rack are configured differently.
See page 46.

Follow steps in the next section for on-the-rack controllers; see page 119 for standalone controllers.

Configuring Serial Ports on an On-the-Rack Controller

Use these steps for SNAP PAC R-series.
1. In PAC Manager, click the Open button g (orin the menu bar, click File > Open).
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.

3. Inthe configuration tree, right-click the name of the 1/0 unit on which you want to configure direct serial
communications and choose Configure from the pop-up menu.
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= Configure I/Q Units X
Mame Type Port Address Watchdog Description Add...
Line_1 SMAP-PAC... Ethernet 10,192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify...

Delete
Import/Copy...

10 Points...

PID Loops...
Modules 3
Events 3

ScratchPad  »

Communications Communications

Others 3 button

Close | Help |

4. (lickthe Communications button and choose Communication Port Control from the pop-up menu.

- !
#=#| Configure Communication Port Control *
[~ Used
Address Description | Value |
COMMUNICATION PORT O
0xFFFF FO31 0400 Control Function For Communication Port 0 FFPP =l
0xFFFF FO31 0404  Logging For Communication Port 0 Disabled =l
0xFFFF FO31 1100 Mode For Communication Port 0 R5232 =l
COMMUNICATION PORT 1
0xFFFF FO31 0408 Control Function For Communication Port 1 Mone j
0xFFFF FO31040C  Logging For Communication Port 1 Disabled =l
0xFFFF FO31 1104 Mode For Communication Port 1 R5232 B3|
COMMUNICATION PORT 2
0xFFFF FO31 0410 Control Function For Communication Port 2 Mone j

T g

Because a configuration file could be built for any controller or brain PAC Manager supports, this window
shows the possible ports and settings for all devices. Only a few apply to R-series PACs.

5. Ifthereis no check mark in the Used box, click the box to place a check mark there.
Ports shown in the window are as follows:

—  Port 0 =RS-232 connector on controller's top
—  Ports 1,2, and 3 = Not used on the R-series controller
6. If Port Qs used for modem communication, do the following:

a. IntheValue field for Control Function for Communication Port 0, choose PPP from the drop-down
list.

b. Inthe Logging for Communication Port field, leave logging Disabled unless you are troubleshooting
serial communication (see page 231).

NOTE: Logging adds significant overhead to serial communication; do not enable it unless you need to.
7. If Port Ois directly connected to a serial device, do the following:
a. Inthe Control Function for Communication Port O value field, choose None from the drop-down list.
b. Inthe Logging for Communication Port field, leave the value field set to Disabled.

Although you can use this log file for troubleshooting, when the control function is set to None, the
log file logs only characters received by the PAC Control strategy. It is better to have PAC Control log
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the data rather than using the log file. The log file adds significant overhead to communication. (For
more about the log file, see page 231)

c. Inthe Mode for Communication Port 0 field, leave the value set to RS232. (The R-series controller
does not support RS-485.)

8. When you have finished configuring the port, click OK.

9. Configure other optional functions, or return to the PAC Manager main window and click the Save button
il | to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O

Unit"on page 68.

Configuring Serial Ports on a Standalone Controller

These steps apply to SNAP PAC S-series controllers.
1. Inthe PAC Manager main window, click the Inspect button @

The Inspect window opens.

- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device

Name field, and current Status Read information appears in the window.

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

&% Inspect Opto 22 Device

Device Name: | 10.199.59.99

Status Read
Status Read

Status:

j Options »

Status Read area last read at 07/05/16 10:34:58

m LDDRESS DESCRIPTION VALUE ~ Iﬁl
) 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
{ WirelessLAN ¥ OxFFFF F030 0008 Buay Flag 0
| Paint Config 0xFFFF F030 0018 Loader Version R5.1lc
Digital Bank 0xFFFF FO30 0000 Memory Map Version 1
0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016
Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A
High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
| 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
| 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
| ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3
ETHERENET 1 Interface
PID L 0xFFFF FO30 002E MAC Address 00-R0-3D-01-85-9C
0xFFFF FO30 0034 IF Address 10.192.55.67
,-__,,,E"exn-‘r"\__:..l_ A LOEFERPE0 201035 m Fane Lo Mamin, mm o A e brin o D55 SOGFAAIR 0, A A s et

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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120

of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

Wpto 22 Device

eS0T S O B ookie Controller

|_ |[EngineRm i
| Cail Portable
| |SofPAC CRIPTION
e lerup Clea
Wireless LAN | Boler =

—— I Chamber 1 s
. Chamber 2 J
Point Config g partable der Versid
o Cookie Controller ory Map Vi
Digital Ban? EngineRm SRy
Di SoftPAC Imware Ver

igital Point = 1
0xFFFF F030 00BO Firmware Verg

In the Device Name field, type the name (or IP address) of the controller (or choose it from the
drop-down list). Click Communications and choose Communication Port Control from the submenu.

@ Inspect Opto 22 Device
Device Name: | 10.192,50.21 | options »
Communication Port Control
Status Read

- x

Status: ‘ Comm Port Control area last read at 07/05/16 12:04:58

) OXFFFF FO31 0400
MiEEsl b OXFFFF FO31 0404
Point Config OXFFFF FO31 0408

OxFFFF FO31 040C
Digital Bank

—— OxFFFF FO31 0410

Tl R OxFFFF F031 0414

Status Write Address | Description | Value | Refresh |

COMMUNICATION PORT 0

Control Function For Communication Port 0 PPP 5| Apply

Logging For Communication Port 0 Disabled |
COMMUNICATION PORT 1

Control Function For Communication Port 1 Mone =1

Logging For Communication Port 1 Disabled |
COMMUNICATIOM PORT 2

Control Function For Communication Port 2 None =1

Logging For Communication Port 2 Disabled =1

Analog Bank
Analog Point
High Density

System 3
ScratchPad b
Data Log 3
PID 3
Events 3
Communications +
Other 3

Close | Help |

[~ AutoRefresh | 15000  msec

The Inspect window shows the ports and features that apply to the controller you're inspecting. The
example above is for a SNAP-PAC-S2, which has four ports. The following table shows how ports are

labeled on the top covers of ST and S2 controllers.

Port = SNAP-PAC-$1
0 S0
1 S1
2 S2
3 -

= SNAP-PAC-S2
Serial 0
Serial 1
Serial 2
Serial 3
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If you are using a modem, do the following:

a.

In the Control Function for Communication Port field for the port the modem is attached to, choose
PPP from the drop-down list. Note that the lowest numbered port with PPP function configured is
the only port that can be used for PPP. See page 122 for more on setting up PPP.

In the Logging for Communication Port field, leave logging Disabled unless you are troubleshooting
serial communication (see page 231). Logging adds significant overhead to serial communication;
do not enable it unless you need to.

If you are using ports on a PAC-S2 to connect to serial I/O units, do the following for each port:

a.
b.

In the Control Function for Communication Port value field, choose None from the drop-down list.
In the Mode for Communication value field, choose the connection type, termination, and bias from
the drop-down list.

In the Logging for Communication Port field, leave the value field set to Disabled.

Although you can use this log file for troubleshooting, when the control function is set to None, the
log file logs only characters received by the PAC Control strategy. It is better to have PAC Control log
the data rather than using the log file. The log file adds significant overhead to communication. (For
more about the log file, see page 231)

For each port that is directly connected to a serial device, do the following:

a.
b.

In the Control Function for Communication Port value field, choose None from the drop-down list.
In the Logging for Communication Port field, leave the value field set to Disabled.

Although you can use this log file for troubleshooting, when the control function is set to None, the
log file logs only characters received by the PAC Control strategy. It is better to have PAC Control log
the data rather than using the log file. The log file adds significant overhead to communication. (See
page 231.)

(PAC-S2 only) In the Mode for Communication value field, choose the connection type, termination,
and bias from the drop-down list.

When you have finished configuring the ports, click Apply.
Configuration data is sent to the controller.

Click the Status Write button on the left side of the Inspect window. In the Operation Command list,
highlight Store configuration to flash.
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=] Inspect Opto 22 Device — X
Device Name: | 10.192.50.21 | options » | Status: | Status Write area last read at 07/05/16 12:06:40
~ Status Write
Status Read |

Status Write Address | Description | Value A Refresh
OxFFFF FO38 0004  Always BootP /[DHCP On Powerup Mo |
e D OxFFFF FO33 0008 Degrees FjC Degrees C [ Apply

OxFFFF FO38 0010 Comm Watchdog Time {msec), 0 = Disable 1]

OxFFFF FO38 0014 TCP Minimum Retransmission Timeout {msec) 250
Point Config 0xFFFF FO38 0018  TCP Initial Retransmission Timeout (msec) 3000

0OxFFFF F038 001C TCP Retransmission Attempts 5
Digital Bank OxFFFF FO38 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000

0OxFFFF FO38 0294 Digital Feature Scan Interval {(msec) [v]
Digital Point 0xFFFF FO38 0050 Max Analog and High Density Digital Scan Interval {msec) 1]

OxFFFF FO38 0298 Out Of Range Value {16-Eit) 0.000
Analog Bank

OxFFFF FO38 02B0  Out Of Range Value (32-Bit) 0.000

Analog Point OxFFFF FO38 0054  Scanner Flaos Ox 00000000 ¥
High Density e st
OptoMMP Device A Send Command
samtred | | [ EZSomore s
el 4 mias-i?osr[; configuration and IP settings to microSD

B » Erase configuration and IP settings from microSC
Erase firmware from microSD

Events . Erase strategy from micraSD
Other
_— Switch to loader mode
3
ST Clear Digital Events - Expanded configuration
Other » Clear Digital Events - Cld configuration v

co= | nep | I™ AutoRefresh 15000 msec

8. (lick Send Command.
The port configuration data is stored to flash memory and a Success message appears.

CONFIGURING PPP

Use this section only if you have SNAP PAC R-series I/O units installed at remote locations or in other places
where an Ethernet network is not available, and you are using modems to communicate between the device
and a computer. You can set up communication so that the device can dial in to a computer, so that
computers can dial into the device, or both.

NOTE: If you are using PPP with a SNAP PAC S-series controller, see instructions in the controller user’s guide.

IMPORTANT: After you have followed the steps in this section to configure PPP on the l/O unit, see the I/O unit’s user’s
guide for information on attaching the modem to the system and setting up Windows dial-up networking or remote
access server on the computer.

Configuring PPP on the I/0 Unit

1. Inthe PAC Manager main window, click the Open button g or choose File > Open.
2. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
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File Edit Tools View Help

,_ BEEIRIE LN

=3 MainProcess
=I5 IO Units

In the configuration tree, right-click the name of the I/O unit on which you want to set up PPP and
choose Configure from the pop-up menu.

| Type | Port | Address | ‘Wwatchdog | De Add...

SMAP-PAC...  Ethemet 10.192.54.110 Enabled
Modify... |
Delete |

Import/Copy... |

1/0 Paints... |
FID Loops... |
Modules 3 |
Events 3 |
Scratch Pad  » |

Communications » Communications

Others 3 | button

3

Make sure the correct 1/0 unit is highlighted in the list. Click the Communications button and choose PPP
from the pop-up menu.
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A || Local IP Address: [EH . 158, 0 . 1

| Configure PPP @

General PPP Serial Port

Connection Timeout: | &0
Baud Rate: |15200 -
Echo Request Period: | 10

Subnet Mask: . . .

B E— Max Authentication Retries: ’37 Echo Request Retries: |37 FEITER Mane :I'
C— Modem Strings \ Data Bits: 8 hd
Initialization: | ATEDO"Mrsnenine ] _
D—1H| — StopBits: |1 v|
Listen: | ATS0=1M~ J
Hangup: | mersrb b rorens A THOAM rars Flow MNone h
F I Incoming PPP Ouil:going FPP
Incoming Connections: IWI Outgoing Connections: ’m Inactivity Timeout: '3‘0—
Set As Default Gateway: Mo - Use Local IP Address: Mo +| Max Connect Time: 'D—
Inactivity Timeout: I':‘Di Set As Default Gateway: ’m Manx Dial Retries: 'D—
Login: I— Login: li Retry Interval: 'D—
Password: I— Password: li Disable Time: 'D—
Remote IP Address: [ 192 . 188 . 0 . 2 PhoneMumber: [ [ PPP Link Always Connected

0K | Cancel | Help |

5. Complete the fields as follows:

A—Local IP Address. Enter the Local IP Address for the PPP interface on the I/O unit. Enter the local Subnet
Mask only if you are using classless IP addressing. If you are not using classless IP addressing, leave the Subnet
Mask at zero, and the 1/O unit will calculate the subnet mask.

IMPORTANT: The network address for the PPP interface must be different from the network ID for the Ethernet
interface. (The network address is obtained by ANDing the IP address and the subnet mask.)

B—Max Authentication Retries. Enter the maximum number of times a login/password combination
can be retried.

C—Connection Timeout and Echo Request. Change these values if necessary to establish and
maintain the connection.

D—Modem Initialization String. Change the modem initialization string, listen string, and hangup
string if necessary. Make sure you use the setting to ignore DTR signal in the modem initialization string:
The default modem initialization string is AT&DO M~ -~~~

Consult the command reference that came with your modem to determine the correct initialization
command strings. A sample modem initialization string might look like this:

AT&F"M~~AT&D0&KO"M~~AT&WO "M~~AT&YO0"M~~

The &F command sets the modem back to factory defaults. The AM tells the Ethernet I/O unit to insert a
carriage return. The ~ tells it to insert a 500ms pause. The &WO writes the current settings to NVRAM profile 0
on the modem. The &YO0 instructs the modem to use NVRAM profile 0 after resetting.

This initialization string is just a sample; command strings for your modem may differ.

E—Outgoing PPP. If the I/0 unit will send outgoing calls, complete the Qutgoing PPP section:
«  Choose Enabled from the drop-down list.
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In the Use Local IP Address field, choose Yes to have the I/O unit use the Local IP Address you entered for
the PPP link; choose No to have the remote device assign the I/O unit an IP address for the PPP link. The
default is No.

If you want the I/O unit to use the device the I/0 unit is calling as the default gateway for all
communication, choose Yes for Set As Default Gateway. The default is No.

Enter the Login and Password the I/0 unit should use for authentication when it calls the remote device.
In the Phone number field, enter the number the modem should dial for outgoing calls from the I/0 unit.

Change the following fields if necessary:

Inactivity Timeout—If the 1/0 unit sends no packets and receives no packets for this number of seconds
after the PPP session is negotiated, the modem will hang up. The default is 30.

Max Connect Time—The maximum amount of time in seconds an outgoing PPP connection can stay
connected after successful negotiation. Default is zero, which disables the timer.

Max Dial Retries—The number of times the 1/0 unit will redial if the first attempt fails. Default is zero.
Retry Interval—The number of seconds the I/0 unit will wait before trying to redial after the first attempt
fails. Default is zero.

Disable Time—If the maximum connect time or maximum number of retries has been reached, the
outgoing PPP dialer waits this number of seconds before doing anything. Default is zero.

PPP Link Always Connected—If you want outgoing PPP to always be connected, so there is no need for
the 1/0 unit to dial out, check this box.

F—Incoming PPP. If the I/0 unit will receive incoming calls via modem, complete the Incoming PPP
section:

Choose Enabled from the drop-down list so the modem will listen for incoming calls.

If you want the I/O unit to use the device calling the I/O unit as the default gateway for all
communication, choose Yes for Set As Default Gateway. The default is No.

Change the Inactivity Timeout if necessary. The default is 30.

Enter the Login and Password the I/0O unit should accept forincoming calls.

In the Remote IP Address field, enter the IP address the I/O unit should give to devices that dial into the
I/0 unit and ask for an address. This address must be on the same subnet as the local IP address.

Enter a modem listen string to make sure the modem automatically answers calls. The default modem
listen string is ATS0=1~M~ , which instructs the modem to answer any incoming calls on the first ring.
Again, refer to your modem’s command reference for the correct listen string.

When all fields are correct, click OK.

IMPORTANT: For the configuration to take effect, you must upload the configuration file to the I/O unit, save it
to flash memory, and restart the /0 unit.

NOTE: Ifthe serial port you are using for PPP was previously used for a direct connection with a serial device, you
must use PAC Manager's Inspect window to reset the port configuration from None to PPP. See page 117 for
more information.

Configure other optional functions, or return to the PAC Manager main window and click the Save button
Il | to save the configuration file.

When you are ready to upload the configuration file to the I/O unit, see “Sending Configuration Data to the I/O
Unit”on page 68. For information on attaching the modem to the system and setting up Windows dial-up
networking or a remote access server, see the SNAP Ethernet-Based I/0 Units User's Guide (form 1460) or the
SNAP PAC R-Series Controller User’s Guide (form 1595).
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4. Setting Up Events and
Reactions

INTRODUCTION

Events and reactions are automatic responses to conditions monitored by SNAP PAC I/O units. The monitored
conditions, called events, and the responses to them, called reactions, can be simple or complex. An example
of a simple event/reaction is turning on a fan in response to a rise in temperature. Complex event/reactions
may involve multiple events and multiple reactions, with a time delay in between. For example, you could set
up a temperature limit as an event that triggers a warning light, and a higher temperature limit as an event
that sets off an audible alarm and sends an email message.

CAUTION: Event/reactions you set up using these instructions in this chapter operate on the /O side of a SNAP PAC
R-series controller, independently of any PAC Control strategy running on the processor’s control side. If you are using
PAC Control with a SNAP PAC R-series I/0 system, do not use this chapter. Instead, use the flowchart logic in the PAC
Control strategy to handle reactions to events. The only reason you might set up event/reactions that operate
independently on the I/O side of the controller would be a need for very fast reactions. If that is the case, be very careful
that the event/reactions you set up do not conflict with PAC Control logic.

The chapter introduces you to the Scratch Pad and other basic event/reaction concepts. It also shows you how
to use PAC Manager to configure the following:

«  Digital event/reactions (see page 131)

«  Alarm event/reactions (see page 137)

«  Serial or Wiegand event/reactions (see page 139)
«  Event messages (see page 141)

EVENT/REACTION CONCEPTS

This section describes using the Scratch Pad to track events and alarms, and types of events, alarms, and
reactions.

The Scratch Pad

Event/reactions are available on SNAP PAC R-series, SNAP PAC EB and SB brains, SNAP Ultimate, and SNAP
Ethernet I/0 units. SNAP Simple I/0 units and E1 and E2 brain boards do not have event/reaction capability.

CAUTION: Event/reactions occur on the l/O side of a SNAP PAC R-series or SNAP Ultimate controller, independently
of any PAC Control strategy running on the control side. If you are using PAC Control, it is best to use flowchart logic
to handle reactions to events. If you do set up event/reactions, be very careful that they do not conflict with PAC
Control logic.

The following contain Scratch Pad areas within their memory maps.
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e groov /O units

«  groov RIO modules

«  SNAP PAC S-series controllers

o SNAP PACR-series controllers

«  SNAP PAC and SNAP Ethernet brains

The Scratch Pad is a convenient place to store data and easily exchange it with other groov EPIC processors,
groov RIO modules, and SNAP PAC controllers, as well as HMI, OPC, and SCADA software.

The Scratch Pad is user-defined, meaning that you define and use its addresses to fit your needs, and you can
redefine them whenever necessary. The Scratch Pad area includes sections for up to five data types
(depending on device type): bits, integers, floats, and strings.

«  The Scratch Pad bits section is a 64-bit mask.

«  The Scratch Pad 32-bit integer section is a table of 10,240 four-byte elements.

«  The Scratch Pad 64-bit integer section is a table of 1024 eight-byte elements.

«  The Scratch Pad float section is a table of 10,240 elements; each float is four bytes.

«  The Scratch Pad strings section is a table of 64 elements. Each element can hold 128 characters or 128
bytes of binary data.

NOTE: Scratch Pad float and 32-bit integer tables are not made up of contiguous addresses in the memory map; each
table is in two address sections. You won't notice this if you are using PAC Control Scratch Pad commands, but if you
are addressing these tables in another application, check the memory map appendix in the OptoMMP Protocol
Guide to make sure you have the correct addresses for the table elements you want.

Using Scratch Pad Bits for Events and Alarms

When Scratch Pad bits are used to track events and alarms, the 64 bits in the mask do not represent channel
numbers. Instead, they represent whatever you decide they should be. For example, you might decide that
bit 1 in the Scratch Pad will indicate a temperature level in Vat #12 (if the temperature reaches 48 °C, bit 1 is
turned on). Bit 2 might indicate the status of Pump A (if the pump is off, the bit is off; if the pump is on, the bit
ison).

Because you can use Scratch Pad bits to keep track of events and alarms, you can set up reactions based on a
variety of conditions. In the example above, you could set up a reaction on an EB brain that sends a stream
packet if bit 1is on and bit 2 is off.

Cascading Events, Alarms, and Reactions

Scratch Pad bits are really a way to set up cascading events and reactions (that is, a series of events and
reactions dependent on each other). For example, the first event in the cascade could be the temperature in
Vat #12 reaching 40 degrees, and the reaction to it is setting Scratch Pad bit 1. The second event in the
cascade is that Scratch Pad bit #1 is set, and the reaction to that is some other action. A cascade of any number
of events and reactions can be configured, as needed.

USING EVENT/REACTIONS

128

(Does not apply to groov I/0 units.) Event/reactions are available on SNAP PAC R-series, SNAP PAC EB and SB
brains, SNAP Ultimate, and SNAP Ethernet I/0 units. SNAP Simple I/0 units and E1 and E2 brain boards do not
have event/reaction capability.

CAUTION: Event/reactions occur on the l/O side of a SNAP PAC R-series or SNAP Ultimate controller, independently
of any PAC Control strategy running on the control side. If you are using PAC Control, it is best to use flowchart logic
to handle reactions to events. If you do set up event/reactions, be very careful that they do not conflict with PAC
Control logic.
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Types of Events, Alarms, and Reactions

NOTE: groov I/0 units and SB brains do not support serial events and reactions nor reactions requiring an Ethernet
network, such as sending email.

The event or reaction can consist of one or a combination of the following. The reaction can take place
immediately or after a delay.

Events:

»  On/off state of a digital channel on a 4-channel module

«  State of on-latch or off-latch for a digital channel on a 4-channel module

«  On/off state of a digital channel on an HDD (high-density digital) module

«  State of an on-latch or off-latch for a digital channel on an HDD module

«  High orlow value of an analog channel (in engineering units)

»  Number on a digital counter or high or low number on a quadrature counter
«  Analog channel value or quadrature counter that is outside allowable range
«  Stateof a bitin the Scratch Pad bits area

«  State of a bitin the Scratch Pad integer 64 area

«  Specific string received by a serial module

Reactions:

«  Turn on/off digital channel

o Clearon-latch or off-latch

«  Copy data from one memmap location to another

« logdata

«  Turnon or off a bit in the Scratch Pad bits area

«  Turnon or off a bit in the Scratch Pad integer 64 area
«  Send a stream packet

«  Send an email message

«  Send a string through a serial module to a serial device
«  Send an SNMP trap

Note that the memory map section formerly called Timers, which provided digital events with a delay
between an event and the reaction to it, has been expanded in firmware 8.1 to include additional options
such as latches and HDD modules. All new digital events should be configured in Digital Events - Expanded to
take advantage of the new flexibility.

Digital events you already configured still exist in Digital Events - Old. Timers you already configured still exist
in Digital Events - Expanded.

PAC Manager User's Guide 129



USING EVENT/REACTIONS

The following table details steps for configuring events and reactions. See page references for more. A
flowchart following the table summarizes Alarm and Serial event and reaction configuration.

Event Reaction Configuration Steps See
I:x;:%tjlnﬁ?mt on/off (on Configure Digital Events - Expanded page 131
Turn digital point on/off (on | 1. Configure Digital Events - Expanded—set Scratch Pad
. . . page 131
different I/0 unit) bit
OR 2. (Email message only) Configure Email page 100
If digital point is on/off Log data (Streaming only) Configure Streaming page 104
OR (SNMP only) Configure SNMP page 96
Copy memory map data 3. (Except data logging) Configure Event Messages—
page 92
OR send message or data
Send message (stream, (Data logging) Configure Data Logging and configure page 87
e-mail, serial, or SNMP trap). Email (optional) page 100
1. Configure Alarm Events (high alarm or low alarm)—set
Turn digital point on/off (on Scratch Pad bit
same |/0O unit). 2. Configure Digital Events - Expanded—turn on/off page 137
. page 131
point
1. Configure Alarm Events (high alarm or low alarm)—set
If analog point value Scratch Pad bit
(Engineering Units) goes | Tyrn digital point on/off (on | 2. (Optional for a delay) Configure Digital Events - page 137
above or below a specified | gifferent I/0 unit) Expanded— use the alarm Scratch Pad bit as the
value OR event, set the time delay, and set a Scratch Pad bit after | page 131
OR Copy memory map data the delay page 100
If digital counter reaches a OR 3. (Email message only) Configure Email page 104
specified value Log data (Streaming only) Configure Streaming page 96
OR (SNMP only) Configure SNMP
Send message (stream, email, | 4. (Except data logging) Configure Event Messages— page 92
serial, or SNMP trap). send message or data based on alarm bit or delay bit page 87
(Data logging) Configure Data Logging based on page 100
alarm bit or delay bit and configure Email (optional)
1. Configure Alarm Events (deviation alarm)—set Scratch
Turn digital point on/off (on Pad bit
same |/0 unit) 2. Configure Digital Events - Expanded—turn on/off page 137
. page 131
point
1. Configure Alarm Events (deviation alarm)—set Scratch
Pad bit
Ifanalog point value Turn digital point on/off (on | 2. (Optional for a delay) Configure Digital Events - page 137
(Engineering Units) or different I/0 unit) Expanded— set time delay and set a Scratch Pad bit
quadrature counter goes OR after the delay page 131
outside an allowable Copy memory map data 3. (Email message only) Configure Email page 100
range OR (Streaming only) Configure Streaming page 104
Log data (SNMP only) Configure SNMP page 96
OR 4. (Except data logging) Configure Event Messages—
Send message (stream, email, send message or data immediately or based on delay page 92
serial, or SNMP trap). bit page 87
(Data logging) Configure Data Logging immediately or | page 100
based on delay bit and configure Email (optional)
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Event Reaction Configuration Steps See
Tzl i am et arm 1. Configure Sgrial Events—set Scratch Pad bit page 139
same /0 unit) 2. Co.nflgure Digital Events - Expanded—turn on/off page 131
point
1. Configure Serial Events—set Scratch Pad bit
2. (Optional for a delay) Configure Digital Events - page 139
Expanded— set time delay and set a Scratch Pad bit
Send SNMP trap after the delay page 131
3. Configure SNMP page 96
4. Configure Event Messages—send trap immediately or | page 92
based on delay bit
If a specific string is . . 1. Configure Serial Events—send email
received by a serial Send one-time email 5 Corlis e Bl page 139
module
1. Configure Serial Events—set Scratch Pad bit
Turn digital point on/off (on | 2. (Optional for a delay) Configure Digital Events - page 139
different I/O unit) Expanded— set time delay and set a Scratch Pad bit
OR after the delay page 131
Copy memory map data 3. (Email message only) Configure Email page 100
OR (Streaming only) Configure Streaming page 104
Log data 4. (Except data logging) Configure Event Messages—
OR send message or data immediately or based on delay page 92
Send message (stream, serial, bit page 87
or multiple emails) (Data logging) Configure Data Logging immediately or | page 100
based on delay bit and configure Email (optional)

The following flowchart summarizes Alarm and Serial event and reaction configuration.

Configure Event Message
Yes | (If used) Configure or Data Logging.
Email, Streaming, » Eventis Alarm or Serial
or SNMP. Scratch Pad bit, or delay
Scratch Pad bit.

Configure Alarm Event or
Serial Event details. >
Reaction is Scratch Pad bit.

Should reaction
occur immediately?

v

A

Configure Digital Events — Expanded.
Trigger is Alarm or Serial Scratch Pad bit.
Set delay time.

Set a new Scratch Pad bit as the reaction.

CONFIGURING DIGITAL EVENTS AND REACTIONS

In a digital event, the I/0 unit monitors one or more inputs, outputs, and Scratch Pad bits for a match to a
specific pattern (the event). When the pattern is matched, the I/0 unit reacts in a predetermined way. The
reaction can tumn digital points on or off and can also set bits in the Scratch Pad. You can configure up to 512
digital events and reactions for SNAP PAC controllers and brains.

Digital event/reactions can be as simple as turning on a light (reaction) when a door opens (event). They can
also be very complex, depending on your needs. For example, suppose you need to monitor a critical group of
switches. If switches 1,2, and 3 are all off at once, you want to turn on an emergency light and sound an alarm.
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On mask

You can set up a digital event for the state of the three switches, and a reaction that automatically turns on the
emergency light and alarm.

In addition to digital states, events can include alarm or other conditions noted in the Scratch Pad. For
instance, to regulate the temperature of a room, you might set up an alarm event that turns on a bit in the
Scratch Pad when the temperature reaches 78° F (see “Configuring Alarms and Reactions”on page 137). Then
you would set up a digital event/reaction to turn on a fan when that Scratch Pad bit is on.

NOTE: If you want to turn on or off digital points that are located on a different I/O unit, you can do so by using the
memory map copying feature. See “Copying Memory Map Data” on page 109 for details.

Digital Point and Scratch Pad Masks

Both events and reactions are in the form of a mask. Digital point masks represent 64 possible digital states;
you choose whether these are point states or on-latch or off-latch states. Scratch Pad masks represent
whatever you decide each bit should be.

For each digital event/reaction, you set up two to eight masks: up to four for the event and up to four for the
reaction.

For the event: The table below shows possible triggers for the event, in the form of four masks. You can
configure only Trigger #1, only Trigger #2, or both. If you configure both, both must be true for the event to be
true. Choose the trigger(s) you want to use; then set up the masks.

Trigger #1

Trigger #2

Off mask On mask Off mask

Digital Point State
Digital Point On Latch
Digital Point Off Latch
HDD Point State

HDD Point On Latch
HDD Point Off Latch
Scratch Pad Bits
Scratch Pad Integer 64

Digital Point State
Digital Point On Latch
Digital Point Off Latch

Digital Point State
Digital Point On Latch
Digital Point Off Latch

Digital Point State
Digital Point On Latch
Digital Point Off Latch

HDD Point State HDD Point State HDD Point State
HDD Point On Latch HDD Point On Latch HDD Point On Latch
HDD Point Off Latch HDD Point Off Latch HDD Point Off Latch

Scratch Pad Bits
Scratch Pad Integer 64

Scratch Pad Bits
Scratch Pad Integer 64

Scratch Pad Bits
Scratch Pad Integer 64

On mask

For the reaction: This table shows possible reactions, again in the form of four masks. You can configure
only Reaction #1, only Reaction #2, or both. When the event occurs, all configured reactions will take place.
Choose the reaction(s) you want to occur, and then set up the masks.

Reaction #1 Reaction #2

Off mask On mask Off mask

Digital Point States

Clear Digital Point On/Off

Digital Point States
Clear Digital Point On/Off

Digital Point States
Clear Digital Point On/Off

Digital Point States
Clear Digital Point On/Off

Latches Latches Latches Latches

HDD Point States HDD Point States HDD Point States HDD Point States

Clear HDD Point On/Off Clear HDD Point On/Off Clear HDD Point On/Off Clear HDD Point On/Off
Latches Latches Latches Latches

Scratch Pad Bits
Scratch Pad Integer 64

Scratch Pad Bits
Scratch Pad Integer 64

Scratch Pad Bits
Scratch Pad Integer 64

Scratch Pad Bits
Scratch Pad Integer 64

132

NOTE: Trigger #1 does NOT control Reaction #1; Trigger #2 does not control Reaction #2. Instead, all the masks work
as a group. All the event masks must be a match for the I/0 unit to set the reaction(s), and if the event occurs, any
and all reactions will be set. If it doesn’t matter whether a specific point or bit is on or off, leave its value at zero in both
the on mask and the off mask.
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When you configure events and reactions, the masks are in hex notation. If you are setting up a Digital On
mask for points 07, for example, you might do so as follows:

Module position: 1 0
Point number:| 3 2 1 0 3 2 1 0
State:l On| - |On | On | - - - [ On

Binary notation:| 1 0 1 1 0 0 0 1

Hex notation: B 1

For more information on mask data format, see page 195. See the following pages for a step-by-step example
to set up event/reactions.

You can also configure the I/0 unit to send a message as a reaction to digital events. See page 92.

How Digital Events Trigger Reactions

Reactions to digital events can be level-triggered (occur continuously) or edge-triggered (occur once). The 1/0
unit continually checks the digital state to see if it matches the event, and the I/O unit sends the reaction as
soon as the state matches the event. If you configure the reaction to occur continuously, the 1/0 unit
continues to send the reaction until the state changes. If you configure it to occur once, the reaction is sent
only once.

In either case, however, if the state changes so that it no longer matches the event, the I/0 unit does NOT
reverse the reaction.

Example: Digital Event/Reaction

Forexample, suppose you have set up an event/reaction to turn on alight when a door is open. As soon as the
event occurs (the door opens), the I/0 unit sends the reaction (turn on the light).

When the door is shut, the I/0 unit stops turning on the light, but it does NOT turn the light off. To turn off the
light when the door is shut, you need to set up a second event/reaction.

Suppose the input for the door’s status is on point 0 on the module in position 0, and the output for the light
is on point 1 on the module in position 1. Here are the two event/reactions to turn on the light when the door
is open, and turn off the light when the door is shut:

Event #0: IF|Mod 0 Pt 0 (Door) is OFF (Open)
Reaction #0: THEN|Turn Mod 1 Pt 1 (Light) ON

Event #1: IF{Mod 0 Pt 0 (Door) is ON (Closed)
Reaction #1: THEN |Turn Mod 1 Pt 1 (Light) OFF

Since this example is a simple one-to-one correspondence, it is pretty easy to set up.

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.

2. C(lickthe Open button g or choose File > Open.

3. Inthe Open Tag Database dialog box, navigate to the configuration file and double-click it to open it.
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=8| PAC Manager - Main_Process - O *
File Edit Tools View Help

DlS|d| X |aa B @5 el
B === )

B Main_Process
=Bl /0 Units
20 Line_1

e
Preprocess

Ready [ N4

4. In the configuration tree, right-click the name of the I/0 unit on which you want to set up digital events
and choose Configure from the pop-up menu.

= Configure /0 Units *

Mame | Type | Port | Address | Watchdog Description Add... |
i SNAP-PAC... Ethernet 10.192.55... Disabled
SNAP-PAC... Ethernet 10.192.55... Disabled

Events
button

Coss | Hep |

5. For processors with firmware 8.1 or higher, click the Events button and choose Digital Events - Expanded
from the pop-up menu.
If your processor has firmware 8.0 or lower, expanded digital events are not available; choose Digital
Events - Old. Choices are more limited with older firmware; see tables on page 73.

IMPORTANT: If you configured digital events in a version of PAC Manager prior to 8.1, you will find them in
Digital Events - Old. If you configured timed events in a PAC Manager version prior to 8.1, you'll see them here in
Digital Events - Expanded.
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#=#| Configure Digital Events - Expanded *
Event
Number: |0 v| [ Used
Address | Description | Value |
EVENT
0xFFFF FOD4 004C Event Enable Disable Enabled 3|
0xFFFF FOD4 0044 Use which data for trigger #1? Digital Point State 3|

0xFFFF FOD4 0000
0xFFFF FOD4 0008
0xFFFF FOD4 0044
0xFFFF FOD4 0010
0xFFFF FOD4 0018

OMN Mask
OFF Mask
Use which data for trigger #27
OMN Mask
OFF Mask

Ox 00000000 00000000
Ox 00000000 00000000
Digital Paint State |
Ox 00000000 00000000
Ox 00000000 00000000

0xFFFF FOD4 0040 Length of Delay Before Reaction (msec.) 0

REACTION
0xFFFF FOD4 0044 Reaction Occurs Continuously =
0xFFFF FOD4 0044  Use which data for reaction #1? Digital Point State =l

0xFFFF FOD4 0020 OM Mask Ox Q0000000 20000000
0xFFFF FOD4 0028 OFF Mask Ox Q0000000 20000000
0xFFFF FOD4 0044 Use which data for reaction #27 Digital Point State |
0xFFFF FOD4 0030 OM Mask Ox Q0000000 20000000
0OxFFFF FOD4 0038 OFF Mask Ox Q0000000 20000000

OK | Cancel

In the drop-down list, choose the lowest unused Event Number. Click to place a check mark in the Used
box.

NOTE: To reduce scanning time, the I/O unit stops scanning digital events when it reaches an unused event.
Make sure you use event numbers in order, starting with the lowest.

Configure the Event by clicking in the Value column and entering a value or choosing from the
drop-down list.

a. Choose Enabled.
b. Choose which digital data to use as the trigger; in this example it is Digital Point State.
C. Leave the Digital ON mask all zeros. Enter the Digital OFF mask for the open door.

Remember that the masks are in hex notation. Here’s how you might figure out the Digital ON mask
to turn on the light:

Module position: 15 — 1 0
Digital point:| 3 | 2 | 1 0| —p [ 3] 2|1 |0]|3]2]1]0
State:] - | - | - | - | —p | - | - |On| = | - | | | -
Binary notation:)| 0 | 0 | O | O | —» 0| O 1 0O 0 01| o0
Hex notation: 0 — > 2 0

You don't need to enter anything for Trigger #2, because the open door is the only dependency for
this event.

d. Ifyouwant adelay between the event and the reaction, enter the delay in milliseconds.

Configure the Reaction.

a. Choose whether the reaction should occur once or continuously; for this example, it's continuously.
b. Choose the digital data and/or Scratch Pad bits to use for the reaction, and enter the masks.

Here's how the Event and Reaction sections might appear for the door/light example.
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= Configure Digital Events - Expanded

Event

Number: |0 v| [V Used

4
=]

Address | Description Value |
EVENT
OxFFFF FOD4 004C Event Enable/Disable Enabled
0xFFFF FOD4 0044 Use which data for trigger £17 Digital Point State
OxFFFF FOD4 0000 OMN Mask O3 00000000 Q0000000
0xFFFF FOD4 0003 OFF Mask O 00000000 Q0000001
0xFFFF FOD4 0044 Use which data for frigger #27 Digital Point State
OxFFFF FOD4 0010 ON Mask O3 00000000 Q0000000
0xFFFF FOD4 0018 OFF Mask O 00000000 Q0000000
OxFFFF FOD4 0040 Length of Delay Before Reaction {msec.) a
REACTION
0xFFFF FOD4 0044 Reaction Occurs Continuously j
OxFFFF FOD4 0044  Use which data for reaction #12 Digital Point State -
OxFFFF FOD4 0020 ON Mask O 00000000 00000020
0xFFFF FOD4 0025 COFF Mask Q¢ 00000000 Q0000000
OxFFFF FOD4 0044 Use which data for reaction #2? Digital Point State -
OxFFFF FOD4 0030 OMN Mask O3 00000000 Q0000000
0xFFFF FOD4 0038 OFF Mask O 00000000 Q0000000
OK. | Cancel |

Event: Digital OFF
mask— door on
mod 0 pt O'is
open.

Reaction: Digital
ON mask—turn
on lightat mod 1

pt1.

Now choose Event Number 1 from the drop-down list and click Used. In the Event and Reaction sections,
enter the Digital ON mask for the closed door and the Digital OFF mask to turn off the light.

#=* Configure Digital Events - Expanded *
Event
Number: |1 v| v Used
Address | Description Value |

EVENT
OxFFFF FOD4 00CC Event Enable /Disable Enabled kA
0xFFFF FOD4 00C4 Use which data for trigger #17 Digital Point State B3|
OxFFFF FOD4 0030 ON Mask O3 00000000 Q0000001
0xFFFF FOD4 00858 OFF Mask O 00000000 Q0000000
0xFFFF FOD4 00C4 Use which data for trigger £27 Digital Point State ka|
OxFFFF FOD4 0090 ON Mask O3 00000000 Q0000000
OxFFFF FOD4 0093 OFF Mask Oz 00000000 Q0000000
OxFFFF FOD4 00CO Length of Delay Before Reaction {msec.) a
REACTION

0xFFFF FOD4 00C4 Reaction Occurs Continuously j
0xFFFF FOD4 00C4 Use whirh data for reartion #17 Dinital Point State -
OxFFFF FOD4 00AQ OMN Mask O3 00000000 Q0000000
0xFFFF FOD4 00AS OFF Mask (O 00000000 Q0000020
OxFFFF FOD400C4  Use which data for reaction #2? Digital Point State 3|
0xFFFF FOD4 00BO ON Mask O3 00000000 Q0000000
0xFFFF FOD4 00B3 OFF Mask O 00000000 Q0000000

’Tl Cancel

10. Click OK.

Both event/reactions are configured.

[=l | to save the configuration file.
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Event: Digital ON
mask— door on
mod 0 pt Ois
closed.

Reaction: Digital
OFF mask—turn
off light at mod 1
pt 1.

11. Configure other event/reactions, or return to the PAC Manager main window and click the Save button
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CONFIGURING ALARMS AND REACTIONS

A reaction can also be set up as a response to an alarm. You can configure alarms for analog points or digital
counters. For example, you could monitor the pressure in a tank and set up an alarm if it rises above a certain
level, or you could trigger an alarm when a specific number of boxes on a conveyor have passed through a
beam sensor. For each alarm, you configure a suitable reaction.

For analog points, alarms are based on the analog input value. For digital points, alarms are based on the
counter value (applies to points on 4-channel digital modules only). For each point, you can configure any or
all of the following alarms:

«  Deviation alarm—sets a range on either side of the current value that is acceptable; beyond that range,
the reaction occurs. For example, suppose you are monitoring temperature. If the current value is 80 and
you set a deviation limit of 6, the reaction will not occur unless the value drops below 74 or rises above
86.

If you have an Alarm Event that is configured as a deviation alarm, in order to capture that an alarm
occurred you need to set a scratch pad bit (such as bit 0) as the reaction of the alarm event. Also, you
need to create another event, such as a Digital Event - Expanded, that triggers based on that scratch pad
bit. The Digital Event would set a different scratch pad bit (such as bit 1) to be used for other logic or
events. For example, digital event 0 sees set bit 0 and sets bit 1. Now bit one remains set until cleared. Set
bit 1 can be used to start a timer that clears bit 1 when it expires. Bit 1 could also trigger an event
message that requires acknowledgment.

NOTE: When a reaction occurs, the deviation limit stays the same, but the value that set off the reaction
becomes the new deviation value. In this example, if the temperature drops to 73, the reaction occurs. Six is still
the deviation limit, but now 73 is the deviation value; another reaction will not occur unless the value drops
below 67 or rises above 79.

«  High-limit alarm—sets a fixed upper limit. If the analog value or counter is higher than the high limit,
the reaction occurs.

«  Low-limit alarm—sets a fixed lower limit. If the analog value or counter is lower than the low limit, the
reaction occurs.

How Alarms Trigger Reactions

Reactions to alarms are edge-triggered, not level-triggered, and when the alarm state changes, the reaction is
automatically reversed. The I/0 unit sends the reaction just once, as soon as the alarm occurs (at the “edge” of
the alarm). The I/0 unit does not send the reaction again until the alarm occurs again. If the alarm stops,
however, the I/0 unit reverses the reaction.

For example, suppose you set up a high-limit alarm that turns on a Scratch Pad bit that will turn on a fan if the
temperature goes over 70°. As soon as the alarm state occurs (the temperature goes over 70°), the I/0 unit
sends the reaction (turns on the bit to turn on the fan). If the temperature remains above 70° the I/0 unit does
not continue to turn on the fan bit; the bit just stays on.

When the temperature falls back below the high limit (70° minus whatever deadband you have set), the I/0O
unit automatically reverses the reaction by turning the Scratch Pad bit off. (To turn the fan off, you would have
to set up a reaction for the off bit, turning the fan off)

Notice that the reaction and its reversal are absolute; they do not depend on the pre-alarm condition. For
example, if the bit to turn on the fan was already on at the time the temperature rose above 70°, the reaction
would turn the bit on even though it was already on. When the temperature fell back below 70°, the 1/0 unit
would not return the fan bit to its pre-alarm condition (on); it would turn the bit off.
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Example: Alarms Event/Reaction

1. Inthe PAC Manager main window, with a configuration file open, right-click the name of the I/O unit on
which you want to set up alarm events. Choose Configure from the pop-up menu.

= Configure /0 Units

*

| Port | Address

MName | Type
Line_1 SMAP-PAC... Ethernet
Preprocess SMAP-PAC... Ethernet

10.192.55... Disabled

| Watchdog | Description Add... |

10.192.55... Disabled

Modify... |
Delete |

Import/Copy... |

10 Points... |
PID Loops... |
Modules 3 |

Events Events

button
ScratchPad |
Communications # |
Others 3 |
Close I Help |
2. (lickthe Events button and choose Alarm Events from the pop-up menu.
=] Configure Alarm Events *
r— Alarm
Mumber: I[J vI [ Used
Address | Description | Value |
DEVIATION ALARM
OxFFFF F110 0000 In Alarm State? N/A
0xFFFF F110 0004 Enable/Disable Alarm Disabled =1
0xFFFF F110 0008 Middle of deviation range 0.000000
0xFFFF F110 000C Deviation Amount (Scaled Units) 0.000000
OxFFFF F110 0010 Scratch Pad Bits OM Ox 00000000 00000000
OxFFFF F110 0013 Scratch Pad Bits OFF Ox 00000000 00000000
HIGH ALARM
OxFFFF F110 0020 In Alarm State? N/A
0xFFFF F110 0024 Enable/Disable Alarm Disabled =1
OxFFFF F110 0023 Limit (Scaled Units) 0,000000
OxFFFF F110 002C Limit Deadband (Scaled Units) 0,000000
OxFFFF F110 0030 Scratch Pad Bits OM Ox 00000000 00000000
OxFFFF F110 0033 Scratch Pad Bits OFF Ox 00000000 00000000
LOW ALARM
OxFFFF F110 0040 In Alarm State? N/A
0xFFFF F110 0044 Enable/Disable Alarm Disabled =1
OxFFFF F110 0043 Limit (Scaled Units) 0,000000
OxFFFF F110 004C Limit Deadband (Scaled Units) 0,000000
OxFFFF F110 0050 Scratch Pad Bits OM Ox 00000000 00000000
OxFFFF F110 0053 Scratch Pad Bits OFF Ox 00000000 00000000
ADVAMCED VALUE SELECTION
0xFFFF F110 0060 Address of value to check 0x FOADDDDD =1
0xFFFF F110 0064 Iz Value a Float? fes =1
CURRENT VALUE
0xFFFF FOAD 0000 Value being alarmed MN/A

[ x 1|

Cancel
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3. Inthe drop-down list, choose the Alarm Number you want to use (by default, it is the same number as
the point the alarm will monitor). Click Used.

The alarm number can be any unused number, but it is best to use the point number, since by default
that point's memory map address and value are shown in the Value Being Alarmed field.

If you need to set two or more alarms on the same point, however, you can do so. For additional alarms,
choose a different alarm number, configure the alarm, and enter the memory map address for the point
in the Advanced Value Selection section. (A complete list of memory map addresses is in the OptoMMP
Protocol Guide, form 1465.)

4. Find the section for the type of alarm you want to use (deviation, high, or low). In the Value column, click
the Enable/Disable Alarm cell and choose Enabled from the drop-down list. Click in other cells to set
deviation or alarm limits. For high and low alarms, also set the deadband for the limit.

A deadband is an allowable variation in the limit to account for signal noise. If the signal fluctuates
slightly, the deadband limit keeps the I/O unit from sending out another alarm.

5. Foreach alarm, also configure the reaction in two parts:
—  Scratch Pad bits that should be turned on
- Scratch Pad bits that should be turned off
See “The Scratch Pad” on page 127.

6. (Optional) If you are setting two or more alarms on the same point, use the Advanced Value Selection
area to enter the memory map address for the point to monitor, and indicate whether the value on that
point is a float.

7. Repeat from step 3 for additional alarms. When you have finished configuring alarms, click OK.
8. (lickthe Save button @ to save the configuration file.

CONFIGURING SERIAL OR WIEGAND EVENTS AND REACTIONS

If you are using Opto 22 serial communication modules—RS-232, RS-485/422, or Wiegand—with SNAP PAC
/0 units, you can configure a serial or Wiegand event to send a serial message, to send an SNMP trap, or to
turn bits in the Scratch Pad on or off when a specific string is received from one or more modules.

Before you configure serial events and reactions, make sure you have configured the serial modules (page 46).

1. Inthe PAC Manager main window, with a configuration file open, right-click the name of the I/O unit on
which you want to set up serial or Wiegand events and choose Configure from the pop-up menu.

= Configure /0 Units X
Mame Type Port Address Watchdog Description Add...
Line_1 SMAP-PAC... Ethernet 10,192.55... Disabled
Preprocess  SMAP-PAC... Ethernet 10.192,55... Disabled Modify...

Delete
Import/Copy...

10 Points...
PID Loops...
Modules 3
— Events
button
ScratchPad  »
Communications »
Others 3

Close | Help
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2. (lick the Events button and choose Serial Events from the pop-up menu, or if you are configuring events
for a Wiegand serial communication module, choose Wiegand Events.

#=#| Configure Serial Events *

Event

Mumber: |0 | [ Used

| Description | Value
EVENT

Serial Ports Mask

Address

0xFFFF F154 0000 0x 00000000

OxFFFF F154 0010 Pattern String (wildcards allowed - e.g. *,7)
REACTION

OxFFFF F154 0038  Resulting String {plug-ins allowed)

OxFFFF F154000C  SNMP Trap Period (seconds) 0

OxFFFF F1540008  SNMP Specific Trap Type 0

0xFFFF F154 0ES0
0xFFFF F154 0F00
0xFFFF F154 0060
0xFFFF F154 0068

SMNMP Trap Priority
Dizable SMMP Trap
Scratch Pad Bits ON
Scratch Pad Bits OFF

High |
Mo j
0x 00000000 00000000
0x 00000000 00000000

0xFFFF F154 0070

]

Enable E-mail Message Disabled =1

Cancel

The example above shows the Configure Serial Events dialog box; the Wiegand Events dialog box is
similar.

3. Inthe drop-down list, choose the lowest unused Event Number. Click Used.

NOTE: To reduce scanning time, the I/0 unit stops scanning serial events when it reaches an unused event. Make
sure you use event numbers in order, starting with the lowest.

4. Inthe Event section, enter a mask in hex notation indicating the serial ports to monitor.

The I/0 unit monitors all ports set as “on”bits in the mask (on = 1; off = 0). If the string is received from
any of those serial ports, the event triggers the reaction. For example, suppose you have serial modules in
positions 1 and 2 on the rack. (Other kinds of modules are in positions 0 and 3.) The following table
shows how you might figure out the mask to monitor three of these serial ports:

Module position:| €¢— 3 2 1 0
Serial port: - - B A B A - -
Default TCP port number: - - [22505(22504 (22503 (22502 - -
Monitor? (Y or N): - - Y N Y Y - -
Mask (binary notation): 0 0 1 0 1 1 0 0
Mask (hex notation): 2 C

The complete hex mask you would enter to monitor these ports is: 0000002C.
5. Enter the pattern string the event should match.
The string is limited to 40 characters. Wildcards (* and ?) can be used.
6. Inthe Reaction section, do any or all of the following:
a. Tosend textin an SNMP trap or a one-time email message, complete the Resulting string field.
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If you send a string, it is limited to 126 characters. You can place data from the serial module or the
I/0 unit's memory map into the string by using any or all of the following plugins:

$! str_ Includes the pattern string in the resulting string.
$! port Shows which serial port sent the pattern string.
SIX _YYYYYYYY Includes data from a memory map address. See “Using Plugins”on

page 95 for more information.

For example, a resulting string that includes the pattern string, the serial port that sent it, and the
text Overload would look like this:
$! str $! port Overload

b. Tosendan SNMP trap, also enter how often in seconds to send the trap (use zero to send it only
once), and enter the trap type. Remember to configure email (page 100).
Trap types are determined by your SNMP management system.

c. Tosend aone-time email notification, also enable E-mail Message. Make sure to configure email
(page 100).
To send multiple emails, don't enable email here. Instead, turn on a Scratch Pad bit (step e) and set
up the email when you configure event messages (page 92).

d. Tosend aserial message out a serial port, don't put the message here. Instead, turn on a Scratch Pad
bit (step e) and set up the serial message when you configure event messages (page 92).

e. Toset Scratch Pad bits, enter masks for the bits to turn on and the bits to turn off when the serial
event occurs.

7. Repeat from step 3 for other serial events and reactions. When you have finished configuring serial
events and reactions, click OK.

8. Click the Save button ﬂ to save the configuration file.

CONFIGURING EVENT MESSAGES

If you are using PAC Control or PAC Manager 9.0 or higher, configure event messages in the
configuration file as shown on page 92.

If you are not using PAC Control or are using a PAC Manager version less than 9.0, you cannot
configure event messages in a configuration file. Instead, use PAC Manager's Inspect mode and follow the
steps below. Note that event messages are not available on SB brains, since messaging requires an Ethernet
connection.
1. Inthe PAC Manager main window, click the Inspect button Q
- Ifyou have not used the Inspect window before, the window will not show any data. Select your
controller from the drop-down list.
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- If you have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.

= Inspect Opto 22 Device

Device Name: | 10.192.50.21

Status Read
Status Read
Status Write

Wireless LAN  »

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density
System 3
ScratchPad  »
Data Log 3

Events 3
Communications
Other 3

Close |

FID

3

Status:

j Options »

Status Read area last read at 07/05/16 12:03:48

~ Refresh |

-D5-0B
1

.0

a

1

hDDRESS DESCRIFTION VALUE

0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}

0xFFFF FO30 0008 Busy Flag a

0xFFFF F030 0018 Loader Version RE6.la

0xFFFF FO30 0000 Memory Map Version 1

0xFFFF F030 0230 Current Boot Device Flash Memory

0xFFFF F030 001C Firmware Version R59.5a

0xFFFF FO30 00R0 Firmware Version Date 07/05/2016

0xFFFF F030 00BO Firmware Version Time 07:58:52

0xFFFF FO30 0020 Unit Type 0x0000007C

0xFFFF FO30 0080 Unit Description SNAP-FAC-51

0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 11

0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 22

0xFFFF FO030 002§ I/0 Unit Hardware Revision (Year) 2005

0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a

0xFFFF FO30 0028 Installed Ram 33554432
ETHERENET 1 Interface

0xFFFF FO30 002E MAC Rddress 00-A0-3D-00

0xFFFF FO30 0034 IF Address 10.1%2.50.2

0xFFFF FO30 0038 Subnet Mask 255.255.192

0xFFFF FO30 003C Gateway Al el e

0xFFFF FO30 0040 DNS 10.192.60.9
ETHERENET 2 Interface

Help |

™ AutoRefresh | 15000  msec

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the

drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have
six or more devices configured.

Device Naf

EngineRm

SASIGE Coil Portable

Status Wiits

Wireless LAN

Chamber 1

Chamber 2

=] Inspect Opto 22 Device

Cookie Controller

Cookie Controller

Paint Config oyl portable

(CRIFTION

rerup Clea
¥y Flag 1

der Versij

o Cookie Controller ory Map Vi

HD@E' B EngineRm mware Verd

Digital Point S2fPAC mware Ver,
=7 i

‘fJxFFFF FO30 00BO Firmware Verg

A SF S e N P e

2. Inthe Device Name field, type the name (or IP address) of the I/O unit (or choose it from the drop-down

list).

3. (lick Events and choose Event Messages from the submenu.
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= Inspect Opto 22 Device — *

Device Name: | 10.192.55.67 j Options » Status: | Event Message area last read at 07/05/16 13:31:00

Event Message
Status Read

Event Message Mumber: |0 -
Status Write |

= . Address | Description Value | Refresh |
Wireless LAN MESSAGE
0xFFFF F120 0040 Message Text Apply
Point Config

0xFFFF F120 9000 Most Recent Message Sent

. 0xFFFF F120 0000 State Inactive =1
Digital Bank OXFFFF F120 0004  Scratch Pad Trigger ON 0x 00000000 00000000
| . 0xFFFF F120 000C Scratch Pad Trigger OFF 0x 00000000 Q0000000
Digital Point STREAMING
Analog Bank OxFFFF F120 0014 Enable Stream Packet Disabled |
OxFFFF F120 0018 Stream Period (seconds) 0

Analog Point E-MAL . .
OxFFFF F120 001C Enable E-mail Message Disabled

=l
High Density OxFFFF F120 0020 E-mail Period (seconds) ]
SERIAL MODULE
System N OxFFFF F120 0033 Enable Serial Module Message Disabled |
0xFFFF F120 003C Serial Ports Mask O 00000000
Scratch Pad SNMP
OxFFFF F120 0024 Enable SMMP Trap Disabled =l
Data Log » OxFFFF F120 0028 Trap Period (seconds) 0
0xFFFF F120 002C Trap Type 1]
PID » 0xFFFF F120 0030 Priority High =1
MEMMAP COPY DESTIMATION
Events 4 OxFFFF F120 8000  MemMap Address 0x 00000000
e OxFFFF F120 8004 IP Address of Destination 0.0.0.0
Commurnications » OxFFFFF1208008  Port 0
Other 5 OxFFFF F120 800C Period (milliseconds) 1}
Close | Help | [~ AutoRefresh | 15000  msec

From the drop-down list, choose the lowest unused message number.
Unused message numbers have no asterisk.
For an email or serial message, or optionally for an SNMP message, enter the message text.

Message text is not sent in the streaming packet. Message text is limited to 127 characters. You can place
data from the I/O unit’s memory map into the message by using a plugin (see page 95). If you are
sending a serial message, make sure the text is formatted so the serial device that receives it will
understand it.

Enter two masks indicating the Scratch Pad on and off bits that should trigger the message.
For help in figuring out the masks, see “Digital Point and Scratch Pad Masks”on page 132.

Streaming section: To send a stream of data as the message, choose Enabled from the drop-down list.
Enter how often in seconds to send the stream (0 sends it only once).

For information on streaming, see page 96.

E-mail section: To send an email message, choose Enabled from the drop-down list. Enter how often in
seconds to send the email (0 sends it only once).

Serial Module section: To send a message through a serial module to a serial device, choose Enabled from
the drop-down list. Enter a mask representing the modules and ports to receive the message.
Information in “Configuring Serial or Wiegand Events and Reactions” on page 139 may be helpful.

SNMP section: To send an SNMP trap as the message, change Disabled to Enabled. Enter how often to
send the trap (0 sends it only once). Also enter the trap type (determined by your SNMP management
software). If you are using SNMP with outgoing PPP and want the trap stored in the I/O unit until the next
communication, set Priority to Low. If you want the I/0 unit to immediately dial out and send the trap, set
Priority to High.

For information on SNMP, see page 96.

NOTE: SNMP messages must be acknowledged. You can do so in your application or in PAC Manager’s Inspect
window: in the Message section, change the State to Acknowledge and click Apply.
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11.

from “Copying Memory Map Data”on page 109.

12.

When all fields are correct, click Apply.

13. Repeat from step 4 to configure additional event messages.

14.

Serial:
SNMP:
Email:

Streaming:

15.

See page 46
See page 96
See page 100
See page 104

Memmap Copy Destination section: To copy memory map data, complete this section using information

For each type of message you configure, make sure you also set up basic configuration:

When you have finished configuring all event messages and any additional configuration required for

them, in the PAC Manager Inspect window, make sure the IP address shown is the correct one. Then click
the Status Write button in the upper-left part of the window.

16.

In the Operation Commands list, highlight Store configuration to flash.

é Inspect Opto 22 Device

Analog Point |
High Density |

System 3 |
ScratchPad |
Data Log 3 |
PID 3
Events 3 |
Communications # |
Other 3 |

Operation

Device Name: | 10.152.50.11 ;I Cptions » | Status: | Status Write area lastread at 05/02/16 16:30:29
-~ Status Write
Status Read |
Status Write | Address | Description | Value A
OxFFFF FO38 0004  Always BootP /[DHCP On Powerup Mo |
. 0xFFFF FO38 0008 Degrees FfC Degrees F | Apply |
WirelessLAN ¥ 0xFFFF F038 0010  Comm Watchdog Time (msec), 0 = Disable 0
OxFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250
Point Config | OxFFFF FO38 0018  TCP Initial Retransmission Timeout (msec) 3000
0xFFFF F038 001C TCP Retransmission Attempts 5
Digital Bank | 0xFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1
Digital Point | 0xFFFF F032 0050 Max Anzlog and High Density Digital Scan Interval (msec) 1000
Analog Bark | OxFFFF FO33 0298  Out Of Range Yalue (15-Bit) -32768.000
0xFFFF F038 02B0  Out Of Range Value (32-Bit) -21474335648.000
0xFFFF FO38 0054  Scanner Flaos 0x 00000000

OptoMMP Device

microSD

Other

Restart Device from powerup
Store configuration to flash

Erase configuration from flash k
Reset to defaults and Restart Device

A Send Command

Store configuration and IP settings to microSD
Erase configuration and IP settings from microSC.
Erase firmware from microSD

Erase strategy from microSD

Switch to loader mode
Clear Digital Events - Expanded configuration
C!ear D!giial Events - OIE:I configuration W

- |

[~ Auto Refresh |15000 msec

17. Click Send Command.
The configuration data is stored to flash memory and a Success message appears.

IMPORTANT: For the following configurations, you must also restart the unit for configuration to take effect:

Changes in TCP port for serial modules

Email configuration

Data logging interval
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18. If you have configured any of these items, in the Operation Commands list, highlight Restart 1/0 Unit
from powerup. Click Send Command.

The I/0 unit is restarted and a success message appears.
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5: Reading and Writing to Specific
Devices

INTRODUCTION

This chapter shows you how to read and write to a SNAP PAC controller or I/O unit directly by using PAC
Manager's Inspect window. In addition to reading and writing specific values, you can configure points and
functions using the steps in this chapter. However, these configurations cannot be saved to a
configuration file.

Because all reads and writes using the steps in this chapter are sent directly to the controller or I/0 unit, the
device you are reading from or writing to must be on the same network as your PC or laptop computer. For a
SNAP PAC SB brain, you can read or write to the brain through a SNAP PAC S-series controller, or you can
connect the computer directly to the brain using a PCI-AC48 adapter card and a serial cable. For more
information on these connections, see the SNAP PAC Brains User's Guide (form 1690).

CAUTION—Ifyou are using PAC Control: When you read and write to specific devices using the instructions in this
chapter, the reads and writes occur independently of PAC Control strategy logic. If you are using PAC Control, you
normally use the flowchart logic in the PAC Control strategy to read and write to the I/0 unit. It's not a problem to
read directly, but if you use the instructions in this chapter t to write to an I/0 unit, be very careful that your actions
do not conflict with PAC Control logic.

As you use PAC Manager's Inspect window, you'll notice that the starting memory map address for each item
is shown. This can be a handy way to determine addresses you need for programming or configuration. You
can also highlight an address and right-click it to copy it; then you can paste it where you are using it.

You can also copy and paste part or all of the data you read in the Inspect window. Just highlight the data you
want to copy and use standard Microsoft Windows commands such as Ctrl+C to copy the data, and Ctrl+V
to paste it into a text, email, or other file.

READING BASIC DEVICE INFORMATION

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.

2. Inthe PAC Manager main window, click the Inspect button Q (orin the PAC Manager menu bar, click
Tools > Inspect).

The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.
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- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

@ nspect Opto 22 Device —

Device Name: | 10,199.99.99 j Options # Status: | Status Read area last read at 07/05/16 10:34:58

Status Read
Status Read
Status Write ADDRESS DESCRIFTION VALUE ~ Refresh |

) 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
{ WirelessLAN ¥ OxFFFF F030 0008 Buay Flag 0
| Paint Config 0xFFFF F030 0018 Loader Version R5.1lc
Digital Bank 0xFFFF FO30 0000 Memory Map Version 1
0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016

Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A

High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
| 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
| 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
| ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log 3
ETHERENET 1 Interface

PID * 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-85-9C
, I_ OXFFFF FO30 0034 IP Address 10.192.55.67
,-__,,,Eue\n—‘r"\__,_.. A LOZFERFEQ 200038, s S nolMongie, e mmton p o team o, 908 OGFL00 QL AN A s, sl

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

Wpto 22 Device

eS0T S O B ookie Controller

1_ [EngineRm i
| Cail Portable
: SoftPAC [CRIPTION
e lerup Clea
Wireless LAN | Boler =

—— I Chamber 1 s
. Chamber 2 J
Point Config g partable der Versid
T Cookie Controller ory Map Ve
HD@E' B EngineRm mware Verd
Di SoftPAC Imware Ver

igital Point = 1
0xFFFF F030 00BO Firmware Verg

3. Inthe Device Name field, type the name (or IP address) of the controller or I/0 unit (or choose it from the
drop-down list). Click Status Read.

Information from the device is displayed in the window.
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Date and time data was last read

!

Click to update data

_ X

Device Name: | 10.192,55.67 x| Gptions » Status: | Status Read area last read at 07/05/16 13:30:03 i
Status Read
Status Read
Status Write P‘DDRESS DESCRIPTION VALUE ~ Refresh |
Nirel 5 0xFFFF F030 0004 Powerup Clear Flag FUC Needed FUC Received (0)
=l 0xFFFF F030 0008 Busy Flag 0
Point Config 0xFFFF F030 0018 Loader Version R5.1c
Dicital Bank 0xFFFF F030 0000 Memory Map Veraion 1
Iqital pan 0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point 0xFFFEF F030 001C Firmware Version A9.5a
0xFFFF F030 00R0 Firmware Version Date 05/03/2016
Analog Bark 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF F030 0020 Unit Type 0x00000074
High Density 0xFFFF F030 0080 Unit Description SNAP-FAC-R1
0xFFFF F030 0024 1/0 Unit Hardware Revision (Month) 4
5 0xFFFF F030 0025 1/0 Unit Hardware Revision (Day) 21
HEEd 0xFFFF F030 0026 1/0 Unit Hardware Revision (Year) 2008
ScratchPad  » 0xFFFF F030 024C I/0 Coprocessor Firmware Version L0.0&
0xFFFF F030 0028 Installed Ram 33554432
Data Log 3
ETHERNET 1 Interface
PID b 0xFFFE F030 002E MLC Lddress 00-20-3D-01-85-9C
Events 5 0xFFFF F030 0034 IF Rddress 10.192.55.67
0xFFFF F0O30 0038 Subnet Mask 255.255.192.0
Communications » 0xFFFF FO30 003C  Gateway 10.192.51.51
0xFFFF F030 0040 NS 10.1592.60.31
Other 3 ETHEENET 2 Interface )
Close | Help | [ AutoRefresh | 15000  msec

Scroll down to see all of the information. Data is current as of the date and time shown in the Status field
at the top right corner of the window. (Note that date and time are from the computer, not from the I/0
unit.) To update data, click the Refresh button. See the next two pages for help in interpreting data.

Interpreting Status Data

The following table may help you interpret the information you see in the Status Read window. Some items
may not appear, depending on the Opto 22 device you are using. Some of this information can be changed
(see page 153). Much of it is used only for troubleshooting. If you have additional questions about status data,

contact Product Support (see page 4).

The term “device”is used in this table to refer to a SNAP PAC brain or controller.

Description Explanation

Since a powerup clear (PUC) is automatically sent by the device whenever it is

Powerup Clear Flag PUC needed
Busy Flag

Loader Version

turned on, this value should show PUC Received.

Zero means the device is not busy and can process your requests.

Revision number of the device’s loader. The loader is like a basic input/output

system (BIOS).

Memory Map Version Revision number of the device’s memory map

(PAC-R and PAC-S only) Whether the PAC booted from its Flash memory or from a

Current Boot Device microSD card

PAC Manager User's Guide 149



READING BASIC DEVICE INFORMATION

Description Explanation

Firmware Version
Firmware Version Date
Firmware Version Time
Unit Type

Unit Description

1/0 Unit Hardware Revision (Month)

I/0 Unit Hardware Revision (Day)

1/0 Unit Hardware Revision (Year)

1/0 Coprocessor Firmware Version

Installed Ram

Product Serial Number
Address

Baud Rate

Number of Framing Errors

Number of FIFO Overrun Errors

Communications Debug Flag

MAC Address

IP Address
Subnet Mask
Gateway

DNS or Name Server
Ethernet 2 MAC Address

Ethernet 2 IP Address
Ethernet 2 Subnet Mask
Ethernet 2 Gateway
Ethernet 2 DNS

Wireless LAN MAC Address

WLAN IP Address

WLAN Subnet Mask

WLAN Primary Gateway
WLAN Secondary Gateway
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Revision number of the device's firmware, and the date and time of the revision

Hex code indicating the device type.

Part number of the device (brain or controller)
Version date of the device’s hardware

(Applicable to rack-mounted controllers and brains manufactured starting in
2016.) Revision number of the I/O coprocessor firmware. If the value is 0 (zero) or
AO0.0a, your device does not have an I/O coprocessor.

For more information, see the SNAP PAC I/0O Coprocessor Firmware Readme.

Number of bytes of RAM in the device

(SB brains only) Barcoded product number inside the brain
(SB brains only) Current serial address of the brain

(SB brains only) Current baud rate of the brain

(SB brains only) A serial transmission error; normally zero. If it’s not zero, verify
baud rate or check for noise on the serial bus.

(SB brains only) Normally zero. Any value other than zero indicates that serial
characters are being dropped.

(SB brains only) A value of 1 indicates that Communication Error Blink Codes are
enabled. See the brain user’s guide for details.

Unique hardware Media Access Control (MAC) identifier for the device, assigned
at the Opto 22 factory. MAC addresses for all Opto 22 devices start with 00-A0-3D.

IP address, subnet mask, and default gateway for the device on the Ethernet
network. You assign these numbers; see page 8.

Not currently used; leave at 0.0.0.0
(SNAP PAC controllers only) Unique hardware Media Access Control (MAC)
identifier for the second Ethernet interface on the device.

(SNAP PAC controllers only) IP address, subnet mask, and default gateway for the
second
Ethernet interface on the device. You assign these numbers; see page 17.

(SNAP PAC controllers only) Not currently used; leave at 0.0.0.0

(Wired+Wireless devices only) Unique hardware Media Access Control (MAC)
identifier for the device’s wireless LAN interface.

(Wired+Wireless devices only) IP address, subnet mask, and gateways for the
wireless LAN interface on the device. You assign these numbers; see page 22.
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Description Explanation

WLAN Primary DNS
WLAN Secondary DNS

Always BootP/DHCP On Powerup

Degrees F/C'

Comm Watchdog Time (msec)’

Out of Range Value (16-bit)

Out of Range Value (32-bit)

Scanner Flags

4-Channel Digital Scan Count!

Analog & High Density Dig Scan Count'

Milliseconds Since Powerup

Elapsed Time Since Powerup

TCP Minimum RTO (msec.)

TCP Initial RTO (msec.)

TCP Retransmits

TCP Idle Session Timeout (msec.)
TCP Idle Session Timeout Count
Ethernet Errors: Late Collisions
Ethernet Errors: Excessive Collisions

Ethernet Errors: Others

Smart Modules Present’

(Wired+Wireless devices only) Not currently used; leave at 0.0.0.0

A value of 0 (the normal setting) means the device sends a request (a BootP or
DHCP request) for an IP address only if its IP address is 0.0.0.0. A value of 1 means
the device sends a BootP or DHCP request every time it is turned on. See page 8
for more information.

Whether temperatures on the I/0 unit are handled in Fahrenheit or Celsius. Set
when you configure the I/0 unit (page 31). Celsius is the default.

If the I/0 unit has a watchdog, the watchdog timeout in milliseconds. Set when
you configure the I/O unit (page 31). Default is 0 (no watchdog).

Only for SNAP PAC analog input modules that return 16-bit values. If a value goes
out of range, this number appears as the value. Default is -32,768. Can be
changed; see page 153.

Only for SNAP PAC analog input modules that return 32-bit values, such as the
SNAP-AIRATE-HFi and SNAP-AIRTD-8U modules. If a value goes out of range, this
number appears as the value. Default is -2147483648. Can be changed; see
page 153.

Shows scanner and control engine options. Value can be any of the following or a
combination of them, in hex. See “Scanner Flags” for more information.

1= Alarms are being processed in the digital scanner rather than the analog
scanner.

2 = Analog/HDD scanner is disabled. (Disables scanning of high-density digital
modules as well as analog modules.)’

4 = Digital scanner is disabled.’

8 = (applies to all standalone and on-the-rack controllers) PAC Control engine is

stopped.

Shows the number of times the processor (brain or on-the-rack controller) has
scanned the digital points for 4-channel digital modules on the I/0 unit. Can be
used for benchmarking.

Shows the number of times the processor has scanned the analog and
high-density digital module points on the I/0 unit. Can be used for
benchmarking.

Milliseconds since the last time the device was turned on. Value rolls over after
4,294,967,295 ms, which is equal to 49.71 days.

Time since the device was last turned on. Time is shown in the format
days:hh:mm:ss

TCP communication settings; see page 229.

Number of times the device closed the session because it was idle.

Values other than 0 may indicate network problems. See page 231.

Mask in hex showing location of analog, serial, and high-density digital modules
on the rack. Module 15 is in bit position 15; module 0 is in bit position 0. (For help
in understanding masks, see “Mask Data” on page 195.)
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Description Explanation

PID Loops Supported

Digital Modules Supported

Arcnet Reconfigs Detected!

Arcnet Reconfigs Initiated by I/O Unit!

Arcnet Transmit Attempts Since Powerup1

Arcnet ACKs'

Arcnet Timeouts'

Arcnet Other (node not found, etc.)’
Arcnet Timeout Value (msec.)!
Arcnet Receive Interrupts’

Ethernet MAC Resets Since Powerup

Dig. Output Point Resets Since Powerup1'2

Dig. Interrupt Failures Since Powerup1

Analog & High Density Digital Scanner'

4-Channel Digital Scanner'

Module X - Times Discovered"

Maximum number of PID loops possible on the device (96 on PAC-R, EB, and SB
brains). See page 63.

Number of 4-channel digital modules supported (0, 8, or 16).

Added in PAC firmware 8.1; older firmware doesn’t include this address. Useful for
SNAP-PAC-R1 and SNAP-PAC-R1-B.

Due to B-series rack limitations, R1-Bs support 4-channel I/O

modules only in the first 8 rack positions.

R1s with serial numbers below 600,000 support 8 digital modules in the first 8
rack positions; newer R1s support 16.

Indicates that a smart module has been added, removed, or reset. (ARCNET is
used on the rack for communication between the processor and analog, serial, or
high-density digital modules.) NOTE: If the rack contains only 4-channel digital
modules, ignore this value.

Error on the rack’s ARCNET bus. Not a concern unless it happens frequently.

Refers to the ARCNET bus on the rack. May be useful in troubleshooting
communication to analog, serial, or high-density digital modules.

Caused by EMI, RFI, or other electrical noise.

Related to digital counters. May have missed counts. Contact Opto 22 Product
Support.

(milliseconds per scan) Average length of time the processor takes to scan all
analog and high-density digital points on the rack. Based on the last 100 scans
(last 50 scans for points on high-density digital modules, as they are included in
every second scan). A value of -1 means the scanner is not running.

(milliseconds per scan) Average length of time the processor takes to scan all
4-channel digital points on the rack, based on the last 100 scans. A value of -1
means the scanner is not running.

How many times the processor has rediscovered a smart module (analog, serial,
high-density digital). Normal value is zero; values over 1 may indicate that a
module is resetting.

! Does not apply to SNAP PAC S-series and SoftPAC controllers
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The following items in the Status Read/Status Write windows can be changed in PAC Manager if the device
supports them.

Always BootP/DHCP on Powerup
Degrees F/C

Comm Watchdog Time

TCP Settings

Digital Feature Scan Interval

Max Analog and High Density Digital Scan Interval

Out of Range Value (16-bit)
Out of Range Value (32-bit)

Scanner Flags
Domain Name

Strategy Download Method

Turnaround Delay

Communication Error Blink Codes
Ethernet 2 Interface Settings

1. Inthe PAC Manager main window, click the Inspect button Q .
The Inspect window opens.
If you haven't used the Inspect window before, no data is displayed in the Status Read pane.

If you have used the Inspect window before, the last device you inspected is shown in the Device

Name field, and current Status Read information appears in the window.

If you have configured other devices, they are listed in alphabetical order in the drop-down list.

&% Inspect Opto 22 Device

Device Name: | 10.199.59.99

Status Read
Status Read

Status:

j Options »

Status Read area last read at 07/05/16 10:34:58

Status Write NS

DESCRIFTION

VALUE

~ Refresh |

0xFFFF F030
0xFFFF F030

| WirelessLAN ¢

: Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
| High Density
System 3
| ScratchPad  »
Data Log 3

FID 3

0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030

0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030

0xFFFF F030
0xFFFF F030

,-__,,,E“e\n-‘r"\__:..l_ A LOZFERFEQ 20038, # S noLMongie, e mmton pob e, 908 AGFAO0 QL A A st sl

00ZE
0034

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress

PUC Receiwed (0}
a

R5.1c

1

Flash Memory
29.5a
05/03/2016
15229232

0x0000007A
SHAP-FRC-R1
4

21

2008

R0.0a
33554432

00-A0-3D-01-85-3C
10.192.55.67

If you have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

Wpto 22 Device

Cookie Controller

|_ |[EngineRm i
| Cail Portable
: SoftPAC [CRIPTION
e lerup Clea
Wireless LAN | Boler i
—— I Chamber 1 s
. Chamber 2 J
Point Config g partable der Versid
o Cookie Controller ory Map Vi
HD@E' B EngineRm mware Verd
Digital Point S2fPAC mware Ver,
0xFFFF F030 00BO Firmware Verg
F oot PP e
e

2. Inthe Device Name field, type the name of the device (or choose it from the drop-down list).
3. Click Status Write.

*

| Inspect Opto 22 Device —

j Options ¥

Device Name: | 10,152,50.12 Status:

Status Write
Status Read

Status Write area last read at 05/02/16 16:56:15

154

Status Write Address | Description | Value ~ Refresh

OxFFFF FO38 0004  Always BootP/DHCP On Powerup Mo hd
Wircless LAN ¥ OxFFFF FO358 0008 Degrees F[C Degrees F =1 Apply

OxFFFF FO38 0010  Comm Watchdog Time {msec), O = Disable 1]
OxFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250

Point Config OxFFFF FO38 0018 TCP Initial Retransmission Timeout (msec) 3000
OxFFFF F033 001C TCP Retransmission Attempts 5

Digital Bank 0xFFFF FO33 0020 TCP Idle Session Timeout {(msec), 0 = Disable 240000

= = OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1

Frle Ho OxFFFF F038 0050 Max Analog and High Density Digital Scan Interval (msec) 1000

Analog Bark OxFFFF F038 0298 Out Of Range Value (16-Bit) -32763.000
OxFFFF FO38 02B0  Qut Of Range Value (32-Bit) -21474836483.000
OxFFFF FO38 0054 Scanner Flaos Ox 00000000 A

Analog Point

High Density Operation

System »
ScratchPad  »
Data Log 3
PID r
Events »
Communications
Other 3

OptoMMP Device
Restart Device from powerup
Store configuration to flash
Erase configuration from flash
Reset to defaults and Restart Device
microSD
Store configuration and IP settings to micraSD
Erase configuration and IP settings from microSC
Erase firmware from microSD
Erase strategy from microsSD
Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration ]

~ Send Command

[tems that can be changed are listed in the upper section of the dialog box. To change one, click its Value

[~ AutoRefresh | 15000  msec

field and either choose from the drop-down list or enter the new value as described below:

Always BootP/DHCP on Powerup (All devices): If you change this field to Yes, the current IP address
becomes temporary and the device will send a BootP broadcast the next time it is turned on. If you

change this field to No, the current IP address is saved to flash memory and becomes a static IP address.

Degrees F/C and Comm Watchdog Time (/0 units only): Changes settings for the whole I/0 unit.
IMPORTANT: Set Degrees F/C before configuring temperature inputs. If some inputs are already
configured, reset their Upper and Lower Scaled Units after changing Degrees F/C.
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TCP settings: CAUTION: Before changing TCP settings, see page 229.

Digital Feature Scan Interval and Max Analog and High Density Digital Scan Interval (/O units
only): Default is 1000 milliseconds for analog and 1 milliseconds for digital. You can decrease the scan
interval (to make it scan more frequently) to make sure the scanner isn't slowed or stopped by heavy
communication on the network. You can also shut down the scanner immediately by changing its scan
interval value to -1 (does not require restarting the 1/0 unit). As of PAC firmware version 8.1, analog
modules with more than 4 points are scanned no faster than every 30 milliseconds, and analog modules
with four or fewer points are scanned no faster than every 6 milliseconds, to maintain synchronization
with the module. Note that scan interval changes revert to default values when power is lost, unless you
save your changes to flash.

Out of Range Value (16-Bit) and Out of Range Value (32-Bit): Set the value that an analog input
module returns when a signal is above or below a defined range. If the default out-of-range value is
potentially a valid in-range value, you can enter a different value to indicate an out-of-range condition.
Most SNAP analog input modules use the 16-bit out-of-range value, which has a default value of -32,768.
Analog input modules that return a 32-bit value (such as the SNAP-AIRATE-HFi and SNAP-AIRTD-8U
modules) use the 32-bit out-of-range value, whose default value is -2147483648.

Scanner Flags: To change the way scanners work or stop/start the control engine, enter one or a
combination of the following values in hex.

— (/O units only) To process alarms in the digital scanner rather than the analog scanner, enter 1.

— (/O units only) To disable the analog scanner, enter 2.

- (I/O units only) To disable the digital scanner, enter 4.

- (PAC-R only) To stop the PAC Control engine runtime, enter 8,

For example, if you have a SNAP-PAC-R1 1/0 unit with digital I/O only and are not using a PAC Control
strategy, you can get faster reactions to events by entering 1 + 2 + 8, which would be 0x0000000B. NOTE:
You must save to flash and restart for this change to take effect.

Strategy Download Method (SNAP PAC controllers only): Choose Background to enable background
downloading. (For details, see the PAC Control User's Guide, form 1700).

Turnaround Delay (controllers or brains with serial ports): Enter how long the controller or brain should
wait to send a response to serial communication. Default is zero (no delay).

Communication Error Blink Codes (SB brains only): For troubleshooting, choose Enabled from the
drop-down list to see communication error blink codes. (See the Troubleshooting section in the brain
user’s guide for details.) Be sure you turn off blink codes after troubleshooting; they will degrade
performance.

Ethernet 2 IP Address information (SNAP PAC controllers only): See “Assigning an IP Address to Ethernet
2 (SNAP PAC Controller Only)” on page 17 for information.

When you have finished entering changes, click Apply.

Most changes take effect immediately. If you change the Scanner Flags, secondary IP address
information, or strategy download method, however, you must store the configuration to flash and
then restart the controller or brain. See also “Assigning an IP Address to Ethernet 2 (SNAP PAC Controller
Only)"on page 17.

Referencing I/0 Points

The following sections show input and output point numbers for I/0 units.

For SNAP serial communication modules, see page 156.You will also need the SNAP Serial
Communication Module User's Guide (form 1191).

CAUTION: Make certain you are using the correct rack for the processor. Using an incompatible rack can cause
severe damage to the brain or controller.
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SNAP PAC Racks

Use any of these racks With any of these processors

mﬁg:gﬁgﬁgﬁ-m* SNAP-PAC-R1, SNAP-PAC-R1-FM?, SNAP-PAC-R1-W*
SNAP-PAC-RCKS SNAP-PAC-R2, SNAP-PAC-R2-FM?*, SNAP-PAC-R2-W*
SNAP-PAC-EB1*, SNAP-PAC-EB1-FM*, SNAP-PAC-EB1-W*

| | _| *
SEQE-EQE-EEﬁSZFM SNAP-PAC-EB2*, SNAP-PAC-EB2-FM*, SNAP-PAC-EB2-W*
SNAP-PAC-SB1*

SNAP-PAC-RCK12-FM* !
SNAP-PAC-RCK16 SNAP-PAC-RCKT6-FM* | >N AT PACSB2

* Obsolete part number

SNAP PAC mounting racks can hold up to 4, 8, 12, or 16 Opto 22 SNAP I/0O modules. Point features and
modules supported vary by processor; see the processor's data sheet for specifications.

Each module contains 1 to 32 channels (points), depending on the module. Examples of modules are shown
in the following diagram.

SNAP PAC

o &

Module position 0, 4-ch digital:

Channels: n

v

1 =
g —D\

Module position 6, high-density
digital:

Channels: n

|

1—Module position 8, analog:

Channels:|7|6|5|4|3|2|1|0|

L ol

wimm|mn

Module position 12, analog:

Channels:

Module position 14, serial:

Ports:

L £

[

li
S

Serial Modules
NOTE: Serial modules cannot be used with SNAP PAC SB brains.

SNAP-SCM-232, SNAP-SCM-485, SNAP-SCM-485-422, and SNAP-SCM-W2 modules each have two serial ports,
A and B. Profibus modules (SNAP-SCM-PROFI) have one serial port.
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To establish an Ethernet connection between the SNAP PAC I/0 unit and a serial module, you use the IP
address of the I/0 unit the module is on, plus the TCP port number for the module’s serial port. The following
table shows default port numbers for each port in each position on the largest rack. For a Profibus module, use

the Port A port number.
Module TCP port Module TCP port
Position L Number Position FO Number
A 22500 A 22516
0 8
B 22501 B 22517
A 22502 A 22518
1 9
B 22503 B 22519
A 22504 A 22520
2 10
B 22505 B 22521
A 22506 A 22522
3 11
B 22507 B 22523
A 22508 A 22524
4 12
B 22509 B 22525
A 22510 A 22526
5 13
B 22511 B 22527
A 22512 A 22528
6 14
B 22513 B 22529
A 22514 A 22530
7 15
B 22515 B 22531

These port numbers can be changed if necessary. See page 46 for instructions.

CONFIGURING 1/0 MODULES, POINTS, AND FEATURES

Before you can read or write to I/0 points, you must configure point types and point features. You can do so
using PAC Manager’s Inspect window. Remember, however, that configurations you set in the Inspect window
cannot be saved to a configuration file. They are sent directly to an individual I/O unit. To use a configuration
file, see “Chapter 2: Configuring Devices,” especially “Configuring I/O Modules and Points”on page 35.

Point Types Requiring Configuration

The SNAP PAC /0 processor can recognize analog, serial, and high-density digital modules, and it assumes a
default configuration for all points on those modules. Any module position not occupied by an analog, serial,
or high-density module is assumed to be a 4-channel digital input module.

You'll need to configure the following point types:

« Al digital output points on 4-channel digital modules. Use point type 180.

«  Analog points that do not use the default point type for the module. For example, if the points on a
SNAP-AIRTD module are 120 Ohm Nickel 3-wire RTDs (=80 to +260 °C), they must be configured,
because the default for that module is 100 Ohm Platinum 3-wire RTDs (=200 to +850 °C). Point types for
analog modules are shown in the tables beginning on page 160. Default point types are indicated.
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Point Features Requiring Configuration

Point features vary based on the processor and the module. The following point features are not automatic
and must be configured for each point that uses them:

High-speed digital input counters and quadrature counters

Digital and analog watchdogs

Analog scaling, clamping, offset and gain, and average filter weight

See “Using I/0 Point Features”on page 70 for a description of features.

Configuring Analog and Digital Points and Features

1. .Inthe PAC Manager main window, click the Inspect button Ql }

2.

The Inspect window opens.

0xFFFF F030 0004

S ’l 0xFFFF FO30 0008

Paint Config | 0xFFFF FO30 0018
= 0xFFFF FO30 0000
EREIE 0xFFFF FO30 0230
Digital Paint | 0xFFFF F030 001C
0xFFFF FO30 00R0

Analog Bank | 0xFFFF FO30 00BO
Analog Point | 0xFFFF FO30 0020
S s 0xFFFF FO30 0080
ELIEEE 0xFFFF FO30 0024
, 0xFFFF FO30 0025

HEED | 0XFFFF FO30 0026
E— ,l 0xFFFF FO30 024C
0xFFFF FO30 0028

Data Log 3 |

FID 3

0xFFFF F030 002ZE
0xFFFF F030 0034

,-\‘_,.P‘E\”—‘F*\_AL > QR ERP 0200038 i Sane fMasin mn A oot b, D5 AASEAAR, O, A ey A suman et

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress

PUC Receiwed (0}
a

R5.1c

1

Flash Memory
19.5a
05/03/2016
15229232

0x0000007A
SHAP-FRC-R1
4

21

2008

R0.0a
33554432

00-A0-3D-01-85-3C
10.192.55.67

é s _ %
Device Name: | 10.199.99.99 Ll Options ¥ | Status: | Status Read area last read at 07/05/16 10:34:58
—Status Read
Status Read |
T — | ADDRESS DESCRIPTION VALUE = Refresh I

In the Device Name field, type the name (or IP address) of the I/O unit (or choose it from the drop-down

list). Click Point Config.
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Module position number 3 Inspect Opto 22 Device - x

ice Name: | 10,192,50,12] j Options ¥ Status: | Point Configuration area last read at 05/02/16 17:00:48
Point numbers for this module are

shown in yellow.

Point Configuration
Status Read

S : Choose a module
[Module {0) t 2 3[4 5 6 7[8 9 10 1112 13 14 15 Typer  AOV5(0aS)

Status Write

" Step 2: Choose a point on the selected module
LEESR - - — - Type: 0 to 10 VDC Single (0x85)
S 5L 2]5 4 L D]5 L D B]E 5 5 D) e e
. . . o (-] A i =} o i ol .
Point zero is currently being read HoriCaliy Name:  a012Yout_0000

he!’e. Since thisis not an analog gDigital par Address | Description | Value | Refresh
point, analog values are grayed ———Digialpant | ALL POINTS
0xFFFF F010 0000 AOV-5 (0x85) Apply

Module Type

out. Analog Bank OxFFFF FO 10 0004 Paint Type 0 DC Single (0x85) hd
OxFFFF FO10 0008 Point Feature 0x 0
. Analog Paint OxFFFF FO10 0024 Watchdog Output Value  0.000
To update values, click the Refresh - - OXFFFFF0100028  Watchdog Enabled Disabled -
High Density OxFFFF FO10 0030 Point Name a012Vout_0000

button. To modlfy valugs, change ANALOG ONLY
the parameters (if applicable) and System  *| | |OxFFFFF010000C  Offset
. OxFFFF FO10 0010 Gain
click Apply. ScratchPad  » OxFFFFF0100014  Upper Scaled Units
OxFFFF FO10 0018 Lower Scaled Units x
ey P OxFFFF FO10 0020 Filter Weight (0=disable) 0.000
BID , 0xFFFF FO10 D0BC Upper Clamp
0xFFFF FO10 00B3 Lawer Clamp
Communications »
Other 3

Help [~ AutoRefresh | 15000  msec

Module position numbers are shown near the top of the page; point numbers for multi-point modules
are shown below. For more information on locating modules and points, see “Referencing I/0 Points”on
page 155.

3. C(lickthe module position and the point number you want to view or configure.
4. Choose orenter the following as necessary for the point.
a. Choose the point type from the drop-down list.
For help, see “Point Type Configuration Tables” on page 160 and “Using I/O Point Features”on
page 70.
b. Configure digital input counters in the Point Feature field as shown below:

0x00000000 Disables all digital point features
0x00000001 Enables and starts counter on digital input

Simple quadrature counter input (requires SNAP quadrature input

0x00000004
module)

Quadrature counter input with index (requires SNAP quadrature input

0x00000041 module)

c. Forautomatic reaction to analog or digital watchdogs, enable the watchdog and enter the value
that the output point should be set to if the watchdog is tripped.

d. (Analog points only) To set offset and gain for the point manually, enter values in those fields. (To
have the processor compute offset and gain, see “Calibrating Offset and Gain Using the Default
Method” on page 175.)

e. (Analog points only) Set upper and lower scaled units, filter weight, and upper and lower clamps as
necessary. (For help, see “Using I/O Point Features”on page 70.)

5. Whenall lines are correct, click Apply to send the configuration to the I/0 unit.

All other points on the same module are automatically configured with the same features and the same
point name.

PAC Manager User's Guide 159



CONFIGURING I/0 MODULES, POINTS, AND FEATURES

6. Clickanother point on the same module and change its point name and features as necessary.
7. Repeat steps for each module you need to configure.

To save configuration to flash memory, see “Saving Configuration to a Device's Flash Memory” on
page 190.

Point Type Configuration Tables

The following tables help you configure points by showing the part number, the point type in decimal and in
hex, and the module type in hex (module type is read-only). For analog modules, tables also include the
number of points per module, the unit of measurement for the module, and its range.

Digital Input and Output Modules page 160
Analog Input Modules page 160
Analog Output Modules page 167

Digital Input and Output Modules

.. Point Type Point Type Module Type
Module & Description (Dec) (Hex) (Hex)
Digital input module* 256 100 00
Digital output module* 384 180 00

* Does not apply to SNAP high-density digital modules, which are recognized by the processor.

Analog Input Modules

Use this data for configuring point types and features (see page 157). If a module has multiple listings, the
default point type is shaded.

Lon) ~ q’
O X 5 3
8 £ 238 B2
- = =T} o K [} )
2 8 o T €€ c © © 2
Part Number & ~ > £ g S o 8 8 c
Description -z E g £5 @ 2 = 5
2@ 2 2 3 38 ° ) > 2
E E 3 c %2 5 - o <)
S 8 o9 & o=
5§ & = <
O O o
SNAP-AIARMS: 0-10 A AC/DC 71 47 71 2 A 0.0 0.0 10.0 11.0
SNAP-AIARMS-i: 0-10 A AC/DC 71 47 29 2 A 0.0 0.0 10.0 11.0
SNAP-AIARMS-i-FM": 0-10 A AC/DC 71 47 29 2 A 0.0 0.0 10.0 11.0
SNAP-AICTD: ICTD Temp. Probe 4 4 04 2 DegreesC -273.0 -40.0 150.0 150.0
SNAP-AICTD-4: ICTD Temp. Probe 4 4 42 4 DegreesC -2730 -400 1500 150.0
SNAP-AICTD-8: ICTD Temp. Probe 4 4 4C 8 DegreesC -273.0 -400 150.0 150.0
SNAP-AILC: -2 to +2 mV/V Fast 34 22 0B 2 Percent  -110.0 -100.0 100.0 110.0
SNAP-AILC: -2 to +2 mV/V Slow 36 24 0B 2 Percent  -110.0 -100.0 1000 110.0
SNAP-AILC: -3 to +3 mV/V Fast 35 23 0B 2 Percent  -110.0 -100.0 1000 110.0
SNAP-AILC: -3 to +3 mV/V Slow 37 25 0B 2 Percent  -110.0 -100.0 100.0 110.0
SNAP-AILC: Filter of 1st channel 0O 0 0B 2 Percent  -110.0 -100.0 1000 110.0
SNAP-AILC-2: -3 to +3 mV/V Fast 35 23 0C 2 Percent  -110.0 -100.0 1000 110.0
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Channel Type (Dec)

Channel Type (Hex)

Module Type (Hex)

Default Unit of
Measurement

Underrange

Low Scale

Full Scale

Overrange

Q2

S

°

o

=

1Sy

o

o

0

[}

c

c

©

£

()
SNAP-AILC-2: -3 to +3 mV/V Slow 37 25 0C 2 Percent  -110.0 -100.0 1000 110.0
SNAP-AILC-2: -4 to +4 mV/V Fast 34 22 0C 2 Percent -110.0 -100.0 100.0 110.0
SNAP-AILC-2: -4 to +4 mV/V Slow 36 24 0C 2 Percent  -110.0 -100.0 100.0 110.0
SNAP-AILC-2: Filter of 1st channel 0 0 0C 2 Percent -110.0 -100.0 1000 110.0
SNAP-AIMA: -20 to +20 mA 64 40 64 2 mA -22.0 -20.0 20.0 22.0
SNAP-AIMA: 0 to +20 mA 2 2 64 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA: 4 to +20 mA 3 3 64 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA2-i: -1 to +1 mA 85 55 27 2 mA -1.1 -1.0 1.0 1.1
SNAP-AIMA-i: -20 to +20 mA 64 40 22 2 mA -220 -200 200 22.0
SNAP-AIMA-i: 0 to +20 mA 2 2 22 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-i: 4 to +20 mA 3 3 22 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-iH: 4 to +20 mA 3 3 2A 2 mA 3.2 4.0 20.0 24.0
SNAP-AIMA-iSRC: -20 to +20 mA 64 40 26 2 mA -220 -200 200 22.0
SNAP-AIMA-iSRC: 0 to +20 mA 2 2 26 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-iSRC: 4 to +20 mA 3 3 26 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-iSRC-FM™:-20to +20mA 64 40 26 2 mA -220 -200 200 22.0
SNAP-AIMA-iSRC-FM: 0 to +20 mA 2 2 26 2 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-iSRC-FM: 4 to +20 mA 3 3 26 2 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-4: -20 to +20 mA 64 40 40 4 mA -220 -200 200 22.0
SNAP-AIMA-4: 0 to +20 mA 2 2 40 4 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-4: 4 to +20 mA 3 3 40 4 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-8: -20 to +20 mA 64 40 4A 8 mA -220 -200 200 22.0
SNAP-AIMA-8: 0 to +20 mA 2 2 4A 8 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-8: 4 to +20 mA 3 3 4A 8 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-32:-20 to +20 mA 64 40 4D 32 mA -220 -200 200 22.0
SNAP-AIMA-32: 0 to +20 mA 2 2 4D 32 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-32: 4 to +20 mA 3 3 4D 32 mA -22.0 4.0 20.0 22.0
SNAP-AIMA-32-FM": -20 to +20 mA 64 40 4D 32 mA -220 -200 200 22.0
SNAP-AIMA-32-FM: 0 to +20 mA 2 2 4D 32 mA -22.0 0.0 20.0 22.0
SNAP-AIMA-32-FM: 4 to +20 mA 3 3 4D 32 mA -22.0 4.0 20.0 22.0
SNAP-AIMV-4: -150 to +150 mV 66 42 44 4 mV -165.0 -150.0 1500 165.0
SNAP-AIMV-4: -75 to +75 mV 68 44 44 mV -825 -750 750 82.5
SNAP-AIMV2-4: -50 to +50 mV 9 9 45 4 mV -55.0 -500 500 55.0
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SNAP-AIMV2-4:-25 to +25 mV 67 43 45 4 mV -275 -250 25.0 27.5
SNAP-AIPM (channel 0 only) 70 46 OA **  ACVRMS 0.0 0 250 275
SNAP-AIPM (channel 1 only) 71 47 O0A **  ACARMS 0.0 0 10 11.0
SNAP-AIPM (channel 2 only) 82 52 0A ** Truepower n/a n/a n/a n/a
SNAP-AIPM (channel 3 only) 83 53 0A ** \Volt/Amps n/a n/a n/a n/a
SNAP-AIPM-3 (channels 0, 4 & 8) 70 46 49 **  ACVRMS 0.0 0 300 330
SNAP-AIPM-3 (channels 1,5 &9) 71 47 49 **  ACARMS 0.0 0 5 5.5
SNAP-AIPM-3 (channels 2, 6 & 10) 82 52 49 ** True power n/a n/a n/a n/a
SNAP-AIPM-3 (channels 3,7 & 11) 83 53 49 ** \Volt/Amps n/a n/a n/a n/a
SNAP-AIPM-3 (channels 12 & 13) 86 56 49 ** Truepower n/a n/a n/a n/a
SNAP-AIPM-3V (channels 0, 4 & 8) 100 64 48 **  ACVRMS 0.0 0 300 330
SNAP-AIPM-3V (channels 1,5 & 9) 89 59 48 ** VACfromCT 0.0 0 0.333 0.366
SNAP-AIPM-3V (channels 2, 6 & 10) 90 5A 48 ** Truepower n/a n/a n/a n/a
SNAP-AIPM-3V (channels 3,7 & 11) 90 5A 48 ** \Volt/Amps n/a n/a n/a n/a
SNAP-AIPM-3V (channels 12 & 13) 184 B8 48 ** Truepower n/a n/a n/a n/a
SNAP-AIRATE: Rate (Frequency) 69 45 69 2 Hz 0.0 0.0 25000.0 27500.0
SNAP-AIRATE-HFi: Rate (0.1 s data 68 44 2B 2 Hz 3 2 500,000 500,000
freshness)
SNAP-AIRATE-HFi: Rate (1 s data 69 45 2B 2 Hz 20 20 500000 500,000
freshness)
SNAP-AIRTD: 100 Ohm Pt 3-wire 10 OA 10 2 DegreesC -200.0 -200.0 850.0 850.0
SNAP-AIRTD: 100 Ohm Ni 3-wire 46 2E 10 2 DegreesC -60.0 -60.0 250.0 250.0
SNAP-AIRTD: 0-400 Ohms, Lead 15 OF 10 2 Ohms 0 0 400 440
Compensated
SNAP-AIRTD: 120 Ohm Ni 3-wire 48 30 10 2 DegreesC -80.0 -80.0 260.0 260.0
SNAP-AIRTD-10: 10 Ohm Cu 3-wire 14 OE OE 2 DegreesC -180.0 -180.0 260.0 260.0
SNAP-AIRTD-10: 0-25 Ohms, Lead 15 OF OE 2 Ohms 0 0 25 275
Compensated

SNAP-AIRTD-1K: 1000 Ohm Pt 3-wire 92 5C OF 2 DegreesC -200.0 -200.0 850.0 850.0
SNAP-AIRTD-1K: 1000 Ohm Ni 3-wire 93 5D OF 2 DegreesC -60.0 -60.0 2500 2500
SNAP-AIRTD-1K: 1000 Ohm Ni 3-wire 94 5E OF 2 DegreesF -50.0 -50.0 275.0 275.0

SNAP-AIRTD-1K: 0-4000 Ohms, Lead
Compensated

SNAP-AIRTD-8U: 0-8000 Ohms - Fixed 155 9B 55 8 Ohms 0 0 8000 8800

15 OF OF 2 Ohms 0 0 4000 4400
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Part Number &

Description

Channel Type (Dec)
Channel Type (Hex)
Module Type (Hex)
Channels per Module
Default Unit of
Measurement
Underrange
Low Scale
Full Scale
Overrange

SNAP-AIRTD-8U:10000hm NiSWIre® 1o pg 55 § DegreesF  -46  -46 1489 1489

70°F

ETQP'A'RTD%U”OOOOM NISWIre@ 181 Bs 55 8 DegreesC -40  -40 135 135
SNAP-AIRTD-8U; 10000hm Pt@0°C 180 B4 55 8 DegreesC 200 -200 850 850
SNAP-AIRTD-8U: 1200hmNi@0°C 179 B3 55 8 DegreesC -80  -80 260 260
SNAP-AIRTD-8U: 1000hmNi@0°C 178 B2 55 8 DegreesC -60  -60 250 250
SNAP-AIRTD-8U: 1000hm Pt@0°C 177 Bl 55 8 DegreesC 200 -200 850 850
SNAP-AIRTD-8U: 10 Ohm Cu 176 BO 55 8 DegreesC -60  -60 355 355
SNAP-AIRTD-8U: 0-8000 Ohms - Auto 171 AB 55 8  Ohms 0 0 8000 8800
SNAP-AIRTD-8U: 0-4000 Ohms - Auto 170 AA 55 8  Ohms 0 0 4000 4400
SNAP-AIRTD-8U: 0-2000 Ohms - Auto 169 A9 55 8  Ohms 0 0 2000 2200
SNAP-AIRTD-8U: 0-1000 Ohms - Auto 168 A8 55 8  Ohms 0 0 1000 1100
SNAP-AIRTD-8U: 0-800 Ohms-Auto 167 A7 55 8  Ohms 0 0 80 880
SNAP-AIRTD-8U: 0-400 Ohms-Auto 166 A6 55 8  Ohms 0 0 400 440
SNAP-AIRTD-8U: 0-200 Ohms-Auto 165 A5 55 8  Ohms 0 0 200 220
SNAP-AIRTD-8U:0-100 Ohms-Auto 164 A4 55 8  Ohms 0 0o 100 110
SNAP-AIRTD-8U: 0-80 Ohms-Auto 163 A3 55 8  Ohms 0 o 8 88
SNAP-AIRTD-8U: 0-40 Ohms-Auto 162 A2 55 8  Ohms 0 0 40 44
SNAP-AIRTD-8U:0-20 Ohms-Auto 161 A1 55 8  Ohms 0 o 20 22
SNAP-AIRTD-8U: 0-10 Ohms-Auto 160 AO 55 8  Ohms 0 o 10 1
SNAP-AIRTD-8U: 0-4000 Ohms - Fixed 154 9A 55 8  Ohms 0 0 4000 4400
SNAP-AIRTD-8U: 0-2000 Ohms - Fixed 153 99 55 8  Ohms 0 0 2000 2200
SNAP-AIRTD-8U: 0-1000 Ohms - Fixed 152 98 55 8  Ohms 0 0 1000 1100
SNAP-AIRTD-8U: 0-800 Ohms - Fixed 151 97 55 8  Ohms 0 0 80 880
SNAP-AIRTD-8U: 0-400 Ohms -Fixed 150 96 55 8  Ohms 0 0 400 440
SNAP-AIRTD-8U: 0-200 Ohms - Fixed 149 95 55 8  Ohms 0 0 200 220
SNAP-AIRTD-8U: 0-100 Ohms - Fixed 148 94 55 8  Ohms 0 0o 100 110
SNAP-AIRTD-8U: 0-80 Ohms -Fixed 147 93 55 8  Ohms 0 o 8 88
SNAP-AIRTD-8U: 0-40 Ohms -Fixed 146 92 55 8  Ohms 0 0 40 44
SNAP-AIRTD-8U: 0-20 Ohms -Fixed 145 91 55 8  Ohms 0 o 20 2
SNAP-AIRTD-8U:0-10 Ohms -Fixed 144 90 55 8  Ohms 0 o 10 1
SNAP-AITM: -150 to +150 mV 66 42 66 2  mV  -1650 -150.0 1500 1650
SNAP-AITM: 75 to +75 mV 68 44 66 2  mV 825 750 750 825
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Part Number &
Description

Channel Type (Dec)
Channel Type (Hex)
Module Type (Hex)
Default Unit of
Measurement
Underrange
Low Scale
Full Scale
Overrange

SNAP-AITM: Type E Thermocouple 19 13 66 DegreesC -270.0 -270.0 1000.0 1000.0
SNAP-AITM: Type J Thermocouple 5 5 66 DegreesC -210.0 -210.0 1200.0 1200.0
SNAP-AITM: Type K Thermocouple 8 8 66 DegreesC -270.0 -270.0 1372.0 13720
SNAP-AITM-i: -150 to +150 mV 66 42 20 mV -165.0 -150.0 1500 165.0
SNAP-AITM-i: -75 to +75 mV 68 44 20 mV -825 -75.0 75.0 825
SNAP-AITM-i: Type E Thermocouple 19 13 20 DegreesC -270.0 -270.0 1000.0 1000.0
SNAP-AITM-i: Type J Thermocouple 5 5 20 DegreesC -210.0 -210.0 1200.0 1200.0
SNAP-AITM-i: Type K Thermocouple 8 8 20 DegreesC -270.0 -270.0 1372.0 13720
SNAP-AITM-4i: -150 to +150 mV 66 42 32 mV -165.0 -150.0 150.0 165.0
SNAP-AITM-4i: -75 to +75 mV 68 44 32 mV -825 -750 75 82.5
SNAP-AITM-4i: -50 to 450 mV 9 9 32 mV -55.0 -50.0 50.0 55.0
SNAP-AITM-4i: -25 to 425 mV 67 43 32 mV -27.5 -25.0 25.0 27.5

SNAP-AITM-4i: Type B Thermocouple 24 18 32
SNAP-AITM-4i: Type C Thermocouple 32 20 32
SNAP-AITM-4i: Type D Thermocouple 33 21 32
SNAP-AITM-4i: Type E Thermocouple 19 13 32
SNAP-AITM-4i: Type G Thermocouple 31 1F 32
SNAP-AITM-4i: Type J Thermocouple 5 5 32
SNAP-AITM-4i: Type K Thermocouple 8 8 32
SNAP-AITM-4i: Type N Thermocouple 30 1E 32
SNAP-AITM-4i: Type R Thermocouple 17 11 32
SNAP-AITM-4i: Type S Thermocouple 23 17 32
SNAP-AITM-4i: Type T Thermocouple 18 12 32

Degrees C 42.0 42.0 1820.0 1820.0
Degrees C 0.0 0.0 2320.0 23200
Degrees C 0.0 0.0 2320.0 23200
DegreesC -270.0 -270.0 1000.0 1000.0
Degrees C 0.0 0.0 2320.0 23200
DegreesC -210.0 -210.0 1200.0 1200.0
DegreesC -270.0 -270.0 1372.0 13720
DegreesC -270.0 -270.0 1300.0 1300.0
DegreesC  -50.0 -50.0 1768.0 1768.0
DegreesC  -50.0 -50.0 1768.0 1768.0
DegreesC -270.0 -270.0 400.0 400.0

SNAP-AITM-8: -75 to +75 mV 68 44 A4F mV -825 -750 75.0 82.5
SNAP-AITM-8: -50 to +50 mV 9 9 4F mV -55.0 -500 50.0 55.0
SNAP-AITM-8: -25 to +25 mV 67 43 4F mV -275 250 250 27.5

SNAP-AITM-8: Type B Thermocouple 24 18 4F
SNAP-AITM-8: Type C Thermocouple 32 20 4F
SNAP-AITM-8: Type D Thermocouple 33 21 4F
SNAP-AITM-8: Type E Thermocouple 19 13 4F
SNAP-AITM-8: Type G Thermocouple 31 1F 4F
SNAP-AITM-8: Type J Thermocouple 5 5 4F
SNAP-AITM-8: Type K Thermocouple 8 8 4F

Degrees C 42.0 42.0 1820.0 1820.0
Degrees C 0.0 0.0 2320.0 2320.0
Degrees C 0.0 0.0 2320.0 23200
DegreesC -270.0 -270.0 1000.0 1000.0
Degrees C 0.0 0.0 2320.0 2320.0
DegreesC -210.0 -210.0 1200.0 1200.0
DegreesC -270.0 -270.0 1372.0 13720

SN IR T SN I =0 IS ST I-SR-~3 G TG (-G N (YNGR G [ TG Y (N NG S BN ENH IENE N NS ENEENEENE Channels per Module
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SNAP-AITM-8: Type N Thermocouple 30 1E 4F 8 DegreesC -270.0 -270.0 1300.0 1300.0
SNAP-AITM-8: Type R Thermocouple 17 11 4F 8 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8: Type S Thermocouple 23 17 4F 8 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8: Type T Thermocouple 18 12 4F 8 DegreesC -270.0 -270.0 400.0 400.0
SNAP-AITM-8-FM": -75 to +75 mV 68 44 4F 8 mV -825 -750 750 825
SNAP-AITM-8-FM: -50 to +50 mV 9 9 4F 8 mV -550 -500 500 55.0
SNAP-AITM-8-FM: -25 to +25 mV 67 43 4F 8 mV -275 250 250 275
SNAP-AITM-8-FM: Type BThermocouple 24 18 4F 8 DegreesC  42.0 420 1820.0 1820.0
SNAP-AITM-8-FM: Type C Thermocouple 32 20 4F 8 DegreesC 0.0 0.0 2320.0 23200
SNAP-AITM-8-FM: Type D Thermocouple 33 21 4F 8 DegreesC 0.0 0.0 2320.0 23200
SNAP-AITM-8-FM: Type EThermocouple 19 13 4F 8 DegreesC -270.0 -270.0 1000.0 1000.0
SNAP-AITM-8-FM: Type GThermocouple 31 1F 4F 8 DegreesC 0.0 0.0 2320.0 23200
SNAP-AITM-8-FM: Type J Thermocouple 5 5 4F 8 DegreesC -210.0 -210.0 1200.0 1200.0
SNAP-AITM-8-FM: Type KThermocouple 8 8 4F 8 DegreesC -270.0 -270.0 1372.0 13720
SNAP-AITM-8-FM: Type N Thermocouple 30 1E 4F 8 DegreesC -270.0 -270.0 1300.0 1300.0
SNAP-AITM-8-FM: Type RThermocouple 17 11 4F 8 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8-FM: Type SThermocouple 23 17 4F 8 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM-8-FM: Type T Thermocouple 18 12 4F 8 DegreesC -270.0 -270.0 400.0 400.0
SNAP-AITM2: -50 to +50 mV 9 9 09 2 mV -550 -500 50.0 55.0
SNAP-AITM2: -25 to +25 mV 67 43 09 2 mV -275 -250 250 275
SNAP-AITM2: Type B Thermocouple 24 18 09 2 DegreesC 420 420 1820.0 1820.0
SNAP-AITM2: Type C Thermocouple 32 20 09 2 DegreesC 0.0 0.0 2320.0 23200
SNAP-AITM2: Type D Thermocouple 33 21 09 2 DegreesC 0.0 0.0 2320.0 23200
SNAP-AITM2: Type G Thermocouple 31 1F 09 2 DegreesC 0.0 0.0 2320.0 23200
SNAP-AITM2: Type N Thermocouple 30 1E 09 2 DegreesC -270.0 -270.0 1300.0 1300.0
SNAP-AITM2: Type R Thermocouple 17 11 09 2 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM2: Type S Thermocouple 23 17 09 2 DegreesC -50.0 -50.0 1768.0 1768.0
SNAP-AITM2: Type T Thermocouple 18 12 09 2 DegreesC -270.0 -270.0 400.0 400.0
SNAP-AITM2-i: -50 to +50 mV 9 9 21 2 mV -55.0 -500 500 55.0
SNAP-AITM2-i: -25 to +25 mV 67 43 21 2 mV -275 -250 250 275
SNAP-AITM2-i: Type B Thermocouple 24 18 21 2 DegreesC 420 42.0 1820.0 1820.0
SNAP-AITM2-i: Type C Thermocouple 32 20 21 2 DegreesC 0.0 0.0 2320.0 23200
SNAP-AITM2-i: Type D Thermocouple 33 21 21 2 DegreesC 0.0 0.0 2320.0 2320.0
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SNAP-AITM2-i: Type G Thermocouple 1F 21
SNAP-AITM2-i: Type N Thermocouple 30 1E 21
SNAP-AITM2-i: Type R Thermocouple 17 11 21
SNAP-AITM2-i: Type S Thermocouple 23 17 21
SNAP-AITM2-i: Type T Thermocouple 18 12 21

w
—_

Degrees C 0.0 0.0 2320.0 2320.0
DegreesC  -270.0 -270.0 1300.0 1300.0
DegreesC  -50.0 -50.0 1768.0 1768.0

DegreesC  -50.0 -50.0 1768.0 1768.0
DegreesC -270.0 -270.0 400.0 400.0

SR PN ENECY NN ENENYENENNEENE Channels per Module

SNAP-AIV:-10to +10VDC 12 C 12 VDC -11.0  -100 10.0 11.0
SNAP-AIV: -5 to +5 VDC 11 B 12 VDC -5.5 -5.0 5.0 55
SNAP-AIV-i: -10 to +10 VDC 12 C 23 VDC -11.0 -100 10.0 11.0
SNAP-AIV-i: -5 to +5 VDC 1M1 B 23 VDC -5.5 -5.0 5.0 55
SNAP-AIV-4:-10 to +10 VDC 12 C 41 VDC -11.0  -10.0 10.0 11.0
SNAP-AIV-4: -5 to +5 VDC 1 B 41 vDC -5.5 -5.0 5.0 55
SNAP-AIV-8:-10to +10 VDC 12 C 4B VDC -11.0  -100 10.0 11.0
SNAP-AIV-8: -5 to +5 VDC 11 B 4B VDC -5.5 -5.0 5.0 55
SNAP-AIV-32:-10to +10 VDC 12 C 4E 32 VDC -11.0 -100 10.0 11.0
SNAP-AIV-32: -5 to +5VDC 11 B 4E 32 VDC -5.5 -5.0 5.0 55
SNAP-AIV-32-FM": -10 to +10 VDC 12 C 4E 32 VDC -11.0  -10.0 10.0 11.0
SNAP-AIV-32-FM: -5 to +5VDC 11 B 4E 32 vDC -5.5 -5.0 5.0 55
SNAP-AIV2-i:-100 to +100 VDC 72 48 24 2 VDC -110.0 -100.0 1000 110.0
SNAP-AIV2-i: -50 to +50 VDC 73 49 24 2 VDC -55.0 -500 50.0 55.0
SNAP-AIVRMS: 0-250 VAC/VDC 70 46 70 2 VAC/VDC 0.0 0.0 2500 275.0
SNAP-AIVRMS-i: 0-250 VAC/VDC 70 46 28 2 VAC/VDC 0.0 0.0 2500 275.0
SNAP-AIVRMS-i-FM™: 0-250 VAC/VDC 70 46 28 2 VAC/VDC 0.0 0.0 250.0 275.0
SNAP-AIR40K-4: 0 to 40K Ohms 74 4A 43 4 Ohms 0 0 40,000 44,000
SNAP-AIR40K-4: 0 to 20K Ohms 75 4B 43 4 Ohms 0 0 20,000 22,000
SNAP-AIR40K-4: 0 to 10K Ohms 76 4C 43 4 Ohms 0 0 10,000 11,000
SNAP-AIR40K-4: 0 to 5K Ohms 77 4D 43 4 Ohms 0 0 5000 5500
SNAP-AIR400K-8: 0 to 400K Ohms 105 69 54 8 Ohms 0 0 400,000 440,000
SNAP-AIR400K-8: 0 to 400K Autorange 188 BC 54 8 Ohms 0 0 400,000 440,000
SNAP-AIR400K-8: 0 to 200K Ohms 106 6A 54 8 Ohms 0 0 200,000 220,000
SNAP-AIR400K-8: 0 to 100K Ohms 107 6B 54 8 Ohms 0 0 100,000 110,000
SNAP-AIR400K-8: 0 to 50K Ohms 108 6C 54 8 Ohms 0 0 50,000 55,000
SNAP-AIR400K-8: 0 to 40K Ohms 74 4A 54 8 Ohms 0 0 40,000 44,000
SNAP-AIR400K-8: 0 to 20K Ohms 75 4B 54 8 Ohms 0 0 20,000 22,000
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SNAP-AIR400K-8: 0 to 10K Ohms 76 4C 54 8 Ohms 0 0 10,000 11,000
SNAP-AIR400K-8: 0 to 5K Ohms 77 4D 54 8 Ohms 0 0 5000 5500
SNAP-AIR400K-8: 0 to 4K Ohms 38 26 54 8 Ohms 0 0 4000 4400
SNAP-AIR400K-8: 0 to 2K Ohms 39 27 54 8 Ohms 0 0 2000 2200
SNAP-AIR400K-8: 0 to 1K Ohms 40 28 54 8 Ohms 0 0 1000 1100
SNAP-AIR400K-8: 0 to 500 Ohms 41 29 54 8 Ohms 0 0 500 550
SNAP-pH/ORP: -1 to +1 VDC 78 4E 25 2 VDC -1.1 -1.0 1.0 1.1
SNAP-pH/ORP: 0-14 pH 79 4F 25 2 pH -14 0.0 14.0 15.4
SNAP-pH/ORP: -0.5 to +0.5 VDC 80 50 25 2 VDC -0.55 -0.5 0.5 0.55
SNAP-PID-V 99 63 DO 4 Percent 0 0 1000 110.0

* Obsolete part number

**The SNAP-AIPM module monitors one device from channel 0 (volts) and channel 1 (amps). Channels 2 and
3 return calculated values. The SNAP-AIPM-3 and SNAP-AIPM-3V monitor three phases from channels 0,4, & 8
(volts) and channels 1,5, & 9 (amps). All other channels return calculated values. See the SNAP AIPM Modules

Data Sheet (form 1453) for details.

Analog Output Modules

Use this data for configuring point types and features (see page 157).
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s 2 2 & °
s <
(8] (&) o
SNAP-AOA-3:4-20 mA 131 83 83 1 mA 4.0 4.0 20.0 20.0
SNAP-AQV-5: 0-10 VDC 133 8 85 1 VDC 0.0 0.0 10.0 10.0
SNAP-AOA-23:4-20 mA 163 A3 A3 2 mA 4.0 4.0 20.0 20.0
SNAP-AOA-23-iSRC: 4-20 mA 163 A3 B3 2 mA 4.0 4.0 20.0 20.0
SNAP-AOA-23-iSRC-FM*: 4-20 mA 163 A3 B3 2 mA 4.0 4.0 20.0 20.0
SNAP-AOA-23-iH: 4-20 mA 163 A3 AB 2 mA 4.0 4.0 20.0 20.0
SNAP-AQV-25:0-10 VDC 165 A5 A5 2 VDC 0.0 0.0 10.0 10.0
SNAP-AQV-27:-10 to +10 VDC 167 A7 A7 2 VDC -10.0 -10.0 10.0 10.0
SNAP-AOA-28: 0-20 mA 168 A8 A8 2 mA 0.0 0.0 20.0 20.0
SNAP-AOVA-8: 0-5 VDC 144 90 CF 8 VDC 0.0 0.0 5.0 5.0
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Part Number &
Description

Default Unit of
Measurement
Underrange
Low scale
Full scale
Overrange

T R
Qo O
o I
St
Q O
s &
[N
o ©
c C
c C
T ©
£ <o
o O

Module Type (Hex)

SNAP-AOVA-8: 0-10 VDC 145 91 CF VDC 0.0 0.0 10.0 10.0
SNAP-AOVA-8: -5 to +5VDC 146 92 CF VDC -5.0 -5.0 5.0 5.0
SNAP-AOVA-8:-10to +10VDC 147 93 CF VDC -10.0 -100 10.0 10.0
SNAP-AOVA-8: 4-20 mA 148 94 CF mA 4.0 4.0 20.0 20.0
SNAP-AOVA-8: 0-20 mA 149 95 CF mA 0.0 0.0 20.0 20.0
SNAP-AOD-29: TPO 5-60 VDC 169 A9 A9 Percent n/a 0.0 100.0 n/a

NERINY RN NCY AN NN Channels per Module

SNAP-AOD-29-HFi: TPO 2.5-24VDC 131 83 B9 Percent n/a 0.0 100.0 n/a

* Obsolete part number

Configuring Serial Modules in the Inspect Window

(Not available on SB brains) Using the Inspect window, you can change many parameters for a serial module.

However, because changes you make in the Inspect window are sent directly to the controller or 1/0 unit and

cannot be saved to a configuration file, make sure you save the configuration to flash memory. For

instructions, see “Saving Configuration to a Device's Flash Memory” on page 190. To use a configuration file,

see Chapter 2: Configuring Devices.

1. Inthe PAC Manager main window, click the Inspect button 7@#‘

2. Inthe Inspect Opto 22 Device window, type the IP address of the I/0 unit (or choose it from the
drop-down list).

3. Click Communications and then click the type of module from the submenu.

4. Choose the module’s position number from the drop-down list.
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Data for this module is
shown in the window.
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= Inspect Opto 22 Device - X
Device Name: | 10,192.55.67 j Options * | Status: ISerial Module area last read at 05/04/16 11:32:19
r~ Serial Modules
Status Read
Serial Module Number: _ ~| Module 5is a Serial Module )
Status Write D
Address | Description | Value | Refresh |
i »
e MODULE INFORMATION
: 0xFFFF FOCO 0500 Module Type RS232 (0xF0) Apply |
Paint Config | OxFFFFFO3A 7F50  Module Subtype 1 {(Revision A)
= OxFFFF FO3A 7F52 Hardware Revision Date 2003-06-06
Digital Bark | OxFFFEFO3A 7F56  Loader Version R10e
Digital Point OxFFFF FO3A 7F5A Firmware Version Rl1e
igital Poin | PORT A
0xFFFF FO3A 80A0 Port Number 22510
Analog Bank
ﬂl OXFFFF FO3A B0A4  Baud Rate 3600 2
Analog Point | OxFFFF FO3A 80A3  Parity None =
0xFFFF FO3A 80A9 Data Bits 8 =1
High Density | OxFFFF FO3A 30AA Stop Bits 1 ]
OxFFFF FO3A 80AB Hardware Flow Control? Mo Jhd
System » | 0xFFFF FO3A 80AC Power-up Test Message? fes =1
0xFFFF FO3A 82A0 EOM Character List Ox 0DOADOOD
ScratchPad  » | PORT B
0xFFFF FO3A 80BO Port Number 22511
Data Log 3 | OxFFFF FO3A 80B4 Baud Rate 9600 52
0xFFFF FO3A 80B8 Parity Mone 52l
PID 3 0xFFFF FO3A 30BS Data Bits 8 =1
0xFFFF FO3A 80BA Stop Bits 1 =
Events b | OxFFFFFO3A80BB  Hardware Flow Control? Mo il
0xFFFF FO3A S0BC Power-up Test Message? fes =1
Communications | OxFFFFFO3A 8280  EOM Character List 0x 0DOAODOO
Other 3 |

- |

™ AutoRefresh | 15000  msec

For help in understanding or changing data, see the following sections:

- "Configuring RS-232 and RS-485/422 Serial Communication Modules” on page 46
- "Configuring Wiegand Modules”on page 51
- “Configuring Profibus Modules”on page 53

- "Configuring SSI (Serial Synchronous Interface) Modules” on page 54

- "Configuring CAN Modules”on page 56
- “Configuring HART Modules”on page 60

See also the SNAP Serial Communication Module User's Guide (form 1191).

To save configuration to flash memory, see “Saving Configuration to a Device's Flash Memory” on

page 190.

Configuring, Viewing, or Changing PID Loops

The Inspect window opens.

For information about PID loops, see page 63. PIDs are normally configured in a configuration file following
the steps on page 65. However, you can also configure, view, or change them using PAC Manager's Inspect
window. (Remember that changes made here cannot be saved to a configuration file.)

1. Inthe PAC Manager main window, click the Inspect button Ql

If you haven't used the Inspect window before, no data is displayed in the Status Read pane.

If you have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.
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- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

@ nspect Opto 22 Device —

Device Name: | 10,199.99.99 j Options # Status: | Status Read area last read at 07/05/16 10:34:58

Status Read
Status Read
Status Write ADDRESS DESCRIFTION VALUE ~ Refresh |

) 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
{ WirelessLAN ¥ OxFFFF F030 0008 Buay Flag 0
| Paint Config 0xFFFF F030 0018 Loader Version R5.1lc
Digital Bank 0xFFFF FO30 0000 Memory Map Version 1
0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016

Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A

High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
| 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
| 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
| ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log 3
ETHERENET 1 Interface

PID * 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-85-9C
, I_ OXFFFF FO30 0034 IP Address 10.192.55.67
,-__,,,Eue\n—‘r"\__,_.. A LOZFERFEQ 200038, s S nolMongie, e mmton p o team o, 908 OGFL00 QL AN A s, sl

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

Wpto 22 Device

eS0T S O B ookie Controller

1_ [EngineRm i
| Cail Portable
: SoftPAC [CRIPTION
e lerup Clea
Wireless LAN | Boler =

—— I Chamber 1 s
. Chamber 2 J
Point Config g partable der Versid
T Cookie Controller ory Map Ve
HD@E' B EngineRm mware Verd
Di SoftPAC Imware Ver

igital Point = 1
0xFFFF F030 00BO Firmware Verg

2. Inthe Device Name field, type the name (or IP address) of the I/O unit (or choose it from the drop-down
list). Click PID and choose PID Loops from the submenu.
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Information for this PID loop is —_

shown in the window.

CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

@ Inspect Opto 22 Device

Device Name: | 10,152,55.67

j Options »

Status:

PID Loop area last read at 05/04/16 11:35:31

Analog Point
High Density

System 3
ScratchPad
Data Log 3
PID 3
Events 3
Communications ¥
Other 3

OxFFFF F200 0034
OxFFFF F200 0000
OxFFFF F200 0004
0xFFFF F200 0008
OxFFFF F200 000C
OxFFFF F200 0010

OxFFFF F210 0010
OxFFFF F210 0014
OxFFFF F210 0018
OxFFFF F210 001C

OxFFFF F210 0050
OxFFFF F210 0054
OxFFFF F210 0038
NvFFFEE F210 NNas

Status Flags Off Mask

Current Value Of Error

Current Value Of P (Gain)

Current Value OF I (Integral)

Current Value OF D (Derivative)

Current Value Of Integral
TUNING

Gain

Tune I (Integral)

Tune D {Derivative)

Feed Forward Gain
CONFIGURATION

Algarithm

Mode

Scan Time (seconds)

MamMan Addrees Fre Trnnt

0.000000
0.000000
0.000000
0.000000

Mone
Automatic
1.000000

v NNNNNNNN

PID Loops
Statos
PID Loop Mumber: [v] - >
Status Write |
= , Address | Description Value | - Refresh |
Wireless LAN STATUS
- OxFFFF F210 0064 Current Value Of Input Apply
Paint Config OxFFFF F210 0068 Current Value Of Setpoint
= 0xFFFF F210 000C Current Value Of Output 0.000000
Digital Bank OxFFFFF210 0008  Current Value Of Feed Forward 0.000000
Digital Point OxFFFF F210 0000 Last Scanned Value Of Input 0.000000
gital Foin OxFFFFF210 0004  Last Scanned Value Of Setpoint 0,000000
0xFFFF F200 0028 Scan Counter [u]
L TEEE OXFFFFF200002C  Status Flags 00000000
OxFFFF F200 0030 Status Flags On Mask 00000000

=
=

v

™ AutoRefresh | 15000  msec

3. From the drop-down list, choose the PID loop number you want to configure, view, or change.

Existing PID loops are indicated by an asterisk (*) next to the number.
4. To configure or change the PID, click inside the cell in the Value column and type the new value or
choose it from a drop-down list, if one is available. When you have finished making changes, click Apply
to send them to the I/0 unit.

NOTE: If you are using PAC Control, it is easiest to tune PID loops in your PAC Control strategy running in Debug
mode. For details, see the PAC Control User's Guide (form 1700).

For information on memory map addresses and what they contain, see the OptoMMP Protocol Guide (form

1465).

READING AND WRITING TO POINTS

You can use PAC Manager to read or change I/0 point values. You must configure points before you can
read or write to them.

CAUTION: Ifyou are using PAC Control, reading and writing is normally done in the PAC Control strategy logic or
in Debug mode. If you use the steps in this section to write to an I/0 unit, be very careful you do not interfere with

strategy logic.

1. Inthe PAC Manager main window, click the Inspect button @
The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.
- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device

Name field, and current Status Read information appears in the window.
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- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

Device Name: | 10,199.99.99 j Options ¥ Status: | Status Read area last read at 07/05/16 10:34:58
Status Read
Status Read
T — ADDRESS DESCRIPTION VALUE = Refresh |

) 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
| WirelessLAN ¢

0xFFFF F030 0008 Busy Flag 1]

| Paint Config 0xFFFF F030 0018 Loader Version R5.1lc

Digital Bark 0xFFFF FO30 0000 Memory Map Version 1
0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point O0xFFFF FO30 001C Firmware Version A9.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016

Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A

High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
| 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
| 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
| ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log 3

FID

ETHERENET 1 Interface
4 0xFFFF FO30 002E MAC Rddress 00-A0-3D-01-85-3C
0xFFFF FO30 0034 IF Address 10.192.55.67

,-__,,,E"e\”-‘r"\__:..l_ A LOZFERFEQ 20038, # S noLMongie, e mmton pob e, 908 AGFAO0 QL A A st sl

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list
are displayed when you have

six or more devices configured.

Wpto 22 Device

eS0T S O B ookie Controller

1_ [EngineRm i
| Cail Portable
: SoftPAC [CRIPTION
e lerup Clea
Wireless LAN | Boler =

—— I Chamber 1 s
. Chamber 2 J
Point Config g partable der Versid
T Cookie Controller ory Map Ve
HD@E' B EngineRm mware Verd
Di SoftPAC Imware Ver

igital Point T 1
0xFFFF F030 00BO Firmware Verg

2. Inthe Device Name field, type the name (or IP address) of the I/O unit (or choose it from the drop-down

list).

3. (lick Digital Point or Analog Point, depending on the type of point you want to read or write to. For
digital points, see “Reading and Writing to Digital Points.” For analog points, see page 174.

Reading and Writing to Digital Points

NOTE: For points on high-density digital modules, you can read or write to individual points using the steps in this
section. To read or write to all points at one time, see “Reading and Writing to SNAP High-Density Digital Points” on

page 182.
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Digital Input Points

CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

Here’s an example showing a SNAP digital input point. Module position numbers are shown near the top of
the Inspect Opto 22 Device window, with the point numbers for each module listed just below the position
number. For more information on locating modules and points, see “Referencing I/0 Points”on page 155.

Module position number

Point numbers for this

é Inspect Opto 22 Device

module. Point 1is currently
being read here.

To update values, click the
Refresh button.

Since point 1 is an input point,
you can turn counting onand —
off or clear counters and
latches.

Device Name: I 10.192.55.67 j Options » | Status: | Digital Point area last read at 05/04/16 11:39:56
r~Digital Point
Status Read |
—_ Step 1: Choose a module
SET [Modole (0) L 2 3|4 5 6 78 © 10 11|12 13 14 15 Typer Digjnone (0x00)
Wireless LAN ¢ | Step 2: Choose a point on the selected module .
r 14 T Type:  Digital Input (0x100)
Pt T o_n' 2 3 l SUSTE 7[5 5 0 LT 5 155 facuye: one (0300)
Point Config | S 0021 22 3324 35 36 I8 29 30 31 jame:  diChiplevelSwitch
J— Digital Bank —Read Area
Digital Point Address | Desdription | Value | Refresh |
STATUS
frlgiies | OXFFFFFOB0 0040 Point State OFF
. LATCHES
Scdog Eoe OxFFFFFOB0 0044 On-atch on
High Density | 0xFFFF FOB0 0048 COCEJFF—LEM ON
0xFFFF FOB0 004C Active 1]
HeEr P | OxFFFFFO0B0 0050  Data 0
ScratchPad  » |
~Write Area
Data Log 3 |
Cukput Counter Clear:
Ay ' Turn On 0xFOS0 0040 Counter On | 0xFO30 0048 Counter | OxFOFD 0004
Events » |
Turn OFf 0xF090 Counter Off | 0xF0S0 004C On-Latch 0xFOF0 0104
Communications * | | |
OffLatch 0xFOF0 0204
Other 3 |

Close | Help |

[~ AutoRefresh | 15000 msec

1. Click the point number you want to read or write to.
The current values for that point number appear in the Read Area. The Status data at the top right corner

of the window shows the date and time values were last read. The Read Area and the Write Area change
depending upon the point type.

2.

To turn counting on or off or to clear counters and latches, click the buttons in the Counter State and

Clear areas near the bottom of the window. (For more information on these features, see page 72.)

Your changes are immediately sent to the I/O unit, and the window is updated to reflect your changes.

Digital Output Points

The following example shows a digital output point.
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é Inspect Opto 22 Device

- *

Device Name: I 10.19

Status Read |
Status Write |

Wireless LAN  » |

Point Config |
Digital Bank |

Current values for point 1 on
this digital output module.
Click the Refresh button to
update values.

Digita-Pait II
Analog Bank |
Analog Point |
High Density |

System 3 |
ScratchPad |
Data Log 3 |

) PID »
Change point state on an —

output point by clickinga—"] ==

button in the Write Area. T}
Other 3

2.55.67 ~| Cptions » | Status: | Digital Point area last written and read at 05/04/16 11:42:36
rDigital Point
Step 1: Choose a module
|Module [0 1 2 3[4 5 s 7[8 9 10 11[12 13 14 15 Type: Dig/none (0x00)
Step 2: Choose a point on the selected module = T T e D)
- — ype: igi I X
Pt [0 1 2 3[4 5 & 7[8 8 10 11 13 12 15 Fenpire: Nome (0x00)
16 17 18 19|20 21 22 23|24 25 26 27(28 29 30 31 pame: doDoughDispenseValve
—Read Area
Address | Description | Value | Refresh |
STATUS
0xFFFF FO30 0140 Point State OM
[ Write Area =
Output Counter Clear:
- 00900140 | Counter on | 0xF080 0148 Courter | OXFOFD 0014
Turn Off | 0xF090 0144 Counter OFf | 0xF090 014C on-Latch 0xFOF0 0114
Off-Lakch 0xFOFD 0214

- |

™ AutoRefresh | 15000  msec

Click the point number you want to read or write to.

2. The current values for that point number appear in the Read Area. The Status data at the top right corner
of the window shows the date and time values were last read. The Read Area and the Write Area change

depending upo

n the point type.

3. Toturn an output point on or off, click a button in the Write Area.

The change is immediately sent to the I/0 unit, and the window is updated.

Reading and Writing to Analog Points

Analog Input Points

This example shows an analog input point. Module position numbers are shown near the top of the Inspect
Opto 22 Device window, with the point numbers for each module listed just below the position number. For
more on locating modules and points, see “Referencing /0 Points”on page 155.
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Module position number

_

Point numbers for this
module. Point 1is currently
being read here.

Click the Refresh button to
update values.

Since point 1isan input point,
you can clear minimu
maximum values or set offset
and gain.

The Two-Point Method
allows you to enter a real-world
range of values

for offset and gain.

CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

= Inspect Opto 22 Device (UDP)

Device Name: | R1 Controller

Status:

j Options »

Analog Point area last read at 09/23/16 12:02:32

Analog Point
Status Read
- Step 1: Choose a module
SR Module | 0 4 5 6 7]8 9 10 11]12 1

— | wirelessLAN ¥ E
01
Point Config 16 17

D%gl

Digital Point
Analog Bank
Analog Point
High Density

System 3
ScratchPad  »

Data Log 3

Events 3
Communicatio i‘
Other 3

Help

1.

Close |

Min. Value 01D 4300

—]
Max, Value | 0xFO1D 4504

0.00000

(1) More Info
3 14 15 Type:  AICTD (Ox04)
tep 2: Choose a point on the selected module = T TS
; 2 3[4 5 6 8 9 10 11|12 13 13 15 poere. None((D):(DD))
18 1920 21 22 23|24 25 26 27|28 23 30 31 pame:  aiOvenTemperature
Read Area
Address |Descriph'on | Refresh |
OxFFFF FO26 3000 Scaled Units
0xFFFF FO26 3004 Counts
OxFFFF FO26 3008  Min. Value (Scaled Units)
OxFFFF FO26 300C  Max. Value (Scaled Units)
0xFFFF FO26 3024 Raw Counts
Write Area
Clear: Offset and Gain

Step 1: Use a calibrator to input the signal that
corresponds to zero Engineering Units (i) More Info

Step 2:  Calcand Set Offset

Step 3: Use a calibrator to input the signal that
corresponds to the maximum input range value
(positive scaling), or the minimum input range value
(negative scaling) (31 More Info

Step4:  Calcand Set Gain

\ Two-Point Method

v

™ AutoRefresh | 15000  msec

Click the point number you want to read or write to.

The current values for that point number appear in the Read Area.
2. Toclear minimum and maximum values, click the buttons in the Clear area (see page 74 for information).

3.

follow the steps on page 177.

To set offset and gain, use the default method (described below), or click the Two-Point Method and

Your changes are immediately sent to the I/0 unit, and the window is updated to reflect your changes.

Calibrating Offset and Gain Using the Default Method

You adjust an analog point’s offset and gain to ensure that the measured values are accurate.
This section describes how to have the offset and gain automatically calculated and set for you.

NOTE: See “Calculating Offset and Gain Using the Two-Point Method” on page 177 if:

You don't have access to a calibrator, or
The point uses inverted scaling and your device has PAC firmware R9.5b or lower. (In inverted

scaling, the lower scaled value is greater than the upper scaled value.)

Starting with the introduction of SNAP-B3000-ENET, all SNAP PAC brains (including SBs), SNAP Ethernet I/0 units,
and E2 brain boards can automatically calculate offset and gain for analog input points. If a -50 mV to +50 mV

input receives signals that are slightly off (for example, not exactly -50 mV at the lowest point), the offset and gain
can be calculated so that values appear accurately when read.

Offset and gain values affect engineering units (EU). For a temperature input, engineering units are in degrees
CorF, depending on how the I/O unit is configured.
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IMPORTANT: To calibrate the point, the I/O unit must be turned on and attached to the network, and you must
have access to the I/O unitin order to use the calibrator. For points on a SNAP PAC SB-series brain, connect directly via

serial or through the controller via Ethernet. (See page 26 for details.)

Save the configuration to flash so that it is not lost when power is turned off. Since each calibration is for a specific
point on a specific I/0O unit, the result cannot be saved to the configuration file and cannot be sent to any other I/0O

unit.

First, calculate offset, and then calculate gain. The offset must be calculated at the signal corresponding to
zero engineering units (EU), and the gain must be calculated at the signal corresponding to the point’s
maximum input range value (or, for inverted scaling, the point's minimum input range value—in inverted
scaling, the lower scaled value is greater than the upper scaled value).
1. InInspect mode, click the Analog Point button.

2. (lickthe module and analog input point you want to calibrate.

#=#| Inspect Opte 22 Device (UDP) —

Device Name: | R 1 Controller j Options » Status: | Analog Point area last read at 09/23/16 12:02:32
Analog Point
Status Read B
= Step 1: Choose a module i) More Info
SEEE s [Modue [0 1 =2 BEMl #+ 5 6 78 8 10 1112 13 14 15 Type:  AICTD (0x04)

Wil SLAN F Step 2: Choose a point on the selected module

Type: ICTD (0x04)

Point U‘ l_ 2 3 4 5 5] 1 8 9 l'El ll 12 13 i-} iS Feature: Mone (0x00)
Module Point C. 16 17 18 1920 21 22 23[24 25 26 27(28 29 30 31 pame: aiOvenTemperature
Read Area
Digital Bank
. / Do Bank | Address | Description | Refresh I
Point Digital Point OxFFFF FO26 3000  Scaled Units
— 0xFFFF FO26 3004 Counts
Analog Bank OxFFFF FO26 3008 Min. Value (Scaled Units)
= 0xFFFF FO26 300C Max. Value (Scaled Units)
Analog Point OxFFFF FO26 3024 Raw Counts
High Density
Write Area
System »
_Sveem o Clear: Offset and Gain
Scratch Pad } . X
e ———— Min. value Step 1: Use a calibrator to input the signal that
Data Log » 102.026 corresponds to zero Engineering Units (i) Mare Info
PID > Step 2:  Calc and Set Offset
Events > 15434.000 Step 3: Use a calibrator to input the signal that
_ corresponds to the maximum input range value
Communications ¥ {positive scaling), or the minimum input range value
(negative scaling) (i) More Info
Other 3 0.00000
Step 4 Calc and 5et Gain
Oﬁ»’set a nd Two-Point Method

Gain buttons

/

Clase I Help |

[T Auto Refresh | 15000  msec

3. Ontheanalog input point, use a calibrator to input the signal that corresponds to zero Engineering Units

(EU).
Example 1:SNAP-AIV (-10 to +10VDC) configured with default scaling
zero EU=0VDC

Example 2: SNAP-AIV (-10 to +10 VDC) configured with custom scaling

Actual Scaled

Units VDC PSI
Lower -10 0*
Upper +10 100

*Zero EU is 0 PSI, which corresponds to a -10 VDC field signal

4. C(lickthe Calc and Set Offset button.
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5. Use the calibrator to input the signal corresponding to the maximum input range value—or for inverted
scaling, to the minimum input range value—for the configured point type.

(In inverted scaling, the lower scaled value is greater than the upper scaled value.)
For precise values, refer to the configured Point Type or see the module's data sheet.
Example:

SNAP-AIV module; Point Type of -10 to +10 VCD:

Maximum Input Range Value = +10 VDC

For inverted scaling, Minimum Input Range Value =-10 VDC

6. Clickthe Calc and Set Gain button.

NOTE: To store offset and gain values permanently, you must save the change to flash when you send the
configuration data to the I/O unit (see page 68).

Calculating Offset and Gain Using the Two-Point Method

You adjust an analog point’s offset and gain to ensure that the measured values are accurate.
«  Offset represents the low scale offset from the correct value.
«  Gain represents the slope of the scaling equation.

The two-point method allows you to use any real-world range of Engineering Units to calculate offset and
gain. Use this method when it isn't convenient or possible to input a signal that equates to either the
zero-scale or full-scale engineering units for a module’s point type. Also, you must use the two-point method
if the analog point you're calibrating uses inverted scaling and you're using PAC firmware R9.5b or lower. (PAC
firmware R9.5¢ and higher can automatically calculate offset and gain for analog points that use inverted
scaling.)

When using the two-point method, choose two points that are as far apart as possible.

1. [fitisn't already open, open the Inspect Opto 22 Device window for the point you want to calibrate (Tools
> Inspect | Analog Point button).

2. (Click the Two-Point Method button in the Offset and Gain area in the bottom-right corner of the Write
Area.

NOTE: You may have to scroll down to see the button.

Offset and Gain

b
L

|
|
!

Step 1: Use a calibrator to input the signal that
corresponds to zero Engineering Units (i) More Info

Step 2:  Calcand Set Offset

Step 3: Use a calibrator to input the signal that
corresponds to the maximum input range value
(positive scaling), or the minimum input range value
(negative scaling) (3} More Info

Step4:  Calcand Set Gain

__ TwopointMethod —| & Two-Point Method button

{
i ™ AutoRefresh | 15000  msec

3. Use a calibrator to input a signal corresponding to the low end of the desired range.
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Expected Value

For example, a SNAP-AIV module has a range of =10 to +10VDC, so you might choose a range of 1.0 to
8.0ifit's convenient. In that case, you would use the calibrator to input a low end of 1.0 VDC on the input
point.

NOTE: For best results, choose two points that are as far apart as possible.

Note the signal’s value on the calibrator and type this value in the Expected Value field.

Write Area

Low Values

Step 1: Use calibrator to input a
signal corresponding to the low
end of the desired range.

Step 2: Enter the value the
input should return in response |
to this signal.

Expected Value:

Step 3: Read the value the
input is currently returning in
response to this signal.

Actual Value:
Read
For best results, choosg a low and high point as far apart as possible. Default Method

Read button

5. (Clickthe Read button to read the value that the input point is returning in response to this signal. This
value appears in the Actual Value field.

6. Use the calibrator again to input a signal corresponding to the high end of the desired range.
Using the SNAP-AIV example in step 2, for the high end you would use the calibrator to input 8.0 VDC on
the input point.

7. Type the Expected Value for the high-end value, and then click Read.

8. (lick the Calculate button to calculate the offset and gain.

9. C(lick Send Values to send the offset and gain to the device.

10. Save the settings to flash memory to make sure that the data is not lost when power to the device is

turned off. See “Saving Configuration to a Device's Flash Memory”on page 190.

Analog Output Points

The following example shows an analog output point.
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= Inspect Opto 22 Device - X

|Module [0 1 2 3[4 5 & 7[8 9 10 11[12 13 14 15 Type:r  AOV-27 (kA7)
" Step 2: Choose a point on the selected module
Wireless LAN 'l E — Type:  +/- 10 VDC Dual (0xAT)
Pomt | O 2 3|4 5 & 7]8 9§ 10 11 515 15 plitie: Nome (0x00)
Point Config | 18 17 18 19020 21 22 23|24 25 28 27 22 30 31 name:  aoConveyorSpeedControl
i Read Area
Digital Bank
%I Address | Description | Value | Refresh I
Current values for point 1 Bigitet-Faimt II OXFFFF FO26 2040 Scaled Urnits 5.000
dule 2. T q OxFFFF FO25 2044 Counts 204.000
on module 2. To upaate Analog Bank | OxFFFF FO26 2048 Min. Value (Scaled Units) Nal
values C“Ck the Refresh - OxFFFF FO26 204C  Max. Value (Scaled Units) Mal
! Analog Paint OxFFFF FO25 2064 Raw Counts -1
button. . o |
High Density
Write Area
System » | Offset and Gain
Output Values: Clear:

Data L 3
Change the value on an = 5000 ﬂl M, Value | OKFOID 4610 | Step2:  Cale and Sek Offset |
D 3
Output Counts (0xFO2A 2044):

output point by using  — |

the Write Area.

Device Name: | 10,182.55.67

j Options >|

Status: IAnang Paint area last read at 05/04/16 11:46:30

Status Read |
Status Write |

—Anzlog Point

Step 1: Choose a module

(i) More Info

ScratchPad |

Qutput Scaled (OxFO2A 2040):

Events 3 |
Communications ¥ |
Other 3 |

| 204,000 Apply |

TPC Period (0:F02A 204C)

I 0.00000 Apply |

Mlim, Walue | 0xF01D 460C

Step 1: Use a calibrator ta input the signal that
corresponds to zero Engineeting Units (i) More Info

Skep 3: Use a calibrator ko inpuk the signal that
corresponds ko the maximum input range value
{positive scaling), or the minimum input range value
(negative scaling) (1) Mere Info

Step 4: | Calc and Set Gain | v

Close | Help |

™ AutoRefresh | 15000  msec

1. Clickthe point number you want to read or write to.
The current values for that point number appear in the Read Area.
2. Tochange the value of an output point, enter the value in the Write Area (either Scaled or Counts) and

click Apply.

The change is immediately sent to the I/0 unit, and the window is updated.

Reading Analog and Digital Banks

You can use PAC Manager to read a bank of points at one time. (Currently it is not possible to write to a bank of
points using PAC Manager.) You must configure points before you can read them.

NOTE: Bank reading cannot be done on digital or analog modules containing more than four points. To read or write
to all points on a high-density digital module, see page 182.

1. Inthe PAC Manager main window, click the Inspect button El
The Inspect window opens.
- Ifyou haven't used the Inspect window before, no data is displayed in the Status Read pane.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device
Name field, and current Status Read information appears in the window.
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- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

@ nspect Opto 22 Device —

Device Name: | 10,199.99.99 j Options # Status: | Status Read area last read at 07/05/16 10:34:58

Status Read
Status Read
Status Write ADDRESS DESCRIFTION VALUE ~ Refresh |

) 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
{ WirelessLAN ¥ OxFFFF F030 0008 Buay Flag 0
| Paint Config 0xFFFF F030 0018 Loader Version R5.1lc
Digital Bank 0xFFFF FO30 0000 Memory Map Version 1
0xFFFF F030 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version L5.5a
0xFFFF FO30 00R0 Firmware Version Date 05/03/2016

Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A

High Density 0xFFFF FO30 0080 Unit Description SNAP-FAC-R1
| 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
| 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
Hegw D 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
| ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432

Data Log 3
ETHERENET 1 Interface

PID * 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-85-9C
, I_ OXFFFF FO30 0034 IP Address 10.192.55.67
,-__,,,Eue\n—‘r"\__,_.. A LOZFERFEQ 200038, s S nolMongie, e mmton p o team o, 908 OGFL00 QL AN A s, sl

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

Wpto 22 Device

eS0T S O B ookie Controller

1_ [EngineRm i
| Cail Portable
: SoftPAC [CRIPTION
e lerup Clea
Wireless LAN | Boler =

—— I Chamber 1 s
. Chamber 2 J
Point Config g partable der Versid
T Cookie Controller ory Map Ve
HD@E' B EngineRm mware Verd
Di SoftPAC Imware Ver

igital Point = 1
0xFFFF F030 00BO Firmware Verg

2. Inthe Device Name field, type the name (or IP address) of the I/O unit (or choose it from the drop-down
list). Click Digital Bank or Analog Bank.
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Digital Bank Window

Values are current as of the Status date and time.
Click Refresh to update values.
| \

-Eﬂ Inspect Opto 22 Device \ —
Device Name: | 10,192,55.67 x| options » Status: | Digital Bank area last read at 05/02/16 16:07;
- Digital Bank Read
Status Read
haE i_az_n?r_af.ss _____ . Yz_u: T P
el 5 0xFFFF FO40 0000 State of Digital Points  0x00000000 0000000C
R G ] 0xFFFF FO40 0002  State of On-Latches 1x00000000 OOFCCCER
0xFFFF FO40 0010 State of Off-Latches 0x00000000 00FCCCFA
Faint Config 0xFEFF F040 0018  Active Counters 0x00000000 00000000
Digital Bank
Digital Paint LDDRESS MODULE BOINT  COUNTER VALUE
Analog Bank 0xFFFF FO40 0100 0 0 1
- 0xFFFF FO40 0104 0 1 0
Analog Point 0xFFFF F040 0108 0 2 0
: : 0xFFFF F040 010C 0 3 0
Doty 0xFFFF FO40 0110 1 4 0
7 0xFFFF FO40 0114 1 5 0
St 0xFEFF FO40 0118 1 6 o
i b 0xFFFF F040 011C 1 7 0
0xFFFF FO40 0120 2 8 0
Datalog * 0xFFFF FO40 0124 2 9 0
0xFFFF F040 0128 2 10 o
PID > 0xFFFF F040 012C 2 11 0
S o OxFEFF F040 0130 3 12 0
i 0xFFFF FO40 0134 3 13 0
Communications ¥ 0xFFFF FO40 0138 3 14 il
0xFFFF F040 013C 3 15 0
Other » 0xFFFF F040 0140 4 16 0 v
Sz | HEE | [~ AutoRefresh | 15000  msec

Remember that values for points on high-density digital modules are not included.

You can copy part or all of the data in this window and paste it into another file, such as a text file or email. Just
highlight what you want to copy, right-click it, and choose Copy from the pop-up menu (or use Ctrl+C). To
highlight all data in the window, right click in the window and choose Select All.

Data Formats. Most digital bank data is in the form of a mask. For example, the State of Digital Points value
shown in the previous figure is this mask:

0x00000000 00OOOOOC

This mask shows, in hex, the state of all 64 possible points (maximum rack of 16 modules with four points per
module). The lowest points are on the right:

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 C
0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 [ 0000 | 0000|0000 | 1100
30 ({30 (30(30|30|30|30(30|30|30| 30|30 (30| 30| 30| 30
15 14 13 12 1 10 9 8 7 6 5 4 3 2 1 0

In this case, all points are OFF except for points 2 and 3 on the module in position 0, which are ON. For more
help in interpreting bank data, see page 196.

Bank counter data, however, uses unsigned 32-bit integers; for help in interpreting counter data, see page 196.
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Analog Bank Window
Values are current as of the Status date and time.
(lick Refresh to update values.

l

= Inspect Opto 22 Device x— X
Device Name: | 10.192.50. 15 LI Options ¥ I Status: |Analog Bank area last read at 05/02/16 16:00:18
—Analog Bank Read
Status Read |

T | "
o 5 0xFFFF FO26 0000 O
R | 0xFFFF F026 1000 1

_ 0xFFFF FO26 2000 2
Point Config | 0xFFFF FO26 2040 2

= 0xFFFF FO26 3000 3
EE s 0xFFFF FO26 3040 3
Digital Point | 0xFFFF FO26 4000 4
OxFFFF FO26 4040 4

0xFFFF FO26 5000 5
_ 0xFFFF FO26 6000 6

Analog Point | 0xFFFF F026 7000 7

: : 0xFFFF FO26 7040 7
IEIER 0xFFFF FO26 8000 &

= 0xFFFF FO26 9000 9

SEED | OXFFFF FO26 9040 9
e ,l 0xFFFF FO26 R000 10
0xFFFF F026 A040 10

Data Log >| OxFFFF F026 BOOO 11

0xFFFF F026 B040 11
PID L2 0xFFFF F026 CO00 12

e OXFFFF F026 D000 13
| OXFFFF F026 E0O0 14
Commurications ,l OXFFFF FO26 E040 14
OxFFFF F026 FOO0O 15

Other >| OXFFFF F026 FO40 15

Sass | HEr | [ Auto Refresh I 15000  msec

L I T S R e B B T R R T I
=
=
=]

For help in interpreting analog point data, see “IEEE Float Data” on page 197.

Reading and Writing to SNAP High-Density Digital Points

In PAC Manager, you can read or write to points on high-density digital modules in two ways: one at a time

using the Digital Point button (see page 172), or all at once as shown below.

1. Toread or write to points on high-density digital modules, click the Inspect button Ql in the PAC
Manager main window.

2. Inthe Inspect Opto 22 Device window, type the Device Name (or IP address) of the I/O unit (or choose it
from the drop-down list). Click High Density.
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= Inspect Opto 22 Device

Device Mame: |F\1 controller j Oplions ¥ Status: |High Denszity Digital Module area last read at 1040407 13:08:07
Hiah Density Digital Module
Status Read
Module Mumber: _ | Standard Module Type: Dig/none [0x00)
Status Write |

Address | Diescription Walue | Riefresh
Puaint Config

Digital B ank. Q
Digital Paint
Analog Bank
Analog Paint Paint State On-Latch Off-Latch Counter
System 3
Scratch Pad  »
Datalog »
FID 3
Ewvents L4
Communications #
Other 4

Cloze Help

3. (lickthe module number for the point you want to read or write to.
SNAP High-Density Digital Input

For an input module, the current states and latches appear, both as bitmasks in hex and individually for each
point. Counter values appear in the Counter column.

= Inspect Opto 22 Device

Device Mame: |FH controller j Optionz ¥ Status: |High Density Digital Module area last read at 10/04/07 13:14:40
High Density Digital Module
Status Read
fodule Mumber: | High Denszity Digital Input Module Type: IDC-32 [O<E0)
Status Wite |
- . Address | D esoription Walue | Refresh
Paint Config STATUS
L 0xFFFF F180 8300 Pairit State Mask 0w 00000000 00000000
Digital Bank LATCHES
Digital Poirt 0xFFFF F180 8308 On-Latch Mask Oz 00000000 00000000
0xFFFF F180 8310 Offt-Latch Mask 0 00000000 00000000
Analog Bank
Analog Point | Paint State On-Latch Off-Latch Counter ‘ ~
. . 0 Off off On 0
High Density 1 of ot on 0
2 Off off Off ]
Syem 0 3 On On oif 8
4 On On Off 0
Scratch Pad  » M off of O 2
[ oif On On 0
»
QD dblleg 7 O 0 O 0 B
FID » 8 off off off 0
3 On off Off 11
Events 3 10 Off [uljj On 0
11 On off Off &
Communications b 12 Off ulij off il
13 oif ulij oif 0
Other — + 14 i i i i
15 off off off 0
18 Off off Off 0 b
Cloze Help
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To clear latches for a point, highlight the point number and click the Clear On-Latch or Clear Off-Latch button.

To clear the counter for a point, highlight the point and click the Clear Counter button.
The change is immediately sent to the I/O unit, and the window is updated.
SNAP High-Density Digital Output

For an output module, the current states appear, as bitmasks in hex and for each point.

=3 Inspect Opto 22 Device

Device Mame: |FH controller

Status Read

Status wiite |

ﬂ Options Status: |High Density Digital Module area last read at 10404407 13:24:24
Hioh Density Digital Module

fodule Mumber: | High Density Digital Output M odule Type: ODC-32-5RC [0=ET)

Address | Drescription Walue | Refresh
Paint Config STATUS
Digital Bank 0«FFFF F180 8340 Paint State Mask 0% 00000000 000041 CE

Digital Paoirt
Analog Bank,
Analog Point Paint State

S

1] On

High Dengity 1 on

2 Off

Spstem 3 3 On

Soratch Pad  » g g;;
Datalog g g: ]

FID 3 g On

3 oif

Events 2 10 Off

11 off

Communications # 12 Off
13 On

Other » 14 0ff

Cloge | Help |

To turn a point on or off, highlight the point number and click the Turn On or Turn Off button.

The change is immediately sent to the I/O unit, and the window is updated.

Reading System Date and Time

SNAP PAC controllers and brains have a real-time clock. A SoftPAC controller uses the computer’s clock.

1. Toread the date and time on the device, click the Inspect button @ in the PAC Manager main
window.

2. Inthe Inspect window, type the name of the device (or choose it from the drop-down list). Click System

> Date And Time.
The device’s date and time appear.

NOTE: Although you can change the date and time by clicking a cell in the Value column and typing in the new
number, then clicking Apply, there is a slight delay before the time is set on the unit. Other ways of setting time
may be more accurate, for example, using PAC Control to synchronize system date and time. See also “Setting
Up System Date and Time” on page 115 for another method.

Reading and Writing to the Scratch Pad Area

Before using this section, be sure to read “Event/Reaction Concepts”on page 127.
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You can read the current state of Scratch Pad bits and current values in Scratch Pad integers, strings, and floats

using PAC Manager. You can also change these values in real time, which can be useful for testing. If you are

running PAC Control, make sure your changes do not conflict with strategy logic.

1. Toread or change the Scratch Pad areg, click the Inspect button Q in the PAC Manager main window.

2. Inthe Inspect Opto 22 Device window, type the IP address of the I/0 unit (or choose it from the
drop-down list). Click Scratch Pad and then choose the area you want from the pop-up menu.

Scratch Pad Bits

The Scratch Pad bits window shows you the current state of the Scratch Pad bits (as of the Status date and
time) and the current On and Off masks. You can change any of these masks by clicking its cell in the Value
column and typing in the new mask, then clicking Apply.

Values are current as of the Status date and time.
Click Refresh to update values.
| \

e v

Device Name: | 10.192,55.67 j Options ¥ Status: | Scratch Pad its area last read at 05/04/16 IY:ZG

| Scratch Pad Bits

| Status Read

| Status Write Address | Description | Value | Refresh |

[ DIRECT ACCESS |
" 0xFFFF FODS 0000 Scratch Pad Bits 0x 00000000 00000000 Apply

| Wireless LAN ¥

MOMO ACCESS
0xFFFF FODS 0400 ON Mask 0x 00000000 00000000 |

i Point Config 0xFFFF FODS 0408 OFF Mask Ox 00000000 00000000 |
| Digital Bank |
: Digital Point |
Analog Bank
Analog Point I
High Density I
|
System 3 |
ScratchPad  »
Data Log 3
PID 3
Events 3
| Communications ¥
Other 3

Close | Help | [ Auto Refresh | 15000 msec |

Scratch Pad Integers, Floats, and Strings

Scratch Pad Floats are used as the example here, but integers and strings are similar. Current values are shown
as of the Status date and time. To update values, click Refresh.
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Change the value in the When all new values are
Value column. entered, click Apply.
= Inspect Opto 22 Device - *
Device Name: I 10,192.55.67 LI Optigns ¥ Status: | Scratch Pad Floats area last read at 05/04/16 11:52:52
Scratch Pad Floats
Status Read |

Status Write | Apply | Address [ value [~ | Refesh
[Jo  OxFFFFFODB 2000 O
Wircless LAN ¥ | 11  OxFFFFFODS 2004
Oz

0xFFFF FODS 2008

Paint Canfig | Os OXFFFF FOD 200C
[J4  oxFFFFFODE 2010
M Os 0xFFFF FODS 2014
Digital Paint | Os 0xFFFF FODG 2018
[07  oxFFFFFODE 201C
ml [1s  oOxFFFFFODS 2020
Analog Point | s 0xFFFF FODS 2024

O w

0xFFFF FODS 2028

wl [J11  oxFFFF FODS 202C

[J12  oxFFFF FODS 2030

ﬂl []13  oxFFFF FODS 2034

SratchPad  » | [J 14  oxFFFF FODS 2033
O s

0xFFFF FODS 203C

Ealalog ’l [116  0xFFFFFODS 2040

P , [0 17 oxFFFF FODS 2044
[0 18  oxFFFF FODS 2048

_eens || [T oFrrrops 20
Communications » | [120  0xFFFF FODS 2050

D 21 0xFFFF FOD3 2054
__oter || |02 orrrronsnss
o e | [ Auto Refresh I 15000  msec

Clear Al

Select All

et

Unselect All

(== = R = = = T = N = Y = = T~ = T = = I = = = = I = =)

The Select All and Unselect All buttons control the check marks in the Apply column boxes. The Clear All
button puts all values at zero.

1. Tochange a value in Scratch Pad integers, floats, or strings, click the cell in the Value column and type the
new value.

A check mark appears in the Apply column box. If you do not want to send a value, click the box to
uncheckit.

2. C(lickthe Apply button to write the new values to the Scratch Pad.
All the checked items are changed.

Data Logging

Data logging is normally configured in a configuration file (see page 87), but you can change it in the Inspect
window. Remember that changes made here cannot be saved to a configuration file, however. To change
configuration, with the I/O unit’s IP address in the Inspect window, click Data Log > Data Logging Configure.
For help, see the information in the steps on page 87.

To read the data in a data log you have set up, use PAC Manager's Inspect window. See instructions on
page 89.To clear all data from a data log, see page 90.

Reading or Changing PID Loops

For information about PID loops, see page 63. PIDs are normally configured in a configuration file following
the steps on page 65. However, you can also configure, view, or change them using PAC Manager's Inspect
window. (Remember that changes made here cannot be saved to a configuration file))

1. Inthe PAC Manager main window, click the Inspect button Ql
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If you haven't used the Inspect window before, no data is displayed in the Status Read pane.
If you have used the Inspect window before, the last device you inspected is shown in the Device

Name field, and current Status Read information appears in the window.

&% Inspect Opto 22 Device

If you have configured other devices, they are listed in alphabetical order in the drop-down list.

Device Name: | 10.199.59.99

Status Read
Status Read

Status:

j Options »

Status Read area last read at 07/05/16 10:34:58

DESCRIFTION

VALUE

~ Refresh |

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress

PUC Receiwed (0}
a

R5.1c

1

Flash Memory
29.5a
05/03/2016
15229232

0x0000007A
SHAP-FRC-R1
4

21

2008

R0.0a
33554432

00-A0-3D-01-85-3C
10.192.55.67

Status Write NS
o , 0xFFFF FO30 0004
| | e 0xFFFF FO30 0008
| Paint Canfig 0xFFFF FO30 0018
= 0xFFFF FO30 0000
EREIE 0xFFFF FO30 0230
Digital Paint 0xFFFF F030 001C
0xFFFF FO30 00R0
Analog Bank 0xFFFF F030 00BO
Analog Point 0xFFFF FO30 0020
S s 0xFFFF FO30 0080
: ELIEEE 0xFFFF FO30 0024
, 0xFFFF FO30 0025
HEED 0XFFFF FO30 0026
| e b 0xFFFF FO30 024C
0xFFFF FO30 0028
Data Log 3
PID * 0xFFFF FO30 002E
0xFFFF FO30 0034
-7 NN

LOXEERFEQ 200038, = Spe b Mot s =t p b ot mrt, OGS G400 Q A% A semsn sl

If you have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list

are displayed when you have

six or more devices configured.

¥ Inspect Opte 22 Device
Device Name] | afJs/=Rels/y}igs] /=g Opti
1_ [EngineRm i

| Cail Portable

: SoftPAC [CRIPTION
e lerup Clea
Wireless LAN | Boiler FI;

——————— Chamber 1 s
. Chamber 2 4
Point Confid o portable der Versig
T Cookie Controller ory Map Ve
Bl Balq]EngineRm mware Verg
Digital Point-22ftPAC mware Ver
| ‘fJxFFFF FO30 00BO Firmware Verg
N LR il ey et e atn i

2. Inthe Device Name field, type the name (or IP address) of the I/O unit (or choose it from the drop-down

list). Click PID and choose PID Loops from the submenu.
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Information for this PID loop is —_

shown in the window.

188

é Inspect Opto 22 Device

Device Name: I 10.19

2,55.67

j Options >|

Status: IPID Loop area last read at 05/04/16 11:35:31

Status Rid. |

Status Write |

—PID Loops

(PID Loop Mumber: I[J - >

Wireless LAN  » |

Point Config |
Digital Bank |
Digital Point |
Analog Bank |
Analog Point |
High Density |
System 3 |
ScratchPad |
Data Log 3 |
PID 3
Events 3 |
Communications ¥ |
Other 3 |

Address

| Py Refresh I

OxFFFF F210 0064
OxFFFF F210 0068
0xFFFF F210 000C
OxFFFF F210 0008
OxFFFF F210 0000
OxFFFF F210 0004
0xFFFF F200 0028
OxFFFF F200 002C
OxFFFF F200 0030
OxFFFF F200 0034
OxFFFF F200 0000
OxFFFF F200 0004
0xFFFF F200 0008
OxFFFF F200 000C
OxFFFF F200 0010

OxFFFF F210 0010
OxFFFF F210 0014
OxFFFF F210 0018
OxFFFF F210 001C

OxFFFF F210 0050
OxFFFF F210 0054
OxFFFF F210 0038
NvFFFEE F210 NNas

Status Flags Off Mask
Current Value Of Error
Current Value Of P (Gain)
Current Value OF I (Integral)

Current Value OF D (Derivative)

Current Value Of Integral

TUNING

Gain

Tune I (Integral)
Tune D {Derivative)
Feed Forward Gain

COMFIGURATION

Algarithm

Mode

Scan Time (seconds)
Mamhan Addrecs Far Tnnit

| Description | Value
STATUS

Current Value Of Input
Current Value Of Setpoint
Current Value Of Output 0.000000
Current Value Of Feed Forward 0,000000
Last Scanned Value Of Input 0.000000
Last Scanned Value Of Setpaint 0.000000
Scan Counter a
Status Flags 00000000
Status Flags On Mask 00000000

0.000000
0.000000
0.000000
0.000000

Mone
Automatic
1.000000

v NNNNNNNN

E

=
=

v

- |

™ AutoRefresh | 15000  msec

From the drop-down list, choose the PID loop number you want to configure, view, or change.
Existing PID loops are indicated by an asterisk (*) next to the number.
To configure or change the PID, click inside the cell in the Value column and type the new value or

choose it from a drop-down list, if one is available. When you have finished making changes, click Apply

to send them to

NOTE: If you are using PAC Control, it is easiest to tune PID loops in your PAC Control strategy running in Debug

the 1/0 unit.

mode. For details, see the PAC Control User's Guide (form 1700).

For information on memory map addresses and what they contain, see the OptoMMP Protocol Guide (form

1465).
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Reading or Changing Events and Event Messages

Digital, alarm, serial, timer, and Wiegand events are normally configured in a configuration file. Event
messages are configured in a configuration file if you are using PAC Control; otherwise, they are configured in
the Inspect window. See Chapter 4: Setting Up Events and Reactions for configuration steps on all events and
event messages.

However, you can read current events and also change their configuration in the Inspect window. Digital
Events are shown below as an example.
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Choose the event
number from the
drop-down list.

CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

Current status of the event (as of the
Status date and time) is shown here.

=5 Inspect Opto 22 Device

Device Mame: |SB brain Status: |Expanded Digital Event arga last read at 10/05/07 18:08:27

j Optionz

i 5 Digital Events - Expanded
=L
This event's - Event Mumber: |0 v
configuration data is Status Wike | — ot = | e
shown here. Paint Confia ress E\?Ecrjl]?tlon alue efresl |
D Digital :l”ank 0=FFFF FOD4 004C  Event Enable/Disable Apply
0«FFFF FOD4 0044 Usze which digital data for tigger? Digital Point State
Digital Paint O«FFFF FOD4 0000 Digital OM 00000000 00000000
O«FFFF FOD4 0003 Digital OFF 00000000 00000000
Analog Bank 0«FFFF FOD4 0044 Usze which scratch pad data for trigger? cratch Pad Bitz
O«FFFF FOD4 0010 Scratch Pad ON (x 00000000 00000000
Analog Point O«FFFF FOD4 0018 Scratch Pad OFF (x 00000000 00000000
0«FFFF FOD4 0040 Length of Delay Before Reaction [msec.] 1]
High Drensity
REACTION
System 3 0«FFFF FOD4 0044 Reaction Occurs Continuously
0«FFFF FOD4 0044 Usze which digital data for reaction”? Digital Point State
SoratchPad v OxFFFF FOD4 0020 Digital OM (x 00000000 00000000
O«FFFF FOD4 0028 Digital OFF (x 00000000 00000000
Datalog » 0x=FFFF FOD'4 0044 Use which scratch pad data for feaction? Scratch Pad Bits
FID 5 O«FFFF FOD4 0030 Scratch Pad ON (x 00000000 00000000
O«FFFF FOD4 0038 Scratch Pad OFF (x 00000000 00000000
Events 3
o CURRENT STATUS 4 Refresh
e AR O+FFFF FOD4 004C  Event State off 4
Other v 0«FFFF FOD4 0048 Time Remaining [mzec. ] 1]
0«FFFF FO40 0000 Current Y alue - Digital Point State [ 00000000 00000000
0=FFFF FOD& 0000 Current Y alue - Scratch Pad Bits (0= 00000000 00000000

Cloze | Help |

Reading or Changing Communications and Other Data

Other data on the I/O unit or standalone controller can also be read and changed using PAC Manager’s Inspect
window. The following table shows where to find the data in the Inspect window and references page
numbers in this guide for information to help you understand what you are reading or how to change it:

To read or change Click this in the Inspect window For help, see

Security Communications > Network Security page 78

PPP Communications > PPP page 122
Streaming Communications > Streaming page 104
Email Communications > E-mail page 100
Modbus Communications > Modbus page 112
SNMP Agent Communications > SNMP page 96
Serial ports on brain Communications > Communication Port Control page 117

or controller

In addition, you can read or write to any memory map address by clicking Other > Generic Read/Write. See
the memory map appendix in the OptoMMP Protocol Guide (form 1465) to make certain you have the correct
address before making any changes.
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WRITING COMMANDS TO THE DEVICE

NOTE: If you are using the PAC Control Redundancy Kit and redundant controllers, do not use PAC Manager to work
with your controllers. Instead, use the PAC Redundancy Manager that comes with PAC Control Professional (version

R9.0 or higher).

Using OptoMMP Device Commands

CAUTION: These hardware commands directly affect the operation or configuration of the device. Be careful when

you use them, as they cannot be undone.

Saving Configuration to a Device's Flash Memory

Saving configuration data to the controller or I/O unit's flash memory makes sure that the data is not lost

when power to the device is turned off.

If you are using a configuration file (as in most of Chapters 2, 3, and 4), you can choose to save configuration
data to flash memory when the file is loaded to the I/O unit. However, if you are writing configuration directly

to the device (as in this chapter), you'll need to follow these steps to save to flash.

Note that this command saves to flash the things you can configure in PAC Manager. It does not affect a PAC

Control strategy, which is saved to flash via PAC Control or PAC Terminal.

CAUTION: Ifyou are using PAC Manager R9.0a or higher, PAC firmware R9.0a or higher, and loader version 6.0 or
higher, and if a controller has a microSD card installed and the card already contains configuration data, that data

will be overwritten. See the controller user’s guide for complete information about microSD.

1. Inthe PAC Manager main window, click the Inspect button Ql
he de

2. Inthe Device Name field, type the name (or IP address) of t
list. Click Status Write.

3. Inthe Operation Command list, highlight Store configuration to flash.

vice, or choose it from the drop-down

é Inspect Opto 22 Device

Analog Point |
High Density |

System » |
ScratchPad  » |
Data Log 3 |
PID r
Events » |
Communications |
Other 3 |

0xFFFF FO38 0054

Operation

Scanner Flaos

OptoMMP Device

microSD

Restart Device from powerup

Store configuration to flash

Erase configuration from flash k
Reset to defaults and Restart Device

~ Send Command |

Store configuration and IP settings to micraSD
Erase configuration and IP settings from microSC
Erase firmware from microSD
Erase strategy from microsSD

Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration ]

Device Name: | 10.192.50.11 ~| options » | Status: | Status Write area last read at 05/02/16 16:30:29
~ Status Write
Status Read |
Status Write | Address | Description | Value iR H
OxFFFF FO38 0004  Always BootP/DHCP On Powerup Mo |
" OxFFFF F033 0008 Degrees F[C Degrees F I Apply
Wireless LAN ¥ OxFFFF FO38 0010 Comm Watchdog Time (msec), 0 = Disable 0
0xFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250
Point Config | OxFFFF FO38 0018  TCP Initial Retransmission Timeout (msec) 3000
0xFFFF FO33 001C  TCP Retransmission Attempts 5
Digital Bank | OxFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
= = OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1
Fole Ho | OxFFFF F038 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bark | OxFFFF F038 0298 Out Of Range Value (16-Bit) -327638.000
OxFFFF FO38 02B0  Qut Of Range Value (32-Bit) -2147483643.000

Ox 00000000

- |

[~ AutoRefresh | 15000 msec

4. C(lick Send Command.
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The configuration data is stored to flash memory and a Success message appears.
Restarting the Device

Restarting the device is just like turning the power off and then turning it back on again. This command can
be used for both 1/0 units and controllers. For an I/O unit, if configuration data has not been saved to flash
memory, restarting resets points to their defaults.

For some configurations to take effect, the device must be restarted. A SNAP PAC controller must be restarted
after you configure its secondary IP address, for example. For an 1/0 unit, if you are using a configuration file (as
in most of Chapters 2, 3, and 4), you can choose to restart the unit when the file is loaded to the I/0 unit and
saved to flash memory. However, if you are writing configuration directly to the I/O unit (as in this chapter),
after you store to flash, you need to follow these steps to restart it.

1. Inthe PAC Manager main window, click the Inspect button @

2. Inthe Device Name field, type the name (or IP address) of the device, or choose it from the drop-down
list. Click Status Write.

3. Inthe Operation Command list, highlight Restart Device from powerup.

| Inspect Opto 22 Device - X
Device Name: | 10.192.50.11 j Options » Status: | Status Write area last read at 05/02/16 16:30:29
Status Write
Status Read
Status Write Address | Description | Value ~ Refresh
OxFFFF FO38 0004  Always BootP/DHCP On Powerup Mo hd
Wircless LAN ¥ OxFFFF FO38 0008 Degrees F[C Degrees F =1 Apply
OxFFFF FO38 0010  Comm Watchdog Time {msec), O = Disable 1]
OxFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250
Point Config OxFFFF FO38 0018 TCP Initial Retransmission Timeout {(msec) 3000
OxFFFF F033 001C TCP Retransmission Attempts 5
Digital Bank 0xFFFF FO33 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000
= = OxFFFF FO38 0294  Digital Feature Scan Interval (msec) 1
Foe Fk OXFFFF F038 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bark OxFFFF F038 0298 Out Of Range Value (16-Bit) -32763.000
OxFFFF FO38 02B0  Qut Of Range Value (32-Bit) -21474836483.000
OxFFFF FO38 0054 Scanner Flaos Ox 00000000 A

Analog Point
High Density Operation
OptoMMP Device
Restart Device from powerup
»
% Store configuration to flash k
ScratchPad  # Erase configuration from flash
»
Datalog Store configuration and IP settings to micraSD
Erase configuration and IP settings from microSC
i Switch to loader mode
»
% Clear Digital Events - Expanded configuration

Reset to defaults and Restart Device
A ' Erase firmware from microSD
Clear Digital Events - Old configuration W

~ Send Command

microSD
M Erase strategy from micro5D
Other

[~ AutoRefresh | 15000  msec

4, C(lick Send Command.
The device is restarted and a Success message appears.

Resetting to Defaults and Restarting

Resetting the device to defaults erases configuration information from the device’s flash memory. (It does not

erase IP address settings nor PAC Control strategy files in a controller) Resetting also does the following:

«  Ifthe device has PAC firmware R9.0a or higher and loader R6.0 or higher and a microSD card is present,
resetting erases PAC firmware, strategy, and IP address and configuration data from the card (does not
erase other data files or I/O coprocessor firmware)

«  (learsall point configuration and features, such as offsets and gains, custom scaling, latches, counters,
and minimum/maximum data

«  Turns off digital outputs and defaults all digital points to inputs
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«  Setsanalog outputs to zero scale (0 counts)
«  Restarts the device

Follow these steps to reset and restart the device:

1. Inthe PAC Manager main window, click the Inspect button @ .
2. Inthe Device Name field, type the name (or IP address) of the I/O unit, or choose it from the drop-down

list. Click Status Write.
3. Inthe Operation Command list, highlight Reset to defaults and Restart Device.

é Inspect Opto 22 Device

|
*

OxFFFF F038 0054

Scanner Flaos

Ox 00000000

Device Name: | 10.192.50.11 ~| options » | Status: | Status Write area last read at 05/02/16 16:30:29
- Status Write
Status Read |
Status Write | Address | Description | Value A~ Refresh
OxFFFF FO38 0004  Always BootP/DHCP On Powerup Mo R
) OxFFFF FO38 0008 Degrees F/C Degrees F &1 Apply
Wireless LAN ¥ OxFFFF FO38 0010 Comm Watchdog Time (msec), 0 = Disable 0
OxFFFF FO38 0014  TCP Minimum Retransmission Timeout {msec) 250
Point Config | OxFFFF FO38 0018 TCP Initial Retransmission Timeout (msec) 3000
OxFFFF FO38001C  TCP Retransmission Attempts 5
Digital Bank | OxFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
= s OxFFFF FO38 0294  Digital Feature Scan Interval {msec) 1
Digital Paint | OxFFFF FO38 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
e OxFFFF F038 0298  Out Of Range Value (16-Bit) -32768.000
| OxFFFF FO38 0260  Out Of Range Value (32-6it) -2147483648.000

Analog Point |
High Density |
System 3 |
ScratchPad  » |
Data Log 4 |
PID »
Events 3 |
Communications * |
Other » |

- |

Operation

OptoMMP Device
Restart Device from powerup
Store configuration to flash

Erase configuration from flash
Reset to defaults and Restart Device
microSD k

Store configuration and IP settings to micraSD
Erase configuration and IP settings from micraSC
Erase firmware from microsD
Erase strategy from microSD

Other
Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration ]

A Send Command |

[~ AutoRefresh | 15000 msec

4. (lick Send Command.
The 1/0 unit is set to defaults and restarted. A Success message appears.

Sending a Powerup Clear

The powerup clear command clears a flag that indicates the I/O unit has lost and then regained power.
Normally a powerup clear command is automatically sent, so normally you won't need to use this command.
If you receive a powerup clear error message, however, you can use PAC Manager to send the command. Note
that a power loss means that any configuration data not stored to the I/O unit's flash memory has been lost.

1. Inthe PAC Manager main window, click the Inspect button _d_l
2. Inthe Device Name field, type the name (or IP address) of the device. Click Status Write.
3. Inthe Operation Command list, highlight Send powerup clear.
4, C(lick Send Command.
The powerup clear is sent, and a Success message appears.

Using microSD Commands

NOTE: These commands require PAC Manager R9.0a or higher and PAC firmware R9.0a or higher. Use Status Read to
see the firmware version (see “Reading Basic Device Information” on page 147).
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SNAP PAC S-series and R-series controllers manufactured from November 2008 to the present have a microSD
card slot that accommodates cards up to 2 GB. These cards can be used to log data, of course, but they can
also be used as a kind of boot disk for the controller, so that you can replace a failed controller with a new one
by simply putting the prepared microSD card into the new controller, turning the controller on, and
connecting it to the network. The new controller boots from the card and configures itself; you can then use
the controller's Reset button to save the data on the card to flash memory.

Before using the card or any of these commands, be sure to read the section on microSD in the Maintenance
chapter of the controller user’s guide. A few steps are repeated here for convenience, but the user’s guide has
the complete information.

Three types of information can be put on the card to use it as a boot disk:

«  PACfirmware files

o Strategy files

«  Configuration data

Configuration data includes all current configurations (those that can be done in PAC Manager) plus the

controller's IP address and IP settings. The steps below show only how to add configuration data; see the
controller user's guide to add firmware and strategy files.

Putting Configuration Data on the microSD Card
1. Inthe PAC Manager main window, click the Inspect button Q .

2. Inthe Device Name field, type the name (or IP address) of the device, or choose it from the drop-down
list. Click Status Write.
3. Inthe Operation Command list, highlight Store configuration and IP settings to microSD card.

| Inspect Opto 22 Device

*

Device Name: | 10.111,11.11 Status: | Status Write area last read at 05/02/16 16:30:29

Status Write
Status Read

j Options ¥

Status Write Address | Description | Value ~ Refresh

OxFFFF FO38 0004  Always BootP/DHCP On Powerup Mo hd
Wircless LAN ¥ OxFFFF FO38 0008 Degrees F[C Degrees F =1 Apply

OxFFFF FO38 0010  Comm Watchdog Time {msec), O = Disable 1]
0xFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250

Point Config OxFFFF FO38 0018 TCP Initial Retransmission Timeout {(msec) 3000
OxFFFF F033 001C TCP Retransmission Attempts 5

Digital Bank 0xFFFF FO33 0020 TCP Idle Session Timeout (msec), 0 = Disable 240000

= = OxFFFF FO38 0294  Digital Feature Scan Interval (msec) 1

Fole Ho OxFFFF F038 0050 Max Analog and High Density Digital Scan Interval (msec) 1000

Analog Bark OxFFFF F038 0298 Out Of Range Value (16-Bit) -32763.000
OxFFFF FO38 02B0  Qut Of Range Value (32-Bit) -21474836483.000
OxFFFF FO38 0054 Scanner Flaos Ox 00000000 A

Analog Point

High Density Operation

OptoMMP Device

System »
ScratchPad  »
Data Log 3
PID r
Events »
Communications
Other 3

Other

4. (lick Send Command.

Restart Device from powerup

Store configuration to flash

Erase configuration from flash
Reset to defaults and Restart Device

microSD
Store configuration and IP settings to microSD
Erase configuration and IP settings k microSC

Erase firmware from microSD
Erase strategy from microsSD

~ Send Command

Switch to loader mode
Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration ]

[~ AutoRefresh | 15000  msec

The controller’s IP settings and all current configuration data are saved to the card.

After you have replaced a controller with a new one by using the microSD card as a boot disk, you must save
the data from the card to the controller's flash memory, so it will be available in case the microSD card is
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removed. Cycling power does not do this. Instead, follow the steps in the Maintenance chapter (microSD
section) of your controller’s user's guide.

Using Other microSD Card Commands

You can also use the following commands with a microSD card in the controller. These commands require PAC
Manager R9.0a or higher and PAC firmware R9.0a or higher. Read microSD card information in the controller
user’s guide before using the card.

1. Inthe Inspect window, type the device’s name or IP in the Device Name field, click Status Write, and
choose the command you need in the Operation Command list:

- Erase Configuration from microSD—deletes all configuration and IP address data from the card.
Does not delete other data files, firmware, or strategy files on the card.

—  Erase Firmware from microSD—deletes firmware on the card, wherever it is located:; also deletes
firmware command and response files. Does not delete data files or strategy files.

- Frase Strategy from microSD—deletes only the strategy from the card. Does not delete data files, IP
address and configuration data, or firmware files.

2. (lick Send Command.

Clearing Configurations and Data Samples

You can use PAC Manager to clear the following configurations: digital events (both old and expanded), alarm
events, email, PID loops, and PPP. You can also clear data in the data log. (Note that some of these features do
not apply to some devices. See the comparison chart on page 73

1. Inthe PAC Manager main window, click the Inspect button Q .

2. Inthe Device Name field, type the name (or IP address) of the /0O unit. Click Status Write. In the Operation
Command list, scroll down to see commands listed under Other.

| Inspect Opto 22 Device —

*

Device Name: | 10,152.50.11

Status Write
Status Read

j Options » Status: | Status Write area last read at 05/02/16 16:30:29

Status Write Address | Description | Value ~ Refresh
OxFFFF FO38 0004  Always BootP/DHCP On Powerup Mo hd
Wircless LAN ¥ OxFFFF FO358 0008 Degrees F[C Degrees F =1 Apply
OxFFFF FO38 0010  Comm Watchdog Time {msec), O = Disable 1]
0xFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250
Point Config OxFFFF FO38 0018  TCP Initial Retransmission Timeout (msec) 3000
OxFFFF F033 001C  TCP Retransmission Attempts 5

Digital Bank

OxFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
= = OxFFFF FO38 0294 Digital Feature Scan Interval (msec) 1
Fole Ho OxFFFF F038 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bark OxFFFF F038 0298 Out Of Range Value (16-Bit) -32763.000
OxFFFF FO38 02B0  Qut Of Range Value (32-Bit) -21474836483.000
OxFFFF FO38 0054 Scanner Flaos Ox 00000000 A

Analog Point
High Density

System »
ScratchPad  »
Data Log 3
PID r
Events »
Communications
Other 3

Operation

Store configuration and IP settings to micraSD A send Command
Erase configuration and IP settings from micraSC

Erase firmware from microsD

Erase strategy from microSD

th

er

Switch to loader mode

Clear Digital Events - Expanded configuration
Clear Digital Events - Old configuration

Clear Alarm Events configuration

Clear PPP configuration

Clear E-mail configuration

Clear PID Loops configuration

Clear Data Logging samples

Send powerup dear ]

3. (lickthe command you want:
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- (lear "Digital Events - Expanded” configuration (Clears digital events in PAC firmware 8.1 and higher.
For PAC firmware 8.0 and older, clears Timers configuration.)

- (lear “Digital Events - Old" configuration (Clears digital events in PAC firmware 8.0 and older)
- Clear Alarm Events configuration
- (lear PPP configuration
- Clear E-mail configuration
—  Clear PID Loops configuration
- (lear Data Logging Samples
4. With the command you want highlighted, click Send Command.
The command is sent immediately to the I/0 unit, and you see a Success message.

FORMATTING AND INTERPRETING DATA

Data is formatted differently for different addresses in the device’s memory map. Starting memory map
addresses are shown in PAC Manager; for a complete list of memory map addresses, see the OptoMMP
Protocol Guide (form 1465).

This section shows how to format and interpret various types of data when you are reading or writing to a
memory-mapped device.

Mask Data

Some data is in the form of a 32-bit or 64-bit mask—four or eight addresses, each holding eight bits. Each bit
in the mask contains the data for one thing in a group: one channel, one module, one Scratch Pad bit, etc.

Mask Data for groovand SNAP 1/0 units

For example, most high-density digital module data (for both groov and SNAP) and most SNAP digital bank
data is in this form (groov 1/0 units and groov RIO modules do not support banks). For example, to read the
state of SNAP digital channels in a bank, you would read the eight bytes starting at FFFFF0400000.

Here's how the data would be returned:

At address: FFFFF0400000 — > FFFFF0400007

Thesebitnumbers:?554321g—p 7|6|5(4(3 (2|10

Show data forthesepoints’| 5 (2 | 1 (g |32 (1|0 _—) 3210|003 210

On SNAP modules in
these positions in the rack:

15 14 _— 1 0

Therefore, at address FFFFF0400000:

This hex data: B 1
Equals this binary data:| 1 0 1 1 o0 |01
Showing the states:| On | Off | On | On | Off | Off | Off | On
Of these channels:| 3 | 2 | 1 03] 2|1 0
On these modules: 15 14

Data from other addresses marked as masks is formatted in a similar way.
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Mask Data for E1s

Unsigned 32-bit Integer Data

Much of the data in the memory map is in the form of unsigned integers, either one byte, two bytes, or four
bytes. With multiple bytes, since the memory-mapped devices use a Big Endian architecture, the high order
byte is in the low order address.

For example, SNAP digital bank counter data is in 4-byte unsigned integers. It takes four bytes to contain the
data for one channel. To read digital bank counter data for channel 0 on module 0, you would start with
address FFFFF0400100. The following table shows the pattern of bank counter data for the first few channels
on a SNAP rack:

o-rNo|lgwor| oD O0O0WL| O« ®| < 1o -~

o o oo o O oo oo oo [ By on B an | — T T — T T

Bylesatthese | 5 5 55| 5505|cooo|oooo|onoo|oaon

2 = = = = = = = = = = = = = = = = b i i U i B i i - o

o oo o o oo o o o o o o o o o o oo o o oo o
[ T T T [T Ty TN TN [Ty T TN [Ty T TN | W Iy I I 1y A 1y T _’

| W Sy I Iy | W Iy I Wy T [ W W Wy T [ W W Wy T [ W W T | W Sy I Iy 1 I

| W W T T | W T T T | W T T T | W T T T | W I I R A Ay T 1y

[Ty T TR TR [Ty T TR TR [T TR TR TR [T TR TR TR | I ' T 'Y By T T TR T

[ B f Ml s [ Wy I gy T [ W I Ny T [ W I Ny T [ W N T T [ W Iy I gy T
Show data for 0 1 2 3 0 1 —»

this point:

On the module in this 0 1

position on the rack: —>

The most significant byte is at the lowest address. For module 0, channel 0, for example, you might receive the
following data:

At this address This binary data Equals this hex data 16 BB 18 87
FFFF FO40 0100 0001 0110 16 —J T

FFFF FO40 0101 1011 101 BB !

FFFF FO40 0102 0001 1000 18

FFFF FO40 0103 1000 0111 87

The 32-bit integer for this reading would be 16 BB 18 87 (most significant byte at lowest address). This hex
figure correlates to the decimal value 381,360,263.

Remember that if you are processing this data using a Little Endian computer (such as an Intel-based PC), you
must convert the data from the Big Endian format in order to use it. Little Endian format is the opposite of Big
Endian; Little Endian places the most significant byte at the highest address.

Digital Channel Data (4-Channel Modules)
NOTE: For high-density digital modules, see “Mask Data” on page 195.

(Does not apply to groov I/0 or groov RIO modules, which have more than 4 channels.) For consistency in
starting addresses, data for individual digital channels has a length of four bytes. However, only the least
significant bit contains the data you're looking for.

For example, to read the state of channel 0 on module 0, you would start with address FFFFFO800000. Data
would be returned as follows:
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To read this inform ation:

Use these addresses:| FFFFFO800000

Contain this data (binary):| 00000000

Point 0 on Module 0: Point State
FFFFF0800001 FFFFFO800002 | FFFFFO800003
Thesebits:| 76543210 76043210 76543210 76543210
ooooo00O0O oooooo0OO 00000001
{hexy| O 0 0 0 0 0 0 ‘ 1
L |
Ignore tlhese Point state is ON.

IEEE Float Data

CHAPTER 5: READING AND WRITING TO SPECIFIC DEVICES

For individual analog channels, values, counts, and minimum and maximum values for one channel are
located next to each other in the memory map. All are four bytes and are IEEE 754 floats.

For example, individual analog channel data for channels 0 and 1 on module 0 appears in these addresses:

Module Channel

Data Beginning Address Ending Address
Scaled units (E.U.*) FFFF F026 0000 FFFF FO26 0003
Counts FFFF FO26 0004 FFFF FO26 0007
0 Minimum value (E.U.¥) FFFF FO26 0008 FFFF FO26 000B
Maximum value (E.U.*) FFFF F026 000C FFFF FO26 000F
Scaled units (E.U.*) FFFF F026 0040 FFFF F026 0043
Counts FFFF F026 0044 FFFF F026 0047
1 Minimum value (E.U.*) FFFF F026 0048 FFFF F026 004B
Maximum value (E.U.*) FFFF F026 004C FFFF FO26 004F

* Engineering Units

IEEE 754 float format is as follows:

1 bit 8 bits 23

X XXXXXXXX

Sign Exponent

bits

XXXXXXKXXXXKXXKXXXXXXXX

Significand

Float calculation: (-1)29"x [1 + Significand/2%] x 2 (Exponent-127)

Example for Opto 22 memory map

At this address:
This hex data:

In binary:

In these bits:
Equals (in decimal):

Representing:

base address base address + 1 | base address + 2 | base address + 3
41 77 33 33
0 100 0001 O 111 0111 0011 0011 0011 0011
31 30...23 22...0
0 130 7,811,891
Sign Exponent Significand

Decimal = (-1)°x [1 +7,811,891/2%3] x 2 130-127)

1x[1.931]x8
15.45 (rounded to 2 decimal places)
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For more information on floats and issues that may arise in their use, see the Using Floats Technical Note (form
1755) available on our website, www.opto22.com.

Analog Bank Data

(Does not apply to groov I/0 units or groov RIO modules.) Remember that the bank area of the memory map is
set up for four channels per module. Analog modules with more than four channels (points) will show data for
channels 0-3 only. If the analog modules you are using have only one or two channels, the addresses for the
upper two or three channels in each module will contain the following: for output modules, 0; for input
modules, FFFFFFFF,

For example, to read all bank analog channel values in scaled units, you would read 256 bytes starting at
address FFFFF0600000. Here's how data for two-channel input modules in positions 0 and 1 would appear:

Beginning Address Ending Address Data Format Module Channel
FFFF FO60 0000 FFFF FO60 0003 four bytes—IEEE float 0 0
FFFF FO60 0004 FFFF FO60 0007 four bytes—IEEE float 1
FFFF FO60 0008 FFFF FO60 000B FFFFFFFF 2
FFFF FO60 000C FFFF FO60 O0OF FFFFFFFF 3
FFFF FO60 0010 FFFF FO60 0013 four bytes—IEEE float 1 0
FFFF FO60 0014 FFFF FO60 0017 four bytes—IEEE float 1
FFFF FO60 0018 FFFF FO60 001B FFFFFFFF 2
FFFF FO60 001C FFFF FO60 001F FFFFFFFF 3
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6: Maintaining Devices

INTRODUCTION

This chapter includes step-by-step procedures for maintaining controllers and brains, including:
«  Viewing and changing IP addresses (below).

«  Loading new firmware (page 201).

«  Maintaining files (page 217).

For other maintenance tasks, such as resetting the device to factory defaults or handling a device whose IP
address you don't know, see the controller or brain user’s guide.

CHANGING IP ADDRESSES

If you need to change an IP address or subnet mask on an Ethernet-based device, you can do so using PAC
Manager. You must know the current IP address in order to change it. The white sticker on the device may
show the IP address. If not, see the device’s user guide for instructions.

«  SNAP PAC controllers and brains (except SBT and SB2)

«  E1andE2 brain boards'

»  SNAP Simple I/0 brains

«  SNAP Ultimate and SNAP Ethernet brains with firmware version R5.0 or higher

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.
2. Inthe menu bar, click Tools > Change IP Settings.

The last version of firmware for E1 and E2 boards is at R1.2. However, you can still use the instructions in this section
for those boards.
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CHANGING IP ADDRESSES

ﬂ PAC Manager

File Tools View Help

[es(d] X[l B B o

=8| Change IP Settings for ETHERMET 1

Current IP Address: I . . . Read Current Settings

Port:

Timeout {msec):

MNew IP Address:
Subnet Mask:
Gateway

DMS Address:

Zhange IF Settings

3. Inthe Current IP Address field, type the IP address of the device whose address you want to view or
change. Click Read Current Settings to see the current subnet mask, gateway address, and DNS address.

Port:

Timeout (msec):

=8| Change IP Settings for ETHERNET 1

X

Current IP Address: | 10 . 20 . 30 . 40

2001

1000

Read Current Settings I

New IP Address:
Subnet Mask:
Gateway

DNS Address:

Change IF Settings

4. Tochange the IP address, subnet mask, or other addresses, enter the new numbers. Make sure you have
typed everything correctly. When everything is correct, click Change IP Settings.
After you confirm the change, a message appears stating that the change was successful and that the
device will restart. Restarting may take 10 to 20 seconds to complete. When you see the following
indicator, the device is ready for use with its new address:
—  The SNAP-PAC-S1's, SNAP-PAC-R1’s, and SNAP-PAC-R1-B’s STAT LED shows solid green or solid
orange when viewed from the top (green means a strategy is running; orange means no strategy is

running).

- The SNAP-PAC-EBT's or SNAP-PAC-EB2's STAT LED shows solid green.
Remember to write the IP address on the sticker or white area on the device.
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INSTALLING NEW FIRMWARE

Important: If you have an R-series controller secured with a private key using PAC Terminal Secure Strategy
Distribution (SSD), follow the directions in the technical note (form #1762) provided with the purchase of SSD. Do not
follow the instructions in this document. If you do not have that technical note, contact your Opto 22 Preferred
Customer Specialist (PCS) to obtain a new copy.

All SNAP PAC controllers and brains?, SNAP serial communication modules, and some SNAP /O modules
contain firmware that can be updated. There are usually two reasons to update firmware:

« Install new features and enhancements and apply bug fixes delivered in the newest release.
«  Repairdamaged firmware on your PAC device.

Typically, you download new firmware from our website and then install it on your PAC device.

Obtaining firmware. To obtain firmware, download it from our website. There are a couple of ways to get
to our website:

« In PAC Manager, click the Get Latest Firmware link in the I/0 Unit Maintenance dialog. PAC Manager
opens your browser and connects you to the Resources & Tools section of our website. Click the
Downloads tab.

«  Open a browser and go to www.opto22.com. Click Support > Downloads.

At the website:
1. Inthe search box, type in your PAC device's part number, followed by the word “firmware”. Press Enter.
2. Inthe list of search results, select the result that matches your PAC device’s part number.
Firmware files have the file extension “bin” (for controllers and brains) or “eio” (for modules).
~  Note that SNAP-PAC-R1-B and -FM firmware files are in the SNAP-PAC-R1 Controller Firmware page.*
—  If you are updating firmware on multiple devices of different series, we package firmware
files for multiple series of products in a single zip file. For example, firmware for all SNAP PAC
controllers and brains are packaged in a single zip file. The zip file can save you time by providing a
single-step download. After you download the zip file, unzip it to access the individual .bin or .eio
files.
3. ClickDownload and save the file to your computer. Remember the path where you saved the file; you will
need it when it's time to install the firmware.

Installing firmware. PAC Manager helps you install firmware on PAC devices connected to your network.
The steps to load new firmware depend on the type of device you have, and whether the device's current
firmware is damaged:

«  Toload firmware for SB brains, go to page 206.
«  Toload firmware for serial communication modules, go to page 210.
«  Toload firmware for some SNAP 1/0 modules, go to page 209.

«  Forall other controllers and brains (including SNAP Ultimate brains with firmware R5.0 or higher), go to
page 203.

« Toload I/0 coprocessor firmware, go to page 211.

2In addition, rack-mounted controllers and brains manufactured starting in 2016 may contain an /0 coprocessor,
which has its own firmware. For details, see page 211.

370 download previous versions of Opto 22 firmware and software, go to our FTP site at
ftp://ftp.opto22.com/Public_Folders_(Unsecured)/Archives_(Software_and_Firmware)/

A you have a SNAP-PAC-R1, the R1 series firmware file is a zip file that contains the .bin files for SNAP-PAC-R1-B, -FM,
and -W. It also contains an additional zip file for SNAP-PAC-R1. Unzip that file and read the instructions in
README.TXT to determine which firmware file to install on your SNAP-PAC-R1.
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INSTALLING NEW FIRMWARE

«  Toreplace damaged firmware (indicated by three slow red blinks of the STAT LED after powerup), see
page 214.

If your SNAP PAC controller has a microSD card slot, you can copy the necessary .bin file to the microSD card,
and then load the firmware from the card. If your PAC isn't networked, this method can be easier. For
instructions to load firmware from a microSD card, see the controller user's guide.

Maintaining compatibility between PAC software and controller firmware. Typically, PAC
software requires a matching (or higher) version number of controller firmware. This is because the firmware
must be able to support new features in the software. It's usually OK to have controller firmware that is newer
(that is, has a higher version number) than the version of PAC software you have. There can be exceptions,
however—such as when a change in the firmware requires a matching change in the software. PAC Control
keeps track of the dependencies between different versions of controller firmware and software, and will
display a warning when the controller firmware is lower than the minimum version number recommended
for your software. (The warning is displayed in PAC Control when you try to go into Debug mode to download
a strategy.)

What Happens to the Device’'s Data When You Load New Firmware?

Successfully loading firmware to a controller or brain erases (clears) all data in volatile memory (RAM) and in
non-volatile memory (battery-backed RAM).5 This includes:

«  The PAC Control strategy

»  All strategy variables, including persistent variables
«  The PAC Control strategy’s Autorun flag

« /0O point, Event, and PID loop configurations

«  Scratch pad values

o Userfiles

«  Any other memory map configurations

The following items are cleared from flash memory:
«  The PAC Control strategy
«  The PAC Control strategy archive

If the following items have been stored to flash memory, they are not cleared when you load firmware:
« /0O point, Event, and PID loop configurations.

o  Scratch pad values.

o Userfiles.

«  Some memory map configuration items. (Note that some memory map configuration items are cleared
by a firmware load. For details, see the OptoMMP Protocol Guide, form 1465.)

A successful firmware load also restarts the device. Restarting a device causes data in volatile memory and in
battery-backed RAM to be lost. This means that accumulated data (such as counts from analog and digital
totalizers) is reset. For these reasons, you shouldn't attempt to load firmware to devices that are running.

And what happens if you select the wrong IP address?

« Ifthe IP address you select is for an Opto 22 device that doesn't match with the firmware type (for
example, your controller is a SNAP-PAC-R1 and you try to load EB2 firmware), nothing on your controller
is erased. PAC Manager simply displays an error in the Results area and it won't attempt to install the
firmware.

>1/0 coprocessor firmware is not cleared when you update controller or brain firmware. For details, see page 211.
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«  Ifyouselectan IP address that is not an Opto 22 device (for example, the IP address belongs to a network
printer), nothing on your controller is erased. PAC Manager displays an error in the Results area and it
won't attempt to install the firmware.

«  Ifyou mistakenly select an IP address for an Opto 22 device that matches the firmware file (for example,
you load R1 firmware to an R1 unit that you don’t want to update), PAC Manager installs the firmware
with the same effects listed previously.

For these reasons, you should be careful when selecting the IP addresses of devices to load firmware to.

Loading Controller and Brain Firmware (Except SB Brains)

For troubleshooting, see page 206.
For SB brains, see page 206.
To replace damaged firmware, see page 214.

Use the steps in this section to load PAC firmware on:

«  SNAP PAC controllers

«  SNAP PAC EB brains

«  E7andE2 brain boards

«  SNAP Ultimate brains with firmware version R5.0 or higher

Before beginning, be sure to have:
« Address information for the controller(s) and/or brain(s) that will receive the new firmware.
«  Thefirmware file for your product, or Internet access to download the firmware from our website.

Review the following information before you get started:

Check your firewall. Firewalls, such as the ones that come with some anti-virus software programs and the
built-in firewall in Windows, can prevent PAC Manager from receiving FTP communications from the
controller, which will result in a timeout error. (Firewalls in a router shouldn't be a problem.) If, during the
firmware update process, a Timeout error message appears in the Results area, you can try temporarily
disabling any firewalls on the computer running PAC Manager. You can reenable the firewalls after loading the
firmware. If disabling firewalls is not an option, you can try:
«  Connecting the PC directly to the controller or brain. For instructions, see the controller or brain’s user
guide.
«  Configuring a firewall exception for PAC Manager.
- To configure a firewall exception in your system's anti-virus software, see the software's instructions.
- To configure a firewall exception in Windows, see page 9.

Are your EB brains daisy-chained? If you're using EB brains in a daisy-chain configuration, you must
update their firmware one device at a time. This is because the brain is restarted after the firmware update,
disrupting communication to the brains downstream of the one being updated.

Are you loading a lower version of firmware? Some controllers don't support lower versions of
firmware. For information on which controllers may not accept lower versions of firmware, review KB87123.
Also, certain SNAP-PAC-R1s (labeled “GEN2") cannot run firmware lower than R10.5g. For instructions on
identifying these controllers, review the instructions on the SNAP-PAC-R1 Controller Firmware page.

Does your R-series controller currently have firmware lower than R9.5a and/or a microSD

card slot? If your R-series controller currently has a version of firmware lower than R9.5a, you can avoid most
of the issues listed in “Troubleshooting”on page 206 by using the most recent version of PAC Manager. If you
have a microSDHC card inserted in your R-series controller (except wireless controllers) and you are updating
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from PAC firmware R9.5a or lower, eject the microSDHC card before installing new firmware (review
OptoKnowledgeBase article KB86180).

Remember to always use the latest version of PAC Manager (download from our website) when you do the
following steps:

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.
2. Click the Maintenance button [}

= 1/0 Unit Maintenance X
Command

Firmware Filename: Get Latest Firmware P Addresses Add...
Install Module Firmware
Install IO Coprocessor Firmware | J 13%%:“? Modify
Install CA Root Certificate Restart Confirmation Interval (sec) : 102030 42 -
Download File From 1O Unit ’— Bt
Upload File To 1/0 Unit 1 Delete
Delete File On IO Unit

Port: Ti t :
Read Filenames On IO Unit or TR (R —
Save Files To Flash 2001 1000
Read Files From Flash
Clear Flash Files I™ Synchronize to PC Time M
Sync 1O Unit to PC Time

Results

Close | Help |

3. Make sure Install Firmware is highlighted in the Command list.
4. Ifyou already have the firmware file on your computer, network, or microSD card, skip to step 5.
If you need to get the new firmware file:

a.

P anyT

g.

Click the blue Get Latest Firmware link.

The link opens your browser and takes you to the Resources & Tools Search section of our website,
www.opto22.com

In the search field, type in your PAC device's part number then click the blue search button.
Click the Filter dropdown, then check Firmware.

Scroll through the list of results and click on your device's series firmware page.

Click the Download button to download the firmware file (it has a “bin” extension®) to your PC.

If you are updating firmware on multiple controllers and brains, select the Firmware for all
SNAP PAC products page, which is a zip file. Click the Download button, then unzip the file to access
the individual .bin files®.

In PAC Manager’s I/0 Unit Maintenance dialog box, click the browse button J and then navigate
to the firmware (bin) file for your product.

Double-click the file to select it. The dialog box closes, and the path and filename appear in the
Firmware Filename field.

5. If the SNAP devices you want to update are displayed in the IP Addresses list, skip to step 6.

of you are updating firmware on a SNAP-PAC-R1, you will download a zip file that has two firmware (bin) files. Unzip
the file and read the instructions in the readme txt file to understand which firmware file to select in the next step.
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If you have previously saved a list of IP addresses and want to use the list, click Load to select and load the
saved list, and then skip to step 6.

If the IP address you want isn't displayed, click Add, and then enter a device’s IP address or host name, or
arange of consecutive IP addresses.

You can specify the IP address in either dot-decimal =5 Add IP Address X
notation or by hostname:
+ Add one IP Address / Host Name
Enter the dot-decimal notation here; — — |

or P+ 1p Address: | 10 . 20 . 30 . 40
Enter a host name here: P Host Name:
To enter a range of IP addresses, click here " Add arange of IP Addresses

and then enter the From and To addresses.

OK | Cancel |

When you've finished adding IP addresses, click OK.

In the IP Addresses list, highlight the IP addresses to send firmware to. To select multiple devices, hold
down the Ctrl key as you click the devices.

IMPORTANT: Do not multi-select daisy-chained or multi-dropped -EB series Ethernet brains. You must update
their firmware one device at a time.

In this example, these devices will receive the firmware update.

= 1/0 Unit Maintenance X
Command
Firmware Filenam Get Latest Firmwarex P Addresses Add...
Install Module Firmware —
(o fe kto -| = Tk
Install IO Coprocessor Firmware | Wsers\jfemia\Desktoplsnap J Modify
Install CA Root Certificate Restart Confirmation Interval (sec) : e e

Download File From 1O Unit 10.20.30.42
Upload File To 1/0 Unit 1
Delete File On IO Unit

Delete

Read Filenames On I/0 Unit ROIE Timeout (msec) : 5

Save Files To Flash 2001 1000 aVE...
Read Files From Flash

Clear Flash Files I~ Synchronize to PC Time Load...

Sync 1O Unit to PC Time

— - prT

You can change the amount of seconds PAC Manager waits before verifying the devices have restarted.

If you have changed the OptoMMP port number (see page 78), enter the correct port number in the Port
field.

CAUTION: Loading firmware erases the current firmware in the selected device. You cannot undo
the erase. Make sure you've selected the IP addresses you want to update, and not others by accident.
For details, see "What Happens to the Device's Data When You Load New Firmware?” on page 202.

To load the firmware, click Execute.

The file is loaded to the PAC devices, and progress is shown in the Results area.

When the file has completed loading and the devices are restarted, a “Success” message is displayed in the
Results area.
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Troubleshooting

« Ifyouareinstalling firmware on a SNAP-PAC-R1 (GEN2) and encounter any of the following messages,
you may be using an older version of PAC Manager:
— 'Response' file is empty. Probable cause - not enough file space
- File load failure: Memory allocate/flash
- Invalid CRC in file

- The firmware update may fail and not show any errors.
Upgrade PAC Manager to the latest version and try again.
« Ifyouare using the latest version of PAC Manager (download from our website) and still encounter issues,
check the following situations that may apply to you:
- Ifyou're updating an R-series controller that has PAC firmware R9.2c or lower, review
OptoKnowledgeBase article KB82101.

- You're updating an R-series controller with a microSD card slot and PAC firmware R9.5a or lower.
(Wireless controllers are not affected.) Review OptoKnowledgeBase article KB86172.

»  Review the pre-requisite items beginning on page 203.

Loading SB Brain Firmware

These instructions apply to SNAP PAC SB brains. For other brains and controllers, see page 203.

NOTE: For an SB brain that has damaged firmware (indicated by three slow red blinks of the STAT LED after powerup),
see page 214.

Before beginning, make sure you have an Internet connection to obtain the firmware. Also, choose how you
will connect to the SB brain (for more information, see the brain user’s guide):

»  Through an S-series controller—see steps in “Installing SB Firmware Through the Controller,” below.

«  Directly from the PC to the brain (requires a PCI-AC48 adapter card in the PC)—see “Installing SB
Firmware Directly from PC to Brain”on page 207.

Installing SB Firmware Through the Controller
1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.
2. Inthe PAC Manager menu bar, click Tools > Install Firmware via Ethernet.

Install Firmware via Ethernet 4

{* Install Firmware via Ethernet Connection
* SNAP-PAC R- and S-series controllers
* SNAP-PAC-EB1 and SNAP-PAC-EB2 brains
* SNAP-UP1-ADS, SNAP-JP1-D6&4, and SNAP-UP 14164 brains (firmware version 5.0 or newer required)
* SNAP-LCE controller
* E1 and E2 brainboards

" Instal Firmware via Ethernet Passthrough Connection
* SNAP-PAC-SB1 and SNAP-PAC-SB2 brains

Cancel

3. Click Install Firmware Through Ethernet Passthrough Connection, and then click OK.
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B 7 Install Firmware via Ethernet Passthrough Connection *

Make sure the Opto 22 device is connected to an Opto 22 controller through
one of the controller's serial ports.

Contraller

1P: [0.0.0.0 Port: | 2001 Timeout: [3000

Serial Port: ’m Baud: |115200 - v 2-Wire
Opto 22 Device

Type: |SNAP-PAC-5B1 w| Serial Address (0-255): [0
Firmware File

Get The Latest Firmware

| H

Start Update | Done

In the Controller section, enter the IP address of the controller. Leave the Port at 2001 unless you have
changed it. Choose the serial port on the controller that the brain is connected to, and make sure the
baud rate matches that on the brain. Change Timeout and 2-Wire if necessary.

In the Opto 22 device section, choose the type of SB brain and enter its serial address.

In the Firmware File section, click the blue Get Latest Firmware link. Follow the directions in “Obtaining
firmware."on page 201 to find the firmware file for your SB brain and download it to your computer.

Click the browse button J and locate the firmware file you just downloaded. Double-click the
filename.

The path and filename appear in the Filename field.
When all the fields are correct, click Start Update.

Progress is shown in the lower part of the window. When the process is complete, the device is ready to
use.

Installing SB Firmware Directly from PC to Brain

This method requires a serial connection from the brain to the PC, via an RS-485 converter such as an Opto 22
PCI-AC48 adapter card.

If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.
In the PAC Manager menu bar, click Tools > Install Firmware via Serial Connection.
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Install Firmware via Serial Connection 4

% Install via R5-485 Connection
* SMAP-PAC-5B1 and SMAP-PAC-SB2 brains

" Install via R5-232 Connection

* SMAP-JP1-ADS, SMAP-UP1-D&4, and SMAP-JP 1-M&4 brains
* SMAP-LCE controller
* SMAP-B3000-EMET, SMAP-EMET-D&4, and SNAP-ENET-564 brains

Cancel

3. (lick Install via RS-485 Connection.

B Install Firmware via R5-483 Connection *

Make sure the Opto 22 device is connected to the computer's serial port via a
serial cable and an R5-485 adapter such as a PCI-AC4E.

—Computer

PC Serial Port: ICOM:[ vl Timeout {miliseconds): ISDDD
Baud Rate: |1152[JD 'I

—Opto 22 Device
Type: ISNAP-PAC-SBI LI Serial Address (0-255): I 0

—Firmware File

Get The Latest Firmware

| B

Start Update I Abort Done

4. Inthe Computer section, choose the COM port the brain is connected to. Make sure the baud rate
matches that on the brain. Change the Timeout if necessary.

5. Inthe Opto 22 Device section, choose the type of SB brain and enter its serial address.

6. Inthe Firmware File section, click the blue Get The Latest Firmware link. Follow the directions in
“Obtaining firmware." on page 201 to find and download the firmware file to your computer.

7. Clickthe browse button J and locate the firmware file you just downloaded. Double-click the
filename.

The path and filename appear in the Filename field.
8. When all thefields are correct, click Start Update.

Progress is shown in the lower part of the window. When the process is complete, the device is ready to
use.
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Loading SNAP I/0 Module Firmware

You can update the firmware on the following SNAP /0 modules:

SNAP-AICTD SNAP-AIMA-IH SNAP-AIV2-i SNAP-SCM-MCH16
SNAP-AICTD-4 SNAP-AIMV-4 SNAP-AOVA-8 SNAP-SCM-PROFI
SNAP-AIMA SNAP-AIRTD-8U SNAP-SCM-232 SNAP-SCM-ST2
SNAP-AIMA-4 SNAP-AV SNAP-SCM-485-422 SNAP-SCM-W2
SNAP-AIMA-i SNAP-AIV-4 SNAP-SCM-CAN2B

Before you begin, download the firmware from our website as described in “Obtaining firmware.”on page 201.
Also, make sure you know the module’s position number on the rack.

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.

2. Clickthe Maintenance button [E|

2D /O Unit Maintenance *
—Command
Install Firmware Module Firmware Filen; Get Latest Firmware | 1o Addresses Add... |
10.192.55.67
Install 1O Coprocessor Firmware I J Modify I
Install CA Root Certificate Module Position:
Download File From 1O Unit
Upload File To IO Unit Delete |
Delete File On IO Unit
Port: Ti t =
Read Filenames On IO Unit oS IEELEER e |
Save Files To Flash I 2001 I 1000
Read Files From Flash
Clear Flash Files Load... |

Sync 1O Unit to PC Time

| Results |

Clear Completed Results

Close | Help I

3. Make sure Install Module Firmware is selected in the Command list.

4. If you already have the module’s firmware file on your computer, network drive, or microSD card, skip to
step 5.

a. C(lickthe blue Get Latest Firmware link.

The link opens your browser and takes you to the Resources & Tools Search section of our website,
www.opto22.com

In the search field, type in SNAP (or your module’s part number) then click the blue search button.
(lick the Filter dropdown, then check Firmware.
d. Scroll through the list of results and click on your module’s firmware page.

n o
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e. (lick the Download button to download the firmware file (it has a “eio” extension) to your PC.

f.  In PACManager's I/O Unit Maintenance dialog box, click the browse button J,and then navigate
to the firmware (.eio) file for your product.

g. Double-click the file to select it.
The dialog box closes, and the path and filename appear in the Firmware Filename field.

If the IP address of the SNAP 1/0 unit that contains the module is displayed on the IP Address list, skip to
step 6.

- Ifyou have previously saved a list of IP addresses and want to use the list, click Load to select and
load the saved list, and then skip to step 6.

- Ifthe IP address you want isn't displayed, click Add, and then enter a device's IP address or host
name, or a range of consecutive IP addresses.

When you've finished adding IP addresses, click OK.

In the IP Addresses list, highlight the IP address of the SNAP /0 unit.

If you have changed the OptoMMP port, enter the correct port number in the Port field.

Enter the module’s position number on the rack in the Module Position field.

Click Execute. The file is loaded to the SNAP /O module, and progress is shown in the Results area.

When the file has completed loading and the devices are restarted, a “Success” message is displayed in
the Results area.

Loading Serial Module Firmware

If you have a SNAP PAC I/O unit, you can load new serial module firmware to a SNAP serial communication
module on the I/0 unit.

1.

2.
3.
4

210

Make sure you have an Internet connection so you can download the new serial module firmware file.
If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.

In the PAC Manager main window, click the Maintenance button .

In the Command list, highlight Install Module Firmware.

=5 /0 Unit Maintenance X
Command
Install Firmware Module Firmware | Get Latest Firmware | b oddresses Add
10.192.50.90

Install IO Coprocessor Firmware |
Install CA Root Certificate
Download File From 1O Unit
Upload File To I/O Unit
Delete File On IO Unit
Read Filenames On IO Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

10.192,55.183
10.192.55.67
10.192.57.187

Modify...
Module Position: fy

et

Delete

Save...

Load...

aalis

Results

Close Help
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5. Clickthe blue Get Latest Firmware link. Follow the directions in “Obtaining firmware.”on page 201 to find
and download the firmware file to your computer.

6. Click the browse button J and locate the serial module firmware file you just downloaded.
Double-click the filename.

The path and filename appear in the Filename field.
7. Inthe Module Position field, type the serial module’s position on the rack (0-15).

8. Inthe IP Addresses list, highlight the IP address of the I/0 unit the serial module is on. (If the correct IP
address is not shown, click Add to add it.)

You can load serial module firmware to multiple /O units at the same time, but only if the modules are in
identical positions on all 1/0 units.

9. C(lick Execute.

The serial module firmware file is loaded to the I/0 unit and then loaded to the serial module, and a
Success message appears in the Results area.

Loading I/0 Coprocessor Firmware
For information about loading PAC firmware, see “Installing New Firmware” on page 201.

The SNAP PAC /0 coprocessor is a programmable chip that can be updated in newer Opto 22 rack-mounted
controllers and brains. It replaces an older, obsolete chip. The change has no effect on function or
performance.

The new programmable chip is included in Opto 22 rack-mounted controllers and brains, starting with the
date codes listed below.

NOTE: For devices manufactured during the month and year listed, use PAC Manager to find out if your device has
an I/0 coprocessor. (For details, see page 212.)

Manufacturing Date Code

Product )
SNAP-PAC-R1, -R1-FM*, R1-W* 06/16
SNAP-PAC-R1-B 01/16
SNAP-PAC-R2, -R2-FM*, R2-W* 02/16
SNAP-PAC-EB1*, -EB1-FM*, EB1-W* 03/17 (See Note)
SNAP-PAC-EB2*, -EB2-FM* 08/16
SNAP-PAC-EB2-W* 03/17
SNAP-PAC-SB1* 05/17 (See Note)
SNAP-PAC-SB2* 06/17 (See Note)

* Obsolete part numbers

Special Note about EB1s, SB1s, and SB2s

As of November 14, 2017, the following products manufactured with 1/0 coprocessors had firmware R3.0a.
You do not need to update the firmware in these products. Note that these products are all obsolete as of
2023:

»  SNAP-PAC-EB1
»  SNAP-PAC-EB1-FM
«  SNAP-PAC-EB1-W
»  SNAP-PAC-SB1
«  SNAP-PAC-SB2
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Does My Product Have an |/0 Coprocessor?

A device's manufacturing date code can rule out whether the device has an 1/0 coprocessor, but to know for
certain, you can inspect the device in PAC Manager.

Using the Manufacturing Date Code

If your device is easily accessible, you can visually check its manufacturing date code to see when it was
manufactured. If it was manufactured before the dates listed in the table on page 211, it doesn't have a chip
that can be updated.

|P Address:

The manufacturing date code (month and
year in MM/YY format) appears in the top
half of a bisected circle, printed on a white
label attached to the device.

Using PAC Manager R9.5a or higher

1. In PAC Manager, click Tools > Inspect to open the Inspect Opto 22 Device window.
2. Inthe Device Name field, select or enter your device.

3. Look at the Value for /O Coprocessor Firmware Version.

If the Value is A0.0a or 0 (zero), your device does not have an |/0 coprocessor.

P,
I/0 Unit Hardware Revision (Year)

OxFFFF F030 0026

These devices don't have an /0

coprocessor.

S, M
OxFFEF F030 0026 I/0 Unit Hardware Revision (Year)

=] Inspect Opto 22 Device ?
Device Name: I 10.20.30.40 L! +| | Options » ! Status: | Status Read area last read at 03/15/17 f
[~ Status Read
Status Read {
Status Write ADDRESS DESCRIFTION VALUE
= 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed POC Beceiwed (
LRl ] 0xFFFF F030 0008 Buay Flag )
Point Config 0xFFFF FO30 0018 Loader Version R6.2b
Digital Bank 0xFFFF FO30 0000 Memory Map Version 1
IOt D ] 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF F030 001C Firmware Version RS9.5d
0xFFFF FO30 00R0 Firmware Version Date 11/07/2016 This device has an
Analog Bank 0xFFFF F030 00BO Firmware Version Time 17:06:29 |/O
coprocessor.
Analog Point 0xFFFF FO30 0020 Unit Type 0x00000068 You should update its
5 E OxFFFF FO30 0080 Unit Description SNAP-FAC-RL -
High D i
'g—enmj 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 5 firmware.
5 0xFFFF FO30 0025 I/0 Unit Hardware Revision (Day) 29
Estm 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2009
ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version R2.0d i
0xFFFF FO30 0028 Installed Ram 33554432
Datatog |
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Using PAC Manager R9.4c or lower
1. To verify you can connect to your controller or brain, click Tools > Inspect.
Then, in the Device Name field, select or enter your device, and press Enter (or click Refresh).
2. Ifyou're connected, click Other > Generic Read/Write.
a. Inthe Address: Ox FFFF field, type: F030024C
b. IntheType field, select: 32-Bit Integer
3. Click Refresh.

If the Value is not 0 (zero), your device has an 1/0 coprocessor, and you should update its firmware.

= Inspect Opto 22 Device e

Device Name: J 10.20.30.40 _l +| v| Options » | Status: |Cushom area last read at 03/15/17 17:24:36

—Generic Read /Write -
Status Read
Stams Write Address: 0x FFFF | FO30024C Type: |32-Bit Integer Length: j

Wireless LAN  » Address

OxXFFFF FO030 024C' 33554691

0] nfi

by e B i e i, »- p"‘*._
A number in the Value field means the device has an I/0 coprocessor.
Your device's number may be different.
Address: 0x FFFF | FO30024C Type: |32-Bit Integer J Length: { f
1
Lddress Value J
OXFFFF FO30 024C O ;
s 3
P - Foer "

This device doesn't have an 1/O coprocessor.

Getting and Loading the 1/0 Coprocessor Firmware

/0 coprocessor firmware updates are posted on the Opto 22 website. To successfully load the /O coprocessor
firmware, you must have both:

«  PACManager R9.5a or higher

«  PACFirmware R9.5a or higher in the device that you're updating

If your device has PAC firmware R9.4c or lower and you aren't ready to upgrade to a newer version of PAC
firmware, follow these steps:

1. Temporarily load PAC firmware R9.5a (or higher).

2. Follow the instructions below to load the I/O coprocessor firmware.

3. Load your previous version of PAC firmware (to overwrite the higher version you installed in step 1).

Previous versions of software and firmware are available from our FTP site:
ftp://ftp.opto22.com/Public_Folders_(Unsecured)/Archives_(Software_and_Firmware)/

To get the I/0 coprocessor firmware update file:

Go to the Downloads section of the Opto 22 website, choose the firmware for your part number, and then
download it to your PC. Firmware files have the file extension “bin.”

NOTE: If your device is wireless, select the file for the comparable controller or brain. For example, if you have a
SNAP-PAC-R1-W, select the file for the R 1 controller, SNAP-PAC-R 1-10-Coprocessor-R3.0a.bin.
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Sometimes we provide firmware files for multiple series of products in a zip file. If you've downloaded a
firmware zip file from our website, you'll need to unzip it to access the individual .bin files.

To load the I/0 coprocessor firmware:

CAUTION: Updating the I/0 coprocessor firmware will reboot your controller or brain. It will not overwrite your
configuration data, but the reboot will cause accumulated data (such as counts from analog and digital totalizers)
to be reset.

In PAC Manager, open the I/0 Unit Maintenance window (Tools > Maintenance).
In the Command list, select Install /0 Coprocessor Firmware.
Click the Browse button, and then navigate to the folder containing the firmware files.

HwnN =

Select the firmware file for your controller or brain, and then click Open.

NOTE: If your device is wireless, select the file for the comparable controller or brain. For example, if you have a
SNAP-PAC-R1-W, select the file for the R T controller, SNAP-PAC-R 1-10-Coprocessor-R3.0a.bin.

5. Inthe IP Addresses list, click the device you want to update.
Use the Add button to add devices to the list.
To select multiple devices, hold down the Ctrl key as you click the devices.

NOTE: Do not multi-select daisy-chained or multi-dropped -EB series Ethernet brains. You must update their
firmware one device at a time.

6. Click Execute to load the firmware.
After the file is loaded and the devices are restarted, a “Success” message appears in the Results area.

If the load fails (for example, if the file you selected isn't compatible with your device), the device's I/0
coprocessor firmware is not changed or overwritten. However, the device will restart, and a “Fail” message
appears in the Results area.

If you select a device that does not have an I/0 coprocessor, or if the device has SNAP PAC firmware R9.4c or
lower, the Results area displays “Command not supported in the build,”and the device does not automatically
restart.

Replacing Damaged Firmware

If the STAT LED on a controller or brain blinks red slowly three times after powerup, the firmware in the device
is damaged. For details, see the Blink Codes section in the device's user guide.

Follow these steps to replace damaged firmware.

1. Make sure you have the following before beginning:
— Address information for the controller(s) and/or brain(s) that will receive the new firmware.
- Internet access to obtain new firmware from our website.

2. Follow instructions in the device’s user guide to restart the device in failsafe bootloader mode. Watch for
the blink code to make sure the device is in this mode.

3. Attach the PC with PAC Manager to the controller or brain using a crossover cable or “straight-through”
Ethernet cable as required:

- EB-series brains can be connected with either type of cable.

- Computers with a Gigabit Ethernet network interface controller (NIC) card can use either type of
cable (because the NIC card has the ability to adapt.)

—  For R-series and S-series controllers that:
—  Have an SD card slot, use a straight-through Ethernet cable.
— Do not have an SD card slot, use a crossover cable.
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- For SB-series brains:

—  Connect through the S-series controller;

- Orconnect directly from the PC using a serial cable and a PCI-AC48 adapter card.
For more information on connections, see the device's user’s quide.
If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.

In the PAC Manager menu bar, click Tools > Install Firmware via Failsafe Bootloader Mode. Click OK at the
message about products it can be used with.

g Loader Mode Firmware Update — *

Ethernet ]Eﬂ'nernet Pass-Through | Serial Direct]

Use the IP and Subnet of the Ethernet Adapter (NIC) on the computer {not the
Opto 22 device). Make sure the Opto 22 device is in loader mode and
connected to the computer via a cross-over cable,

Computer

IP Address of PC Ethernet NIC: | 0.0 .0 .0

Subnet of PC Ethernet NIC: | o .0 .0 .0
Opto 22 Device

Type: |5NAP-PA(:-R1 j Timeout (miliseconds): W
Firmware File

Get The Latest Firmware

| -

Start Update | Done

Choose one:
—  Fora SNAP PAC controller or EB brain, click the Ethernet tab and continue with step 7.

—  Foran SB brain, if you're connecting to the brain through the S-series controller, click the Ethernet
Pass-Through tab and skip to step 8.

- Foran SB brain, if you're connecting serially from the PC to the brain, click the Serial Direct tab and
skip to step 9.

For a controller or EB brain, enter the IP address and subnet of the PC (not the controller or brain). Choose

the controller's or brain’s device type from the drop-down list. Skip to step 10.

For an SB brain using Ethernet Pass-Through, do the following:

- Inthe Controller section, enter the IP address of the controller. Leave the Port at 2001 unless you
have changed it. Choose the serial port on the controller that the brain is connected to, and make
sure the baud rate matches that on the brain.

— Inthe Opto 22 device section, choose the type of SB brain and enter its serial address. Skip to
step 10.

For an SB brain using Serial Direct, do the following:
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10.

11.

12.

13.

- Inthe Computer section, choose the COM port the brain is connected to. Make sure the baud rate
matches that on the brain.

— Inthe Opto 22 device section, choose the type of SB brain and enter its serial address. Go on to
step 10.

Click the blue Get Latest Firmware link.

The link opens your browser and takes you to the Firmware Downloads section of our website,
www.opto22.com

Choose the firmware for your part number from the list and download it to your PC.
If you have any difficulty obtaining or loading new firmware, contact Opto 22 Product Support.

Click the browse button J and locate the firmware file you just downloaded. Double-click the
filename.

The path and filename appear in the Filename field.
When all the fields are correct, click Start Update.

Progress is shown in the lower part of the window. When the process is complete, either repeat from
step 7 for another device, or click Done.

The device is now ready to use.

INSTALLING CA ROOT CERTIFICATES

NOTE: As part of the process of installing the certificate on the controller, the controller will be restarted to
activate the certificate. You may need to schedule a system shutdown to coordinate putting the certificate on the
controller and rebooting the controller.

To place a root certificate in the /pki/root-certs folder on your controller:

1.
2,
3.

In the PAC Manager menu bar, click Maintenance .

In the Command list, select Upload File To I/0 Unit.

Click the Browse button ==l and browse to the location of the certificate. Select the certificate, and then
click OK.

In the Destination field, type /pki/root-certs/ and the name you want the certificate to have on the
controller; for example:

/pki/root-certs/Equifax Secure Certificate Authority.cer

Select the IP address of the SNAP PAC device that you want to install the certificate on.

r ~
| 1/0 Unit Maintenance X
Command -
Install Firmware Filename: IP Addresses Add
Install Module Firmware = =
Install 1jO Coprocessor Firmware | C:\Equifax_Secure_Certificate_AL _l 99,999,98.920 =
Install CA Root Certificate Modify...

Destination:

Download File From I/0 Unit
pload File To IjO Unit i Jpkifroot-certs Equifax_Secure_Ce Delete

Delete File On IO Unit

Read Filenames On IO Unit
Save Files To Flash Save...
Read Files From Flash
Clear Flash Files Load...
Sync 1O Unit to PC Time

~ s i

el

Click Execute.
(Optional) Repeat steps 2-6 if you have additional certificates to install.
Select the Save Files To Flash command, and then click Execute.
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9. Restart the SNAP PAC device to activate the certificates.

MAINTAINING FILES

The memory in a SNAP PAC controller or brain includes a substantial area available for file storage:

SNAP-PAC-S1 SNAP-PAC-S2
SNAP-PAC-S1-FM* SNAP-PAC-S2-W* 25MB
SNAP-PAC-S1-W
SNAD PAC T8 SNAP-PACR2
SNAP-PAC-R2-FM* 20MB

SNAP-PAC-R1-FM*

SNAP-PAC-R1-W* SNAP-PACR2-W!

Limited only by the size of the
SoftPAC hard drive on the computer the
software runs on.

SNAP-PAC-EB1* SNAP-PAC-EB2*
SNAP-PAC-EB1-FM* SNAP-PAC-EB2-FM* 20MB
SNAP-PAC-EB1-W* SNAP-PAC-EB2-W*

* Obsolete part numbers

In addition, beginning in early 2009, microSD slots were added to S-series and R-series PACs for removable
storage up to 2 GB.

In the file storage area or on a suitable removable disk, you can store any types of files. These files can be
sorted into directories or folders just as they can on a PC, and they are available for use within a PAC Control
strategy or an application you develop. For example, the SNAP device can read the files, add data to them, and
even send data from them via FTP to another device on the network.

For managing general data files on a microSD card, see instructions in the Maintenance chapter of the
controller user's guide. Do not use PAC Manager for general microSD file management. However, you can use
PAC Manager for some functions related to firmware, strategy, and configuration files on the card. See “Using
microSD Commands”on page 192.

To use PAC Control strategy logic to create and manage files, see “Communication Commands”in
Chapter 10 of the PAC Control User’s Guide.

Tools for Managing Files

There are several tools you can use to manage files. You can use FTP software or even Windows Explorer to
move files to and from the device via FTP, and you can use PAC Manager to move and manage files on the
device. Here are some additional details:

«  PAC Control lets you programmatically work with the SNAP PAC controller or I/O unit's file system,
within your control strategy. You can create files and folders on the device and write to, add data to, or
read them; receive file data via FTP; send all or part of the data in a file via FTP, and more. PAC Control
works with one I/0 unit at a time. A PAC Control strategy can also FTP files to one or more other I/0 units
or controllers.

«  PACManager's main advantage for file management over other commercially available FTP client
software is that it can work with multiple Ethernet devices at once, for example sending data via FTP to
ten I/0 units at the same time, or deleting the same file from multiple I/O units simultaneously. However,
PAC Manager can see only the folders and files at the root of the device’s file system (not the names of
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files within folders). For this reason, do not use PAC Manager for working with files on a microSD card in
the controller, as all of its files are in a directory.

Newer versions of Windows Explorer can be used for FTP operations with a single controller or I/O unit.
It's easy to drag and drop files and folders to the device, and you can see the complete file structure. You
may find that data isn't always refreshed correctly.

Other FTP software products you can download may be more reliable than Windows Explorer; they
also may give you extra features like communication details, which are useful for debugging. Some may
not support filenames with spaces or other specific characters. They work with one device at a time.
You can also use a command prompt for FTP, again with one device at a time.

Note that FTP cannot be used through a firewall in the PC. Make sure any firewall in the computer is
disabled before you try to work with files. Firewalls in a router should not be a problem, however.

Keep the following limitations in mind as you work with files on controllers and I/0 units:

Maximum length for filenames and directory
names

127 characters

Filename characters allowed

All ASClI characters except *, 2, null,and /
NOTE: Some FTP client software may not allow spaces
or specific characters.

Path name component separator

/

Maximum number of files and directories that
can be open simultaneously

16

Maximum directory depth

Limited only by available memory
NOTE: PAC Manager reads only the root names; files
within folders are not listed.

Maximum number of files

Limited only by available memory. Each file uses 516
bytes of overhead plus its number of bytes rounded
up to the nearest multiple of 516 bytes.

Maximum number of directories

Limited only by available memory. Each directory
uses 516 bytes.

Maximum amount of memory available in the
device's file system

Approximately 2.5 MB on a SNAP PAC S-series, 2 MB
on a SNAP PAC R-series or EB brain (varies slightly
depending on the device’s firmware version). Data
storage on a SoftPAC controller is limited only by the
size of the hard drive on the computer the software
runs on.

Maximum amount of memory available in
removable storage (per microSD card)

2 GB (available on S-series and R-series PACs)

When using the SNAP device as an FTP server, for example with an FTP client such as CuteFTP, you can use an
anonymous login. The device ignores any user ID or password.

CAUTION: Make sure you save files to flash memory if needed. If power to the controller or I/0 unit is turned off, files
are destroyed unless they have been saved to flash. (Does not apply to files in removable storage.)
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Moving Files to the SNAP PAC Controller or I/0 Unit

To move files to the SNAP PAC controller or I/0 unit, use any standard FTP client software or PAC

Manager. (Do not use PAC Manager for files on a microSD card.) A maximum of five devices can FTP files to a
SNAP controller or I/0 unit simultaneously.

Follow these steps to move files to the SNAP device using PAC Manager:

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.
2. Clickthe Maintenance button [E|.

= 1/0 Unit Maintenance

Command

Firmware Filename: Get Latest Firmware P Addresses Add...
Install Module Firmware
Install IO Coprocessor Firmware | J 13%%:“? Modify
Install CA Root Certificate Restart Confirmation Interval (sec) : 102030 42 =
Download File From 1O Unit ’— Bt
Upload File To 1/0 Unit 1 Delete
Delete File On IO Unit

Port: Ti t :
Read Filenames On IO Unit or TR (R —
Save Files To Flash 2001 1000
Read Files From Flash
Clear Flash Files I™ Synchronize to PC Time M
Sync 1O Unit to PC Time

Results

Close | Help |

In the Command list, highlight Upload File To I/0 Unit. Click the browse button J and locate the
source file you want to load.

In the Destination field, type the filename as you want it to appear on the SNAP PAC device.

The filename can be the same or different from the source filename. You can specify a path on the device
using the separator / Forexample, to place the file Product Categories.txt into the folder Products, you
would type: Products/Product Categories.txt Ifthefolder does not exist, it is created.

If the IP address(es) of the device(s) you want to load the file to appear in the IP Addresses list, skip to

step 7. (Or, if you have previously saved a list of IP addresses, click Load to load the saved list.) If the
address(es) you need don't appear in the list, click Add.
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=8| Add IP Address >

* Add one IP Address / Host Mame

GIPﬁ.ddress:l i .0.0.0
©” Host Name: I

" Add a range of IP Addresses

Fram: I - - -
To: I . . .

6. Enter the address or a range of consecutive addresses, then click OK.
The address(es) you entered appear in the I/0 Unit Maintenance dialog box.
7. Highlight the IP addresses to load the file to.
8. (lick Execute.
The file is loaded to the I/O units, and a Success message appears in the Results area.

File to upload (source)
Highlighted IP addresses

Path and filename on will receive file

/0 unit(s)
## 1/0 Unit Maintenance *
—Command \ 4 v
Install Firmware Filename: P Addresses l Add
Install Module Firmware S
C: e ktoy o 10.192.50.90
Install IO Coprocessor Firmware I \serglyfemia\Desktop'Prody J 10.192.55.183 Modify

Install CA Root Certificate Destination: 10.192.55.67

Download File From 1/ Unit
R [Products/Product Categories.t 10.192.57.187 Delete

Delete File On IO Unit
Read Filenames On IO Unit —
Save Files To Flash
Read Files From Flash
Clear Flash Files

Sync 1O Unit to PC Time

Results |

Upload File To IO Unit Capy |
10.192,55.67 - Success

Select All |

Clear Completed Results |

aalis

Load...

Close | Help |

Moving Files from the SNAP PAC Controller or I/0 Unit

To move files from the SNAPPAC controller or I/0 unit, use any standard FTP client software or PAC
Manager (do not use PAC Manager for files on a microSD card), or use the FTP communication handle in a PAC
Control strategy. (In PAC Control, a maximum of 16 communication handles can be used simultaneously to
FTP files. For details, see “Communication Commands”in the PAC Control User's Guide (form 1700).
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Here’s how to move files from the device using PAC Manager:
1. Inthe PAC Manager main window, click the Maintenance button .
2. Inthe Command list, highlight Download File From I/O Unit.

=5 /0 Unit Maintenance X
Command
Install Firmware Filename: IF Addresses Add
Install Module Firmware | 10.192.50.90
Install I/0 Coprocessor Firmware 10.192.55.183 i
Install CA Root Certificate Destination: 10.192.55.67 —
Download File From 1O Unit 10.182.57. 187
Upload File To 1/0 Unit | = 13257 Delete

Delete File On IO Unit
Read Filenames On IO Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files Load
Sync 1O Unit to PC Time

Save...

i

Results

Select All
Clear Completed Results

Close | Help |

3. Inthe Filename field, enter the filename (and path, if any) of the file on the controller or I/O unit.
Forexample: Products/Product Categories.txt

4. Inthe Destination field, enter the path and filename where you want the file to go (or click the browse
button | to locate the path, then type in the filename).

The filename can be the same or different from the source filename.

5. Inthe IP Addresses list, highlight the IP address of the SNAP PAC device you are downloading the file
from. (If it does not appear, click Add to add it to the list))

6. Click Execute.
The file is loaded from the device, and a Success message appears in the Results area.

Reading Filenames

You can use PAC Manager to read and list the names of all files and folders in the root of the controller or /0
unit. Note that files located inside folders (or folders inside folders) are not listed, even though they are there.
PAC Manager will not show any files on a microSD card. You can use a standard FTP software program to see
them.

1. Inthe PAC Manager main window, click the Maintenance button .
2. Inthe Command list, highlight Read Filenames On 1/0 Unit.

3. Inthe IP Addresses list, highlight the IP address of the SNAP PAC device you are reading. (If it does not
appear, click Add to add it to the list.)

4, C(lick Execute.
The list of root file and folder names appears in the Results area.
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All root-level files and
folders on the device
with the IP address
10.192.55.67.

Folders are designated
as <DIR>.

=5 /0 Unit Maintenance X
Command
Install Firmware IP Addresses Add...

Install Module Firmware
Install IO Coprocessor Firmware
Install CA Root Certificate
Download File From 1O Unit
Upload File To I/O Unit
Delete File On IO Unit
Read Filenames On 10 Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

10.192.50.90
10.192,55.183
10.192.55.67
10.192.57.187

Modify...

Delete

Save...

aali

Load...

Results
Read Filenames On IO Unit

10,192,55.67 - Success
Products, <DIR >, 2016/07/01 09:54:00 Select All
Clear Completed Results

Close | Help |

The listing shows the file or folder name, the file's size in bytes (or <DIR> for folders), and the date and
time it was placed there (in the format YYYY/MM/DD hh:mm:ss).

Deleting a File from a SNAP PAC Controller or I/0 Unit

You can also use PAC Manager to delete a file from one device or from several devices at once. (You cannot
use it to delete files on a microSD card.)

1.
2,
3.

In the PAC Manager main window, click the Maintenance button .

In the Command list, highlight Delete File On I/0 Unit.

In the Filename field, type the filename (and path, if any) of the file you want to delete.
Forexample: Products/Product Categories.txt

In the IP Addresses list, highlight the IP address(es) of the SNAP PAC device(s) you are deleting the file
from. (If the correct IP addresses are not shown, click Add to add an address or group of addresses, or if
you have saved a list of IP addresses, click Load to load the saved list.)

Click Execute.
The file is deleted and a Success message appears in the Results area.

Using Flash Memory with the File System

You can use PAC Manager to move files between the controller or I/0 unit's file system and its flash memory,

which stores files so they are not lost if the device loses power. Remember that flash memory is smaller than

the memory available for file storage; check the controller's or I/O unit's data sheet for details. (You cannot use
PAC Manager with files on a microSD card.)

You can do any of the following on one or multiple devices:

Save all files in the file system to flash memory

Clear allfile system files from flash memory (does not affect firmware, strategy files, or point configuration
data)

Load files from flash memory into the device's file system, replacing all files in the file system
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Follow these steps:
1. Inthe PAC Manager main window, click the Maintenance button .
2. Inthe Command list, highlight the command you want to use.

In the following example, Save Files To Flash is highlighted.

## 1/0 Unit Maintenance *
r—Command
Install Firmware IP Addresses I Add...
Install Module Firmware 10.192.50.90
Install IO Coprocessor Firmware 10.192.55.183 Madify

Install CA Root Certificate =
Download File From 1O Unit 13 12; ﬁ'i;?
Upload File To 1/0 Unit RATE Delete

Delete File On IO Unit
Read Filenames On I/0 Unit
Save Files To Flash

Read Files From Flash

Clear Flash Files

Sync 1O Unit to PC Time

Results |

Save...

Fl ek

Load...

Copy |
Select Al |
Clear Completed Results |

Close | Help |

3. IntheIP Addresses list, highlight the IP address(es) of the device(s) you want the command to apply to. (If
the correct IP addresses are not shown, click Add to add an address or group of addresses, or if you have
saved a list of IP addresses, click Load to load the saved list.)

CAUTION: Make sure you have chosen the correct command and the devices you want to affect. You cannot
undo these commands.

4, C(lick Execute.
The command is executed and a Success message appears in the Results area.
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7: Troubleshooting

INTRODUCTION

If you are having difficulty using PAC Manager, here are some suggestions that may help. In addition, make
sure to check the Troubleshooting section in the device's user’s guide. If you cannot find the answers you need
in these guides, contact Opto 22 Product Support. For contact information, see page 4.

PAC MANAGER ERROR MESSAGES

When you send configurations to I/0 units in PAC Manager, you may see the following messages in the lower
part of the Send Configuration to 1/0 Unit dialog box:

Message Notes

Could not open I/O unit: [IP address] or
An error occurred while connecting to 1/0 Unit
[IP address].

Timeout error. Check basic communication with the device (See the
Troubleshooting appendix in the device’s user guide for help).

[number] points successfully configured. Success message.

Could not configure digital module [number], point

[number]. Check the point to make sure it's correct for the module type
Could not configure analog module [number], point installed.

[number].

Module [name] exists at position [number] but was not Check configuration; an analog module is at this position but no
configured points have been configured on it yet.

Could not configure temperature. These configurations apply to the 1/0 unit as a whole, not to
Could not configure watchdog. individual points. Contact Product Support for help. (See page 4.)

Save to Flash—Operation Failed.
Contact Product Support. (See page 4.)
Clear Flash on 1/O Unit: [name of unit]—Operation Failed.
Communication could not be established with the restarted PAC Manager successfully connected to the device but could not
1/0 Unit send it a PUC. Check cables and communication.

TROUBLE CONNECTING TO THE I/0 UNIT OR CONTROLLER

See the Troubleshooting section in the user's guide for your device:
e SNAP PAC S-series—the SNAP PAC S-Series Controller User's Guide (form 1592)
e SNAP-PAC R-series—the SNAP PAC R-Series Controller User's Guide (form 1595)
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o  SNAP PAC EB and SB brains—the SNAP PAC Brains User's Guide (form 1690)

Trouble Assigning an IP Address to a Brain or Controller

If you cannot see a SNAP controller or brain that needs a static IP address assigned, it may be because your
network or PC is not allowing the BootP request through to PAC Manager.

If you suspect a network issue (for example, rules on a managed switch), bypass all network devices and
connect your PC directly to the controller or brain with a crossover cable.

If you still have trouble, firewalls and security software limitations on your PC may be the problem. See
“Checking Network Setup and PC"on page 8 to troubleshoot this issue.
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PAC Manager can be useful in troubleshooting problems with I/0 units and controllers. Before calling Opto 22
Product Support, you can use PAC Manager to get device and firmware information and view diagnostic
messages. To help with communication problems, you can change TCP settings. You can also check for
Ethernet errors, which indicate network problems.

Getting Device and Firmware Information—Individual Device

These steps provide information for one device at a time. To get information on all devices on the Ethernet
network at once, see page 228.

If you need to contact Opto 22 Product Support for assistance in using an I/O unit or controller, it is helpful to
have device and firmware information at hand before you call us.

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.

2. Inthe PAC Manager main window, click the Inspect button @

3. Inthe Device Name field, type the name (or IP address) of the device. Click Status Read.
This example shows a SNAP-PAC-S1; other devices are similar.
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= Inspect Opto 22 Device
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Device Name: | 10,192.50.20

Status Read
Status Read |

Status:

j Options

Status Read area last read at 07/05/16 13:42:15

Status Write hDDRESS

DESCRIPTION

VALUE

A Refresh |

0xFFFF FO30
0xFFFF FO30

Wireless LAN  #

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

System 3
ScratchPad
Datalog
PID 3
Events 3
Communications »
Other 3

Close | Help |

0xFFFF FO30
0xFFFF FO30
0xFFFF FO30
0xFFFF FO30
0xFFFF FO30
0xFFFF FO30

0xFFFF FO30
0xFFFF FO30
0xFFFF FO30
0xFFFF FO30
0xFFFF FO30
O0XFFFF FO30
O0XFFFF FO30

OXFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030

Keep this window open on your screen when you call Product Support.

0004
aoos

0ols
aooo

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

TUnit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERNET 1 Interface
MAC Address
IP Rddress
Subnet Mask
Gateway
DNS

ETHERNET 2 Interface

PUC Receiwed (0)
a

R6.0a

1

Flash Memory
R9.5a
07/05/2016
07:58:52

0x0000007C
SHAP-PAC-51

00-RA0-3D-01-48-FB
10.1592.50.20
255.255.192.0
10.192.51.50
10.192.60.91

[~ AutoRefresh | 15000  msec

NOTE: Because the Status Read area is used for both standalone controllers and I/O units, some items apply to some
devices and not others. The following items do not apply to standalone controllers:

Degrees F/C

Comm Watchdog Time (msec.)
Scanner Flags

4-Channel Digital Scan Count

Analog & High Density Dig Scan Count

Smart Modules Present

PID Loops Supported

Digital Modules Supported

Arcnet data

Digital resets and interrupt failures since powerup
Analog and Digital Scanners (msec per scan)

Module X - Times Discovered

For help in interpreting Status Read data, see page 149.

Viewing Diagnostic Messages

PAC Manager displays a Diagnostic Messages button (yellow exclamation mark) on the Status Read page
when any of the following conditions are detected:

«  The OptoMMP port is not set to the default value of 2001.
«  The Modbus port is not set to the default value of 502.

«  The SNMP port is not set to the default value of 161.

«  The FTP server port is not set to the default value of 21.

«  The Control Engine port is not set to the default value of 22001.
«  This device is set to Always BootP on Powerup.
«  Thel/O coprocessor firmware in this device needs to be updated.

«  Theanalog and high density digital scanner is turned off.'
«  Thedigital 4-channel scanner is turned off.!
«  The control engine is turned off.
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'For more information about scanners, see “Scanner Flags”in “Changing Status Data”on page 153.

NOTE: If your SNAP-PAC R-series controller cannot communicate via the host port after attempting to update
firmware, see KB82101, Updating to firmware 9.2¢ or higher may fail on SNAP-PAC-R controllers, on the Opto 22

website.

If you see the button, click it and read the diagnostic messages. They may help you solve problems or provide
useful information when you call Product Support.

Exclamation mark button

= Inspect Opto 22 Device - *
Device Name: |1o.192.55.s? j Options ¥ Status: | Status Read area last read at 07/01/16 12\8:04
Status Read
Status Read |
e LDDRESS DESCRIFTION VALUE s Refresh
= 5 0xFFFF FO30 0004 Powerup Clear Flag PUC Needed PUC Receiwed (0}
e OxFFFF F030 0008 Buay Flag 0
Point Config 0xFFFF F030 0018 Loader Version E5.1c
Diital Bank 0xFFFF FO30 0000 Memory Map Version 1
gita! Ban 0xFFFF FO30 0230 Current Boot Device Flash Memory
Digital Point 0xFFFF FO30 001C Firmware Version 29.5a
0xFFFF FO30 00RO Firmware Version Date 05/03/2016
Analog Bank 0xFFFF F030 00BO Firmware Version Time 15:29:32
Analog Point 0xFFFF FO30 0020 Unit Type 0x0000007A
High Density 0xFFFF FO30 0080 Unit Deacription SHNAE-FAC-R1
g 0xFFFF FO30 0024 I/0 Unit Hardware Revision (Month) 4
5 0xFFFF F030 0025 I/0 Unit Hardware Revision (Day) 21
HEEn 0xFFFF FO30 0026 I/0 Unit Hardware Revision (Year) 2008
ScratchPad ¥ 0xFFFF FO30 024C I1/0 Coprocessor Firmware Version A0.0a
0xFFFF FO30 0028 Installed Ram 33554432
Data Log 3
ETHERNET 1 Interface
PID * 0xFFFF FO30 002E MAC Rddress 00-A0-30-01-85-9C
S 0xFFFF FO30 0034 IF Rddress 10.192.55.67
ven 0xFFFF FO30 0038 Subnet Mask 255.255.192.0
oo P 0xFFFF FO30 003C Gateway 10.192.51.51
0xFFFF FO30 0040 DHS 10.192.60.31

Other 3

Close | Help |

ETHERENET 2 Interface

™ AutoRefresh | 15000  msec

Getting Device and Firmware Information—Multiple Devices

You can get device type, IP address, and firmware information for all Opto 22 Ethernet-based devices on one
network, all at one time. This method is especially useful for making sure firmware is up to date on all devices.
Note that SNAP PAC SB brains are not included, since they are on a serial, not an Ethernet, network.

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.

2. Inthe PAC Manager menu bar, click Tools > Find Opto 22 MMP Devices.
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| Find Opto 22 MMP Devices = EH ==
MMP Part: Timeout: (3000 m:  Devices Found: 0
MALC Address | IF Address | Firmnware | Unit Type |

Find | Help

3. (lick Find.

PAC Manager discovers all Ethernet-based Opto 22 memory-mapped devices on the network and lists

their MAC addresses, IP addresses, firmware versions, and unit types.

[o]l e ]

| Find Opto 22 MMP Devices
MMP Port: | 2001 Timeout: | 3000 ms  Devices Found: 114
MAC Address | IP Address | Firmware | Unit Type
00-AD-3D-02-07-58 10,192.50.100 RS.2b 0x56 OPTOEMU-SMNR-DR.1 _|
00-20-0C-30-B6-E0 10,192,144 AD.Oa 0x53
00-AD-3D-01F3-43 10,192.55.173 R9.1a 0 5A OPTOEMU-SMR-3Y
00-AD-3D-01-24-5E  10,192,57.80 R9.23 076 SMAP-PAC-EB1
00-AD-3D-01-09-76 10,192.50.11 RS.2b 076 SMAP-PAC-EB1
00-AD-3D-00-44D2 10,192.54.243 R6.1c 093 SMAP-UP 1-ADS
00-AD-3D-01-7B-7F 10,192.50.84 R3.23 076 SMAP-PAC-EB1
00-AD-3D-00-0C-04 10,192,56,211 R7.03 093 SMAP-B3000-EMET
00-AD-3D-00-FB-C2  10,192,56,213 R7.03 093 SMAP-B3000-EMET
00-AD-3D-00-0C-50 10,192.56,215 R7.0a 093 SMAP-B3000-EMET
00-AD-3D-00-FB-A2  10,192.56.214 R7.03 093 SMAP-B3000-EMET
00-AD-3D-00-0C-58  10,192.56.216 R7.0a 093 SMAP-B3000-EMET -
< | [l
Help

TCP Settings

Retransmit timeout (RTO) refers to the length of time the controller waits while communicating before timing
out. The RTO is determined by the controller's TCP/IP stack, and the stack continually recalculates the RTO
based on recent network traffic. If the network becomes busier, for example, the stack automatically adjusts

the RTO to a higher value.

If the TCP/IP stack times out while trying to transmit data, it doubles the current RTO and tries again. This
process continues for five retries; after that, the device stops trying and sends a timeout message.

PAC Manager User’s Guide




USING PAC MANAGER TO TROUBLESHOOT PROBLEMS

If you are receiving frequent timeout messages from the device, you can change the TCP parameters in PAC
Manager.

1.
2.
3.

Start PAC Manager: Click the Windows Search button and type PAC Manager <version_number>.
In the PAC Manager main window, click the Inspect icon @

In the Device Name field, type the name or IP address of the controller.
Then, click Status Write.

=] Inspect Opto 22 Device = &I
Device Name: | 10.192.50.45 j Options » Status: | Status Write area last read at 02/19/15 14:45:45
Status Write
Status Read |
Address ‘ Description | Value - Refresh
OxFFFF FO35 0004 Always BootP/DHCP On Powerup No 1=
" OxFFFF F038 0008 Degrees FfC Degrees C = Apply
Wcless PN | 0xFFFF F038 0010 _Comm Watchdeg Time (msec), 0 = Disable 0 c
OxFFFF FO38 0014 TCP Minimum Retransmission Timeout (msec) 250
Paint Config OxFFFF F038 0018 TCP Initial Retransmission Timeout (msec) 3000
OxFFFF F033 001C  TCP Retransmission Attempts 5
Digital Bank OxFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
- ; |UXFFFF FO35 U299 Digital Feature Scan Interval (msec) T
Digital Point OXFFFF FO33 0050 Max Analog and High Density Digital Scan Interval (msec) 1000
Analog Bark OxFFFF FO38 0298 Out Of Range Value -32768,000
OxFFFF FO38 0054  Scanner Flags 0x 00000000

Analog Paint OxFFFF FO38 0154 Host Name
High Density Operation

OptoMMP Device - Send Comma

CAUTION: Note the following recommended settings:

TCP Minimum Retransmission Timeout (msec): 250
TCP Initial Retransmission Timeout (msec): 3000
TCP Retransmission Attempts: 5

TCP Idle Session Timeout (msec): 240,000

Ifyou set these fields too low, you may not be able to communicate with the device at all—even through PAC
Manager—to fix the settings. Then you would have to reset the controller to factory defaults.

Change these four fields as necessary:

Minimum RTO sets an absolute minimum value for the RTO. The device’s calculated RTO will never go
below this value.

Initial RTO sets the RTO for the first communication try. Be careful: since all future tries are based on this
value, if you set it too low for network conditions, a connection will never be made.

TCP Retransmits sets the number of times the device retries communication. Larger, busier networks
need a higher number of retransmits than smaller networks with less traffic.

TCP idle session timeout sets how long (in milliseconds) the device allows a session to remain open
without any activity. After this time, the device checks the session to make sure it is still good, and closes
it if it is not. The default is 240,000 milliseconds, or four minutes.

Click the Apply button to write your changes to the controller.

In the Operation Commands list, highlight Store configuration to flash. Click Send Command.
In the Operation Commands list, highlight Restart brain from powerup. Click Send Command.
The new TCP parameters are set.
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Checking Ethernet Errors

If you are having problems communicating with the controller or I/O unit, follow troubleshooting suggestions
in the user's guide for the device.

You can use PAC Manager to check Ethernet errors reported by the SNAP PAC device. These errors indicate
network problems. You will need to know the device's IP address.

1. If PAC Manager isn't already open, click the Windows Search button and type PAC Manager.

2. Inthe PAC Manager main window, click the Inspect button Q

3. Inthe Device Name field, type the name (or IP address) of the controller or I/0O unit. Click Status Read.
4. Scroll down until you see these items:

Ethernet Errors: Late Collisions
Ethernet Errors: Excessive Collisions
Ethernet Errors: Others

| Inspect Opte 22 Device — X

j Options »

Device Mame: ‘ 10,192.55.67 Status: | Status Read area last read at 07/01/16 12:25:23

Status Read
Status Read |

Status Write 0xFFFF F030 0068 TCP Retransmits 5 A Refresh |
OxFFFF F030 006C TCP Idle Session Timeout (msec.) 240000
OxFFFF FO30 0108 TCP Idle Session Timeout Count 1]
Wireless LAN b|
OxFFFF F030 0070 Ethernet Errors: Late Collisions
Point Config O0xFFFF FO030 0074 Ethernet Errors: Excessive Collisions 0
OxFFFF FO30 0078 Ethernet Errors: Others a
Digital Bank
Digital Paint 0xFFFF F030 007C Smart Modules Present 0x003C
{analog, serial, etc.)
Analog Bank 0xFFFF F030 011C PID Loops Supported EL
0xFFFF FO30 0148 Digital Modules Supported 16
Analog Point
m OxFFFF FO30 0100 Arcnet Reconfigs Detected a
OxFFFF FO30 0104 Lrcnet Reconfigs Initiated by I/0 Unit 0
OxFFEF FO30 0120 Arcnet Transmit Attempts Since Powerup 1696606351
HEEm D OxFFFF FO30 0128  Arcnet ACKs 1696606339
SoatchPad OxFFFF FO30 0134 Arcnet Timeouts 1]
OxFFFF FO30 0124 Arcnet Other (node not found, etc) 12
Data Log 3 OxFFFF F030 0130 Arcnet Timeout Value (msec.) a
= R 0xFFFF FO30 0138 Arcnet Beceive Interrupts 1696606339
0OxFFFF FO30 0110 Ethernet MAC Resets Since Powerup a
Emis D OxFFFF F030 0114 Dig. Output Point Resets Since Powerup 0
Communications » O0xFFEF F030 0118 Dig. Interrupt Failures Since Powerup 0
Cther 3 0xFFFF FO30 0140 Inalog & High Density Digital Scanner 6.070 msec/scan W
Close | Help | ™ AutoRefresh | 15000 msec

All three of these items should have a value of zero. If any of these items has a value other than zero, you

may have a network problem.

Troubleshooting Serial Communication

If you need to troubleshoot serial communication over PPP, you can turn on logging for the port the modem
uses. Any data received or transmitted on the port is logged to a file on the controller, which you can retrieve
using FTP and analyze for problems.

You can also log communication with a serial device or I/0 unit for troubleshooting, but since the log file logs
serial data sent only between PAC Control and the serial device or I/O unit, it is easier to log communication in
your PAC Control strategy in these cases.

CAUTION: Logging adds significant overhead to serial communication. Do not enable logging unless you are
troubleshooting.
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Creating the Log File
1. Inthe PAC Manager main window, click the Inspect button @

2. Inthe Device Name field, type the name (or IP address) of the controller (or choose it from the
drop-down list).

3. Click Communications and choose Communication Port Control from the submenu.
The Inspect window shows the ports and features that apply to the controller you're inspecting.

Inspect Opto 22 Device - X
P 3

Device Name: | 10.192.50.21 ﬂ Options + Status: ‘Ccmm Port Control area last read at 07/05/16 12:04:58

Communication Port Control
Status Read
Status Write Address | Description | Value
COMMUNICATION PORT 0
Wircless LAN b 0xFFFF FO31 0400 Control Function For Communication Port 0 PPP
reless OxFFFFF0310404  Logging For Commurnication Part 0 Disabled
COMMUNICATION PORT 1

Foint Config OxFFFF FO31 0408 Control Function For Communication Port 1 Mone

— OxFFFF FO31 040C Logging For Communication Port 1 Disabled
Digital Bank COMMUNICATION PORT 2

o ) 0xFFFF FO31 0410 Control Function For Communication Port 2 MNone
Digital Point OxFFFFF0310414  Logging For Communication Part 2 Disabled
Analog Bank
Analog Point
High Density

System 3
ScratchPad  »
Data Log 3
PID 3
Events 3
Communications +
Other 3

Close | Help | [~ AutoRefresh | 15000  msec

Refresh |
Apply

1 T T ET T ET i 5

4. Find the port you're troubleshooting. In its Logging For Communication Port # field, click Disabled and
change it to Enabled.

Logging begins immediately.

Retrieving the Log File

1. Before retrieving the log file, go back to the PAC Manager Inspect window and set Logging For
Communication Port # back to Disabled (see steps in the previous section).

When you disable logging, all data is flushed to the file.

2. Usean FTP client to retrieve the log file, which is located in the root directory of the controller's file
system and named Comm<x>.log (where <x> is the physical serial port number).

See “Maintaining Files”on page 217 for information on FTP clients, and “Moving Files from the SNAP PAC
Controller or I/0 Unit"on page 220 for how to retrieve the file.

Reading the Log File

In the log file, full duplex serial communication is transformed into a single stream using these rules:
«  Databytes are not transformed in any way. The binary data byte is logged.

«  Adirection byte is prepended to every data byte: 0 = outgoing, 1 = incoming.

«  The data stream is terminated by a null character (ASCIl 0x00).

The maximum log file size is 16 kb. When it reaches the end, the log stream wraps to the beginning of the file.
To locate the oldest data in a wrapped file, search for a null character in place of a 1 or 0; since the null
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terminates the log data stream, the next logged data byte is the oldest data byte in the file. If the null
character is at the end of the file, the file has not wrapped.

Troubleshooting Wireless LAN Communication

If you are having difficulty with wireless LAN communication on a Wired+Wireless controller or brain (part
number ending in -W), Opto 22 Product Support may ask you to log WLAN data.

1. (SNAP PAC controllers only) Make sure there is a microSD card to receive the log file.

If no card is in the microSD slot, no log file is created. (A card is not required for a SNAP PAC EB-W brain,
which has no card slot)

In the PAC Manager main window, click the Inspect button @

In the Inspect window's Device Name field, type the name (or IP address) of the controller (or choose it
from the drop-down list).

Click Wireless LAN and choose Wireless LAN Configure.
Change the WLAN Logging value as Product Support directs.
Enter the Network Key.

. Click Apply. When asked to restart the device, click Yes.

w N
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The log is always written to the same file; path and filename on both controllers and brains is:
/sdcard0/ATHO .LOG

If the file already exists, new data is appended to the end of it.

The log file looks similar to this:

B ATHO.LOG - Notepad
File Edit Format View Help

00007d15 sdwrkr wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ00007d1l5 sdwrkr ~
wmi_statsEvent_rx() : EnterZ00007dl5 sdwrkr  ARG000 updating target statsC00008549 sdwrkr 3
wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ00008549 sdwrkr wmi_statsevent_rx{) : Enter:
00008549 sdwrkr ARG6000 updating target statsZ00008d7d sdwrkr wmi_control_rx() :
WMI_REPORT_STATISTICS_EVENTIDZ00008d7d sdwrkr wmi_statseEvent_rx{) : EnterZ00008d7d sdwrkr

ARG6000 updating target statsIZ000095bl sdwrkr  wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDC
000095b1 sdwrkr  wmi_statsevent_rx() : EnterZ000095bl sdwrkr  ARG000 updating target statsC
00009de5 sdwrkr wmi_control_rx({) : WMI_REPORT_STATISTICS_EVENTIDZ00009de5 sdwrkr
wmi_statsEvent_rx() : EnterZ00009de5 sdwrkr  ARG000 updating target stats-0000a6l9 sdwrkr
wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ0000a6l19 sdwrkr wmi_statsevent_rx{) : Enter:
0000a619 sdwrkr ARG6000 updating target statsZ0000aed4d sdwrkr wmi_control_rx() :
WMI_REPORT_STATISTICS_EVENTIDZ0000aed4d sdwrkr wmi_statseEvent_rx{) : EnterZ0000aed4d sdwrkr

ARG6000 updating target statsIZ0000b681 sdwrkr  wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDC
0000b681 sdwrkr  wmi_statsevent_rx() : EnterZ0000b681 sdwrkr  ARG000 updating target stats:C
0000beb5 sdwrkr wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ0000bebS sdwrkr
wmi_statsEvent_rx() : EnterZ0000beb5 sdwrkr  ARG000 updating target stats-0000c6e9 sdwrkr
wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDZ0000c6e9 sdwrkr wmi_statsevent_rx{) : Enter:
0000c6e9 sdwrkr ARG6000 updating target statsZ0000cfld sdwrkr wmi_control_rx() :
WMI_REPORT_STATISTICS_EVENTIDZ0000cf1ld sdwrkr wmi_statsevent_rx{) : EnterZ0000cfld sdwrkr =
ARG6000 updating target statsIZ0000d751 sdwrkr  wmi_control_rx() : WMI_REPORT_STATISTICS_EVENTIDC
0000d751 sdwrkr wmi_statseEvent_rx{) : Enterz0000d751 sdwrkr ARG000 updating target stats:
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Product Support will interpret the log file.
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A: Menus

FILE MENU

EDIT MENU

New. Displays the Create New Tag Database dialog, allowing you to specify the name and location of a new
tag database. If changes to the current configuration have not been saved, you will be asked if you wish to
save those changes before proceeding. Only one configuration may be open at a time.

Open. Displays the Open Tag Database dialog, allowing you to open a previously created tag database. If
changes to the current configuration have not been saved, you will be asked if you wish to save those changes
before proceeding. Note that only one configuration may be open at a time.

Close. Closes the current configuration. If changes to the configuration have not been saved, you will be
asked if you wish to save those changes.

Save. Displays the Save Tag Database dialog, allowing you to save your configuration to disk.

Save As. Displays the Save Tag Database As dialog, allowing you to define a new name and/or location for
the current configuration.

(Recent Tag Databases). The four most recently opened Tag Databases are listed below Save As on the
File menu. Selecting any of them is equivalent to choosing Open Tag Database from the File menu and
entering the tag database name.

Exit. Closes the current configuration file and exits PAC Manager. If changes to the current configuration have
not been saved, you will be asked if you wish to save those changes before exiting PAC Manager.

Cut. Has no current functionality.

Copy. Available when an I/0 Unit is highlighted in the tree view. When selected, the highlighted I/0 Unit will
be copied to the clipboard.

Paste. Pastes an 1/0 Unit from the clipboard into the strategy tree. This item is enabled only when an 1/0 Unit
has been previously copied to the clipboard.
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TOOLS MENU

VIEW MENU

Select menu items in the Tools menu to inspect and manage SNAP PAC controllers and brains, including
configuring IP addresses, installing firmware, and exchanging files.

Send Configuration to I/0 Unit. After you have finished configuring I/0 units and saved the
configuration file, you must load the configuration file into the I/0 unit's memory. This menu item opens the
Send Configuration To I/0 Unit dialog box.

Inspect. Opens the Inspect Opto 22 Device window. Select this menu item to view and change I/0 and other
configuration settings for a specific SNAP PAC controller or brain.

IMPORTANT: Configuration changes made to the I/0 Unit in the Inspect window are not saved in the PAC Manager
configuration file.

Maintenance. Displays the 1/0 Unit Maintenance window. Select this menu item to upgrade firmware,
exchange files, and manage items in flash memory.

Assign IP Address. Displays the Assign IP Address dialog. Select this menu item to see all Opto 22 Ethernet
devices that are broadcasting DHCP or BootP requests. You can then assign IP addresses to these devices and
test the addresses to confirm proper communication.

Change IP Settings. Displays the Change IP Settings dialog box. Select this menu item to change the IP
address and related network settings on a SNAP PAC controller or brain.

Install Firmware via Ethernet. Opens the Maintenance dialog box, which is used to download new
firmware to SNAP PAC controllers and brains.

Install Firmware via Serial Connection. Launches the application OptoFlash-ENET, which is used to
download new firmware to SNAP Ethernet and SNAP Simple brains via a serial connection. See the online help
included with OptoFlash-ENET for more information.

Install Firmwatre via Failsafe Bootloader Mode. Provides a way to install firmware when the firmware
in the device is damaged. See “Replacing Damaged Firmware”on page 214.

Import/Copy 1/0 Unit. Displays the Inspect Opto 22 Device window. This dialog enables you to save an 1/0
unit’s flash memory image to a file on your hard disk. This image file can then be used to configure another 1/0
unit. Configuration information can also be read directly from an I/0 unit and sent directly to another I/O unit,
orimported into PAC Manager to create a new I/0 unit configuration that can be expanded upon.

Modbus Calculator. Converts an I/0 unit memory map address to a Modbus Unit ID and Register Address.
See “Determining Modbus Unit ID and Register Address”on page 113.

Find Opto 22 MMP Devices. Displays a dialog box you can use to find the MAC and IP addresses (see
“Find Opto 22 MMP Devices”on page 259) of all Opto 22 memory-mapped devices on the Ethernet network.

Toolbar. Toggles the display of the toolbar.

Status Bar. Toggles the display of the Status Bar.
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HELP MENU

APPENDIX A: MENUS

Help Topics. Opens the PAC Manager Help file's index of topics.
Manuals. Provides the PAC Manager User's Guides in PDF format.
Opto 22 on the Web. Provides links to downloads, product support, and the Opto 22 website.

About PAC Manager. Provides general information about PAC Manager, including the version number and
copyright information.
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B: Dialog Boxes

ADD/EDIT ANALOG POINT
Use this dialog box to add analog points or edit the configuration of existing analog points.

Name. Type in a name for the I/0 point. The name must start with a letter and may contain letters, numbers,
and underscores (spaces are converted to underscores).

Description (optional). Enter a description of the point.

Type. When the channel can be configured as either an input or an output, select the type from the
drop-down list.

Module. Select the I/0 module or point type from the drop-down list. All available modules of the type
specified will be included.

Units. Each analog module has a default set of units. These units are displayed in this field. If you assign
custom units to the module (by clicking the Custom button), the custom units will appear here instead.

Zero Scale. The module’s default zero-scale value appears here. This can be changed to a custom value (by
clicking the Custom button).

Full Scale. The module’s default full-scale value appears here. This can be changed to a custom value (by
clicking the Custom button).

Default button. Click here to return the units, zero-scale value, and full-scale value to the defaults for the
module. This is useful if you have assigned custom units and values through the Custom button that you now
wish to ignore.

Custom button. Click here to display the Scale Analog Readings to assign custom units, zero-scale, and/or
full-scale values to the module. For example, you could change the voltage range of a 0-10 VDC module to be
interpreted instead as a pressure range of 20-200 psia.

Watchdog. Click No (the default) to disable a watchdog on this point, or click Yes to enable the watchdog
(available for outputs only). If you select Yes, a new field will appear to allow you to define the value to be
assigned to the output should the watchdog be triggered. Enter a value between the zero-scale and full-scale
values (described above).

A watchdog is triggered if no communication activity is detected on the bus for the amount of time specified
in the Watchdog field of this point’s I/O unit.
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ADD/EDIT DIGITAL POINT

ADD/EDIT DIGITAL POINT

Use this dialog box to configure a digital point for an 1/0 unit.

Name. Type in a name for the I/0 point. The name must start with a letter and may contain letters, numbers,
and underscores (spaces are converted to underscores).

Description (optional). Enter a description of the point.

Type. When the channel can be configured as either an input or an output, select the type from the
drop-down list.

Module. Select the I/0 module or point type from the drop-down list. All available modules of the type
specified will be included.

Features. Click here to view and select from the available features for the I/0 point you are configuring.
Features are available only if you are adding a point to a multifunction 1/0 unit. By default no feature is
selected.

For inputs, depending on the module and 1/0 unit, you may be able to configure the module as a counter,
on-pulse, off-pulse, frequency, period, on-time totalizer, off-time totalizer, or quadrature counter feature. You
may be able to configure an output module as a time-proportional output (TPO).

Watchdog. This field, which appears only if you enable the watchdog, also has only two values. Click the
field and select On or Off from the drop-down list. Remember, watchdogs are available only for output
modules.

ADD/EDIT EVENT MESSAGE

240

Use this dialog box to add a new event message or edit an existing event message.

Message Name. Type in a descriptive name for this event message. The message name is not sent to the
I/0 Unit. It is used only within PAC Manager to differentiate event messages from one another.

Message Text. For e-mail, serial, and SNMP event messages, type in the text to be sent as the message. For
MemMap Copying, this field holds the Source Memory Map address or the Source Data. Plugins can be used
in the message text. The text limit is 127 characters.

Streaming. To have the I/0 Unit periodically stream data back to a PC, select Enabled from the drop-down
list. You must first use Configure Streaming to set the host(s) to receive the streamed data.
Period (sec). Enter the interval in seconds at which streaming should take place. A value of 0 means that
data will be streamed only once.

E-mail. To have the I/0 Unit send the Message Text using e-mail, select Enabled from the drop-down list. You
must first use Configure E-mail to set the e-mail address that will receive the Message Text.

Period (sec). Enter the interval in seconds at which the e-mail should be sent. A value of 0 means that
the e-mail message will be sent only once.

Serial Module. To have the I/0 Unit send the Message Text as a string through a serial communication
module, select Enabled or Disabled from the drop-down list and enter the string to send in the Message Text
area. You must first use Configure Serial Modules to set serial modules and their ports.

Serial Ports Mask. Enter a mask representing the serial modules and ports to send the message
through. Bits 0-31 correspond to ports 0-31.

PAC Manager User’s Guide



APPENDIX B: DIALOG BOXES

SNMP Trap. To have the 1/0 Unit send the Message Text as an SNMP trap, select Enabled from the
drop-down list. You must first use Configure SNMP Agent to set up SNMP system variables, community
groups, and management hosts.

Period (sec). Enter the interval in seconds at which to send the SNMP trap. A value of 0 means that the
trap will be sent only once.

Trap Type. Enter the trap type required by your SNMP management software. Refer to the
documentation for your SNMP management software for information on determining the required
SNMP trap type.

Priority. If you are using SNMP with an outgoing PPP (modem) connection and want the SNMP trap
stored in the I/0 Unit until the next communication, set Priority to Low. If you want the 1/0 Unit to
immediately dial out and send the trap, set Priority to High.

MemMap Copy Destination. To change the state of a digital point on a different /O Unit, or to copy data
from one memory map address to another, select Enabled from the drop-down list and complete the
MemMap Address, IP Address, Period (msec), and IP Port fields for the location the data is being copied to. In
the Message Text area, enter the source data or memory map location data is being copied from.

MemMap Address. Enter the destination memory map address in hexadecimal. You do not have to
include the leading FFFF.

Period (msec). Enter the interval in milliseconds at which the MemMap copy should take place. A value
of 0 means that the copy will be done only once.

IP Address. Enter the IP address of the destination I/0 Unit. Use 0.0.0.0 if copying to an address on the
same /0 Unit.

IP Port. Enter the IP port of the destination I/0 Unit. This field is ignored if copying to the same I/0 Unit.

ADD/EDIT I/0 UNIT

Use this dialog box to add a new I/0 Unit or edit an existing 1/0 Unit.

1.

No v e WwnhN

Enter a name for the 1/0 unit. The name must start with a letter and may contain letters, numbers, and
underscores. Spaces are converted to underscores.

(Optional) Enter a description of the unit.

Select the type of I/0 unit from the drop-down list.

Choose whether temperatures will be handled in Fahrenheit or Celsius.

Specify the communication port to use (2007, unless you have changed it for security purposes).
Enter the I/0 unit's IP address.

The Address List area shows IP addresses of the 1/0 units that should receive this configuration. If you
have /0 units that are exactly alike, list all of them here. That way you can download the configuration
file to all the 1/0 units at once. To list them, click Add and enter a single IP address or a range of addresses.
Select whether you want a Watchdog on the unit. The default is No (disabled). If you select Yes, a new
field appears; enter the Watchdog timeout value in seconds. The default timeout is 0.5 seconds.

When a watchdog is enabled, the 1/0 unit monitors activity on the port. If no communication is received
for the specified interval, the unit automatically sets designated digital and analog I/0 points to values
you have set in the Watchdog field of the Add/Edit Analog Point or Add/Edit Digital Point.

ADD/EDIT IP ADDRESS

Use this dialog box to add an IP Address or a range of IP Addresses that will all receive this 1/0 unit
configuration. Usually these are I/0 units that are exactly alike. Also use this dialog box to modify a single IP
address.
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ADD/EDIT MEMORY MAP VALUES

Click either Add one IP Address or Add a range of IP Addresses.
For a single IP address, enter or change the address and click OK.

To add a range of IP addresses, enter the first address in the range in the From field. Enter the last IP
address in the To field. Then click OK.

ADD/EDIT MEMORY MAP VALUES

Use this dialog box to add a new Memory Map Value or edit an existing Memory Map Value.

Address. Type in a valid Memory Map Address. The address must be in hexadecimal and correspond to a
valid write area in the device's Memory Map. Use the OptoMMP Protocol Guide (form 1465) as a reference.

Value. Type in the value to send to the above address. The value may be in hexadecimal (integer types only)
or decimal. For hex, precede the value with Ox. (Based on this convention, PAC Manager will remember if your
value is in hex or decimal.)

Type. Select the type of Memory Map Value.

ADD/EDIT PID LOOPS

Use this dialog box to add or change PID loops on SNAP PAC brains and R-series controllers. You can configure
up to 96 PID loops. Four algorithms are available to choose from.

See also “Configuring PID Loops”on page 63.

1.
2,
3.

Enter a unique, descriptive name for the PID.

(Optional) Enter a description of the PID.

Select the type of input: /0 Point, Host, or PID Output.

- Ifthe PID’s process variable comes from an 1/0 point on the same unit, select 1/0 Point. Choose the
point from the drop-down list or type a point name to configure a new point.

- Ifthe PID’s process variable comes from an PAC Control strategy, select Host. Enter an initial value for
the input.

- Ifthe PID’s process variable is the output of another PID on this brain (a cascading control loop),
select PID Output. Choose the PID from the drop-down list.

(Optional) If you chose I/0 Point or PID, check the Square Root box if the error should be calculated

based on the square root of the process variable (applies to flow control systems where volumetric flow is

proportional to the square root of a signal from a flow transducer).

Set the valid range of the process variable by entering the low range and the high range. (See below

for optional responses to out-of-range input.)

Choose the source for the setpoint: I/0 Point, Host, or PID Output.

- To control the setpoint using a device such as a potentiometer, select I/0 Point; choose an I/0 point
from the drop-down list or type a new point name.

- To control setpoint using PAC Control or PAC Display, select Host and enter an initial value.

- Ifanother PID loop will control the setpoint, select PID Output and choose the PID from the
drop-down list.

Choose the destination for the PID output: I/0 Point or Host. (To use the output for controlling the

setpoint or input of another PID, choose Host.)

Enter upper and lower clamp values to prevent the output from exceeding a desirable range. These

values should equal the range of the output point, if used. Or choose values to make sure that the output

device doesn't shut off (for example, keeping a circulation pump running regardless of the PID output) or
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that the output never reaches a destructively high setting (for example, keeping a motor below
maximum).

9. (Optional) Enter minimum and maximum change values. The output won't respond until the
minimum change is reached (for example, you may not want a heater to turn on to correct a 1 degree
error). Maximum change prevents too drastic a change in output (for example, you could limit the
increase in a pump’s output to prevent pipe breakage). The default for both minimum and maximum is
zero, which disables the feature.

10. Choose how the PID should respond (output options) if the input goes out of range. If no boxes are
checked, the PID will freeze output at the current value. To have PAC Control logic or an operator respond,
check Switch to manual mode. To force the output to a specific value, check Force output and type the
output values. NOTE: If both boxes are checked (forced output and manual mode), the output will be forced
and the PID put into manual mode; but if the PID is already in manual mode, the output will not be forced.

11. Choose algorithm: Velocity, ISA, Parallel, Interacting. See also “Algorithm Choices”on page 64.

12. Choose mode. Auto activates the PID. Manual requires that PAC Control logic or an operator control the
PID output.

13. Enter a scan rate to determine how often the input is scanned and the controller output is calculated.
Minimum value is 0.001 (1 millisecond). Scan time should be greater than system lag (the time it takes for
the controller output to have a measurable effect on the system). Also consider other PIDs and tasks on
the brain competing for processing power.

14. Enter a positive or negative value for Gain. Heating systems usually require a negative value and cooling
systems a positive value. NOTE: Gain is usually refined during the tuning process.

15. (Optional) Enter Feed Forward Initial and Feed Forward Gain values if you need to offset the
controller output in your application. These values are constants that are multiplied and added to the
controller output; often they are not used in PIDs.

16. (Optional) Enter Integral (Tune I) and Derivative (Tune D) settings if you know the desirable settings.
However, Integral and Derivative are not essential to basic configuration and are better determined in the
tuning process.

17. Click OK.

ADD/MODIFY NEW DEVICE

To add a new 1/0 Unit Name, click Options to open the Add New Device dialog box.

Device Name: Enter a name for the 1/0 unit. You can use the IP address or any unique name. Change the
timeout if necessary.

Direct Connection to Ethernet Device: Use this option if there is a direct connection to the brain via an
Ethernet cable.

o IPAddress or Hostname: Enter the IP address or hostname of an Ethernet I/0 unit, such as a PAC EB-series
or PAC R-series device.

o FEthernet Port: Use the default of 2001 for Ethernet Port unless you have changed the port.

Direct Connection to Serial Device: Use this option if the I/0 unit is connected directly to the PC using a
serial cable and a PCI-AC48 adapter card.

o PCSerial Port: Enter the serial port on the PC where the brain is connected.

«  PCBaud Rate: The baud rate on the PC must match the rate set on the brain.

«  Serial Device Address: Enter the serial address of the brain.

Pass-Through Ethernet Controller to Serial Device: Use this option for SNAP-PAC-SB1 and SB2 brains
connected to a SNAP-PAC-S1 or S2 controller.

«  IPAddress or Hostname: Enter the IP address or hostname of the S-series controller.
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o Fthernet Port: Use the default of 2001 for Ethernet Port unless you have changed it.

«  Controller Serial Port. Enter the controller's serial port where the brain is connected. On a SNAP-PAC-S1, it's
Serial 2. On a SNAP-PAC-S2, it could be any port.

o Controller Baud Rate: The baud rate on the controller must match the rate set on the brain.
o Serial Device Address: Enter the serial address of the brain.

o 2-Wire RS-485: Check this box for a 2-wire RS-485 connection. SNAP-PAC-S1 controllers support only
2-wire RS-485. SNAP-PAC-S2 controllers support 2-wire or 4-wire RS-485.
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ASSIGN IP ADDRESS

Use this dialog box to assign IP addresses to Opto 22 devices, either by listening for devices sending DHCP or
BootP broadcasts, or by first creating a list of mappings.

NOTE: In order to assign IP addresses, you must be logged in with administrator rights.

See also “Assigning an IP Address” on page 8, especially “Checking Network Setup and PC."

Each device ships from the factory with a unique MAC address (printed on a label on the device) and a default
IP address of 0.0.0.0, which is invalid. SNAP PAC controllers and EB-series brains, SNAP-LCE, SNAP Ultimate,
SNAP Ethernet, and SNAP Simple I/0 send out a BootP broadcast when first turned on. E1s and E2s send out a
DHCP broadcast. In most cases, you must give each of these devices a fixed, static IP address. See also
“Assigning IP Addresses to SNAP PAC” on page 8.

Assigning IP Addresses to SNAP PAC

If your network has a DHCP server, either assign a static IP address before connecting the device to the
network (preferred), or disable the server. Note the MAC address of each device that needs an IP address, and
turn on the device(s).

NOTE: SNAP PAC controllers have two separate Ethernet network interfaces. Each interface has a separate MAC
address and therefore takes a separate IP address. Only ENETT sends a BootP request. Once you have assigned this
primary IP address, you can assign the secondary address using the Inspect Opto 22 Device window.

1. Double-click the MAC address of the device in the upper list.

2. Inthe Mapping dialog box, enter the IP Address and Subnet Mask for the device. If it will be talking to a
device on another subnet, enter the Gateway (router) address. If it will talk only on the local subnet, leave
the gateway address all zeros (0.0.0.0). Leave the DNS address at 0.0.0.0 and the Host Name field blank.
Click OK.

3. The new IP address information appears in the upper list in the dialog box, and the device’s status
changes to Mapped. The address information also appears in the lower list to show that this device has
been mapped to this address.

4. With the device still highlighted, click Assign. The address is saved to flash memory and the status
changes to Static IP. To verify that the IP address has been successfully assigned, highlight the device in
the upper list and click Test. A DOS window opens and the IP address is pinged.

5. Forfuture reference, write the IP address next to the MAC address on the white sticker provided on the
device.

6. Tosave the list of IP address and MAC address mappings (the lower list in the dialog box), click Save List.

NOTE: If you have a large number of devices or are on a separate network, you can create the mappings list first, save
it, and then load it into PAC Manager later. Devices that match the mappings receive their IP addresses as soon as
they appear in the upper list. Click Assign All to save them.

ASSIGN SECONDARY IP ADDRESS

SNAP PAC controllers each have two, independent Ethernet network interfaces. With PAC Project Professional,
you can use these interfaces to segment the control network from the company network or for Ethernet link
redundancy. For more information, see the PAC Control User’s Guide (form 1700), the PAC Display User's Guide
(form 1702) and the OptoOPCServer User's Guide (form 1439, available with the purchase of PAC Project
Professional or OptoOPCServer).
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CONFIGURE E-MAIL

IMPORTANT: The two Ethernet interfaces will work only if they are on separate network segments, so the control
engine can clearly determine where to direct communication. For example:

ENET1 ENET2

IP Address: 192.168.0.12 10005
Subnet Mask: 255.255.255.0 255.255.255.0

The first Ethernet interface, ENETT1, sends a BootP broadcast and is assigned an IP address just like other Opto
22 devices (see "Assign IP Address” on page 245).

To assign an IP address to ENET2, follow these steps:
1. Make sure that ENET1 has already received an IP address.
2. Inthe PAC Manager main window, click the Inspect button.

3. Inthe Inspect window, enter the IP address for ENET1 and click Status Read. Status information for the
controller appears in the window. If the secondary IP address has not been assigned yet, the secondary IP
address information will show all zeros.

4. Click Status Write. Enter the IP address information for ENET2 in the Value column in the Secondary IP
Address, Secondary Subnet Mask, and (if necessary) Secondary Default Gateway fields. Click Apply. The
information is sent to the SNAP PAC, but it cannot communicate on the secondary interface until it is
restarted.

5. Inthe Operation Commands section, highlight Restart Device from powerup. Then click Send Command.

The SNAP PAC controller is restarted. You can check to make sure the controller is back on line by clicking
Status Read again and making sure the secondary IP address information is shown. To verify communication,
open PAC Manager on a PC that is on the same network segment as the secondary IP address, and use the
Inspect window to check status.

CONFIGURE E-MAIL

You can send an email message or page someone in response to an event. Use this dialog box to set up email
parameters. See “Configure Event Messages”on page 247 to set up the message itself.

IP Address and Port. Enter the IP address and port number of the Simple Mail Transfer Protocol (SMTP)
server the 1/0 unit will use to send email. You should be able to get this information from your network
administrator.

Timeout. Enter the length of time in milliseconds the 1/0 unit should wait for a response from the email
server. The default is 30,000.

From. Enter a valid email address that will identify the I/0 unit to the person who receives the email.
To. Enter the email address of the person who will receive the email.

Subject. Enter a phrase that will indicate the purpose of the email to the person receiving it. Note that this
subject line applies to all email messages sent by this I/0 unit. Plugins can be used in this field. For example, if
a similar email will be sent at intervals (such as an email of the data log), you can use the seqid plugin to put a
sequence number at the end of each subject line. This plugin is in the format:

$! segid

So, for example, if you enter Ultimate Data Log $!_seqid_ in the subject field, the first email message will have
a subject line of Ultimate Data Log 0, the next message will have a subject line of Ultimate Data Log 1, and so
on. For information on other plugins, see “Using Plugins”on page 95.
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IMPORTANT: For the configuration to take effect, you must upload the configuration file to the brain, save it to flash

memory, and restart the brain.

CONFIGURE EVENT MESSAGES

If you are using PAC Control or PAC Manager 9.0 or higher, configure event messages in the

configuration file as shown on page 92.

If you are not using PAC Control or are using a PAC Manager version less than 9.0, you cannot
configure event messages in a configuration file. Instead, use PAC Manager's Inspect mode and follow the
steps below. Note that event messages are not available on SB brains, since messaging requires an Ethernet

connection.

1. Inthe PAC Manager main window, click the Inspect button Q
- Ifyou have not used the Inspect window before, the window will not show any data. Select your

controller from the drop-down list.

- Ifyou have used the Inspect window before, the last device you inspected is shown in the Device

Name field, and current Status Read information appears in the window.

= Inspect Opto 22 Device

Device Name: | 10.192.50.21

Status Read
Status Read

Status:

j Options »

Status Read area last read at 07/05/16 12:03:48

Status Write hDDRESS

DESCRIFTION

VALUE

~ Refresh |

0xFFFF F030
0xFFFF F030

Wireless LAN  »

Point Config
Digital Bank
Digital Point
Analog Bank
Analog Point
High Density

System 3
Data Log 3
PID 3
Events 3
Communications
Other 3

Close | Help |

0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030

0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030

0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030
0xFFFF F030

0004
0008

0018
00oo
0230
001c
00RO
00BO

00z0
0080
0024
0025
00z2é
024C
002g

00ZE
0034
0038
003c
0040

Powerup Clear Flag PUC Needed
Busy Flag

Loader Version
Memory Map Version
Current Boot Device
Firmware Version
Firmware Version Date
Firmware Version Time

Unit Type

Unit Description

I/0 Unit Hardware Revision (Month)
I/0 Unit Hardware Revision (Day)
I/0 Unit Hardware Revision (Year)
I1/0 Coprocessor Firmware Version
Installed Ram

ETHERENET 1 Interface
MAC Rddress
IF Rddress
Subnet Mask
Gateway
DNS

ETHERENET 2 Interface

PUC Receiwed (0}
a

Ré.la

1

Flash Memory
R9.5a
07/05/2016
07:58:52

0x0000007C
SHAP-FRC-51

33554432

00-A0-3D-00-D9-0B
10.1582.50.21
255.255.182.0
10.1582.51.50
10.192.60.91

™ AutoRefresh | 15000  msec

- Ifyou have configured other devices, they are listed in alphabetical order in the drop-down list.

- Ifyou have configured six or more devices, the Inspect window provides two additional time-saving
features: Next and Back navigation buttons (to navigate back and forth through the alphabetized list
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of devices), and a list of the five most recently inspected devices (displayed at the top of the
drop-down list).

Next and Back navigation buttons
and Most Recently Used list
are displayed when you have

six or more devices configured. ]
| Inspect Opto 22 Device
Device Nameq{ | aflslrgel gl =g Opti
Cookie Controller
1_ [EngineRm
Status R4 ol partable i
Status Wiitd AT
A b rerup Clea
ireless ,
———{Chamber 1 v Flag 4
. Chamber 2 4
Point Confid o portable der Versig
T Cookie Controller ory Map Ve
Bl Ban]EngineRm mware Verg
Digital Point-22ftPAC mware Verg
‘fJxFFFF FO30 00BO Firmware Verg
A S o P —

2. Inthe Device Name field, type the name (or IP address) of the I/O unit (or choose it from the drop-down
list).
3. (lick Events and choose Event Messages from the submenu.

= Inspect Opto 22 Device — *

Device Name: | 10,192.55.67 j Options » Status: | Event Message area last read at 07/05/16 13:31:00

Event Message
Status Read
Event Message Mumber: |0 -
Status Write |

Address | Description | Value | Refresh |
Wireless LAN  #

MESSAGE
OxFFFFF120 0040  Message Text Apply
Point Config 0xFFFF F120 9000 Most Recent Message Sent

— OXFFFFF1200000  State Inactive ]
Digital Bank OxFFFF F120 0004  Scratch Pad Trigger ON 0x 00000000 00000000
| . 0xFFFF F120 000C Scratch Pad Trigger OFF 0x 00000000 00000000
Digital Point STREAMING
Analog Bank OxFFFF F120 0014 Enable Stream Packet Digabled ea|
OxFFFF F120 0018 Stream Period (seconds) 1}
Analog Point E-MAL
OxFFFF F120 001C Enable E-mail Message Disabled ea|
High Density OxFFFF F120 0020 E-mail Period (seconds) 1}
SERIAL MODULE
System N OxFFFF F120 0038 Enable Serial Module Message Disabled ea|
0xFFFF F120 003C Serial Ports Mask 0x Q0000000
Scratch Pad  » SNMP
OxFFFF F120 0024 Enable SMMP Trap Disabled ea|
Data Log » OxFFFF F120 0028 Trap Period (seconds) 1}
0xFFFF F120 002C Trap Type a
PID » OxFFFF F120 0030 Priority High =l

MEMMAP COPY DESTINATION

Events L4 OxFFFF F120 8000 MemMap Address 0x 00000000
e OxFFFF F120 8004 IP Address of Destination 0.0.0.0
Communications » OxFFFFF120 8008 Port 0

Other 5 OxFFFF F120 800C Period (milliseconds) 0
Close | Help | ™ AutoRefresh | 15000  msec

4. From the drop-down list, choose the lowest unused message number.
Unused message numbers have no asterisk.
5. Foranemail or serial message, or optionally for an SNMP message, enter the message text.

Message text is not sent in the streaming packet. Message text is limited to 127 characters. You can place
data from the I/O unit’s memory map into the message by using a plugin (see page 95). If you are
sending a serial message, make sure the text is formatted so the serial device that receives it will
understand it.

248 PAC Manager User’s Guide



10.

11.

12.
13.
14.

15.

16.
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Enter two masks indicating the Scratch Pad on and off bits that should trigger the message.
For help in figuring out the masks, see “Digital Point and Scratch Pad Masks”on page 132.

Streaming section: To send a stream of data as the message, choose Enabled from the drop-down list.
Enter how often in seconds to send the stream (0 sends it only once).

For information on streaming, see page 96.

E-mail section: To send an email message, choose Enabled from the drop-down list. Enter how often in
seconds to send the email (0 sends it only once).

Serial Module section: To send a message through a serial module to a serial device, choose Enabled from
the drop-down list. Enter a mask representing the modules and ports to receive the message.

Information in “Configuring Serial or Wiegand Events and Reactions” on page 139 may be helpful.

SNMP section: To send an SNMP trap as the message, change Disabled to Enabled. Enter how often to
send the trap (0 sends it only once). Also enter the trap type (determined by your SNMP management
software). If you are using SNMP with outgoing PPP and want the trap stored in the I/0 unit until the next
communication, set Priority to Low. If you want the I/0 unit to immediately dial out and send the trap, set
Priority to High.

For information on SNMP, see page 96.

NOTE: SNMP messages must be acknowledged. You can do so in your application or in PAC Manager’s Inspect
window: in the Message section, change the State to Acknowledge and click Apply.

Memmap Copy Destination section: To copy memory map data, complete this section using information
from “Copying Memory Map Data” on page 109.

When all fields are correct, click Apply.
Repeat from step 4 to configure additional event messages.
For each type of message you configure, make sure you also set up basic configuration:

Serial: See page 46
SNMP: See page 96
Email: See page 100
Streaming: See page 104

When you have finished configuring all event messages and any additional configuration required for
them, in the PAC Manager Inspect window, make sure the IP address shown is the correct one. Then click
the Status Write button in the upper-left part of the window.

In the Operation Commands list, highlight Store configuration to flash.
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Wireless LAN  »

Analog Bank |

0xFFFF F038 0010

OxFFFF FO38 0280

Comm Watchdog Time {msec), 0 = Disable

OxFFFF FO38 0014  TCP Minimum Retransmission Timeout (msec) 250

Point Config | OxFFFF FO38 0018  TCP Initial Retransmission Timeout (msec) 3000
0xFFFF F038 001C TCP Retransmission Attempts 5

Digital Bank | 0xFFFF FO38 0020 TCP Idle Session Timeout {msec), 0 = Disable 240000
OxFFFF FO33 0294 Digital Feature Scan Interval (msec) 1

Digital Point | 0xFFFF F032 0050 Max Anzlog and High Density Digital Scan Interval (msec) 1000
0xFFFF FO38 0298  Out Of Range Value (15-Bit) -32768.000

Out Of Range Value (32-Bit)

%] Inspect Opto 22 Device — X
Device Name: | 10.192.50.11 _v| options » | Status: | Status Write area lastread at 05/02(16 16:30:29
—Status Write
Status Read |
Status Write | Address | Description | Value Y :
OxFFFF FO38 0004  Always BootP /[DHCP On Powerup Mo e
0xFFFF FO38 0008 Degrees F/C Degrees F [ Apply |

0

-2147483648.000

Analog Paint | 0xFFFF FO38 0054 Scanner Flaos 0% 00000000
High Density | Operation

OptoMMP Device
Restart Device from powerup

A Send Command

Store configuration to flash k

System » |
Erase configuration from flash
e
St Reset to defaults and Restart Device
micraSD
22515 ' Store configuration and IP settings to microSD

PID » Erase configuration and IP settings from microSC.
Erase firmware from microSD

Events » | Erase strategy from microSD
Other
= Switch to loader mode
3
MI Clear Digital Events - Expanded configuration
Other 3 |

C!ear D!giial Events - OIE:I configuration W
- |

™ Auto Refresh IISUD[J msec

17. Click Send Command.
The configuration data is stored to flash memory and a Success message appears.

IMPORTANT: For the following configurations, you must also restart the unit for configuration to take effect:

Changes in TCP port for serial modules SNMP configuration
Email configuration PPP configuration
Data logging interval

18. If you have configured any of these items, in the Operation Commands list, highlight Restart /O Unit
from powerup. Click Send Command.

The I/0 unit is restarted and a success message appears.

CONFIGURE I/0 POINTS

SNAP I/0 units are configured by first adding a SNAP module, then configuring each point on that module.
SNAP modules and points are listed in an expandable, tree-like view. The window is resizable.

1/0 Unit. Displays the I/0 unit on which I/0 points are being configured.

Type. Displays the type of I/0 Unit for which points are going to be added. This field is for display purposes
only and cannot be modified.

Add. To add I/0 points to a SNAP 1/0 Unit, you must first add a SNAP module to the I/0 Unit, then add I/0
points to that module.

To add a SNAP module to an I/0 Unit
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Highlight the location where the module will be added and click the Add button. In the Add Module
dialog that appears, select the type of module (Analog Input/Output or Digital Input/Output) and the
name of the SNAP module you are configuring. Click OK.

To add an I/0 point to a SNAP module

Double-click a SNAP module in the list to see the point locations it contains. Highlight the location where
the point will be added and click the Add button. Depending on whether the I/O point being added is
analog or digital, enter configuration information for the new 1/0 point in either the Add/Edit Analog
Point or Add/Edit Digital Point.

Modify. To change an existing SNAP module or I/0 point, highlight the item in the list and click the Modify
button. Change configuration information for the SNAP module or I/0 point in the Add Module dialog, the
Add/Edit Analog Point or the Add/Edit Digital Point as necessary.

Delete. To delete an existing SNAP module or 1/0 point, highlight the item in the list and click Delete. Before
deleting a SNAP module, you must first delete all I/O points associated with that module. When deleting I/0
points, note that only points having a reference count of zero can be deleted.

Move To. To move an I/0 point to an empty channel on another (or the same) I/0 Unit, highlight the point,
click Move To, and use the Move Point To to move the point. If the I/O point is referenced in a PID loop or
event/reaction, you can move the point only within the same 1/0 unit, not to another unit.

Expand All/Collapse All. To view or hide all /O points in a SNAP /0 unit, click the Expand All button or the
Collapse All button.

CONFIGURE I/0 POINTS (G4EB2)
G4EB2 I/0 units are configured by adding a point for each G4 module.
1/0 Unit. Displays the I/0 unit on which I/O points are being configured.

Type. Displays the type of I/0 Unit for which points are going to be added. This field is for display purposes
only and cannot be modified.

Add. Points that have not been configured yet show as Not Used. Double-click the channel number for the
point you want to add. Enter configuration information for the new 1/0 point. See “Configuring Digital Points
for a G4EB2"on page 38.

Modify . To change an existing point, highlight the item in the list and click the Modify button. See
“Configuring Digital Points for a G4EB2" on page 38.

Delete. To delete an existing point, highlight the item in the list and click Delete. When deleting I/0 points,
note that only points having a reference count of zero can be deleted.

Move To. To move an I/0 point to an empty channel on another (or the same) I/0 Unit, highlight the point,

click Move To, and use the Move Point To to move the point. If the |/O point is referenced in a PID loop or
event/reaction, you can move the point only within the same 1/0 unit, not to another unit.

CONFIGURE I/0 UNITS

This dialog box shows all the I/0 units in the current configuration and is the “home base” for configuring 1/0.
For more details on configuring I/0 and features, see Chapter 2: Configuring Devices.
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To resize the dialog box, move the mouse near any edge until the pointer turns into a two-way arrow, then
click and drag the border in any direction. To resize a column, click and drag the column dividers in the list
header, or double click the divider to expand the column just wide enough to display the longest item in the
column.

To configure a new 1/0 unit, click Add or double-click anywhere in the list box below any configured units.
The Add/Edit I/0 Unit dialog box will appear.

To change an I/0 unit in the list, highlight it and click Modify and change the unit's settings in the Add/Edit
170 Unit dialog box.

To remove an I/0 unit in the list, highlight it and click Delete. Only I/O units with a reference count of zero
can be deleted.

To add or modify I/0 points for the highlighted I/0 unit, click 1/0 Points. The Configure /0 Points dialog box
will appear.

To copy and save I/0 Unit configurations, click Import/Copy and select 1/0 units in the I/O Unit
Import/Copy dialog box that appears.

To configure additional items, click the buttons shown below:

Click PID Loops to configure proportional-integral derivative (PID) loops on SNAP PAC brains or R-series
controllers.
«  (lick Modules and select a module type:
- Serial Modules
(see “Configuring RS-232 and RS-485/422 Serial Communication Modules” on page 46)
- Wiegand Modules
(see “Configuring Wiegand Modules”on page 51)
- Profibus Modules
(see “Configuring Profibus Modules”on page 53)
- Motion Modules
(see the SNAP PAC Motion Control User’s Guide, form 1673)
- SSI Modules
(see “Configuring SSI (Serial Synchronous Interface) Modules”on page 54)
—  CAN Modules
(see “Configuring CAN Modules”on page 56)
- HART Modules
(see “Configuring HART Modules”on page 60)
«  (lick Events and select an event to define or an event message to send as a reaction to an event.

«  C(lick Scratch Pad to view and configure bitmask, integer, float, and string memory areas of a SNAP PAC
controller or brain.

NOTE: If you are using the Scratch Pad on a SNAP PAC S-series controller, you must first configure an /O unit to
represent the controller. Configure this I/O unit as a Generic OptoMMP Device, using the IP address for the
controller. (Do not add any points or configure other features.)

«  (lick Communications and select the type of communication to configure, for example, PPP, Modbus,
Security, Streaming, and so on.

«  (lick Others to configure date and time, data logging, or I/0 unit options you want to have saved in the
configuration file.
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CONFIGURE MEMORY MAP VALUES

Use this dialog box to assign values to specific memory map locations that are not otherwise included in
configuration files. These values will be sent to the I/0 unit or controller when you send the configuration file.
For memory map addresses and valid values, see the OptoMMP Protocol Guide (form 1465).

NOTE: If you are using a SNAP PAC S-series controller, you must first configure an /0 unit to represent the controller.
Configure this I/0 unit as a Generic OptoMMP Device, using the IP address for the controller. (Do not add any points
or configure other features.)

The Memory Map Values List displays the Address, Value and Type of each Memory Map Value. The Address is

always represented in hexadecimal (hex). The Value field can contain hex or decimal values (integer types

only). If the value is in hex it is preceded by Ox. The Type field can be either 4-byte Int, 8-byte Int, Float, or

String.

«  Toaddanew Memory Map Value, click Add to open the Add/Edit Memory Map Values dialog box.

«  Tochange an existing Memory Map Value, highlight it and click Modify.

«  Todelete an existing Memory Map Value, highlight it and click Delete. To highlight more than one, hold
down the Ctrl key and click additional items in the list.

CONFIGURE PID LOOPS

Use this dialog box to configure proportional integral derivative (PID) loops on SNAP PAC brains, and R-series

controllers. You can configure up to 96 PID loops. Four algorithms are available to choose from. See also

“Configuring PID Loops”on page 63.

« Toadda PID, highlight the lowest available number in the list and click Add to open the Add/Edit PID
dialog box.

«  Tochange an existing PID, highlight it in the list and click Modify.

«  Todeletea PID, highlight it and click Delete.

Each PID must be configured with essential parameters and then individually tuned for efficiency. You can
configure PIDs through either PAC Manager or PAC Control, but for tuning PIDs, it's easier to use the graphic
tuning tools in PAC Control. (For details, see the PAC Control User’s Guide, form 1700.)

CONFIGURE PPP

Local IP Address. Enter the Local IP Address for the PPP interface on the I/0 unit. Enter the local Subnet
Mask only if you are using classless IP addressing. If you are not using classless IP addressing, leave the Subnet
Mask at zero, and the 1/0 unit will calculate the subnet mask.

IMPORTANT: The network address for the PPP interface must be different from the network ID for the Ethernet
interface. (The network address is obtained by ANDing the IP address and the subnet mask.)

Max Authentication Retries. Enter the maximum number of times a login/password combination can be
retried.

PPP Link Always Connected. If you want outgoing PPP to always be connected, so there is no need for
the 1/0 unit to dial out, check this box.

Modem Initialization String. Change the modem initialization string and modem hangup string if
necessary. Make sure you use the setting to ignore DTR signal in the modem initialization string:

PAC Manager User's Guide = 283


http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1875
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3165

CONFIGURE PPP

The default modem initialization string is AT &D0O"M~~~~

Consult the command reference that came with your modem to determine the correct initialization
command strings. A sample modem initialization string might look like this:
AT&F M~~AT&D0&K0O M~ ~AT&W0 "M~ ~AT&Y 0 M~~

The &F command sets the modem back to factory defaults. The AM tells the Ethernet I/O unit to insert a
carriage return. The ~ tells it to insert a 500ms pause. The &W0 writes the current settings to NVRAM profile 0
on the modem. The &Y0 instructs the modem to use NVRAM profile 0 after resetting.

This initialization string is just a sample; command strings for your modem may differ.

Outgoing PPP. If the I/0 unit will send outgoing calls, complete the Outgoing PPP section:
Choose Enabled from the drop-down list.

In the Use Local IP Address field, choose Yes to have the I/O unit use the Local IP Address you entered for the
PPP link; choose No to have the remote device assign the I/0 unit an IP address for the PPP link. The default is
No.

If you want the I/0 unit to use the device the 1/0 unit is calling as the default gateway for all communication,
choose Yes for Set As Default Gateway. The default is No.

Enter the Login and Password the 1/0 unit should use for authentication when it calls the remote device.
In the Phone number field, enter the number the modem should dial for outgoing calls from the 1/0 unit.

Change the following fields if necessary:

« Inactivity Timeout—If the I/0 unit sends no packets and receives no packets for this number of seconds
after the PPP session is negotiated, the modem will hang up. The default is 30.

«  Max Connect Time—The maximum amount of time in seconds an outgoing PPP connection can stay
connected after successful negotiation. Default is zero, which disables the timer.

«  Max Dial Retries—The number of times the I/O unit will redial if the first attempt fails. Default is zero.

«  RetryInterval—The number of seconds the I/0 unit will wait before trying to redial after the first attempt
fails. Default is zero.

o Disable Time—If the maximum connect time or maximum number of retries has been reached, the
outgoing PPP dialer waits this number of seconds before doing anything. Default is zero.

Incoming PPP. If the I/O unit will receive incoming calls via modem, complete the Incoming PPP section:
Choose Enabled from the drop-down list so the modem will listen for incoming calls.

If you want the I/0 unit to use the device calling the I/0 unit as the default gateway for all communication,
choose Yes for Set As Default Gateway. The default is No.

Change the Inactivity Timeout if necessary. The default is 30.
Enter the Login and Password the I/0O unit should accept for incoming calls.

In the Remote IP Address field, enter the IP address the I/0 unit should give to devices that dial into the I/0
unit and ask for an address. This address must be on the same subnet as the local IP address.

Enter a modem listen string to make sure the modem automatically answers calls. The default modem listen
string is ATS0=1"M~ , which instructs the modem to answer any incoming calls on the first ring. Again, refer
to your modem’s command reference for the correct listen string.
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(Not applicable to SB brains) Profibus modules (part number SNAP-SCM-PROFI) are a type of serial module.
Before configuring a Profibus module, see the SNAP Serial Communication Module User's Guide (form 1191)

for more information about these modules.

1. With the configuration file open, right-click the name of the I/0 unit the Profibus module is on. From the

pop-up menu, choose Configure.
The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

==l

Address
Ethernet 10.192.54.

Mame

‘Wwatchdog
Enabled

4 | i

Cloze | Help |

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules »_-,—— Modules
Events 3 button
Scratch Pad  »
: Communications »
Others 3

2. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Profibus Modules

from the pop-up menu.

| Configure Profibus Modules @
Prafibus odule
Mumber: m [ Used
Address | Dezcription | alue
FMODULE INFORMATION
0«FFFF FOCO 0000 todule Type Digdnome [0=00]
0«FFFF FO3& 7FO0 todule Subtype 0
(«FFFF FO34 FFOZ2 Hardware Revizion D ate KB
(«FFFF FO3A 7RO Loader Wersion KB
(4FFFF FO3A FFO4, Firrare Verzion KB
PORT &
(=FFFF FO3& 8000 IP Part Mumber 22500
(=FFFF FO3& 8004 Baud Rate 15200 =1
0«FFFF FO3& 8008 Parity Even
(=FFFF FO3& 8009 Data Bits a8
(=FFFF FO3& 8004, Stop Bits 1
(«FFFF FO3A 2008 Hardware Flow Contral? &[]
0«FFFF FO3& 800C Power-up Test Meszage? Yes ikl
0=FFFF FO3& 8200 EOM Character List (= 0D Q0000
Cancel Help

3. Inthe Number field, choose the Profibus module’s position from the drop-down list. Click to put a check

mark in the Used box.
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CONFIGURE SERIAL MODULES

If you need to change port numbers, enter the new numbers for each port in the TCP port Number field.

5. Change the Baud Rate and EOM Character List fields if necessary to match your Profibus devices. Choose
whether to have the module automatically send a Test Message when turned on (the default is Yes).

6. When data is correct, repeat from step 3 for additional Profibus modules.

7.  When all Profibus modules are configured, click OK to close the dialog box and return to configuring 1/0O
units.

IMPORTANT: If you have changed a TCP port number, you must save the change to flash and restart the /0 unit
when you send the configuration data to the /0 unit (see “Sending Configuration Data to the I/O Unit” on page 68).

CONFIGURE SERIAL MODULES

This dialog allows you to configure SNAP serial communication modules (part numbers SNAP-SCM-232 and
SNAP-SCM-485) for use with the 1/0 unit. For each serial module port you want to use, click the corresponding
row and then enter or modify the values in the columns listed below. Most values can be changed by
selecting a new value from a drop-down list.

Status. To enable a port on a serial module, select the appropriate row and click the Status column. A
drop-down list is displayed with the choices Enabled, Disabled, and Clear. Choosing Enabled activates the
entire row and assigns default values to each column. Choosing Disabled deactivates the row but doesn't
change any values in the other columns. Choosing Clear deactivates the row and clears all the other columns.
Only the columns that are Enabled will be sent to the I/0 unit.

Module. The module location on the SNAP 1/0 rack. This value cannot be changed.

Port. The serial module port being configured. Each serial module has two ports, A and B. This value cannot
be changed.

IP Port. The IP Port number for access to the serial port. The default value that appears should work for most
IP communication, and changing this value shouldn't be necessary. If the IP port number is changed, however,
the 1/0 unit must be restarted for the change to take effect.

Baud Rate. Choose the baud rate. The default is 9600.

Parity. Choose None, Odd, Even, Mark or Space from the drop-down list. The default is None.
Data Bits. Choose 8 or 7 from the drop-down list. The default is 8.

Stop Bits. Choose 1 or 2 from the drop-down list. The default is 1.

EOM Chars. Enter hexadecimal values representing the End Of Message characters that the /0 Unit should
be looking for. The default is 0DOA, which is the ASClI representation for carriage return and linefeed. A
maximum of eight hexadecimal digits may be entered.

Test Message. Select Yes in the drop-down list if you want the I/0 Unit to send a test message on powerup.
Select No if no test message is desired. The default value is Yes.

CONFIGURE SNMP AGENT

SysName. Enter the name assigned to the I/0 unit as a managed node within the SNMP management
system.
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SysLocation. Enter the physical location of the I/0 unit.
SysContact. Enter the ID of the contact person for the /0 unit.

Community Groups. To set up the Community Groups you need, highlight a line in the list. Click the String
cell within the line and type the name of the group. Then click in the Read, Write, and Trap cells and choose
Yes or No from the drop-down list to indicate whether that group has privileges to read, write, and receive
traps.

Management Hosts. To set up Management Hosts, highlight a line in the list. Start with hosts on the local
network first, because the system sends messages to hosts in numeric order, and it stops sending messages
when it finds a host that it cannot connect to. Click the Community String cell and enter the name of the
community group the host belongs to. Click the Host IP Address cell and enter its IP address, including the
dots (forexample, 10.192.55.60).

Version. From the drop-down list, choose the version of SNMP you are using.

Destination Port. 161 is the default port for SNMP communications. If you know that your application will
use a different port, enter the number of that port here.

Authentication/Cold Start Trap. To enable authentication or cold start traps, click the box to check it.

CONFIGURE STREAMING

Enable Streaming. To enable streaming, choose Yes from the drop-down list.

Enable I/0 Mirroring. |/0 mirroring is a separate function. It's generally not a good idea to use both
streaming and mirroring on the same 1/0 unit. See “Mirroring I/0 Point Data”on page 107 for more
information.

Interval. Enter how often in milliseconds you want the I/0 unit to send the streamed data. If you are
configuring streaming to use only as an event message, set the streaming interval to 0. Zero means that the
stream will be sent only once.

Use Default Streaming Area. To stream all addresses in the Streaming section of the I/0 unit’s memory
map, click Use Default Streaming Area. For more information, see the memory map appendix in the OptoMMP
Protocol Guide (form 1465). (Note that the Streaming section does not include data from high-density digital
modules.)

To stream only part of the Streaming section, or to stream a different part of the memory map, click Specify
Streaming Area. Enter the starting address in the Memory Map Address field (the address must be entered in
hex), and enter the size in bytes of the data to stream in the Size Of Data field.

IP Port. Enter the IP port on the PCs or devices that receive the streamed data. Your application must refer to
this port number. Use the default of 5001 unless you know it is already being used for another purpose.

Stream Target. Enter the IP addresses of up to eight devices to receive the streamed data.

CONFIGURE WIEGAND MODULES

(Not applicable to SB brains) Wiegand modules are a type of serial module. Before configuring a Wiegand
module, see the (form 1191) for more information about these modules.
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CONFIGURE WIEGAND MODULES

1.

2.

With the configuration file open, right-click the name of the I/0 unit the Wiegand module is on. From the
pop-up menu, choose Configure. The Configure I/0 Units dialog box opens.

=»| Configure I/O Units

==l

4

Cloze | Help

Address
Ethernet

I

De Add...

Modify...
Delete

Import/Copy...

1/0 Paints...
FID Loops...
Modules :,—
Events 3
Scratch Pad  »
: Communications »
Others 3

—— Modules
button

Make sure the correct I/0 unit is highlighted. Click the Modules button and choose Wiegand Modules
from the pop-up menu.

| Configure Wiegand Modules @
WWiegand Maodule
Mumber: |0 | [ Used
Address | D escription | Walue
MODULE INFORMATION
O«FFFF FOCO 0000 Module Type Diig/more [0x00]
(«FFFF FOZA 23501 todule Subtype i]
0=FFFF FO3& 8502 Hardware Revision Date REC
0=FFFF FO3& 8506 Loader WVersion REC
0=FFFF FO3& 8504 Firrmwware Version REC
PORT &
0=FFFF FO3& 8600 IP Port Number 22500
0=FFFF FO3& 8604 Format ] |
0=<FFFF FO3& 8608 Data Length kr)
0=FFFF FO3& 8E0C Site Position g
0=FFFF FO3& 8610 Site Length g
(«FFFF FOZA 3614 Badge Pozition 13
0=<FFFF FO3& 8618 Badge Length 15
0=FFFF FO3& 8E1C Parity Check Mo
OxFFFF FOZA 3620 Ewen Parity Poszition i]
0=FFFF FO3& 8624 0dd Parity Pogition ]
PORT B
0=FFFF FO3& 8640 IP Port Number 22501
0=FFFF FO3& BE44 Format ] |
0=FFFF FO3& BE48 Data Length kr)
0=FFFF FO3& BE4C Site Position g
0=FFFF FO3& 8650 Site Length g
(«FFFF FOZA 3654 Badge Pozition 13
0=FFFF FO3& BE5E Badge Length 15
0=FFFF FO3& 8ERC Parity Check Mo
(«FFFF FOZA 3660 Ewen Parity Poszition i]
0=FFFF FO3& BEE4 0dd Parity Pogition ]
QK. | Cancel Help
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3. Inthe Number field, choose the Wiegand module’s position from the drop-down list. Click to put a check
mark in the Used box.

4, Ifyou need to change port numbers, enter the new numbers for each port in the TCP port Number fields.

5. Clickthe Format/Value cell, and from the drop-down list, choose a standard data format (shown by its
total data length) or choose C for custom.

NOTE: O is the 37-bit Opto 22 format used in a sample PAC Control strategy available for use with Wiegand
modules. For details, see the SNAP Serial Communication Module User's Guide (form 1191).

6. Change the following fields if necessary to match your Wiegand hardware device:
Data Length—total length of data in the transmission
Site Position—first bit of the site code
Site Length—Iength of the site code, in bits
Badge Position—first bit of the badge code (should be the next bit after the site code)
Badge Length—Iength of the badge code, in bits
7. When data for both ports is correct, repeat from step 3 for additional Wiegand modules.

8. When all Wiegand modules are configured, click OK to close the dialog box and return to configuring I/O
units.

IMPORTANT: If you changed a TCP port number, you must save the change to flash and restart the I/O unit when you
send the configuration data to the I/O unit (see page 68).

9. When you are ready to send all configuration data to the I/O unit, see “Sending Configuration Data to the
I/0 Unit"on page 68.

FIND OPTO 22 MMP DEVICES

Use this dialog box to find out the MAC addresses, IP addresses, firmware versions, and/or unit types of all
Opto 22 memory-mapped devices on the network. Opto 22 memory-mapped devices include SNAP PAC and
SNAP-LCE controllers, SNAP Ethernet, SNAP Ultimate, and SNAP Simple I/0 units, and E1 and E2 1/O units.
(Opto 22 M4-series controllers with Ethernet cards are not included.)

CAUTION: You may have problems if your network includes old Opto 22 SNAP Ethernet brains with firmware version
R1.3m or earlier, or controllers with MASENET-100 adapter cards at firmware version R1.3k or earlier (these may be
affected by the Find feature even though it does not report them). These brains and adapter cards may have to be
rebooted if you use the Find feature. To avoid this problem, update the older devices to newer firmware first.

1. Leave the MMP Port at 2001 unless you have changed it for security purposes.
2. Adjust the Timeout if necessary for your network. Timeout is in milliseconds.

3. ClickFind. All the Opto 22 MMP devices on your network are listed. The total number of devices is shown
in the Devices Found field.

4. If youwant to copy device information to the clipboard, click Copy.

INSPECT OPTO 22 DEVICE

When you use the Inspect Opto 22 Device window, you are reading and writing directly to a specific SNAP PAC
controller or brain. You must have its IP address in order to do so. The type of device determines which areas
are supported.

CAUTION: Any configuration changes you make here are not saved in a configuration file.
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I/0 UNIT IMPORT/COPY

To use the Inspect Opto 22 Device window, enter the IP address of the device (or choose it from the
drop-down list). Then click the button on the left that corresponds to what you want to do:

Status Read. See basic information about a SNAP PAC controller or brain. See “Interpreting Status Data” on
page 149.

Status Write. Send commands to a device (such as Store configuration to flash), change the unit’s basic
configuration (such as whether degrees are shown in F or C), or assign the second IP address on a SNAP PAC
controller (see “Assign Secondary IP Address”on page 245).

Wireless LAN. Choose to configure a wireless LAN or view a wireless LAN's status. See “Configuring Wireless
LAN Communication (Wired+Wireless Models Only)”on page 22.

Point Config. Configure I/0 points. See “Configuring Analog and Digital Points and Features” on page 158.
Digital Bank, Analog Bank. Read |/0 points. See “Reading Analog and Digital Banks” on page 179.

Digital Point, Analog Point. Read or write to individual 1/0 points. See “Reading and Writing to Points”on
page 1/1.

High Density. Read or write to SNAP high-density digital points. See “Reading and Writing to SNAP
High-Density Digital Points” on page 182.

System. Read or change the date and time. See “Reading System Date and Time”on page 184.

Scratch Pad. Read or write to Scratch Pad Bits, Integers, Floats, and Strings. See “Reading and Writing to the
Scratch Pad Area” on page 184.

Data Log. Configure data logging and read the log. See “Data Logging”on page 186.
PID. Configure PID loops. See “Configuring, Viewing, or Changing PID Loops”on page 169.

Events. Read current events and change events; configure event messages. See “Configuring Event
Messages”on page 141.

Communications. Display information about and configure security, protocols, communication ports, and
a variety modules including serial modules (RS-232, RS-485/422, Wiegand, Profibus, Motion, SSI, CAN, and
HART modules). For information on how to configure these modules, see “Configuring I/0 Modules and
Points”on page 35.

Other. Read or write to any address in the device’s memory map. For a complete list of memory map
addresses, see the OptoMMP Protocol Guide (form 1465).

|/0 UNIT IMPORT/COPY

Use this dialog box to import and copy I/0 unit flash memory images. An 1/0 unit's flash memory contains
information about any settings that have been explicitly configured for that unit. A flash memory image saves
this information so it can be stored in a file or copied to another |/0O unit. The dialog box contains:

Existing 1/0 Unit Flash Memory. Choose an existing 1/0 unit. If you want to add or modify an I/0 unit,
click Options. For help, see “Add/Modify New Device” on page 243.

PAC Manager User’s Guide


http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1875" target="_blank
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1875" target="_blank

APPENDIX B: DIALOG BOXES

Previously Saved I/0 Unit Image File. Select this option and enter the filename of a flash memory
image file that you want to copy to another 1/0 unit. You can also click the Browse button at the end of the
filename field and locate the image file using the standard File Open dialog box.

Read. After selecting an Image Source option, click Read to read a flash memory image from an I/O unit or an
existing flash memory image file. Note that the dialog box does not close when you click this button.

Send Image To I/0 Unit Flash Memory. Select this option and enter an I/0 unit's IP address to copy the
selected flash memory image source to that unit.

Save To I/0 Unit Image File. Select this option and enter the name of a file that will store the flash
memory image. You can also click the Browse button at the end of the filename field and specify the name
and location of the image file using the standard File Save dialog box.

Create New I/0 Unit. Select this option to create a new /0 unit in PAC Manager using the selected flash
memory image source. Since the source image does not contain an I/0 unit name, you will be prompted to
enter one. For more information, see “Creating a New I/O Unit from an Existing One”on page 28.

Send/Save/Create. After selecting an Image Destination option, click this button to copy the image source
to an I/0 unit, save the image source to afile, or create a new I/0 unit in PAC Manager. Note that the dialog
box does not close when you click this button, so you can repeat the Read-Send/Save/Create cycle as needed.

|/0 UNIT MAINTENANCE

To use the /0 Unit Maintenance dialog box, see one of the following topics:

“Changing IP Addresses” on page 199
“Installing New Firmware”on page 201
“Maintaining Files” on page 217

For other maintenance tasks, such as resetting the device to factory defaults or handling a device whose IP
address you don't know, see the controller or brain user's guide.

MOVE POINTTO

Use this dialog to move an I/0 point from one 1/0 unit to a location on another (or the same) I/0 unit.

The 1/0 Units list displays all I/0 units that are compatible with the point being moved. The current I/0 unit is

highlighted. The Points list displays all I/0 points on the highlighted I/0 unit. Currently configured /0O points

are in gray text, and open channels are marked Unused.

1. Selectan open channel on the current I/O unit or select another I/0 unit (if available) from the I/O units
list and select one of its channels as the destination channel.

2. Click OK to move the I/0 point to the specified channel.

SCALE ANALOG READINGS

|n

This dialog box is used to specify a custom scale factor that will convert from the “real” units of a module to

some engineering units which describe the process parameter being measured.

Scaled Units. Type the name of the new engineering units (EU) for the module here. (Simply delete the
default scale and type a new scale—for example, PSI.) As soon as you press Tab or click outside this field, the
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name of the new EU appears in the protected (grayed-out) Scaled columns in the Lower Value and Upper
Value areas of the dialog box.

Actual Lower Value. Provide the actual real-world lower value that you wish the scaled lower value to
correspond to. By default, the zero-scale value appears.

Note that inputs typically have under-range capability, which means you can specify a lower actual value less
than the zero-scale value. Outputs do not have under-range capability.

Actual Units. The actual units of the module appear here. They are displayed for reference only and cannot
be changed.

Scaled Lower Value. Type in the new scaled lower value here. This can be any floating point value.
Scaled Units. The name of the new units you typed in the Scaled Units field (above) appear here.

Actual Upper Value. Provide the actual real-world upper value that you wish the scaled upper value to
correspond to. By default, the full-scale value appears.

Note that inputs typically have over-range capability, which means you can specify an upper actual value
greater than the full-scale value. Outputs do not have over-range capability.

Actual Units. The actual units of the module appear here. They are displayed for reference only and cannot
be changed.

Scaled Upper Value. Type in the new scaled upper value here. This can be any floating point value, as long
as it is greater than the scaled lower value.

Scaled Units. The name of the new units you typed in the Scaled Units fields (above) appear here.

SEND CONFIGURATION TO I/0 UNIT

262

Use this dialog box to send configuration information to one or more /0 Units.

1/0 Units List. The list on the left shows all the I/0 units in this configuration file. When you click a unit, the
Address List shows all the IP addresses associated with the highlighted unit. This is the address list you set up
in the Add/Edit I/0 Unit.

Sending Configuration Information

Highlight the /0 unit configuration(s) you want to send.

2. Highlight the IP addresses to receive the I/0 unit configuration. If you don't highlight any addresses, the
configuration will be sent to the entire list. If you highlight more than one I/O unit configuration, each
unit configuration will automatically be sent to all the IP addresses associated with it.

3. If necessary, change the Timeout field. The timeout field shows how long, in milliseconds, PAC Manager
will try to communicate with the I/0 unit before returning a timeout error.

4. To save the configuration file to flash memory as well as to RAM, check Save to Flash. To also restart the
unit, check Restart Device.

IMPORTANT: For the following configurations, you must save to flash and restart the I/O unit in order any
changes to the configuration to take effect:

—  Changesin IP port for serial modules
- SNMP configuration
—  Email configuration
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- PPP configuration
- Datalogging interval

Clearing Flash. To erase the flash memory of all highlighted I/0 units in the list, click Clear Flash. Click
Details to show or hide the Status Area, which displays the results of the last Send or Clear Flash operation.
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A

accessing data log, 89
address, assigning IP address, 8
to multiple devices, 14
alarm
clearing configuration, 194
configuring, 138, 188
description, 137
trigger, 137
types, 137
algorithms for PIDs, 64
analog bank
data format, 197
reading, 179
analog module data format, 198
analog point
average filter weight, 72, 75
bipolar, 73
calibrating, 44, 175
clamping, 71, 75
configuring, 40, 157
features, 73
gain, 71
maximum value, 71
minimum value, 71
minimum/maximum value, 74
offset, 71
offset and gain, 44, 74, 175
reading, 174
scaling, 42, 71,73
unipolar, 73
viewing data, 157
watchdog, 71,73
writing to, 174
assigning IP address, 8, 14
average filter weight, 72, 75

B

bootloader mode, for loading firmware, 214

C

CA root certificate, 216
calibrating analog point, 44, 71, 175
CAN modules
configuring, 56
cascading events and reactions, 128
changing
/0 points automatically, 107
IP address, 199
clamping analog output point, 71, 75
clearing
configuration, 194
configuration data from flash memory, 70
datalog, 90
file from /0 unit, 222
files from flash memory, 222
resetting to defaults, 191
communicating with /0 unit
assigning IP address, 8
monitoring communication, 73
communicating with processor
IP address, 8
communication
dial-up, 122
modem, 122
PPP, 122
serial, 117
wireless, 22
community groups, 97
configuration data on microSD card, 192
configuration file, 26
adding analog point, 40
adding digital point, 35
adding I/0 unit, 31
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copying, 62
creating, 27
creating from a PAC Control strategy, 30
custom scaling, 42
loading to brain, 68
moving I/0 point, 62
configuration, clearing, 194
configuring
alarm events and reactions, 137
alarms, 138
CAN modules, 56
communications port, 117
copying I/0 configuration, 28
data logging, 87
data streaming, 104
date and time, 115
delayed reactions to events, 133
digital event/reactions, 131
email, 100
event messages, 92
event/reactions, 130
/0, 26, 157
I/0 unit, 31
mistic 1/0 units, /
PID loops, 63, 169
PPP, 122
Profibus modules, 53
RS-232 and RS-485/422 serial modules, 46
Scratch Pad, 102
serial event/reactions, 139
serial modules, 168
serial ports on brain or controller, 117
serial synchronous interface (SSI) modules, 54
SNMP, 96
Wiegand event/reactions, 139
Wiegand modules, 51
wired network security, 78
wireless LAN, 22
control engine port, changing, 80, 84
controller
assigning IP address, 8
changing IP address, 199
control engine port, 80
restarting, 191
converting IEEE float, 197
copying
/0 configuration, 28
memory map data, 109
counter
description, 70, 72
quadrature, 73

266 PAC Manager User’s Guide

D

data
copying from memory map, 109
formatting and interpreting, 195
IEEE float format, 197
streaming, 92, 104
data format
2-channel analog modules, 198
digital bank counters, 196
digital channel, 196
IEEE float, 197
mask, 195
data logging
accessing data, 89
clearing data log, 90
configuring, 87, 186
values from memory map addresses, 87
date and time
configuring, 115

reading, 184
deadband, 139
deleting

configuration data from flash memory, 70
file from 1/0 unit, 222
deviation alarm, 137
diagnostic messages, 227
dial-up networking, 122
digital bank
counter data format, 196
reading, 179
digital channel
data format, 196
digital event/reactions
clearing, 194
configuring, 131, 188
description, 131
examples, 133
trigger, 133
digital point
configuring, 35, 157
counter, 70, 72
features, 70
latching, 70, 72
on high-density module, 182
quadrature counter, 70, 73
reading, 172
state, 70,72
viewing data, 157
watchdog, 71, 73
writing to, 172
disable host communication, 80
DNS Resolver, 99



downloading
see loading or installing

E

edge trigger, 137
email
clearing configuration, 194
configure DNS server, 99
configuring, 100, 189
message, 92
erase
configuration from microSD, 194
firmware from microSD, 194
strategy from microSD, 194
error messages, 225
Ethernet 2 IP address, assigning, 17
Ethernet errors, 231
EtherNet/IP
turning off protocol, 81
event message
configuring, 92, 188
plugins, 95
event/reaction, 131, 133, 188
cascading, 128
configuration steps (table), 130
configuring digital, 131
delayed, 133
Scratch Pad, 127
serial, 139
types, 129
Wiegand, 139
exclamation mark button, 227

F

failsafe bootloader mode, 214
file
clearing from flash memory, 222
deleting from file system, 222
loading from flash memory to file system, 222
reading filenames, 221
sending from 1/0 unit, 220
sending to I/0 unit, 219
file storage, removable, 217
file system on brain or controller, 217
filter address, 84, 87
filter mask, 84, 87
filter weight, 75
find Opto 22 MMP devices, 228
firmware
failsafe bootloader, 214
for serial module, 210

getting data about, 226, 228
loading to controller, 201
loading to 1/0 unit, 201
replacing damaged, 214
flash memory, 70
clearing files, 222
loading files from, 222
saving configuration data to, 68, 190
saving file system files, 222
float
format, 197
IEEE, 197
Modbus, 112
flow control, 48
format
IEEE float, 197
Modbus float, 112
of counter data, 196
of data, 195
of data for 2-channel analog modules, 198
of digital channel data, 196
FTP
client software comparison, 217
default port, 78
limiting access to, /78
login, 80
password, 80
reading filenames, 221
sending files to and from 1/0 unit or controller,
217

G

G4EB2
configuring points, 38
gain, 44, 74,174,175
definition, 71
gateway address, 11

H

hardware, getting data about, 226, 228
help

troubleshooting, 225
high limit alarm, 137
high-density digital modules

reading or writing to points, 182
host communication, disabling, 80
host name

configure DNS server, 99
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| loading

configuration file, 68

files from flash memory, 222

new firmware to /0 unit or controller, 201

I/0 modules
configuring analog and digital, 26
configuring RS-232 and RS-485/422 serial mod-

nof new firmware to serial module, 210
o / logging
viewing, 157 data, 87

I/0 point
clearing configuration, 194
configuring, 35, 157
features, /0
logging data, 87
mirroring, 107
reading, 171 M
reset points to defaults, 191 MAC address 8

wiiting to, 171 management hosts, 97

serial port data, 231
wireless data, 233
login for FTP, 80
low limit alarm, 137

/0 unit i
. map file, 14
adding, 31 mapping IP addresses, 14
changing IP address, 199 maspf ’ ,

clearing files from flash memory, 222
copying between configuration files, 62
deleting file, 222
file system, 217
getting files via FTP, 220
hardware commands, 190
loading files from flash memory, 222
reading basic information, 147/
restarting, 191
saving files to flash memory, 222
sending files via FTP, 219
IEEE float, 197
initializing Scratch Pad values, 102
installing
new firmware to 1/0 unit or controller, 201
interacting algorithm for PID, 64
IP address
assigning, 8
assigning IP address to Ethernet 2, 17
assigning to multiple devices, 14
assigning wireless, 22
changing, 199
mapping, 14
ISA algorithm for PID, 64

data format, 195

digital point, 132

Scratch Pad, 132
maximum value, 71, 74
memory

saving configuration to, 190

saving files, 222
memory map

copying data, 109

logging data from, 87
message, 92

plugins, 95
microSD card, 217
microSD commands, 192, 194
minimum value, 71, 74
mirroring I/0 point data, 107
mistic /0 units, 7
MMP devices, finding, 228
Modbus/TCP

changing float format, 112

configuring, 189

default port, 78

limiting access to, /78

memory map address conversion, 113
modem, 122
K module types, 160
MOMO, 131
mounting rack

M-series, 156

kernel, see firmware

L SNAP PAC, 156
moving
latdgj’e;ﬁmon 70 files from 1/0 unit, 220

files to 1/0 unit, 219

level trigger, 133 /0 point in configuration file, 62
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must-on, must-off, 131

N

network
find OptoMMP devices, 228
security on wired network, 78
security on wireless LAN, 22

0

off, 72
off-latch, 70, 72
offset, 44, 74,174,175
definition, 71
on, 72
on-latch, 70, 72
operation commands, 190
OptoMMP
default port, 78
find devices, 228
limiting access to, 78
OptoMMP device commands, 190

P

PAC Control, 127, 147
and direct reads and writes, 147
and event/reactions, 127
copying configuration files from, 30
managing files on 1/0 unit or controller, 217
protecting strategy, 80
parallel algorithm for PID, 64
password
for FTP, 80
peak, /1
PID loops
algorithms, 64
configuring, 63, 169
plugins, 95
point types, 160
port
changing, for security, 78
serial, on brain or controller, 117
ports for serial modules, 156
power
powerup clear, 192
restarting controller, 191
restarting 1/0 unit, 191
powerup clear, 192
PPP
clearing configuration, 194
configuring, 122, 189

troubleshooting serial communication, 231
primary IP address, assigning, 8
problems, troubleshooting, 225
processor
assigning IP address, 8
Product Support
getting device and firmware data, 226, 228
Profibus
configuring modules, 53
protecting PAC Control strategy, 80
protocol
default ports, 78
limiting access to, /78
turning off EtherNet/IP, 81

Q

quadrature counter, 70, 73

R

reaction

delayed, 133

digital, 137

example, 133

Scratch Pad, 127

trigger

analog, 137
digital, 133

reading

analog bank, 179

analog point, 174

data log, 89

digital bank, 179

digital point, 172

digital points on high-density modules, 182

filenames on file system, 221

/0 points, 171

/0 unit information, 147

Scratch Pad, 184

system date and time, 184
registered management hosts, 97
removable storage, 217
reset points to defaults, 1971
reset to defaults and restart device, 191
Restart device from powerup, 191
retransmit timeout (RTO), 229
root certificate, 216

S

saving
configuration to flash memory, 68, 190
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file system files to flash memory, 222 state of digital point, 70, 72

scaling Status Read information, 149
analog point, 42 store configuration and IP settings to microSD, 193
description, 71,73 store configuration to flash, 190

scanner flags, 155 strategy

Scratch Pad, 127 protecting, 80
masks, 132 streaming data, 92, 104, 189
reading, 184 subnet mask, 8
setting initial values, 102
writing to, 184

secondary IP address, assigning, 17 T

security, 22, 78, 189 TCP/IP
FTP login, 80 settings, 229

send powerup clear, 192 stack, 229

serial time, system, 115, 184
communication, troubleshooting, 231 timed events, 134
event/reactions, 139, 188 timeout, 229
message, 92 timer, configuring, 194
ports on brain or controller, configuring, 117 traps, 97

serial modules troubleshooting, 225
2-wire or 4-wire mode, 48 diagnostic messages, 227
CAN, 56 Ethernet errors, 231
flow control, 48 getting device and firmware data, 226, 228
loading firmware, 210 serial communication, 231
port numbers, 156 Status Read data, 149
Profibus, 53 TCP settings, 229
serial synchronous interface, 54 wireless communication, 233
Wiegand, 51

serial modules (RS-232, RS-485/422)
configuring, 46 U

serial synchronous interface UDP and streaming data, 104
configuring modules, 54

setting offset and gain, 44, 175

SMTP V
Configure DNS server, 99 valley, 71

SNAP PAC controller velocity algorithm for PID, 64
assigning IP address viewing module and point data, 157

Ethermet 2, 17
primary, 8
file system, 217 W

SNAP PACREST API, 2, 79 watchdog, 73

SNMP definition, 71
access privileges, 97 Wiegand
agent, 97 configuring modules, 51
community groups, 97 event/reactions, 139, 188
configuring, 96, 189 wireless LAN
default port, 78 configuring, 22
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